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  めにࡌࡣ 

  についてࣝ࢔ࣗࢽ࣐

 ࠋࡍ࡛ࡢࡶࡓࡋい࡚記述ࡘ࡟び訂ṇࡼ࠾機能強化ࠊい機能ࡋ新ࡿࡅ࠾࡟FEMtoolsࠊࡣࢺン࣓ࣗ࢟ࢻࡢࡇ

関連ࢻキ࣓ࣗンࢺ 

 ࠋいࡉࡔࡃ࡚ࡋ参照ࡶࣝ࢔ࣗࢽ࣐ࡢ௚ࡢࡑࠊࡣࣝ࢔ࣗࢽ࣐ࡢࡇ

  使用方法ࡢࢺキ࣓ࣗンࢻ

FEMtools࣓ࣗ࢟ࢻࡢンࠊࡣࢺHTML࡟基࡙いࡼ࠾ࣉࣝ࣊ࡓび PDF࣐࡚ࡗࡼ࡟ࣝ࢔ࣗࢽ利用࡛ࠋࡍࡲࡁ 

 ࠋいࡉࡔࡃ࡚ࡋ選択ࢆࢡࢵࣆࢺࣉࣝ࣊ࡽ࠿࣮ࣗࢽ࣓࣭ࣉࣝ࣊ࠊࡣ࡟ࡿࡍࢫࢭࢡ࢔࡟ࣉࣝ࣊

 ࣐ࡢࣝ࢔ࣗࢽ目次ࢆ参照ࠊࡣ࡟ࡿࡍContentsࢆࣈࢱ使用ࡉࡔࡃ࡚ࡋいࠋ 

 索引㡯目ࣜࢆࢺࢫ参照ࠊࡣ࡟ࡿࡍIndexࢆࣈࢱ使用ࡉࡔࡃ࡚ࡋいࠋ 

 ࠋࡍࡲࡋ準ᣐ࡟࣒ࢸࢫࢩ࣭ࢢン࢕ࢸ࣮ࣞ࣌࢜ࡣい࡚ࡘ࡟௙様ࡢࣈࢱࡢ௚ࡢࡑ

࡟ࡵࡓࡴㄞࢆࣝ࢖࢓ࣇPDFࠋいࡉࡔࡃ࡚ࡋ選択ࢆManualsࡽ࠿࣮ࣗࢽHelp࣓ࠊࡣ࡟ࡿࡍࢫࢭࢡ࢔࡟ࣝ࢔ࣗࢽ࣐
ࡣ Adobe Acrobat Reader࢖ࢆンࠋࢇࡏࡲࡾ࡞ࡤࢀࡅ࡞ࡋ࣮ࣝࢺࢫ 

FEMtoolsࢻキ࣓ࣗンࢺに࠾いて使用さࡿࢀ規則 

FEMtools࣐ࠊࡣࣝ࢔ࣗࢽ視覚的࡟情報ࢆ識別࡟ࡢࡿࡍ便利ࡼ࡞うࠊ࡟いࡢ࠿ࡘࡃ規則ࢆ設࡚ࡅいࠋࡍࡲ 

                     記号          用途ࡣࡓࡲࣝ࢖ࢱࢫࡢࣉ࢖ࢱ
extract nodes FEMtools ࣐ࢥン࢖ࣛࢻンࡢ例 
SET ECHO FEMtools ࣐ࢥン࣐ࢥࡣࡓࡲࢻンࡢࢻ構文 
Settings ࣓࣐ࢥ࣭࣮ࣗࢽンࢻ 

 ࠋࢇࡏࡲࡾ限ࡣ࡜ࡿࢀࡉ適用ࡶࡋࡎ必ࠊࡣい࡚࠾࡟ࢺン࣓ࣗ࢟ࢻ᪥本語ࡣ規則ࡢࡇ ※

統一性࡜ Linuxࡢ࡛࣒࣮࢛ࣇࢺࢵࣛࣉ大文Ꮠ／ᑠ文Ꮠࡢ区別ࢆ考慮ࠊ࡚ࡋFEMtools࣐ࢥン࠾࡟ࢺࣉࣜࢡࢫ࣭ࢻ
ࢻࡢFEMtoolsࠊࡋ࠿ࡋࠋࡍࡲい࡚ࢀࡉ使用ࡀᑠ文Ꮠ࡚ࡋ対࡟㸧ྡࣝ࢖࢓ࣇ࡟引数㸦特࡜ࢻン࣐ࢥࡢ࡚࡭ࡍࡿࡅ
࣓࢟ࣗンࠊࡣ࡛ࢺㄞࡳ易࣐ࢥ࡟ࡵࡓࡿࡍࡃンࡣࢻ通常大文Ꮠ࡛記࡚ࢀࡉいࠋࡍࡲ 
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FEMtools 4 について 

FEMtools 4ࠊࡣFEMtools࣒࣮ࣞࣇワ࣮ࡼ࠾ࢡびࡢࡑ௚ࣙࢩ࣮ࢣࣜࣉ࢔ࡢ࡚࡭ࡍࡢン࣭ࣔࡼ࠾࣮ࣝࣗࢪび࢜ࢻ࢔
ン࣭ࡢ࣮ࣝࢶ新ࣙࢪ࣮ࣂン࡛ࠊࡓࡲࠋࡍFE࢖࣭ࢱ࣮ࢹンࡼ࠾ࢫ࢖࢙ࣇ࣮ࢱびࡣࣂ࢖ࣛࢻ FEࡢ࣒ࣛࢢࣟࣉ現行版
 ࠋࡍࡲࢀࡉ更新࡟ࡵࡓࡿࡍࢺ࣮࣏ࢧࢆ

FEMtools 4ࣙࢪ࣮ࣂンࢆࢺ࢖ࣛ࢖ࣁࡢ以ୗ࡟要約ࠋࡍࡲࡋ 

 Windows64࣒࣮࢛ࣇࢺࢵࣛࣉࡢࢺࢵࣅ㸦710ࠊ8ࠊ㸧ࠊLinux 64ࢺࢵࣅ RHEL6+ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆ 
 ࣐ࢦ࣭ࣟࢺࣇࢯࣟࢡ࢖条件ࡢ࡚࡭ࡍࠊ FEMtools EXEࡼ࠾び DLLࣝ࢖࢓ࣇࠊ㸦Windows㸧࡛ࣝࢱࢪࢹࢆ署ྡࡋ

 㸦v4.1.1㸧ࠋࡍࡲ
 新ࠕCheck for Updates࣒ࠖࣛࢢࣟࣉ自動更新機能 
 ࢺࢵࢿࠊࢡࢵࣟࢻ࣮ࣀワ࣮ࢺࢵࢿࠊࢡワ࣮࣑࣮ࣟࠊࢡンࡢࢢ更新ࣛࢭ࢖ンࢆࢫ形成ࡿࡍ新ࡋいࣛࢭ࢖ン࣭ࢫ

 ࣮ࢱ࣮ࣞࢢ࢕ࣇンࢥ
 最新࣋ࢥ࢖࢔࣭ࢫ࣮࣭࣋ࣝࢺࢡン㸦SVG㸧ࡢᑟ入 
 高解像ᗘࣔࢱࢽ㸦4K㸧ࡢ自動ࢥ࢖࢔ン 
 新࢖ࠕンࠖࢱ࢕ࢹ࢚࣭ࣝࢹ࣭ࣔࢺࢫࢸ࣭ࣈ࢕ࢸࢡࣛࢱ 
 ࢟ࢵࣆ࣭ࢡࢵ࢕ࣇࣛࢢンࢢ機能ࡢ改良㸦表示用࢟ࢵࣆンࠊࢢFace࢟ࢵࣆン࢟ࢵࣆ࣭ࢻࢳࢵࢱࢵ࢔ࠊࢢンࢢ㸧 
 ࣮࣓࢝ࢢࢭ࣭ࣈンࢡ࣮ࣆࡢ値ࢆ見ࡿࡅࡘ新ࣂン࣮ࢱࢡࣛࢺࢻ㸦v4.2㸧 
 ࢚ンࢪン㸦v4.1࡜ v4.2㸧ࢆ୚えࡿ最適化ࢫࢡࢵ࢕ࣇࣛࢢ 
 新ࣝࢱࢪࢹ信号処理㸦DSP㸧࣐ࢥンࢻ 
 時系列࢕࢘࡜ࠖࣝࢿࣕࢳ࣭ࢱ࣮ࢹࠕン࢘ࢻ関数ࢆ定義ࡢࡵࡓࡿࡍ新ࡋい࣐ࢥンࢻ 
 2D࡜ 3Dࡢ要素ࡢ Strain࡜ Stressࢸࡢンࠊࢺ࣮࣏ࢧࡢࣝࢯෆ部計算値あࡿい࢖ࡣン࣏࣮࢖࣭ࢱ࣮ࢹ࣭ࢺン࣮ࢱ

 㸦v4.1㸧ࢫ࢖࢙ࣇ
 ABAQUSࠊANSYSࠊNASTRANࠊSAP2000ࡢ最新ࣙࢪ࣮ࣂンࢺ࣮࣏ࢧࡢ 
 ANSYS࢖ン࢙ࣇ࣮ࢱｲࡢࣂ࢖ࣛࢻ࡜ࢫ新ࡋい革新的࡞ FEᢏ術㸦v4.2㸧 
 新 ANSYSࡿࡼ࡟ࢱ࣮࣓ࣛࣃ感ᗘ解析࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔ࡜ンࡢࢢᢏ術更新㸦v4.2㸧 
 静的変఩ࠊABAQUSࠊANSYSࠊNASTRAN࢖ン࢙ࣇ࣮ࢱｲࡢࣂ࢖ࣛࢻ࡜ࢫ追加ࢺ࣮࣏ࢧ㸦v4.1㸧 
 ABAQUS SIMࣝ࢖࢓ࣇ㸦v4.0.1㸧ࡢ࡜新࢖ン࢙ࣇ࣮ࢱｲࢫ 
 LS-DYNA᭷限要素ࡢ࡜ࢪ࣮ࢣࢵࣃ新࢖ン࢙ࣇ࣮ࢱｲࢫ 
 克服࣓ࣜࣔࡓࢀࡉ制限ࡢ࡬新ࡋい芯外ࣙࢩࣉ࣮࢜ࣂࣝࢯン 
 FEMtoolsࡿࡼ࡟࣮ࣂࣝࢯ ILP64㸦8ࢺ࢖ࣂ㸧整数࢖ンࡢࢱ࣮ࢹ࣭ࢫࢡࢵࢹ使用 
 ILP64ᣑ張࣏࢖ン࢖࣭࣮ࢱンࢫࢡࢵࢹ付ࡿࡼ࡟ࡅ大規模ࢺ࣮࣏ࢧࡢࢺࢵࢭࢱ࣮ࢹ㸦v4.1㸧 
 感ᗘ㸦MLS㸧ࡿࡍࢻ࣮ࣟࢆ質量計算ࡢ新࣮ࣝࢶ 
 ࣮ࣔࢻ参加地ᅗ㸦MPM㸧ࢆ計算ࡢࡵࡓࡿࡍ新࣮ࣝࢶ 
 加振ࡼ࠾びࢺ࣮࣏ࢧ఩置選択用ࡢ新ࡋい࣮ࣝࢶ 
 新MACࢬ࢖࣐ࢱࢫ࢝ࡢࣝࢿࣃ࣭࣮ࣗࣅࣉࢵࢺ㸦v4.2㸧 
 新࣮ࣔ࢔࣮ࣗࣅ࣭࢔࣭࣌ࣉ࣮࢙ࢩࢻ 
 ࢖ࣞࢺࢫン࣭࣏ࣞࢫンࢫ㸦v4.1㸧࣏ࢫ࣭ࣞࢫࣞࢺࢫࠊンࢫ㸦v4.2㸧ࡿࡼ࡟ࢺ࣮࣏ࢧࡢ相関ศ析ࠊ感ᗘ解析ࣔࠊ

 更新ࡢࢢン࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹ
 材料特性࡜幾何学的特性࢖ࡢンࢫࢡࢵࢹ㸦v4.1.1㸧ࢆ直接参照ࡿࡍ新ࡋい材料特性࡜幾何学ࢱ࣮࣓ࣛࣃ 
 RSM逆算࡜検証ࡢࡵࡓࡢ新ࡋい࣐ࢥンࢻ 
 最ᑠࡢ FRFࣞ࣋ࣝ design.2ࡢࡵࡓࡢ Topometry最適化 
 FEMtools RBPE㸦剛体ࡢ࣮ࢱࢡࣛࢺࢫࢡ࢚࣭࢕ࢸࣃࣟࣉ更新㸦v4.2㸧 

主ࣙࢪ࣮ࣂ࡞ン࣭࣮ࣜࣜࢫᒚ歴 

V4.0.0.1830    June 2017 
V4.0.1.1850 to v4.0.1.1885  December 2017 – April 2019 
V4.1.0.1971 to 1772   June 2019 
V4.1.1.1991    October 2019 
V4.1.2.1996 to 1998   March 2020 – May 2020 
V4.2.0    March 2021 
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FEMtools 4ࢻキ࣓ࣗンࢺとࢽ࣮ࣞࢺンࢢ 

FEMtools࣓ࣗ࢟ࢻンࢡࢵࣈ࣭࣒ࢸࢫࢩࠊࢺ࣮ࣀ࣭ࢫ࣮ࢥࠊࣉ࣭࣒ࣝ࣊ࢸࢫࢩࡣࢺ㸦PDF㸧ࡼ࠾び出力物࢔ࣗࢽ࣐ࡢ
࡛ࣝ構成࣓ࣗ࢟ࢻࡢ࡚࡭ࡍࠋࡍࡲࢀࡉンࡀࢺ現ᅾࣙࢪ࣮ࣂ࣭ࢫ࣮ࣜࣜࡢン用࡟更新࡚ࢀࡉいࠋࡍࡲ 

 概説ࢺキ࣓ࣗンࢻ

FEMtools 4࣓ࣗ࢟ࢻンࡣࢺ次࣓ࣗ࢟ࢻࡢン࡛ࢺ構成ࠋࡍࡲࢀࡉ 

 FEMtools 4 Release Notes㸦࣮ࣜࣜࢺ࣮ࣀ࣭ࢫ㸧：ࠊࡣࣝ࢔ࣗࢽ࣐ࡢࡇFEMtools 4.0ࡢ新ࡋい特徴ࢆ紹௓ࠊࡋ従
来ࣙࢪ࣮ࣂンࢻ࣮ࣞࢢࣉࢵ࢔ࡢࡽ࠿方法ࡘ࡟࡝࡞い࡚解ㄝࠋࡍࡲࡋ 

 FEMtools 4 Getting Started Manual㸦ᑟ入࣐ࣝ࢔ࣗࢽ㸧：࢖ࠊࡣࣝ࢔ࣗࢽ࣐ࡢࡇンࢭ࢖ࣛࠊ࣮ࣝࢺࢫンࢿ࣐࣭ࢫ
 ࠋࡍࡲࡋい࡚解ㄝࡘ࡟形成方法ࢆFEMtoolsࠊ起動ࠊࢺン࣓ࢪ࣮

 FEMtools 4 Framework User's Guide㸦࣒࣮ࣞࣇワ࣮ࢻ࢖࣮࢞ࢨ࣮࣭ࣘࢡ㸧：ࠊࡣࢻ࢖࢞ࡢࡇFEMtoolsࣔ ࣮ࣝࣗࢪ
㸦࣮ࣘ࢖࣭࣮ࢨン࢖࣭ࢱ࣮ࢹࠊࢫ࣮࣋ࢱ࣮ࢹࠊࢫ࢖࢙ࣇ࣮ࢱンࢺࣉࣜࢡࢫࠊࢫ࢖࢙ࣇ࣮ࢱ言語ࢡࢵ࢕ࣇࣛࢢࠊ

 ࠋࡍࡲい࡛ࢇ含ࢆ情報ࡢい࡚ࡘ࡟㸧ࢫ
 FEMtools 4 Mesh User's Guide㸦࣓ࢻ࢖࣮࢞ࢨ࣮࣭ࣘࣗࢩࢵ㸧：ࣗࢩࢵ࣓ࠊࡣࢻ࢖࢞ࡢࡇ生成ࣗࢩࢵ࣓ࠊ変形ࠊ

要素変換ࣗࢩࢵ࣓ࠊ精ᗘࡘ࡟࣮ࣝࢶ࣭ࣗࢩࢵ࣓ࡢ࡝࡞い࡚ࡢ情報ࢆ含࡛ࢇいࠋࡍࡲ 
 FEMtools 4 Dynamics User's Guide㸦ࢻ࢖࣮࢞ࢨ࣮࣭ࣘࢫࢡ࣑ࢼ࢖ࢲ㸧：ࠊࡣࢻ࢖࢞ࡢࡇFEMtoolsࡢ構造ࢼ࢖ࢲ

 ࠋࡍࡲい࡛ࢇ含ࢆ例題ࠊ情報࡞実際的ࠊ背景࡞理論的ࡢンࣙࢩ࣮࣑ࣞࣗࢩ࣭ࢫࢡ࣑
 FEMtools 4 Pretest and Correlation Analysis User's Guide㸦ࢺࢫࢸࣜࣉ解析࡜相関ศ析࣮ࣘࢻ࢖࣮࢞ࢨ㸧：࢞ࡢࡇ

 ࠋࡍࡲい࡛ࢇ含ࢆ例題ࠊ情報࡞実際的ࠊ背景࡞理論的ࡿࡍ関࡟相関ศ析࡜解析ࢺࢫࢸࣜࣉࠊࡣࢻ࢖
 FEMtools 4 Sensitivity Analysis and DOE User's Guide㸦感ᗘ解析࡜実㦂計画法࣮ࣘࢻ࢖࣮࢞ࢨ㸧：ࢻ࢖࢞ࡢࡇ

 ࠋࡍࡲい࡛ࢇ含ࢆ情報ࡿࡍ関࡟実㦂計画法㸦DOE㸧࡜感ᗘ解析ࠊࡣ
 FEMtools 4 Model Updating User's Guide㸦ࣔ࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹンࢻ࢖࣮࢞ࢨ࣮࣭ࣘࢢ㸧：ࢹࣔࠊࡣࢻ࢖࢞ࡢࡇ

 ࠋࡍࡲい࡛ࢇ含ࢆ情報࡞実際的ࡿࡍ関࡟確率論的解析ࠊ外力ྠ定ࠊࢢン࢕ࢸ࣮ࢹࣉࢵ࢔ࣝ
 FEMtools 4 Model Updating Theoretical Manual㸦ࣔ࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹンࢢ理論࣐ࣝ࢔ࣗࢽ㸧：ࣝ࢔ࣗࢽ࣐ࡢࡇ

FEMtoolsࣔࠋࡍࡲい࡛ࢇ含ࢆ理論的背景ࡿࡍ関࡟ࢢン࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࠊࡣ 使࡟ࢢン࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹ
用ࡿࢀࡉ᭷限差ศ解析法ࡘ࡟࡝࡞い࡚解ㄝࠋࡍࡲࡋ 

 FEMtools 4 Model Updating Examples Manual㸦ࣔ࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹンࢢ例題࣐ࣝ࢔ࣗࢽ㸧：ࡣࣝ࢔ࣗࢽ࣐ࡢࡇ
 ࠋࡍࡲࡋい࡚解ㄝࡘ࡟例題ࡢࢀࡒࢀࡑࡿࡍ関࡟ࢢン࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔ

 FEMtools 4 Optimization User's Guide㸦最適化࣮ࣘࢻ࢖࣮࢞ࢨ㸧：ࠊࡣࢻ࢖࢞ࡢࡇ一般非線形ࡿࡼ࡟࣒ࣛࢢࣟࣉ
最適化ࠊࢬ࢖ࢧࠊ形状ࡢ࣮ࣜࢺ࣓࣏ࢺࠊ࣮ࢪ࣏ࣟࢺࠊ最適化ࡼ࠾びDOE/RSࣉM 構造最適ࡿࡼ࡟ンࣙࢩ࣮ࢣࣜ

化࡟関ࡿࡍ理論的࡞背景ࠊ実際的࡞情報ࠊ例題ࢆ含࡛ࢇいࠋࡍࡲ 
 FEMtools 4 Modal Parameter Extractor 㸦MPE㸧 User’s Guide㸦࣮࣮ࣔࢱࢡࣛࢺࢫࢡ࢚࣭ࢱ࣮࣓ࣛࣃ࣭ࣝࢲ

㸦MPE㸧࣮ࣘࢻ࢖࣮࢞ࢨ㸧：࣮ࢱࢡࣛࢺࢫࢡ࢚࣭ࢱ࣮࣓ࣛࣃ࣭ࣝࢲ࣮ࣔࠊࡣࢻ࢖࢞ࡢࡇ㸦MPE㸧࢜ࢻ࢔ン࣭
 ࠋࡍࡲい࡛ࢇ含ࢆ例題࡜情報ࡿࡍ関࡟࣮ࣝࢶ

 FEMtools 4 Rigid Body Properties Extractor 㸦RBPE㸧 User’s Guide㸦剛体特性࢚࢖࣮࢞ࢨ࣮࣭࣮ࣘࢱࢡࣛࢺࢫࢡ
ࢱࢡࣛࢺࢫࢡ剛体特性࢚ࡢࡵࡓࡿࡍ推定ࢆ剛体特性ࡽ࠿関数㸦FRF㸧ࢫン࣏ࢫ周波数ࣞࠊࡣࢻ࢖࢞ࡢࡇ：㸧ࢻ
࣮㸦RBPE㸧用࢜ࢻ࢔ࡢン࣭࡟࣮ࣝࢶ関ࡿࡍ理論的背景ࠊ実際的࡞情報ࠊ例題ࢆ含࡛ࢇいࠋࡍࡲ 

 FEMtools 4 ARTeMIS Interface User's Guide㸦ARTeMIS࢖ンࢻ࢖࣮࢞ࢨ࣮࣭ࣘࢫ࢖࢙ࣇ࣮ࢱ㸧：ࠊࡣࢻ࢖࢞ࡢࡇ
ARTeMIS࢖ࢆࣝ࢖࢓ࣇン࣏࣮ࡿࡍࢺ࣮࣏ࢫࢡ࢚／ࡋࢺ方法ࡘ࡟い࡚ࡢ情報ࢆ含࡛ࢇいࠋࡍࡲ 

 FEMtools 4 ABAQUS Interface User's Guide㸦ABAQUS࢖ンࢻ࢖࣮࢞ࢨ࣮࣭ࣘࢫ࢖࢙ࣇ࣮ࢱ㸧：ࠊࡣࢻ࢖࢞ࡢࡇ
ABAQUS࢖ࢆࣝ࢖࢓ࣇン࣏࣮ࡿࡍࢺ࣮࣏ࢫࢡ࢚／ࢺ方法ࡼ࠾びABAQUSࡢࣂ࢖ࣛࢻ使用方法ࡘ࡟い࡚ࡢ情報
 ࠋࡍࡲい࡛ࢇ含ࢆ

 FEMtools 4 ANSYS Interface User's Guide㸦ANSYS࢖ンࢻ࢖࣮࢞ࢨ࣮࣭ࣘࢫ࢖࢙ࣇ࣮ࢱ㸧：ࠊࡣࢻ࢖࢞ࡢࡇ
ANSYS࢖ࢆࣝ࢖࢓ࣇン࣏࣮ࡿࡍࢺ࣮࣏ࢫࢡ࢚／ࢺ方法ࡼ࠾びANSYSࡢࣂ࢖ࣛࢻ使用方法ࡘ࡟い࡚ࡢ情報ࢆ含
 ࠋࡍࡲい࡛ࢇ

 FEMtools 4 LS-DYNA Interface User's Guide㸦LS-DYNA࢖ンࢻ࢖࣮࢞ࢨ࣮࣭ࣘࢫ࢖࢙ࣇ࣮ࢱ㸧：ࠊࡣࢻ࢖࢞ࡢࡇ
LS-DYNA࢖ࢆࣝ࢖࢓ࣇン࣏࣮ࡿࡍࢺ࣮࣏ࢫࢡ࢚／ࢺ方法ࡼ࠾びLS-DYNAࡢࣂ࢖ࣛࢻ使用方法ࡘ࡟い࡚ࡢ情報
 ࠋࡍࡲい࡛ࢇ含ࢆ

 FEMtools 4 NASTRAN Interface User's Guide㸦NASTRAN࢖ンࢻ࢖࣮࢞ࢨ࣮࣭ࣘࢫ࢖࢙ࣇ࣮ࢱ㸧：ࢻ࢖࢞ࡢࡇ
い࡚ࡘ࡟使用方法ࡢࣂ࢖ࣛࢻびNASTRANࡼ࠾方法ࡿࡍࢺ࣮࣏ࢫࢡ࢚／ࢺン࣏࣮࢖ࢆࣝ࢖࢓ࣇNASTRANࠊࡣ
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 ࠋࡍࡲい࡛ࢇ含ࢆ情報ࡢ
 FEMtools 4 UNIVERSAL FILE Interface User's Guide㸦UNIVERSAL FILE࢖ン࢖࣮࢞ࢨ࣮࣭ࣘࢫ࢖࢙ࣇ࣮ࢱ

ン࣏࣮࢖ࢆࢱ࣮ࢹࡢࢺࢫࢸ࡜FEAࠊ࡚ࡋ使用ࢆࢺࢵ࣐࣮࢛ࣇ࣭ࣝ࢖࢓ࣇ࣭ࣝࢧ࣮ࣂࢽࣘࠊࡣࢻ࢖࢞ࡢࡇ：㸧ࢻ
 ࠋࡍࡲい࡛ࢇ含ࢆ情報ࡢい࡚ࡘ࡟使用方法ࡢࣂ࢖ࣛࢻびI-DEASࡼ࠾方法ࡿࡍࢺ࣮࣏ࢫࢡ࢚／ࢺ

 FEMtools 4 SAP2000 Interface User's Guide㸦SAP2000࢖ンࢻ࢖࣮࢞ࢨ࣮࣭ࣘࢫ࢖࢙ࣇ࣮ࢱ㸧：ࠊࡣࢻ࢖࢞ࡢࡇ
SAP2000࢖ࡢࣝ࢖࢓ࣇン࣏࣮ࢺ方法ࡼ࠾ࠊびSAP OAPIࡢࣂ࢖ࣛࢻ使用方法ࡘ࡟い࡚ࡢ情報ࢆ含࡛ࢇいࠋࡍࡲ 

 FEMtools 4 Programmer’s Guide㸦ࢻ࢖࣐࢞ࣛࢢࣟࣉ㸧：ࠊࡣࣝ࢔ࣗࢽ࣐ࡢࡇFEMtoolsࢺࣉࣜࢡࢫ言語ࣛࢢࣟࣉ
びࡼ࠾ࣝ࢔ࣗࢽ࣐ࢫンࣞ࢓ࣇ࣭ࣜࢺࣉࣜࢡࢫFEMtoolsࠊࡓࡲࠋࡍࡲい࡛ࢇ含ࢆ情報ࡢい࡚ࡘ࡟使用方法ࡢ࣒
APIࣜࣞ࢓ࣇン࡜ࣝ࢔ࣗࢽ࣐࣭ࢫ一緒࡟利用ࠋࡍࡲࢀࡉ 

 FEMtools 4 GUI Reference：ࣞ࢓ࣇࣜࡢࡇン࡟ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲࠊ࣮ࣂ࣮ࣝࢶࠊ࣮ࣗࢽ࣓ࠊࡣࢫ関ࡿࡍ情報ࢆ
含ࣞ࢓ࣇࣜࡴンࠋࡍ࡛ࣝ࢔ࣗࢽ࣐࣭ࢫ 

 FEMtools 4 Command Reference：ࣞ࢓ࣇࣜࡢࡇンࠊࡣࢫFEMtools࣐ࢥンࢻ言語要素ࢩࠊンࠊࢫࢡࢵࢱ引ࡁ数࠾
 ࠋࡍ࡛ࣝ࢔ࣗࢽ࣐࣭ࢫンࣞ࢓ࣇࣜࡴ含ࢆ情報࡞ヲ細ࡢい࡚ࡘ࡟ࢻン࣐ࢥ各ࡴ含ࢆび例証ࡼ

 FEMtools 4 Scripting Reference：ࣞ࢓ࣇࣜࡢࡇンࠊࡣࢫFEMtoolsࢺࣉࣜࢡࢫ言語要素㸦変数ࠊ演算子ࠊ関数ࢫࠊ
 ࠋࡍ࡛ࣝ࢔ࣗࢽ࣐࣭ࢫンࣞ࢓ࣇࣜࡿࡍい࡚記述ࡘ࡟㸧ࢺン࣓ࢺ࣮ࢸ

 FEMtools 4 Application Programming Interface 㸦API㸧 Reference㸦ࣙࢩ࣮ࢣࣜࣉ࢔ン࢖࣒ࣛࢢࣟࣉン࢖࢙ࣇ࣮ࢱ
ン࢖࣭ࣈ࢕ࢸࢡࣛࢱン࢖ࡢ࡜ࢫ࣮࣋ࢱ࣮ࢹFEMtoolsࠊࡣࣝ࢔ࣗࢽ࣐࣭ࢫンࣞ࢓ࣇࣜࡢࡇ：㸧ࢫンࣞ࢓ࣇ࣭ࣜࢫ
 ࠋࡍࡲࡋ解ㄝ࡚ࡋ関࡟ࢫ࢖࢙ࣇ࣮ࢱ

次表࣓ࣗ࢟ࢻࡢࢀࡒࢀࡑࡣンࢆࢺࢵ࣐࣮࢛ࣇ࣭ࢺ示ࠋࡍࡲࡋ  

 ࢺࢵ࣐࣮࢛ࣇ ྡࢺン࣓ࣗ࢟ࢻ
FEMtools 4 Release Notes PDF 
FEMtools 4 Getting Started Manual  PDF, Help  

    

FEMtools 4 Framework User's Guide  PDF, Help  

FEMtools 4 Mesh User's Guide  PDF, Help  

FEMtools 4 Dynamics User’s Guide  PDF, Help  

FEMtools 4 Pretest and Correlation Analysis User’s Guide  PDF, Help  

FEMtools 4 Sensitivity Analysis and DOE User’s Guide  PDF, Help  

FEMtools 4 Model Updating User’s Guide  PDF, Help  

FEMtools 4 Model Updating Theoretical Manual  PDF  

FEMtools 4 Model Updating Examples Manual  PDF  

FEMtools 4 Optimization User’s Guide  PDF, Help  

    

FEMtools 4 Modal Parameter Extractor (MPE) User’s Guide  PDF, Help  

FEMtools 4 Rigid Body Properties Extractor (RBPE) User’s Guide  PDF, Help  
   
FEMtools 4 ARTeMIS Interface User’s Guide PDF, Help 
FEMtools 4 ABAQUS Interface and Driver User’s Guide  PDF, Help  
FEMtools 4 ANSYS Interface and Driver User’s Guide  PDF, Help  
FEMtools 4 LS-DYNA Interface and Driver User’s Guide  PDF, Help  
FEMtools 4 NASTRAN Interface and Driver User’s Guide  PDF, Help  
FEMtools 4 UNIVERSAL FILE Interface and Driver User’s Guide  PDF, Help  
FEMtools 4 SAP2000 Interface and Driver User’s Guide  PDF, Help  
   
FEMtools 4 Programmer’s Guide  PDF  
FEMtools 4 GUI Reference Manual  Help  
FEMtools 4 Command Reference Manual  Help  
FEMtools 4 Scripting Reference Manual  Help  
FEMtools 4 API Reference Manual  Help 
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 Help㸦࣊ࣝࣉ㸧ࠊࡣFEMtoolsࡢ Help࣓ྍࢫࢭࢡ࢔ࡽ࠿࣮ࣗࢽ能࣓ࣗ࢟ࢻ࡞ンࢆࢺ参照ࣟࢡ࢖࣐ࡣࣉࣝ࣊ࠋࡍࡲࡋ
ࢺࣇࢯ HTML  ࠋࡍࡲࡋ使用ࢆHTML WebHelp㸦Linux㸧ࠊ㸦Windows㸧ࣉࣝ࣊

PDFࢺࢵࣂࣟࢡ࢔࣭ࣅࢻ࢔ࡣ㸦Adobe Acrobat㸧࣏࣮࣓ࣗ࢟ࢻ࣭ࣝࣈࢱンࢺࢵ࣐࣮࢛ࣇ࣭ࢺ㸦PDF㸧ࢆ参照ࠋࡍࡲࡋ
ࢬ࣒ࢸࢫࢩ࣭ࣅࢻ࢔：࢕ࢸ࢕ࣜ࢕ࢸ㸦Windows/Linux用࣮ࣘ࢔࢙࢘ࢺࣇࢯ࣭ࢲ࣮࣭ࣜࣅࢻ࢔ࠊࡣࣝ࢖࢓ࣇࡢࡽࢀࡇ
㸦www.adobe.com㸧ࡽ࠿利用ྍ能㸧ࢆ使用࡚ࡋㄞࡽ࠿ࢺࢵࣂࣟࢡ࢔࣭ࣅࢻ࢔ࠊࡓࡲࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡴ PDF࣮࢛ࣇ
ࡽ࠿࣮ࣗࢽHelp࣓ࠊࡣ࡟ࡿࡍࢫࢭࢡ࢔࡟ࣝ࢔ࣗࢽ電子࣐ࡢࡽࢀࡑࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ出力ࢆࣝ࢔ࣗࢽ࣐࣭ࢺࢵ࣐
Manualsࢆ選ࡉࡔࡃ࡛ࢇいࠋ 

FEMtools࢙࢘ࢺ࢖ࢧࣈ 

ࡢୖࢺࢵࢿ࣮ࢱン࢖ FEMtools࢝ࠊࡣࢺ࢖ࢧ࣭ࢺ࣮࣏ࢧ࣭࣮࣐ࢱࢫFEMtools࣓ンࢼࢸンࡼ࠾ࢫびᢏ術࣮ࢧࢺ࣮࣏ࢧ
ࡢ࡚࡭ࡍࡘ持ࢆᶒࢫࣅ FEMtools࣮ࣘࣙࢩ࣮ࢣࢽ࣑ࣗࢥࡢࡵࡓࡢ࣮ࢨン／ࢭࡢࢺ࣮࣏ࢧン࡚ࡋ࡜࣮ࢱ活用࡛ࡼࡿࡁ
う࡟意ᅗ࡚ࢀࡉいࠋࡍࡲ次࢖࣭࢔࢙࢘ࢺࣇࢯࡽ࠿ࢺ࢖ࢧࡢン࡟ࢪ࣮ࢣࢵࣃ࣭࣮ࣝࢺࢫ付属࣓ࣗ࢟ࢻࡿࡍンࢺや補語

情報ࢆ見࣓ࣗ࢟ࢻࠊࢺࣉࣜࢡࢫࠊࢳࢵࣃࠊ࢔࢙࢘ࢺࣇࢯࠊࡓࡲࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡅࡘンࡢ࡝࡞ࢺ新ࣙࢪ࣮ࣂンࢆ

 ࠋࡍ能࡛ྍࡀ࡜ࡇࡿࡍࢻン࣮ࣟ࢘ࢲ

http://www.femtools.com/support 

FEMtoolsࢽ࣮ࣞࢺン࣭ࢢコ࣮ࢫ 

DDS㸦Dynamic Design Solutions㸧ࡼ࠾び FEMtoolsࠊࡣ࣮ࢼࢺ࣮ࣃ新規࢖ࡢࡵࡓࡢ࣮ࢨ࣮ࣘࡢンࣙࢩࢡࢲࣟࢺン࣭
や࣮ࢨびୖ級࣮ࣘࡼ࠾ࢫ࣮ࢥ FEMtoolsࣙࢩ࣮ࢣࣜࣉ࢔ン開Ⓨ者ࢽ࣮ࣞࢺࡢࡵࡓࡢンࢆࢫ࣮ࢥ࣭ࢢᥦ供ࠋࡍࡲࡋ 

ヲ細ࡘ࡟い࡚ࠊࡣsupport@femtools.com࠾࡟問い合わࡏ頂ࠊ࠿ࡃあࡿいࡣ最新情報ࡢࢺ࢖ࢧ
http://www.femtools.com/coursesࢆ閲覧ࡉࡔࡃ࡚ࡋいࠋ 
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 ンࣙࢩ࣮ࣞࢢ࢕ࣇコン、ࢫンࢭ࢖ࣛ、࣮ࣝࢺࢫン࢖

 ࠋࡍࡲࡋ示ࢆ最少必要条件ࡢࡵࡓࡢ࣮ࣝࢺࢫン࢖࡜࣒ࢸࢫࢩ࣭ࢢン࢕ࢸ対象࣮࢜࣌ࣞࢺ࣮࣏ࢧ

 ࣒࣮࢛ࣇࢺࢵ࣭ࣛࢺ࣮࣏ࢧ

FEMtoolsࠊࡣWindows 64ࡼ࠾ࢺࢵࣅび Linux 64࡛ࡳࡢ࣒࣮࢛ࣇࢺࢵࣛࣉࡢࢺࢵࣅ利用ྍ能࡛࣮ࣂ࣭ࢺࢵࣅ32ࠋࡍ
 ࠋࢇࡏࡲࢀࡉࢺ࣮࣏ࢧやࡣࡶࡣびMAC OSࡼ࠾ンࣙࢪ

次表ࠊࡣFEMtools 4ࢺ࣮࣏ࢧࡢ対象ࢆ࣒࣮࢛ࣇࢺࢵࣛࣉ示ࡍࡲࡋ: 

Platform  Operating System㸦s㸧  Processor㸦s㸧  
WIN64  Windows 7/8/8.1/10 64-bit  Intel 64; AMD 64  
LIN64  Linux 64-bit 㸦RHEL 6+, CentOS 6+,…㸧  Intel 64; AMD 64  

最新ࡢ対象࣒࣮࢛ࣇࢺࢵࣛࣉ情報ࡘ࡟い࡚ࠊࡣFEMtools ࢺ࢖ࢧ 㸦http://www.femtools.com㸧 ࢆ確認ࡉࡔࡃいࠋ  

最小࢖ン࣮ࣝࢺࢫ必要条件 

Windows 

 Microsoft Windows 7ࢺࢵࣅ64  10ࠊ8.1ࠊ8ࠊ? 
 最ᑠ 4 GB RAM 
 最ᑠ 500MBࢫ࣮࣌ࢫ࣭ࢡࢫ࢕ࢹࢻ࣮ࣁ 
 Open GLࢻ࣮࢝ࢫࢡࢵ࢕ࣇࣛࢢࡿࡍࢺ࣮࣏ࢧࢆ 

OpenGL対応࡛ࢻ࣮࢝ࢫࢡࢵ࢕ࣇࣛࢢ࣭ࢱ࣮ࣞࣞࢭࢡ࢔࣭࢔࢙࢘ࢻ࣮ࣁࡢあࢫࢡࢵ࢕ࣇࣛࢢࡤࢀ性能ࡣ向ୖࡍ
 ࠋうࡻࡋ࡛ࡿ

 CDࡣࡓࡲ電子࣓࣮ࣝ࢖ࡽ࠿ンࡢࡵࡓࡿࡍ࣮ࣝࢺࢫ CD-ROM࢖ࡣࡓࡲࣈ࢖ࣛࢻンࢺࢵࢿ࣮ࢱ接⥆ 
 USB࣏࣮ࢺ㸦ࢭ࢖࣭ࣛࢡࢵࣟ࡟ࢻ࣮ࣀンࣙࢩࣉ࣭࢜ࢫン用ࢻࡢンࢆࣝࢢ使用ࡿࡍ場合㸧 
 ࣛࢭ࢖ン࣮ࣂ࣮ࢧࢫ㸦ࢺࢵࢿワ࣮ࢭ࢖࣭ࣛࢡンࣙࢩࣉ࣭࢜ࢫン用㸧ࡢ TCP/IP接⥆ 
 ࢲ࣮࣭ࣜࢺࢵࣂࣟࢡ࢔࣭ࣅࢻ࢔あࡿいࡣ PDF࣓ࣗ࢟ࢻンࢆࢺㄞࣙࢩ࣮ࢣࣜࣉ࢔ࡢࡵࡓࡴン 

Linux 

 ࢖ンࣝࢸMKL 11.0や࢖ࠊンࣝࢸ 64㸦RHEL 6+(CentOS 6+)...㸧ࡿࡍࢺ࣮࣏ࢧࢆ Linux 64ࢺࢵࣅ OS 
ࡢ௚ࡢࡑ Linux OSࠋࢇࡏࡲࢀࡋࡶ࠿ࡿࢀࡉࢺ࣮࣏ࢧࡶ 

 最ᑠ 4 GB RAM 
 最ᑠ 500MBࢫ࣮࣌ࢫ࣭ࢡࢫ࢕ࢹࢻ࣮ࣁ 
 Open GLࢻ࣮࢝ࢫࢡࢵ࢕ࣇࣛࢢࡿࡍࢺ࣮࣏ࢧࢆ 

OpenGL対応࡛ࢻ࣮࢝ࢫࢡࢵ࢕ࣇࣛࢢ࣭ࢱ࣮ࣞࣞࢭࢡ࢔࣭࢔࢙࢘ࢻ࣮ࣁࡢあࢫࢡࢵ࢕ࣇࣛࢢࡤࢀ性能ࡣ向ୖࡍ
 ࠋうࡻࡋ࡛ࡿ

 CDࡣࡓࡲ電子࣓࣮ࣝ࢖ࡽ࠿ンࡢࡵࡓࡿࡍ࣮ࣝࢺࢫ CD-ROM࢖ࡣࡓࡲࣈ࢖ࣛࢻンࢺࢵࢿ࣮ࢱ接⥆ 
 ࣛࢭ࢖ン࣮ࣂ࣮ࢧࢫ㸦ࢺࢵࢿワ࣮ࢭ࢖࣭ࣛࢡンࣙࢩࣉ࣭࢜ࢫン用㸧ࡢ TCP/IP接⥆ 
 ࢲ࣮࣭ࣜࢺࢵࣂࣟࢡ࢔࣭ࣅࢻ࢔あࡿいࡣ PDF࣓ࣗ࢟ࢻンࢆࢺㄞࣙࢩ࣮ࢣࣜࣉ࢔ࡢࡵࡓࡴン 

 変更点ࡢ࣮ࣝࢺࢫン࢖

 FEMtools 4࢘ࢲࠊࡣン࣮ࣟࢻあࡿいࠊࡣUSB࣓ࣔࣜや CD-ROMࠋࡍࡲࢀࡉࢫ࣮࡚ࣜࣜࡗࡼ࡟ 
 FEMtools࢜ࢻ࢔ン࣭࣐ࠊࡣ࣮ࣕࢪ࣮ࢿ空白ࢆ含ࢆ࣒࣮ࢿࢫࣃࡴ扱うࠋࡍࡲࡁ࡛ࡀ࡜ࡇ 
 新ࡋいࡀࢳࢵࣃあࡿ場合࡛࢜ࢻ࢔ࠊࡶン࣭࣐ࢆࣉࢵ࢔ࢺ࣮ࢱࢫࠊࡣ࣮ࣕࢪ࣮ࢿ起動ࠋࢇࡏࡲࡋ新ࡋい࢜ࢻ࢔ン

 ࠋࡍࡲࢀࡉ起動ࡀࣉࢵ࢔ࢺ࣮ࢱࢫ࡟ࡳࡢ場合ࡓࢀࡉ検知ࡀ
 ࠊࡣ࣮ࣕࢪ࣮ࢿ࣐࣭ࢪ࣮ࢣࢵࣃ利用ྍ能ࢭ࢖ࣛ࡞ン࡞ࡀࢫい新ࡋい࢜ࢻ࢔ンࢆࣉࢵ࢔ࢺ࣮ࢱࢫࡢ起動ࡏࡲࡋ
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 < 手動࡛㸦Add-onsࢆ࣮ࣕࢪ࣮ࢿ࣐࣭ࢪ࣮ࢣࢵࣃࡾ࠾࡝࡛ࡲ௒ࠊࡶい場合࡛࡞ࡽ࠿ࡘ見ࡀࢫンࢭ࢖ࣛࠋࢇ
Install/Remove Add-on㸧操作࢖ࠊࡾࡼ࡟࡜ࡇࡿࡍン࢜ࢻ࢔ࡢࢪ࣮ࢣࢵࣃ࣭࣮ࣝࢺࢫンࢆ確認ࡲࡁ࡛ࡀ࡜ࡇࡿࡍ
 ࠋࡍ

 ࢔ン࢖ン࣮ࣝࢺࢫ処理࡛ࠊࡣFEMtoolsࢺࣉࣜࢡࢫ࣭࣮ࢧࢵࢭࣟࣉࣜࣉ㸦uninstall_packages.bas㸧ࡀ最初ࢻ࢔࡟
࢜ン࣭࢔ࢆࢪ࣮ࢣࢵࣃン࢖ンࠊࡋ࣮ࣝࢺࢫ次ࡢࡑ࡟௚ࡢ手⥆࢔ࡀࡁン࢖ンࠋࡍࡲࢀࡉ࣮ࣝࢺࢫ 

 ࢖࣭ࢱ࣮ࢹン࡟ࢫ࢖࢙ࣇ࣮ࢱ関ࠊࡣࣝ࢖࢓ࣇ࣭ࢺࣉࣜࢡࢫࡿࡍ現ᅾ࣮ࢲ࢛ࣝࣇࡢ

㸦<installdir>/scripts/interfaces㸧࢖࡟ンࠋࡍࡲࢀࡉ࣮ࣝࢺࢫ各࢖ン࢙ࣇ࣮ࢱｲࡢࢫ専用ࡀ࣮ࢲ࢛ࣝࣇࣈࢧあࡲࡾ
ࡏࡲࡾ変わࡣ場所㸦<installdir>/scripts/drivers㸧ࡢࣝ࢖࢓ࣇ࣭ࢢン࢕ࢸࢵࢭびࡼ࠾ࢺࣉࣜࢡࢫ࣭ࣂ࢖ࣛࢻࠋࡍ
 ࠋࢇ

FEMtools 3.xࢻ࣮ࣞࢢࣉࢵ࢔ࡢ 

以ୗࠊࡣFEMtoolsᪧࣙࢪ࣮ࣂンࡽ࠿ FEMtools 4.0あࡿいࡣ FEMtools 4.1ࡢࡵࡓࡢ࣮ࢨ࣮ࣘࡿࡍࢻ࣮ࣞࢢࣉࢵ࢔࡟
情報࡛ࠋࡍ 

FEMtools 4ࡣ新ࡋい࢖࡟࣮ࣜࢺࢡࣞ࢕ࢹンࡀ࡜ࡇࡿࡍ࣮ࣝࢺࢫ推奨ࠋࡍࡲࢀࡉ 

 FEMtools 4.0ࡼ࠾び ࡣ࣮ࣜࢺࢡࣞ࢕ࢹ࣭࣮ࣝࢺࢫン࢖࣭ࢺ࢛ࣝࣇࢹࡢ4.0.1 c:\femtools\4࡛ࠊࡓࡲࠋࡍFEMtools 
 ࠋࡍc:\femtools\4.1࡛ࠊࡣ4.1࡛

 ࢻンࢡࢵࣟࢻ࣮ࣀࡿࡼ࡟ࣝࢢ㸦nodelocked㸧ࣛࢭ࢖ンࠊࡣࢫv3.3以降ࠊࡣ࡟ࡿࡍࢻ࣮ࣞࢢࣉࢵ࢔ࡽ࠿新ࡋいࣛ
期間対応ࠋࡍࡲࡋ࡜必ࢆࣝ࢖࢓ࣇ࣭ࢫンࢭ࢖ FEMtoolsࣛࢭ࢖ンࠊࡣ࡛ࣝ࢖࢓ࣇ࣭ࢫFEMtools 4ࢆ実行ࡓࡿࡍ
 ࠋࢇࡏࡲࡋ࡜必要ࢆࣝ࢖࢓ࣇ࣭ࢫンࢭ࢖いࣛࡋ新ࡢࡵ

 ࣙࢪ࣮ࣂࡢࡇンࢆ最初࡟起動ࡿࡍ時ࠊ新ࡋい࢕ࢸࢵࢭン࡟࣮ࣜࢺࢡࣞ࢕ࢹ࣒࣮࣍ࡀࣝ࢖࢓ࣇ࣭ࢢ作成࡛ࡿࢀࡉ

ࡣいࡿ401あࠊン番号㸦400ࣙࢪ࣮ࣂࡣࣝ࢖࢓ࣇ࣭ࢢン࢕ࢸࢵࢭࡢࡑࠋうࡻࡋ 410㸧ࢆ表わࡍ xyzࢆ備えࡓ
femtools_xyz.ini࡛ࠋࡍ 

 以前࢖ࡢン࢕ࢸࢵࢭ࣭࣮ࣝࢺࢫンࡢࣝ࢖࢓ࣇ࣭ࢢ修ṇ㡯目ࡢୖࣉࢵ࢔ࢺ࣮ࢱࢫࠊࡣ新ࡋい࢕ࢸࢵࢭン࢓ࣇ࣭ࢢ

 ࠋࡍࡲࢀࡉᥦ示࡟時ࣉࢵ࢔ࢺ࣮ࢱࢫࡢ最初ࡣࢀࡑࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ࣮ࣆࢥ࡟自動的࡟ࣝ࢖
 ᪧࣙࢪ࣮ࣂン中࡛使用࢕ࢸࢵࢭ࣭ࣂ࢖ࣛࢻࡢࢺࣉࣜࢡࢫ࣭ࣂ࢖ࣛࢻࡓࢀࡉンࡼ࠾ࢢび࢝ࢬ࢖࣐ࢱࢫ設定ࠊࡣ

FEMtools 4ࡣ࡟自動的࡟設定࣒ࢱࢫ࢝ࡢࣂ࢖ࣛࢻࡢࡑࠋࢇࡏࡲࢀࡉ設定ࠊࡣINIࡼ࠾ࣝ࢖࢓ࣇび BAS࢖ࣛࢻ
ࡢࢺࣉࣜࢡࢫ࣭ࣂ FEMtools 4ࣙࢪ࣮ࣂン࠾࡟い࡚再設定࡞ࡽ࡞ࡤࢀࡅ࡞ࡋい࡛ࡻࡋうࠋ 
 ࠋࡍࡲࡋᏑᅾ࡟installdir>\scripts\drivers>ࠊࡣࣝ࢖࢓ࣇࡢࡽࢀࡇ

 FEMtools 4.x࣮ࣜࣜࡢࢺ࣮ࣀ࣭ࢫ FEMtools࣐ࢥンࢻ言語ࡢ࡬更新点ࡉࡔࡃ࡚ࡋࢡࢵ࢙ࢳࢆいࠋ必要࡞場合ࡣ
 ࠋいࡉࡔࡃ࡚ࡋ更新ࢆࢺࣉࣜࢡࢫ࣭ࢻン࣐ࢥ

 FEMtools 4.x࣮ࣜࣜࡢࢺ࣮ࣀ࣭ࢫ FEMtools APIࡢ࡬更新点ࡉࡔࡃ࡚ࡋࢡࢵ࢙ࢳࢆいࠋ必要࡞場合ࣛࢢࣟࣉࡣ
 ࠋいࡉࡔࡃ࡚ࡋ更新ࢆࢺࣉࣜࢡࢫ࣭࣒

 FEMtools 3.xࡣࣝ࢖࢓ࣇ࣭ࢺࢡ࢙ࢪࣟࣉ FEMtools 4࢖࡟ン࣏࣮ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍࢺ 

FEMtools 4ࢺ࣮ࢹࣉࢵ࢔ࡢ 

FEMtools 4ࣙࢪ࣮ࣂンࢆ最新ࣙࢪ࣮ࣂン࡟更新ࠊࡣ࡟ࡿࡍHelp > Check for Updates࣓࣐ࢥ࣭࣮ࣗࢽンࡢࢻ実行ࢆ推
奨ࠋࡍࡲࡋ 

ࡿあࢳࢵࣃ࣭ࢺ࣮ࢹࣉࢵ࢔ࡣ自動更新࡛ࠋいࡉࡔࡃ࡚ࡋ注意࡟࡜ࡇ࡞必要ࡀ⥆接ࢺࢵࢿ࣮ࢱン࢖ࡣ࡟自動更新ࡢࡑ

いࡣ利用ྍ能࢖࣭ࢻ࣮ࣞࢢࣉࢵ࢔࡞ンࡀ࣮࣮ࣛࢺࢫ示࢘ࢲࠊࢀࡉン࣮ࣟ࢖࡜ࢻンࡢ࣮ࣝࢺࢫ選択ྍࡀ能ࡲࡾ࡞࡟

ࡿࡍࢻン࣮ࣟ࢘ࢲࡽ࠿ࢺ࢖ࢧ࣭ࢺ࣮࣏ࢧFEMtoolsࠊࡣࢳࢵࣃび最新版ࡼ࠾࣮࣮ࣛࢺࢫン࢖࣭ࢻ࣮ࣞࢢࣉࢵ࢔ࠋࡍ
 ࠋࡍ能࡛ྍࡶ࡜ࡇ

FEMtools 4.0.1ࡼ࠾び FEMtools 4.1ࠊࡣFEMtools 4.0ྍࡀࢻ࣮ࣞࢢࣉࢵ࢔ࡢࡽ࠿能࡞場合࡛ࡢࡑࠊࡶ再࢖ン࣮ࢺࢫ
ࡢࡑࠋࡍࡲࡾ࡞࡟必要ࡀࣝ FEMtools 4.1࢖ンࠊࡣ࣮࣮ࣛࢺࢫFEMtools࢘ࢲࡽ࠿ࢺ࢖ࢧ࣭ࢺ࣮࣏ࢧン࣮ࣟࡇࡿࡍࢻ
 ࠋࡍࡲࡁ࡛ࡀ࡜

FEMtools 4.1࢖࣭ࢺ࢛ࣝࣇࢹࡢンࡣ࣮ࣜࢺࢡࣞ࢕ࢹ࣭࣮ࣝࢺࢫ c:\femtools\4.1࡛ࢥࡵࡓࡢࡑࠋࡍン࡟ୖࢱ࣮ࣗࣆ
FEMtools 4.0ࡼ࠾び   ࠋࡍ能࡛ྍࡶ࡜ࡇࡿࡍ維持ࢆ4.1
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FEMtools 4.0 更新情報 

FEMtools 4ࠊࢺ࣮ࢹࣉࢵ࢔ࡢ࣮ࣝࣗࢪࣔࡢ࡚࡭ࡍࠊࡣ標準 FEࡢ࣒ࣛࢢࣟࣉ最新ࣙࢪ࣮ࣂンࡼ࠾ࢺ࣮࣏ࢧࡢび過去
 ࠋࡍン࡛ࣙࢪ࣮ࣂ新࡞࣮ࣕࢪ࣓ࡓࡋ統合ࢆࢫ࣮࣭ࣜࣜࢫンࢼࢸン࣓ࡢ

 ࠋࡍ࡛ࡾ࠾࡜ࡢ以ୗࡣࢺ࢖ࣛ࢖ࣁࡢࢫ࣮ࣜࣜࡢࡇ

 と構成࣮ࣝࢺࢫン࢖

 Windows 64-bit࣒࣮࢛ࣇࢺࢵࣛࣉࡢ㸦710ࠊ8ࠊ㸧ࡼ࠾び Linux 64-bit RHEL6+ 対応 
 ࢘ࢲン࣮ࣟࢻ対応ࠊࡣࡓࡲUSBࠊ CD-ROMࢫ࣮ࣜࣜࡢ  
 Linuxࢥン࡛ୖࢱ࣮ࣗࣆ使用ྍ能࡞ Safenet HLࢻンࢺ࣮࣏ࢧࡢࣝࢢ 
 個別ࣛࢭ࢖ンࡢࢻ࣮ࢥ࣭ࢫ FE࢖࣭࣒ࣛࢢࣟࣉンࢫ࢖࢙ࣇ࣮ࢱ 
 ࣒ࣛࢢࣟࣉ自動ࢺ࣮ࢹࣉࢵ࢔用ࡢ新ࠕCheck for Updates࣮ࠖࣝࢶ 
 新ࡋいࣛࢭ࢖ンࢫ㸦ࢺࢵࢿࠊࢡࢵࣟࢻ࣮ࣀワ࣮ࡼ࠾ࢡび࣮࣑ࣟンࢢ㸧 

 ࢫ࢖࢙ࣇ࣮ࢱン࢖࣭࣮ࢨ࣮ࣘ

 新ࡋい࣋ࢥ࢖࢔ࡢࢫ࣮࣭࣋ࣝࢺࢡン㸦SVG㸧 
 高解像ᗘࣔࢱࢽ㸦4K㸧用ࡢ自動的࣮ࣜࢣࢫンࢥ࢖࢔࣭ࢢン 

 ࢡワ࣮࣒࣮ࣞࣇ

 MS Office㸦Excel, PowerPoint, Word㸧用࣐ࢥࡢンࢻ 
 新࢖ࠕンࠖࢱ࢕ࢹ࢚࣭ࣝࢹ࣭ࣔࢺࢫࢸ࣭ࣈ࢕ࢸࢡࣛࢱ 
 ࢟ࢵࣆ࣭ࢡࢵ࢕ࣇࣛࢢンࢢ機能㸦表示ࠊFace࢟ࢵࣆン࢟ࢵࣆ࣭ࢻࢳࢵࢱ࢔ࠊࢢンࢢ㸧ࡢ更新 
 DOF࣮ࣜࣞࣙࢩン用ࡢ新ࡋい࣐ࢥンࢻ 
 新ࡋいࣝࢱࢪࢹ信号処理㸦DSP㸧࣐ࢥンࢻ 
 時系列ࡼ࠾ࠖࣝࢿࣕࢳ࣭ࢱ࣮ࢹࠕび࢘࢕ン࢘ࢻ関数ࢆ定義ࡢࡵࡓࡿࡍ新ࡋい࣐ࢥンࢻ 

 ࢫ࢖࢙ࣇ࣮ࢱン࢖࣭ࢱ࣮ࢹ

 Abaqus 2016ࠊAbaqus 2017ࢺ࣮࣏ࢧࡢ 
 Abaqus SIMࣝ࢖࢓ࣇ新࢖ン࢙ࣇ࣮ࢱｲࢫ 
 MSC.Nastran 2018ࢺ࣮࣏ࢧࡢ 
 MSC.Nastran࣮ࣃ࣮ࢫ要素࢖ン࢙ࣇ࣮ࢱｲࢺ࣮࣏ࢧࡢࢫ 
 Ansys 18+ࢺ࣮࣏ࢧࡢ 
 LS-DYNA᭷限要素ࢪ࣮ࢣࢵࣃ新ࡋい࢖ン࢙ࣇ࣮ࢱｲࢫ 
 SAP2000 v19ࢺ࣮࣏ࢧࡢ 

動態解析 

 ࣓ࣔࣜ制御用新ࠕout-of-core solverࠖ࢜ࣙࢩࣉン 
 ࣐࣮ࢱࢫDOF選択用 K/M比計算ࡢࡵࡓࡢ新ࡋい࣐ࢥンࢻ 
 ࢫ࣮࣋ࢱ࣮ࢹ㸦MBA㸧࡟剛体࣮ࣔࡼ࠾ࢻび回転 DOFࢆ追加ࡢࡵࡓࡿࡍ新ࡋい࣐ࢥンࢻ 
 ࣮ࣔࢭ࢔࣭ࢫ࣮࣭࣋ࣝࢲンࣜࣈ㸦MBA㸧剛接⥆ࢺ࣮࣏ࢧࡢ 

 解析ࢺࢫࢸࣜࣉ

 質量荷重感ᗘ㸦MLS: Mass Loading Sensitivity㸧用ࡢ新ࡋい計算࣮ࣝࢶ 
 ่࣮ࣔࢻ激係数解析㸦MPA㸧ࡢ࣮ࣝࢶ更新 
 ่࣮ࣔࢻ激係数࣐ࣉࢵ㸦MPM㸧用ࡢ新ࡋい計算࣮ࣝࢶ 
 FEࣔࡢࣝࢹ初期化用ࡢ新ࡋい࣮ࣘ࢕ࢸ࢕ࣜ࢕ࢸ 
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 加振ࡼ࠾び支持఩置ࡢ選択用ࡢ新ࡋい࣮ࣝࢶ 
 ࢭン࣮ࢧ選択࢖ࢆン࣏࣮ࡢࡵࡓࡿࡍࢺ࣮࣏ࢫࢡ࢚ࠊࢺ新ࡋい࣐ࢥンࢻ 

相関分析 

 新ࡋい࢖ン࢔࣮ࣗࣅ࣭࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮࣭ࣔࣈ࢕ࢸࢡࣛࢱ 
 ่࣮ࣔࢻ激係数計算ࡢ改良 
 ࣮ࣔࣝࢲ直交係数㸦EVO㸧計算ࡢ改良 

感ᗘ解析とࣔ࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹンࢢ 

 新ࡋいࣉ࢖ࢱ࣭ࢱ࣮࣓ࣛࣃ㸦ࣜࣉࢫンࢢ剛性࣮ࣜࢣࢫンࢢ系数㸧ࢺ࣮࣏ࢧࡢ 

実験計画法 

 RSM逆算ࡼ࠾び検証ࡢࡵࡓࡢ新ࡋい࣐ࢥンࢻ 
 DOE࢖ࡢࢱ࣮ࢹン࣏࣮ࡢࡵࡓࡢࢺࢵࢭࣜࠊࢺ新ࡋい࣐ࢥンࢻ 

最適化 

 最ᑠ FRFࣞ࣋ࣝ設計ࡢ࣮ࣜࢺ࣓࣏ࢺࡢࡵࡓࡢ最適化 

 ンࣙࢩ࣮ࣞࢢ࢕ࣇコン、ࢫンࢭ࢖ࣛ、࣮ࣝࢺࢫン࢖

 ンࣙࢩ࣮ࣞࢺࢫン࢖

FEMtools 4࢘ࢲࡣン࣮ࣟࠊࢻUSBࢡࢵ࢕ࢸࢫあࡿいࡣ CD-ROM࡛࣮ࣜࣜࠋࡍࡲࢀࡉࢫ 

 FEMtools࢜ࢻ࢔ン࣭࣐ࠊࡣ࣮ࣕࢪ࣮ࢿ空白ࢆ含ࢆ࣒࣮ࢿࢫࣃࡴ扱うࠋࡍࡲࡁ࡛ࡀ࡜ࡇ 
 新ࡋいࢳࢵࣃ処理ࡢ開始時࢜ࢻ࢔࡟ン࣭࣐ࡣ࣮ࣕࢪ࣮ࢿ実行ࠋࢇࡏࡲࢀࡉ新ࡋい࢜ࢻ࢔ンࡀ検知ࡿࢀࡉ場合࡟

 ࠋࡍࡲࢀࡉ実行࡟自動的ࠊࡣ
 ࠊࡣ࣮ࣕࢪ࣮ࢿ࣐࣭ࢪ࣮ࢣࢵࣃ利用ྍ能ࢭ࢖ࣛ࡞ン࡞ࡀࢫい場合実行ࢭ࢖ࣛࠋࢇࡏࡲࢀࡉンࡀࢫ見ࡃ࡞ࡽ࠿ࡘ

手動࡛ࢆ࣮ࣕࢪ࣮ࢿ࣐࣭ࢪ࣮ࢣࢵࣃࠊࡣ࡟場合ࡿあࡀࢪ࣮ࢣࢵࣃン࣭ࣙࢩ࣮ࣞࢺࢫン࢖࡞利用ྍ能ࠊࡶ࡚

㸦Add-ons > Install/Remove Add-on㸧実行ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 
 ࢔ン࢖ン࣮ࣝࢺࢫ処理࡛࢔ࠊࡣン࢖ン࣮ࣝࢺࢫ手⥆ࡀࡁ始ࡿࡲ前ࢺࣉࣜࢡࢫ࣭࣮ࢧࢵࢭࣟࣉࣜࣉ࡟

㸦uninstall_packages.bas㸧FEMtools࢔ン࢖ン࢜ࢻ࢔ࡀ࣮ࣝࢺࢫン࣭࢖ࡢࢪ࣮ࢣࢵࣃンࢆ࣮ࣝࢺࢫ解除ࠋࡍࡲࡋ 
 ࢖࣭ࢱ࣮ࢹン࡜ࢫ࢖࢙ࣇ࣮ࢱ関係࣮ࢲ࢛ࣝࣇࠊࡣࣝ࢖࢓ࣇ࣭ࢺࣉࣜࢡࢫࡿࡍ<installdir>/scripts/interfaces࢖࡟ン

ン࢕ࢸࢵࢭびࡼ࠾ࢺࣉࣜࢡࢫ࣭ࣂ࢖ࣛࢻࠋࡍࡲࡾあࡀ࣮ࢲ࢛ࣝࣇࣈࢧࡢ用ࢫｲ࢙ࣇ࣮ࢱン࢖各ࠊࢀࡉ࣮ࣝࢺࢫ

 ࠋࢇࡏࡲࡾ変わࡣ఩置㸦<installdir>/scripts/drivers㸧ࡢࣝ࢖࢓ࣇ࣭ࢢ

コ࣐ン࢖ࣛࢻン࣭ࢱ࣮࣓ࣛࣃ 

࣭ࣉࢵ࢔ࢺ࣮ࢱࢫࡀ変数ࡢࡽࢀࡑࠋࡓࡋࡲࢀࡽ加えࡅ付࡟ࡵࡓࡿࡍ定義ࢆ環境変数ࡀࢱ࣮࣓ࣛࣃン࣭࢖ࣛࢻン࣐ࢥ

ࣉࣜࢡࢫࠋࡍࡲࢀࡉ適用ࡀ環境変数ࡢࡇࠊ࡟直後ࡓࡋ実行ࢆFEMtoolsࠊ࡟うࡼࡿࡁい࡚利用࡛࠾࡟ࢺࣉࣜࢡࢫ
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ使用ࢆࢢン࢕ࢸࢵࢭ構成ࢬ࢖࣐ࢱࢫ࢝ࡢࡑࠊࡣ࣐ࣛࢢࣟࣉ࣭ࢺ

 更新点ࡢ࣒ࣛࢢࣟࣉ

FEMtoolsࡣ定期的ࢺ࣮ࢹࣉࢵ࢔࡟情報ࡢࡑࠊࢀࡉࢡࢵ࢙ࢳࢆ情報ࣙࢪ࣮ࣂ࣭ࢺ࣮ࢹࣉࢵ࢔ࡣ࡟ンࡀᏑᅾࡿࡍ場所
や࣒ࢸࢫࢩ情報ࡀ含ࠊࡓࡲࠋࡍࡲࢀࡲ新࢜ࢻ࢔ࡓࢀࡉࢫ࣮ࣜࣜ࡟ࡓン࣭ࣔ࡟࣮ࣝࣗࢪ関ࡿࡍ通知ࡀあࡲࢀࡋࡶ࠿ࡿ

 ࠋࢇࡏ
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FEMtoolsࡣ  ࠋࡍࡲࡋᥦ供ࢆンࣙࢩࣉ࣭࢜ࢺ࣮ࢹࣉࢵ࢔ࡢࡘ2

 ࣉࢵ࢔ࢺ࣮ࢱࢫ時ࡢ通知：ࣉࢵ࢔ࢺ࣮ࢱࢫ時ࡢ࣒ࢸࢫࢩ࡟最新版ࢆ定期的࢘ࢲࠊࡋࢡࢵ࢙ࢳ࡟ン࣮ࣟ࢖࡜ࢻン

推࡟ࡵࡓࡃ࠾࡚ࡋ࡟最新ࢆ࢔࢙࢘ࢺࣇࢯࡣンࣙࢩࣉ࢜ࡢࡇࠋࡍࡲࢀࡉ通知ࡀ࡜ࡇࡿい࡚ࡁ࡛ࡀ準備ࡢ࣮ࣝࢺࢫ

奨ࠋࡍࡲࢀࡉ 
 ࣙࢪ࣮ࣂ࣭ࢺ࣮ࢹࣉࢵ࢔ン࢖ࡢンࡢ࣮ࣝࢺࢫ手動ࢆࢺ࣮ࢹࣉࢵ࢔ࡣ࣒ࢸࢫࢩ：ࢡࢵ࢙ࢳ自動࡛ࡋࢆࢡࢵ࢙ࢳࡣ

ࡿࡍ決定ࢆ࠿ࡁ࡭ࡍࢆࢺ࣮ࢹࣉࢵ࢔ࡘいࠊࡋ使用ࢆ㸦Help > Check for Updates㸧ࣉࣝ࣊ࠊ࡟ࡾ代わࠋࢇࡏࡲ
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇ

 

FEMtoolsࡢ࡜࣮ࣂ࣮ࢧ࣭ࢺ࣮ࢹࣉࢵ࢔接⥆ࢆ確立࢖ࠊࡣ࡟ࡿࡍンࢺࢵࢿ࣮ࢱ接⥆ࡀ要求࡟࡜ࡇࡿࢀࡉ注意ࡃ࡚ࡋ
 ࠋいࡉࡔ

使ࢆンࢱConfigure࣎ࠊࡣ変更ࡢンࣙࢩࣉ࣭࢜ࢺ࣮ࢹࣉࢵ࢔ࠊい࡚࠾࡟以降ࠊࡾあࡀ応答指示࡟時ࣉࢵ࢔ࢺ࣮ࢱࢫ
用࡚ࡋ行うࠋࡍࡲࡁ࡛ࡀ࡜ࡇ 

 ࠋࡍࡲࡁ開ࢆࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲࡢ次ࡣࢀࡇ

 

࡟単ࡣ通知ࡢࣉࢵ࢔ࢺ࣮ࢱࢫ 7᪥間隔࡛作成࢕ࢸࢵࢭ࣭࣮ࢨ࣮ࣘࡣࢀࡇࠋࡍࡲࢀࡉンࣝ࢖࢓ࣇ࣭ࢢ㸦࣮࣭࣮ࣘ࣍ࢨ
ࡢෆ࣮ࣜࢺࢡࣞ࢕ࢹ࣒࣮ femtools_400.ini㸧࡛設定ࠊࢀࡉCheckDaysInterval࡛修ṇࡢࡑࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ値ࡋ࡜
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選ࢆンࣙࢩࣉ࢜…Manually checkࠊࡣࢀࡇࠋࢇࡏࡲࢀ行わࡣࢡࢵ࢙ࢳࡢࢺ࣮ࢹࣉࢵ࢔ࠊࡤࢀࢀࡉ設定ࡀ㈇࠿0ࠊ࡚
ぶ࡜࡜ࡇ等価࡛ࠋࡍ 

FEMtoolsࣛࢭ࢖ン࣭ࢫコン࣮ࢱ࣮ࣞࢢ࢕ࣇ 

FEMtoolsࣛࢭ࢖ンࢥ࣭ࢫン࣮ࢱ࣮ࣞࢢ࢕ࣇ㸦License Configurator㸧ࡣ更新ࢺࢵࢿࠊࢡࢵࣟࢻ࣮ࣀࠊࢀࡉワ࣮ࣟࠊࢡ
࣮࣑ンࢭ࢖ࣛࡢࢀࡒࢀࡑࡢࢢンࢆࢫ形成࡟ࡵࡓࡿࡍ使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍWindows࡛ࠊࡣHelp > License 
Configuratorࢆ使用࢖ࠊࡋン࣮࣮ࣛࢺࢫ㸦Start > All Programs > FEMtools 4 > FEMtools License Configurator㸧࡟
 ࠋいࡉࡔࡃ࡚ࡋ使用ࢆftlmࠊࡣLinux࡛ࠋࡍࡲࢀࡉࢫࢭࢡ࢔࡬ࢡンࣜ࡟FEMtools 4ࠊ࡚ࡗࡼ

 

FEMtools License Configurator 

 ࠋࡍࡲࡋ使用ࢆLicense settingsࠊࡣい࡚ࡘ࡟ࢫンࢭ࢖࣭ࣛࢡワ࣮ࢺࢵࢿ࡜ࢫンࢭ࢖࣭ࣛࢡࢵࣟࢻ࣮ࣀ
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Core Product Nameࡀ入力࡞ࢀࡉい場合ࣉࢵ࢔ࢺ࣮ࢱࢫࠊ時ࠊ࡟FEMtoolsࢭ࢖ࣛࡣンࡀࢫ利用ྍ能ྡࢺࢡࢲࣟࣉ࡞
 ࠋࡍࡲࡾ࡞࡟ྡࢺࢡࢲࣟࣉࡿࡼ࡟ࢡࢵ࢙ࢳ自動ࠊ場合ࡿあ࡛ࢫンࢭ࢖ࣛ࡞利用ྍ能ࡢ個別ࠋࡍࡲࡋᥦ示ࢆ

次ࢆࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲࡢ開ࠊࡣ࡟ࡃConfigure license roamingࢆ使用ࠋࡍࡲࡋ 

 

࣮࣑ࣟンࣙࢩࣉ࣭࢜ࢢンࡢ設定後ࢆࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲࡢࡇࠊ閉ࠊ࡚ࡌ選択ࡓࢀࡉ Core Product Nameࢭ࢖ࣛࡢン
࡟ࡵࡓࡿࡍࢡࢵ࢙ࢳࢆࢫ FEMtoolsࢆ再開ࡉࡔࡃ࡚ࡋいࢭ࢖ࣛࠋンࡀࢫ利用ྍ能࢜ࢻ࢔࡞ン࡚࡭ࡍࡶ自動的࢙ࢳ࡟
 ࠋࡍࡲࢀࡉࢡࢵ

 ࣝࢢンࢻ

FEMtoolsࠊࡣSafenet SuperPro࡟加えࠊLinuxࢥン࡛ୖࢱ࣮ࣗࣆ使用ྍ能࡞新ࡋい Safenet HLࢻンࡋࢺ࣮࣏ࢧࢆࣝࢢ
 ࠋࡍࡲࢀࡉ使用࡟共࡜ࢫンࢭ࢖࣭ࣛࢡࢵࣟࢻ࣮ࣀࡣࣝࢢンࢻࠋࡍࡲ

 変更ࢫンࢭ࢖ࣛ

FE࢖࣭࣒ࣛࢢࣟࣉンࢫ࢖࢙ࣇ࣮ࢱ㸦ࡼ࠾び࢜ࢻ࢔ン解析࢜ࣙࢩࣉン㸧ࡣ個別ࢭ࢖ࣛࡢン࢖࡚ࣛࡗࡼ࡟ࢻ࣮ࢥ࣭ࢫ
 ࠋࡍࡲࢀࡉࢫンࢭ
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 新ࡋい hostid UUIDࡀ利用ྍ能࡛ࡣࢀࡇࠋࡍ wrlmhostid.exe࣮࡛ࣘ࢕ࢸ࢕ࣜ࢕ࢸ示ࡢࡇࠊࢀࡉ UUIDࢻ࣮ࢥ
uuidࠕFt_HostInfo㸦ࠊࡣ 㸧ࠖ関数ࡶࡽ࠿࣒ࣛࢢࣟࣉ࡚ࡗࡼ࡟検索ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

 引ࡁ数 Ft_ProductInfo㸦"server"㸧ࠊࡣFt_ProductInfo㸦"name"㸧࡜共࡟使用࡛ࡼࡿࡁう࡟加えࠋࡓࡋࡲࢀࡽ 

例 

Sub Main print "hostid(uuid) = "; Ft_HostInfo("uuid")  
print "ft_productinfo(server)=";ft_productinfo("server")  
print "ft_productinfo(name)=";ft_productinfo("name")  

End Sub  

 FEMtools 4ࢭ࢖ࣛࡣン࣓ࢪ࣮ࢿ࣐࣭ࢫン࡟ࡵࡓࡢࢺ RLM 12.2ࢆ使用ࠋࡍࡲࡋあࡢ࠾ヲ細࡞情報࡟関ࠊࡣ࡚ࡋ
RLM࣓ࣗ࢟ࢻンࢆࢺ参照ࡉࡔࡃ࡚ࡋいࠋ 

 RLM_ROAM環境変数ࡣ㸯᪥間ࢭ࢖ࣛࡢンࢆࢫ᭷効ࠊ࡟ࡵࡓࡿࡍ࡜”tiday”値ཷࢆ理ࡢࡇࠋࡍࡲࡋ機能ࠊࡣRLM 
v11.0+࢔࢖ࣛࢡンࡢ࣮ࣂ࣮ࢧ࡜ࢺ両方ࡢ設定࡟依Ꮡࠋࡍࡲࡋ 

 環境変数 RLM_QUEUEࡀࢺ࣮࣏ࢧࡢ加えࠊࢀࡽRLM_QUEUE環境変数ࡀᏑᅾࡿࡍ場合㸦重要࡛࡞い値㸧ࠊ
FEMtools࢖࣓ࡣン機能ࢺ࢘࢔ࢡࢵ࢙ࢳࡢ設定ྍࡀ能ࢭ࢖ࣛࠋࡍࡲࡾ࡞࡟ンཷࡀࢫ理࡞ࢀࡉい場合㸦௚࣮ࣘࡢ
ࠋࡍࡲࡕᚅࡣFEMtoolsࠊ࡛ࡲࡿ࡞࡟利用ྍ能ࡀࢫンࢭ࢖ࣛࡢࡑࠊ㸧ࢫンࢭ࢖ࣛࡿい࡚ࢀࡉ使用࡚ࡗࡼ࡟࣮ࢨ
RLM_QUEUE変数ࡀ設定࡚ࢀࡉい࡞い場合ࠊFEMtoolsࢭ࢖ࣛࡣンཷࢆࢫ理ࠋࢇࡏࡲࡋRLM_QUEUEࡣ
RLM_ROAM࡜非互換性࡛あ࡟࡜ࡇࡿ注意ࡉࡔࡃ࡚ࡋいࠋRLM_ROAM࣑࣮ࣟࡣンࡢࢢ準備࡚ࡁ࡛ࡀいࡿ場
合ࠊRLM_QUEUEࡣ非ࣈ࢕ࢸࢡ࢔化ࠋࡍࡲࢀࡉ言い࠿えࠊࡤࢀRLM_ROAM࡜ RLM_QUEUEࡢ両方ࢺࢵࢭࡀ
 ࠋࡍࡲࢀࡉ無視ࡣRLM_QUEUEࠊ場合ࡿࢀࡉ
ࡣ制限ࡢࡇ RLM v12.0ࠊ࡚ࡗࡼ࡟起動ࢥンࢆ࣮ࣝࣟࢺ強化ࢭ࢖ࣛࡣࢀࡇࠋࡍࡲࡋンཷࡀࢫ理ࡿࢀࡉ場合࡛
ࢀ࡞࡟᭷効ࡀࢫンࢭ࢖一᪦ࣛࠋࡍࡲࡋࢡࢵࣟࢆࢫンࢭ࢖ࣛࡢ࡛࣮ࢱ࣮ࣗࣆンࢥ࣭ࣝ࢖ࣂࣔࡀRLM_ROAMࠊࡶ
 ࠋࢇࡏࡲࡋや作動ࡣࡶࡣRLM_QUEUEࠊ࡛ࡢࡿ࡞࡟ࢫンࢭ࢖࣭ࣛࢡࢵࣟࢻ࣮ࣀࡀࢫンࢭ࢖ࣛࡢ࠾あࠊࡤ

 ࣛࢭ࢖ンࠊࡣ࡟ࣝ࢖࢓ࣇ࣭ࢫ‘customer’࡜‘contract’ࡀࢻ࣮ࣝ࢕ࣇࡢᏑᅾࢭ࢖ࣛࡢࡇࠋࡍࡲࡋンࢫ情報㸦Help > 
License Information㸧࡜࣮࣐ࢱࢫ࢝ࠊࡣ契約ࡢ情報ࢆ示ࠋࡍࡲࡋ起動ཷࡀ理ࡓࢀࡉ場合ࢥࠊン࢕࣭࣮࢘ࣝࢯン
ࡣ情報࣮࣐ࢱࢫ࢝ࠋࡍࡲࡋ出力ࢆ情報࣮࣐ࢱࢫ࢝ࡢࡑ࡟࢘ࢻ aboutࡶ࡛ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ確認࡛ࠋࡍࡲࡁ 

 RLMࣜࡢ࡬ࢺ࢖ࢧ࣭ࢺ࣮࣏ࢧンࠊࡀࢡHelp࣓࣮ࣗࢽ㸦Help > RLM Support Site㸧࡟加えࠋࡓࡋࡲࢀࡽ 
 RLM࣐࣓ࢪ࣮ࢿンࣜࡢ࡬ࣝ࢔ࣗࢽ࣐࣭ࢺンࠊࡀࢡFEMtools License Configurator ࡟加えࠋࡓࡋࡲࢀࡽ 
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 変更点ࡢࢺキ࣓ࣗンࢻ

次ࡢ大変化࣓ࣗ࢟ࢻࡀン࡜ࢺ例࡟作ࡓࡋࡲࢀࡽ: 

 FEMtools࣓ࣗ࢟ࢻンࢫ࣮ࣜࣜࡢࡇࡣࢺ伴࡚ࡗ更新ࠋࡍࡲࢀࡉ 
 新規ࡢ LS―DYNA࢖ン࢙ࣇ࣮ࢱｲࡀࢻ࢖࢞ࡢࣂ࢖ࣛࢻ࡜ࢫ追加ࠋࡍࡲࢀࡉ 
 実㦂計画法㸦DOE:design of experiments㸧ࡢ基礎情報ࡼ࠾び࣏ࣞࢫンࣜࢹ࣭ࣔࢫ࢖࢙ࣇ࣭ࢫンࢢ㸦RSM:response 

surface modeling㸧ࠊࡣFEMtools Model Updating User’s Guide࡜ FEMtools Optimization User’s Guidࡽ࠿新ࡋい
FEMtools Sensitivity࡜ Design of Experiments࡟ࢻ࢖࣮࢞ࢨ࣮ࣘࡢ移動ࠋࡓࡋࡲࡋFEMtools Model Updating User’s 
Guide࡜ FEMtools Optimization User’s GuidࠊࡣFEMtools DOE/RSMࡢ使用方法ࡘ࡟い࡚ࡾࡼࡢ実際的࡞情報ࢆ
ᥦ供ࠋࡍࡲࡋ 

 個別࣮ࣜࢺ࣓࣏ࢺࡢ最適化ࡢ例題ࡢヲ細࡞記述ࠊࡀFEMtools Optimization User’s Guid࡟追加ࠋࡍࡲࢀࡉ 
 PointCloud࢜ ࣓ࣗ࢟ࢻ࡚ࡋ࡜関数ࢺࣉࣜࢡࢫࡣCreateObject関数ࠋࡍࡲࢀࡉ変更ࡀࢺン࣓ࣗ࢟ࢻࡢࢺࢡ࢙ࢪࣈ

ンࢺ化ࠊࡋࡔࡓࠋࡓࡋࡲࢀࡉFillࠊFindNearestࠊSearchRadiusࠊࡣPointCloud࢜ ࢻ࡚ࡋ࡜使用方法ࡢࢺࢡ࢙ࢪࣈ

࣓࢟ࣗンࢺ化ࠋࡓࡋࡲࢀࡉPointCloud࢜ ࣭ࣜࢺࣉࣜࢡࢫࠊࡣࢺࢡ࢙ࢪࣈい辞書࢜ࡋ新࡜使用方法ࡢࢺࢡ࢙ࢪࣈ

 ࠋࡍࡲࢀࡉ化ࣉ࣮ࣝࢢ࡟章ࡢ使用方法㸧ࠖࡢࢺࢡ࢙ࢪࣈObject Methods㸦࢜ࠕいࡋ新ࡢࣝ࢔ࣗࢽ࣐ࢫンࣞ࢓ࣇ
 ࣐ࢥンࢻ SENSITIVITY SOLVER࣓ࣗ࢟ࢻࡣンࢺ化࡚ࢀࡉい࣓ࣗ࢟ࢻࡣࢀࡑࠊࡀࡓࡋࡲンࡾྲྀࡽ࠿ࢺ除ࠊࢀ࠿

SENSITIVITY SOLVERࡣ SENSITIVITY METHOD char_val࡟替わ࡟࡜ࡇࡓࡗ注意ࡉࡔࡃ࡚ࡋいࠋ 

例題ࡢ変更点 

 次ࡢ例題ࡀ追加ࠋࡍࡲࢀࡉ 

 Calculix࢖ࡢン࢙ࣇ࣮ࢱｲࣂ࢖ࣛࢻ࡜ࢫ：..\examples\interfaces\calculix 
 LS-Dyna࢖ࡢン࢙ࣇ࣮ࢱｲࣂ࢖ࣛࢻࡢࡵࡓࡢ：ࣂ࢖ࣛࢻ࡜ࢫ:..\examples\interfaces\lsdyna 

 ࣎ࣝࢺ締ࢺ࣮ࣞࣉࡵ構造㸦“BoxBeam”㸧ࢺࢫࢸࣜࣉࡢ解析: ..\examples\pretest\boxbeam 
 ࡛࣎ࣝࢺ締ࢺ࣮ࣞࣉࡵ構造㸦“BoxBeam”㸧ࡢ FEMࢺࢫ࢟ࢸ相関ศ析: ..\examples\correlation \boxbeam 
 GVTࣙࢩ࣮࣑ࣞࣗࢩン࣭ࣔ࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࡢࣝࢹンࢢ: ..\examples\updating\gvt 
 ࡛࣎ࣝࢺ締ࣝࢹ࣭ࣔࢺ࣮ࣞࣉࡵ㸦“JimBeam”㸧࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࡢンࢢ:  

..\examples\updating\jimbeam 
 ࣜࣉࢫンࢢ要素ࢱ࣮࣓ࣛࣃ࣭ࢺ࣮ࢹࣉࢵ࢔ࡢ KT࡜ KRࡢ使用方法： 

..\examples\updating\plate_modal\run06ktr.cmd 
 ࣜࣉࢫンࢢ要素ࢱ࣮࣓ࣛࣃ࣭ࢺ࣮ࢹࣉࢵ࢔ࡢ Dࡢ使用方法： 

..\examples\updating\plate_modal\run06d.cmd 
 ࣏ࢫࣞࠊࢱ࣮࣓ࣛࣃ࡞ࢡࢵࣜࢿ࢙ࢪン࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࡢ࣮ࣂࣝࢯࠊࢫンࢢ方法:  

..\examples\generic\excel (using MS Excel solver)  

..\examples\generic\frf (generic solver to driver PADEFRF and MODALFRF) 

..\examples\generic\modal 
 ࣏࣮ࣞࢺ例題：..\examples\reporting\updating 

 次ࡢ例題ࡀ࣮ࢲ࢛ࣝࣇ移動ࠋࡓࡋࡲࡋ 

 \fea\complex_modes࣮ࢲ࢛ࣝࣇࠊࡣ\dynamics\complex_modes࡟移動ࠋࡓࡋࡲࡋ 
 \fea\modal_solver࣮ࢲ࢛ࣝࣇࠊࡣ\dynamics\modal_solver࡟移動ࠋࡓࡋࡲࡋ 

 次ࡢ例題ࡀ更新ࠋࡓࡋࡲࢀࡉ 

 \dynamics\modal_solver 
 ..\examples\updating\generic\excel\demo.cmd 
 ..\examples\optimization\doe\spring\spring_doe_excel.bas 
 ..\examples\optimization\genetic\dmo\dmo_ga.cmd 

 inertia.basࡣࢺࣉࣜࢡࢫ࣭࣒ࣛࢢࣟࣉ࣭ࣔࢹ削除ࠋࡓࡋࡲࢀࡉ 
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FEMtools࣒࣮ࣞࣇワ࣮ࢡ 

FEMtools࣒࣮ࣞࣇワ࣮ࡢࢡ主࡞変更点ࢆ示ࠋࡍࡲࡋ 

FEMtoolsࢺࣉࣜࢡࢫ言語 

 Dictionary㸦辞書㸧࢜ࠋࡓࡋࡲࢀࡉࢺ࣮࣏ࢧࡀࢺࢡ࢙ࢪࣈDictionaryࠊࡣ様々ࢆࣉ࢖ࢱ࣭ࢱ࣮ࢹ࡞格納࣮ࢿ࣐ࡋ
 㸦Help > Helpࣉࣝ࣊ࠋࡍ࡛ࢺࢡ࢙ࢪࣈ࣭࢜ࢫ࣮࣋ࢱ࣮ࢹ࡞柔軟ࡿࡁ࡛ࡀ࡜ࡇࡿࡍ使用࡟ࡵࡓࡿࡍࢺン࣓ࢪ
Topics > Scripting Reference > Object Methods > Dictionary㸧ࡽ࠿ FEMtoolsࣞ࢓ࣇ࣭ࣜࢺࣉࣜࢡࢫンࣝ࢔ࣗࢽ࣐ࢫ
 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆ

 ࠊࡣࣝ࢖࢓ࣇ࣭ࣝࢼ࣮ࣕࢪ”journal_FT<pid>.tmp”ࡼࡢうࠊ࡟現ᅾࣙࢩࢵࢭࡢンࢫࢭࣟࣉ pidࡀ付ࠋࡍࡲࢀࡽࡅ
複数ࡢ FEMtoolsࣙࢩࢵࢭンࢸࡌྠࡀン࣏ࣛࣜ࡟࣮ࢲ࢛ࣝࣇ࣭ࣝ࢖࢓ࣇ共᭷ࡿࢀࡉ場合ࡢ問題ࢆ回避ࠋࡍࡲࡋ 

 Calculix࢖ン࢙ࣇ࣮ࢱｲࢫとࣂ࢖ࣛࢻ 

 FRF࣮ࣜࠊࡣࢲ短いࡣࡓࡲ長い ASCII࡟ࡵࡓࡿࡍࢺ࣮࣏ࢧࢆࢺࢵ࣐࣮࢛ࣇ更新ࠋࡓࡋࡲࢀࡉ 
 ࢺࣉࣜࢡࢫ࣭࣒ࣛࢢࣟࣉ࣭ࣂ࢖ࣛࢻ㸦calculix.bas㸧ࠊࡣWindows࡜ Linuxࡢ両方࡟ࡵࡓࡢ更新ࠋࡓࡋࡲࢀࡉ 
 ࢥ࣭ࣂ࢖ࣛࢻンࣙࢩ࣮ࣞࢢ࢕ࣇン࢕ࢸࢵࢭࠊࡣンࣝ࢖࢓ࣇ࣭ࢢ calculix.ini中࡛設定ࠋࡍࡲࢀࡉ 
 例題ࡢ..\examples\interfaces\calculixࡀ追加ࠋࡓࡋࡲࢀࡉ 

 ࣂ࢖ࣛࢻとࢫ࢖࢙ࣇ࣮ࢱン࢖࣭ࣝ࢖࢓ࣇ࣭ࣝࢧ࣮ࣂࢽࣘ

 ࢖ࡢࢺ࢛ࣝࣇࢹン࢕ࢸࢵࢭ࣭ࢫ࢖࢙ࣇ࣮ࢱンࠊࡣ࡛ࢢ異࢖ࡽ࠿ࣝ࢖࢓ࣇࡿ࡞ン࣏࣮ࣉ࣮࢙ࢩࢻ࣮ࣔࡓࢀࡉࢺや

ODS࡟ࢫ࣮࣋ࢱ࣮ࢹࡀ追加࡞ࢀࡉいࠊ࠿既Ꮡୖ࡟ࢻ࣮ࣔࡢ書ࡼࡿࡍࡁう࡟修ṇࠋࡍࡲࢀࡉFRFࡘ࡟い࡚ࠊࡣ
append࣮ࣔ࢜ࡢࢻンࡢࡇࠋࡍ࡛ࢺ࢛ࣝࣇࢹࡀ振ࡿ舞いࠊࡣSET INTERFACE UFF࣐ࢥンࢻあࡿいࡣ変数
interface.uff.aflagsࡢ設定ࡾࡼ࡟修ṇࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

 ࢺン࣓ࢪネ࣮࣐࣭ࢫ࣮࣋ࢱ࣮ࢹ

 ࣮࢜ࣛ࢖角㸦DEFINE EULER࣐ࢥンࢻ㸧ࢆ使用࣮ࣝ࢝ࣟࡓࡋᗙ標系ࡢ定義 
 新ࡋいࢱ࣮࣓ࣛࣃ D㸦材料ࡢ弾性࣐ࢫࢡࢵࣜࢺ係数ࣜࣉࢫ࡜ン࣮ࣝࢣࢫ࣭ࢢ係数㸧：࣒࣮ࣅࡣࢱ࣮࣓ࣛࣃࡢࡇ

やࣜࣉࢫンࢢ㸦࣭ࣞࣟࢮンࡶࢫࢢ含ࡴ㸧ྠ࡜様࢙ࣝࢩ࡟やࡢࢻࢵࣜࢯ特性ࢆ表わࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡍ次ࣔࢹࡢ

ンࣙࢩ࣮ࣞࢺࢫン例ࢆ参照ࡉࡔࡃ࡚ࡋいࠋ 
\examples\updating\plate_modal\run06d.cmd  

 新ࡋいࢱ࣮࣓ࣛࣃ KT࡜ KRࣜࣉࢫࠊࡣンࢢ並進剛性ࣜࣉࢫ࡜ンࢢ回転剛性࡟関࣮ࣝࢣࢫࡿࡍ係数࡛ࠋࡍ次ࡢ
 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆン例ࣙࢩ࣮ࣞࢺࢫンࣔࢹ
\examples\updating\plate_modal\run06ktr.cmd 

 PARAMETER TEXTࠊࡣNastranࡢࣝ࢖ࢱࢫ倍精ᗘࢺࢵ࣐࣮࢛ࣇ㸦例え7.17+10ࠊࡤ㸧ࢆㄞࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡴ
以前࡚ࡋ࡜7.17ࠊࡣㄞ࡚ࢀࡲい7.17ࠊࡀࡓࡋࡲE+10࡚ࡋ࡜ㄞࡳ込ࠋࡍࡲࢀࡲ 

 CLEAR SHAPES࣐ࢥンࡀࢻ改善࣐ࢥࡢࡇࠋࡓࡋࡲࢀࡉンࡀࢻ実行ࡓࢀࡉ場合ࡢ警告࣓ࡶࢪ࣮ࢭࢵ改善ࡲࢀࡉ
 ࠋࡓࡋ

 ࣏ࡽ࠿࣮ࣗࢽ࣓࣭ࣉࢵ࢔ࣉࢵ重力荷重㸦Gravity Loads㸧ࢆ実行ࡓࡋ場合ࠊGravity Loads࡟ࣝࣈ࣮ࢸ追加ࢀࡉ
 ࠋࡓࡋࡲࡋ改善ࢆい問題࡞

 ࣐ࢥンࢻMODIFY FRFࡀ更新ࡾࡼࠊࢀࡉ多ࣙࢩ࣮ࣞ࣌࢜ࡢࡃンࡀ解析ࡼ࠾びࡢࢺࢫࢸ FRF࡟対࡚ࡋ実行ࢀࡉ
 ࠋࡍࡲ

 ANALYZE[KEYWORD=VALUE,...࣐ࢥンࠊࡣࢻ総体的࡞解析特性ࢆ指定࡟ࡵࡓࡿࡍ使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ
ࡢࡑ API関数 Ft_GetProperties("analyze")ࢆࡽࢀࡑࡣ検索࡟ࡵࡓࡿࡍ使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

 ࢫ࢖࢙ࣇ࣮ࢱン࢖࣭࣮ࢨ࣮ࣘ

FEMtools࣮ࣘ࢖࣭࣮ࢨンࡢࢫ࢖࢙ࣇ࣮ࢱ変更点ࡘ࡟い࡚概ㄝࠋࡍࡲࡋ 
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 ࢘ࢻン࢕ン࣭࢘ࣙࢩ࣮ࢣࣜࣉ࢔ン࣭࢖࣓

 ࡣࣝ࢖ࢱࢫ࣭ࢺ࢛ࣝࣇࢹ白い背景㸦white background㸧࡟変わࠋࡓࡋࡲࡾFEMtools 3࡛ ࣝ࢖ࢱࢫ࣭ࢺ࣮࣏ࣞࠊࡣ
㸦report.sty㸧࡚ࡋ࡜知࡚ࢀࡽいࠊࡀࢀࡇࠋࡓࡋࡲdefault.styࠊࡾ࡞࡟report.styࡣ削除ࠋࡓࡋࡲࢀࡉ 

 新ࡋいࠊ࡚ࡋ࡜ࣝ࢖ࢱࢫFEMtools 4ࢆࣝ࢖ࢱࢫ FEMtools 3ࡢࡵࡓࡿࡍࢺࢵࢭࣜ࡟ ft3.styࡀ追加ࠋࡓࡋࡲࢀࡉ 

ツールバー 

 新ࡋい࣋ࢥ࢖࢔ࡢࢫ࣮࣭࣋ࣝࢺࢡン㸦SVG㸧 
 高解像ᗘࣔࢱࢽ㸦4K㸧対応ࡢ自動的࣮ࣜࢣࢫンࢥ࢖࢔࣭ࢢン 

コンソ࣮࣭ࣝ࢘࢕ン࢘ࢻ 

 一般ࠊ࡟実行࣓࣮ࣗࢽ関数࡚ࡗࡼ࡟生成ࡿࢀࡉ FEMtools࣐ࢥンࡣࢻᑠ文Ꮠࡀ࣮ࢱࢡࣛࣕ࢟ࡢ使用ࠋࡍࡲࢀࡉ
ࡣࢻン࣐ࢥࡢ࡚࡭ࡍࠊࢀࡉ改善ࡀࢀࡇࠋࡓࡋࡲい࡚ࢀࡉ生成ࡀࢻン࣐ࢥࡢ大文Ꮠࡣ࡟࣮ࣗࢽ࣓ࡢ少数ࠊࡋ࠿ࡋ

ᑠ文Ꮠ࢟ࣕࣛࢆ࣮ࢱࢡ使用࡚ࡋ生成ࠋࡍࡲࢀࡉ 

 ࣮࣮ࣛࣟࣉࢫࢡ࢚࣭ࢫ࣮࣋ࢱ࣮ࢹ

 ࠋࡍࡲࢀࡉ表示࡚ࡋ࡜ࣉ࣮࢙ࢩ࣭࣮ࢱンࢥࠊࡃ࡞ࡣ࡛࡚ࡋ࡜ࣉ࣮࢙ࢩや変形ࡣࡶࠊࡣ変形ࡢ解析ࢺࢫࢸࣜࣉ

 ࢢキンࢵࣆ࣭ࢫࢡࢵ࢕ࣇࣛࢢ

ࡲࢀࡉᑟ入ࡀ機能ࡢࡵࡓࡢ操作ࢢン࢟ࢵࣆࡿࡼ࡟࣒ࢬࣜࢦࣝ࢔いࡋ新ࠊࢀࡉ更新ࡀࢫ࢖࢙ࣇ࣮ࢱン࢖࣭ࢢン࢟ࢵࣆ

 ࠋࡓࡋ

Graphics࢘࢕ン࡞ࣈ࢕ࢸࢡ࢔ࡀ࢘ࢻ場合ࡢୖ࣮ࣂ࣮ࣝࢶࠊ Picking࣎ࢱン࡟࣮ࣗࢽ࣓ࣈࢧࠊࡣ変わࠊ࡚ࡗPicking
 ࠋࡍࡲࡋࢺ࣮࣏ࢧࡀ機能ࡢ次ࠊࡣࣝࢿࣃPickingࠋࡍࡲࡁ開ࢆࣝࢿࣃ

 節点࡜要素࢖࣏ࠊン࢖ࣛࢫ࣮ࣞࢺ࡜ࢺン࢟ࢵࣆࡢンࢆࢢ選択ࡢࡑࠋࡍࡲࡋ機能ࠊࡣ現ᅾ表示࡚ࢀࡉいࢩࢵ࣓ࡿ

ࣗ㸦FEࢺࢫࢸࡣࡓࡲ㸧࡟ࣉ࢖ࢱ依Ꮡࠋࡍࡲࡋ 
 Single Pick, Polygon Pick, Pick by Face, Pick by Attached ࡢ࡝࡞選択ྍࡀ能࡛ࠋࡍ 
 ࡢ࣒ࢸ࢖࢔追加ࡢ࣒ࢸ࢖࢔ࠊ削除࢟ࢵࣆࠊンࡢࢻ࣮࣭ࣔࢢ選択ྍࡀ࡝࡞能࡛ࠋࡍ 
 ࢟ࢵࣆンࢢ操作ࡢ開始ࠊ中断ྍ࡝࡞⥆⥅ࠊ能࡛ࠋࡍ 
 ࡛ࢺࢵࢭ選択ࢆ࣒ࢸ࢖࢔ࡓࢀࡉ保Ꮡྍࡀ能࡛ࠋࡍ 
 ࢆࢱࣝ࢕ࣇ࣭ࢫ࣮࣋ࢱ࣮ࢹ使用ࢡࢵࣆࠊࡋ選択ࢆ初期化ྍࡀ࡜ࡇࡿࡍ能࡛ࠋࡍ 
 隠ࢥࢆ࣮ࣗࣅࡢ࣒ࢸ࢖࢔ࢀンࠊ࡟ࡵࡓࡿࡍ࣮ࣝࣟࢺSee-through Element Highlight Mode㸦透明要素࢖ࣛ࢖ࣁࡢ

 ࠋࡍ能࡛ྍࡀ࡜ࡇࡿࡍ選択ࢆ㸧ࢻ࣮࣭ࣔࢺ



24 - FEMtools 4 Release Notes  

 

Pickingࣝࢿࣃ 

Node-point࣌࢟ࢵࣆ࣭࢔ンࠊࡣࢢPickingࡣ࡛ࣝࢿࣃ利用࡛ࠋࢇࡏࡲࡁ 

Node-Point Pairingࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ㸦Tools > Correlation Analysis > Node-Point Pairs㸧ࡀ追加ࠋࡓࡋࡲࢀࡉ 

 ࢔࣮ࣗࣅ࣭࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮ࣔ

ࡀ࢔࣮ࣗࣅ࣭࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮࣭ࣔࣈ࢕ࢸࢡࣛࢱン࢖ Tools > Correlation Analysis࣓࡟࣮ࣗࢽ追加ࠊࢀࡉTools > 
Correlation Analysis > Mode Shape Pair Viewerࢆ使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 
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 ࢔࣮ࣗࣅ࣭࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮࣭ࣔࣈ࢕ࢸࢡࣛࢱン࢖

更新ࢆ࢖ࣞࣉࢫ࢕ࢹ࣭ࢫࢡࢵ࢕ࣇࣛࢢࠊ࡜ࡿࡍ選択ࢆ࢔࣌ࠋࡍࡲࡋ示ࢆ࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮ࣔࡢ現ᅾࡣ࡟ࣝࣈ࣮ࢸ

 ࠋࡍࡲࡋ化ࢺ࢖ࣛ࢖ࣁࢆMAC値ࡢ中࣮ࣗࣅࢫࢡࢵࣜࢺ࣐ࠊࡋ

伴ࢆ白い輪郭ࡣࢻ࣮࣭ࣔ࢔࣌ࠋいࡉࡔࡃ࡚ࡋࢡࢵࣜࢡࢆMAC値ࡢ任意࡟ࡵࡓࡿࡍ更新ࢆ࣮ࣗࣅ࣭ࣉ࣮࢙ࢩࢻ࣮ࣔ
 ࠋࡍࡲࢀࡉ表示࡛ࢇ並ࡶࢻ࣮࣭ࣔ࢔非࣌ࠋࡍࡲࢀࡉ表示࡛ࢢン࣮ࣜࢣࢫ࡞適ษࡣࣉ࣮࢙ࢩࢻ࣮ࣔࠊࢀࡉ識別࡚ࡗ

 

非࣌ࣉ࣮࢙ࢩࢻ࣮࣭ࣔ࢔㸦࢖ン࢔࣮ࣗࣅ࣭࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮࣭ࣔࣈ࢕ࢸࢡࣛࢱ㸧 

更ࡀࢫࢡࢵ࢕ࣇࣛࢢ࡜ࣝࣈ࣮ࢸ࡜ࡿࡍࠋࡍࡲࡋ使用ࢆンࢱCreate Pair࣎ࠊࡣ࡟ࡿࡍ強調ࢆ࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮ࣔ
新ࠋࡍࡲࢀࡉ 

Delete Pairࠊ Clear AllࠊAuto Pairࢆ使用ࣉ࣮࢙ࢩࢻ࣮ࣔࠊࡋ結果ࢥࢆンࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ࣮ࣝࣟࢺ 
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ࡉࡔࡃ࡚ࡋࢡࢵࣜࢡࢆンࢱClose࣎ࠊࡣ࡟ࡿࡌ閉ࢆࣝࢿࣃ࣭࢔࣮ࣗࣅ࣭࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮࣭ࣔࣈ࢕ࢸࢡࣛࢱン࢖
いࠋ 

 ࢻコ࣐ン࣭࣮ࣗࢽ࣓

次࣐ࢥ࣭࣮ࣗࢽ࣓ࡢンࡀࢻ FEMtools 4࡟加えࠋࡓࡋࡲࢀࡽ 

 Database > Test Model Editor：࢖ࡢࣝࢹ࣭ࣔࢺࢫࢸンࢆࣝࢿࣃ࣭ࢱ࢕ࢹ࢚࣭ࣈ࢕ࢸࢡࣛࢱ開ࠋࡍࡲࡁ 
 Tools > Pretest Analysis > Mode Participation Maps：ࢺࢫࢸࣜࣉ解析่ࢻ࣮ࣔࡢ激࣐ࢆࣉࢵ計算ࠋࡍࡲࡋ 
 Tools > Pretest Analysis > Excitation Location Selection：ࢺࢫࢸ構造ࣔࡢࣝࢹ最適加振ࣞࢆࢺ࢘࢔࢖᥈索ࣃࡿࡍ

 ࠋࡍࡲࡁ開ࢆࣝࢿ
 Tools > Pretest Analysis > Support Location Selection：ࢺࢫࢸ構造ࣔࡢࣝࢹ支持方法や࣌ࢫࢧンࢻ最適方法ࢆ見

 ࠋࡍࡲࡋ表示ࢺࢵࣟࣉ࡟ࡵࡓࡿࡅࡘ
 Tools > Correlation Analysis > Mode Shape Pair Viewer：࢖ン࢔࣮ࣗࣅ࣭࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮࣭ࣔࣈ࢕ࢸࢡࣛࢱ

 ࠋࡍࡲࡁ開ࢆ
 Help > License Configurator：ࣛࢭ࢖ンࢥ࣭ࢫン࢖ࢧ࢔ࢆ࣮ࢱ࣮ࣞࢢ࢕ࣇンࠋࡍࡲࡋ 
 Help > FEMtools Support Site：FEMtoolsࢆࢪ࣮࣌ࢺ࣮࣏ࢧ開ࠋࡍࡲࡁ 
 Help > RLM Support Site：RLMࢆࢪ࣮࣌ࢺ࣮࣏ࢧ開ࠋࡍࡲࡁ 
 Help > Check for Updates：最新ࣙࢪ࣮ࣂンࠋࡍࡲࡋࢡࢵ࢙ࢳࢆ 

次࣐ࢥ࣭࣮ࣗࢽ࣓ࡢンࡀࢻ FEMtools 4࠾࡟い࡚ࠊ削除ࠋࡓࡋࡲࢀࡉ 

 View > Graphical Pickingࠊࡣ࣮ࣗࢽ࣓ࣈࢧView > Graphical Picking࣓࡚ࡗࡼ࡟࣮ࣗࢽ開ࠊࡃPicking Panel࡟替
えࠋࡓࡋࡲࢀࡽ 

 ࣓࢕࣭࢘ࣗࢩࢵンࡢ࣮ࣗࢽ࣓࣭ࣉࢵ࢔ࣉࢵ࣏ࡢ࢘ࢻGraphical Pickingࣗࢽ࣓࣭ࣉࢵ࢔ࣉࢵ࣏ࠊࡣ࣮ࣗࢽ࣓ࣈࢧ
 ࠋࡓࡋࡲࢀࡽ替え࡟Picking Panelࠊࡃ開࡚ࡗࡼ࡟࣮ࣗࢽGraphical Picking࣓ࡢ࣮

 ࣮ࣂ࣮ࣝࢶ࣭ࢫࢡࢵ࢕ࣇࣛࢢ中ࡢpicking࣎ࢱンࡣ࣮ࣗࢽ࣓ࣈࢧࡢ削除ࢱ࣎ࡢࡑࠊࢀࡉンࠊࡣPickingࢆ開ࡲࡁ
 ࠋࡍ

 ࢫࢡࢵ࢕ࣇࣛࢢ

FRFࡢ࢖ࣞࣉࢫ࢕ࢹ࣭ࢺ࢛ࣝࣇࢹ改善：以前ࣙࢪ࣮ࣂン࡛0ࠊࡣ振幅値ࡀ検知ࡓࢀࡉ場合ࠊY軸࣮ࣜࢣࢫンࢆࢢ固
定࡚ࢀࡉいࡀࢀࡑࠋࡓࡋࡲ改善࣮ࣜࢣࢫࡢࡑࠊࢀࡉンࡣࢢ中間値ࡣࡓࡲ STD࣮࣋ࢢࣟࠋࡍࡲࡾ࡞࡟ࢫ㸦FRF㸧࢝
ࡢࢺ࢛ࣝࣇࢹ࣭ࣈ࣮ Y軸ୗ限値ࢢࣟࡣ㸦FRF㸧値ࣞࡢンࢪ外消去ᢏ術࡟基࡙いࡓ中間値㸦log(FRF)㸧-10*std
㸦log’(FRF)㸧以ୗࡼࡿ࡞࡟う࡟決定ࠋࡍࡲࢀࡉ 

 ࢢン࢕ࢸ࣮࣏ࣞ

FEMtoolsࡢࢫ࣮࣋ࢱ࣮ࢹ情報ࢆ直接的࡟MSWordࠊPowerpointࠊExcelࡣࡓࡲࠊ ASCIIࢺ࣮࣏ࣞ࡟ࣝ࢖࢓ࣇࢺࢫ࢟ࢸ
 ࠋࡍ必要࡛ࡀOffice2013以ୖࠊࡣ࡚ࡋ࡜動作条件ࡢࡑࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ

次ࡢ機能࣐ࢥࡀンࠋࡍࡲࢀࡉࢺ࣮࣏ࢧ࡚ࡗࡼ࡟ࢻ 

 新ࡋいࣙࢩࢵࢭンࡢ開始：ProgramNameࡀWORDࠊPOWERPOINTࠊEXCELࡢ場合࣐ࢥࠊンࢻ REPORT 
ProgramName LAUNCHࢆ使用ࠋࡍࡲࡋ 

 既Ꮡ࣓ࣗ࢟ࢻンࡢࢺ開ࡃ：ProgramNameࡀWORDࠊPOWERPOINTࠊEXCELࠊTEXTࡢ場合࣐ࢥࠊンࢻ
REPORT ProgramName OPENࢆ使用ࠋࡍࡲࡋ 

 新ࡋい࣓ࣗ࢟ࢻンࢆࢺ作成：ProgramNameࡀWORDࠊPOWERPOINTࠊEXCELࠊTEXTࡢ場合࣐ࢥࠊンࢻ
REPORT ProgramName NEWࢆ使用ࠋࡍࡲࡋ 

 ࣙࢩࢡࢭンࡢࣝࢺ࢖ࢱ࣭ࢻ࢖ࣛࢫࡣࡓࡲ追加：ProgramNameࡀWORDࠊPOWERPOINTࠊEXCELࠊTEXTࡢ場
合࣐ࢥࠊンࢻ REPORT ProgramName TITLEࢆ使用ࠋࡍࡲࡋ 

 ࢺ࣮࣏ࢫࢡ࢚ࡢࣝࣈ࣮ࢸࠊࢡࢵ࢕ࣇࣛࢢ：ProgramNameࡀWORDࠊPOWERPOINTࠊEXCELࠊTEXTࡢ場合ࠊ
ࢻン࣐ࢥ REPORT ProgramName MODELࢆ使用ࠋࡍࡲࡋ 
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 ࣉ࣮࢙ࢩࠊ࡚ࡋ࡜ࣝࣈ࣮ࢸࠊࢡࢵ࢕ࣇࣛࢢ情報㸦例えࣉ࣮࢙ࢩࢻ࣮ࣔࠊࡤ㸧ࢺ࣮࣏ࢫࢡ࢚ࡢ：ProgramName
ࢻン࣐ࢥࠊ場合ࡢTEXTࠊEXCELࠊPOWERPOINTࠊWORDࡀ REPORT ProgramName SHAPEࢆ使用ࠋࡍࡲࡋ 

 新規ࡢࢻ࢖ࣛࢫ追加：࣐ࢥンࢻ REPORT POWERPOINT ADDSLIDEࢆ使用ࠋࡍࡲࡋ 
 ࣌࢔情報㸦ࠊࢻ࣮ࣀDOF࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮ࣔࠊ㸧ࢺ࣮࣏ࢫࢡ࢚ࡢ：ProgramNameࡀWORDࠊ

POWERPOINTࠊEXCELࠊTEXTࡢ場合࣐ࢥࠊンࢻ REPORT ProgramName PAIRࢆ使用ࠋࡍࡲࡋ 
 ࢫࢡࢵࣜࢺ࣐ࠊ࡚ࡋ࡜ࣝࣈ࣮ࢸࠊࢡࢵ࢕ࣇࣛࢢ㸦例えࠊࡤMAC࣐ࢫࢡࢵࣜࢺ㸧ࢺ࣮࣏ࢫࢡ࢚ࡢ：

ProgramNameࡀWORDࠊPOWERPOINTࠊEXCELࠊTEXTࡢ場合࣐ࢥࠊンࢻ REPORT ProgramName MATRIX
 ࠋࡍࡲࡋ使用ࢆ

 ෆ部࢕ࢸࢵࢭン࣐ࢥ：ࢺ࣮࣏ࢫࢡ࢚ࡢࢢンࢻ REPORT TEXT VARIABLEࢆ使用ࠋࡍࡲࡋ 
 ࣓ࣗ࢟ࢻンࡢࢺ保Ꮡ：ProgramNameࡀWORDࠊPOWERPOINTࠊEXCELࡢ場合࣐ࢥࠊンࢻ REPORT 

ProgramName SAVEࢆ使用ࠋࡍࡲࡋ 
 ࣓ࣗ࢟ࢻンࢆࢺ閉ࡿࡌ：ProgramNameࡀWORDࠊPOWERPOINTࠊEXCELࠊTEXTࡢ場合࣐ࢥࠊンࢻ REPORT 

ProgramName CLOSEࢆ使用ࠋࡍࡲࡋ 
 ࣙࢩࢵࢭンࢆ閉ࡿ：ProgramNameࡀWORDࠊPOWERPOINTࠊEXCELࡢ場合࣐ࢥࠊンࢻ REPORT 

ProgramName QUITࢆ使用ࠋࡍࡲࡋ 
 ࣏࣮ࣞ࢕ࢸンࢢ過程࡚ࡗࡼ࡟生成ࢸࡓࢀࡉン࣏ࣛࣜࡢࣝ࢖࢓ࣇ削除：ProgramNameࡀWORDࠊ

POWERPOINTࠊEXCELࡢ場合࣐ࢥࠊンࢻ REPORT ProgramName RMFࢆ使用ࠋࡍࡲࡋ 

参ࢆ㸧ࢫンࣞ࢓ࣇࣜࢻン࣐ࢥFEMtools Command Reference㸦ࠊࡣい࡚ࡘ࡟ヲ細ࡢい࡚ࡘ࡟ࢻン࣐ࢥいࡋ新ࡢࡽࢀࡇ
照ࡉࡔࡃ࡚ࡋい࢕ࢸ࣮࣏ࣞࠋンࡢࢢ例題ࠊࡣ../examples/reporting/updating ࡛࣮ࢲ࢛ࣝࣇ見ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡅࡘ 

 生成ࣗࢩࢵ࣓

Lattice㸦格子㸧࣓࢖࣏ࡢࣗࢩࢵンࢺ間ࣙࢩ࣮ࣞࣜࡢンࢆ追加ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

 ࣮ࣜࣞࣙࢩンࠊࡣDEFINE FMDRELATION࣐ࢥン࡚ࡗࡼ࡟ࢻ追加ࠋࡍࡲࢀࡉ 
 ࣮ࣜࣞࣙࢩンࠊࡣCLEAR FMDRELATION࣐ࢥン࡚ࡗࡼ࡟ࢻ削除ࠋࡍࡲࢀࡉ 
 既Ꮡࣙࢩ࣮ࣞࣜࡢン情報ࠊࡣEXTRACT FMDRELATION࣐ࢥン࡚ࡗࡼ࡟ࢻ確認࡛ࠋࡍࡲࡁ 

 ࢱ࢕ࢹ࢚࣭ࣝࢹ࣭ࣔࢺࢫࢸ

開ࡽ࠿Database > Test Model Editorࠊࡣࢀࡇࠋࡓࡋࡲࢀࡉ追加ࡀࣝࢿࣃ࣭ࢱ࢕ࢹい࢚ࡋ新ࡢࡵࡓࡢࣝࢹ࣭ࣔࢺࢫࢸ
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡃ

 

 ࣝࢿࣃ࣭ࢱ࢕ࢹ࢚࣭ࣝࢹ࣭ࣔࢺࢫࢸ
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ࡲࢀࡉ構成࡛ࡘ㸰ࡢ㸦右㸧࢔࢚࣭ࣜ࢖ࣞࣉࢫ࢕ࢹ࣭ࢫࢡࢵ࢕ࣇࣛࢢ࡜㸦ᕥ㸧ࣝࣈ࣮ࢸࡓࢀࡽࡅࡘࡀࣈࢱࠊࡣࣝࢿࣃ

 ࠋࡍࡲい࡚ࢀࡉ意ᅗ࡟うࡼࡿࡍ編集ࢆ⥆び接ࡼ࠾ᗙ標系ࠊᗙ標ࢺン࢖࣏ࠊࡣࢀࡑࠋࡍ

ࡉࢫࢭࢡ࢔ࡽ࠿㸧ࢡࢵࣜࢡෆ࡛右ࣝࣈ࣮ࢸ㸦࣮ࣗࢽ࣓࣭ࣉࢵ࢔ࣉࢵ࣏ࡣンࣙࢩ࣮ࣞ࣌࢜ࡢ࡚࡭ࡍびࡼ࠾ࣈࢱࡢࡘ4
 ࠋࡍࡲࡋ記述࡟以ୗࠊい࡚ࡘ࡟ࣈࢱ各ࠋࡍࡲࡋ依Ꮡ࡟ࣈࢱࡓࢀࡉ選択ࡣ࣮ࣗࢽ࣓ࡢࡑࠋࡍࡲࢀ

Measurement Points㸦測定࣏࢖ンࢺ㸧 

新ࡋい測定࣏࢖ン࡟ࣝࣈ࣮ࢸࡀࢺ入力ࠋࡍࡲࢀࡉAppend new pointࢆ使用ࠊࡋ新ࡋい࣏࢖ンࢆࢺ追加ࡲࠋࡍࡲࡋ
ࡲࡋ使用ࢆCreate new point(s)ࠊࡣ࡟ࡿࡍ生成ࢆࢺン࢖い࣏ࡋ新ࡢ用ࢫ࢖࢙ࣇ࣮ࢧ࣭ࢺ࣮ࣞࣉࡣいࡿンあ࢖ࣛࠊࡓ
 ࠋࡍ

ࢽSelect࣓ࠊ࠿ࡿࡍ選択ࢆࢺン࢖࣏ࠊࡾࡼ࡟࡜ࡇࡿࡍࢡࢵࣜࢡࢆ࣮࣮࣐࣭࢝ࢺン࢖࣏ࡢࢺࢵࣟࣉ࣭ࢫࢡࢵ࢕ࣇࣛࢢ
 ࠋࡍ能࡛ྍࡶ࡜ࡇࡿࡍ使用ࢆࢻン࣐ࢥ࣭࣮ࣗ

既Ꮡࡢᗙ標系定義ࠊࡣ選択ࡋࢡࢵࣜࢡࢆࣝࢭ編集ࡢ࡚࡭ࡍࠊ࠿ࡿࡍ選択࡞ࣝࣂ࣮ࣟࢢ࡟ࣝࢭ変更ࢆ加え࡜ࡇࡿ

ࡢࣝࢭࡓࢀࡉ選択ࠊ選択後ࣝࢭࠊࡣ࡚ࡋ࡜編集操作ࠋࡍࡲࡁ࡛ࡀ ࣭࣎ࢻCtrl࣮࣮࢟࣎ࠊࡋࢡࢵࣜࢡࣝࣈࢲࢆࡘ1
ࡋ示ࢆ値ࡌྠࡣࣝࢭࡢ࡚࡭ࡍࡓࢀࡉ選択ࠋࡍࡲࡋࢡࢵࣜࢡࢆンࢱン࣭࣮࣎ࢱ࡚ࣜࡋ編集ࢆෆ容ࠊࡋ保持ࢆンࢱ

 Editࠊࡣࡓࡲࠋࡍࡲࡾࡲࡣ当࡚࡟ࣝࣈ࣮ࢸࡢ࡚࡭ࡍࡢࢱ࢕ࢹ࢚࣭ࣝࢹ࣭ࣔࢺࢫࢸࠊࡣ舞いࡿ振ࡢࡇࠋࡍࡲ
Selected Points࣓࣐ࢥ࣭࣮ࣗࢽンࢆࢻ使用ࡉࡔࡃ࡚ࡋいࠋ 

 Number points, Delete Selection, Sort all points, Renumber all points and Recordࠊࡣ࡚ࡋ࡜ンࣙࢩ࣮ࣞ࣌࢜ࡢ௚ࡢࡑ
point selection in setࠋࡍࡲࢀࡉࢺ࣮࣏ࢧࡀ࡝࡞  

 

Measurement Pointsࡢࣈࢱ右࣮ࣗࢽ࣓࣭ࢡࢵࣜࢡ 
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Add Pointsࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ 

Coordinate Systems㸦ᗙ標系㸧ࣈࢱ 

新ࡋいᗙ標系定義࡟ࣝࣈ࣮ࢸࢆ入力ࠊࡣ࡟ࡿࡍAppend new itemࢆ使用ࠊࡣࡓࡲࠋࡍࡲࡋ各࣏࢖ン࡟ࢺ対応ࡿࡍ
Generate a unique CSࠊ࠿Define CS referenced by pointsࢆ使用ࠋࡍࡲࡋ 

既Ꮡࡢᗙ標系ࡢ定義ࡣ各ࣝࢭ中ࡾࡼ࡟࡜ࡇࡿࡍࢡࢵࣜࢡࢆ編集ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ補語࢕ࢸࣃࣟࣉࡢ㸦System, 
Position & DirectionsࠊRotation groups㸧ࡶ編集ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

CSࡀ定義࢖࣏ࡓࢀࡉンࡢࢺ矢印࣐࣮࣮࢝ࢆ見ࣝࣈ࣮ࢸࠊࡣ࡟ࡿ中ࡢ CS行ࢺ࢖ࣛ࢖ࣁࢆ化࢖࣏ࠊࡋンࢵࣜࢡࢆࢺ
ࡀ࣮࣮࣐࢝ࡢࡑࠊ場合ࡿい࡚ࢀࡉ定義ࡀCSࠋࡍ能࡛ྍ࡚ࡗࡼ࡟࡜ࡇࡿࡍࢡ CS IDࢆ共᭷࢖࣏ࡢ࡚࡭ࡍࡿࡍン࡟ࢺ
現わࠋࡍࡲࢀ 

Sort all item(s)ࡼ࠾び Renumber all item(s) respectivelyࢆ使用ࠊࡋ行ࠊࡋࢺ࣮ࢯࡣ再番号付ࡲࡁ࡛ࡀ࡜ࡇࡿࡍࡅ
 ࠋࡍ

 

Coordinate Systemࡢࣈࢱ右࣮ࣗࢽ࣓࣭ࢡࢵࣜࢡ 
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Connectivities㸦結線㸧ࣈࢱ 

新ࡋい結線ࡢ定義方法ࢻ࣮࣎ࣉࢵࣜࢡࠊࡣ࡚ࡋ࡜㸦例えࠊࡤMS Excel࡛ࡢ定義㸧ࡿ㈞ࡽ࠿付࡟ࣝࣈ࣮ࢸࠊࡾࡓࡅ
入力ࠊࡣ࡟ࢀࡑࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍPaste from clipboard ࡜ Insert after Selectionࢆ使用ࠋࡍࡲࡋ 

既Ꮡࡢ結線ࡢ編集方法ࠊ࠿ࡿࡍࢡࢵࣜࢡࢆࣝࢭࠊࡣ࡚ࡋ࡜あࡿいࡣ Number connectivitiesࠊSort all connectivitiesࠊ 
Renumber all item(s)ࢆ࡝࡞使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

行番号㸦第ࡢࣝࣈ࣮ࢸ 1࣒࢝ࣛ㸧ࢡࢵࣜࢡࢆ選択ࢆࢡࢵࣜࢡࡢࡑࠊࡋ維持ࠊࡲࡲࡓࡋCtrl࡜ Shiftࢱ࣮࣎࢟ࡢンࢆ
一緒ࠊ࠿ࡿࡍࢡࢵࣜࢡ࡟あࡿい࢕࣭࢘ࢫࢡࢵ࢕ࣇࣛࢢࡣン࢘ࢻෆ࢖ࡢンࣈ࢕ࢸࢡࣛࢱ選択ࠊ࡚ࡗࡼ࡟複数ࡢ結線ࢆ

選択ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

結線࣓ンࢆࣉ࣮ࣝࢢ࣭࣮ࣂ設定ࣉ࣮ࣝࢢࠊࡣ࡟ࡿࡍ IDࢆ編集ࡢࡑࠊ࠿ࡿࡍ結線ࢆ選択ࠊࡋAssign groupࢆ使用ࡋ
選択ࢆ結線ࡿࡍ࡟࣮ࣂン࣓ࠊࡋ選択ࢆࣉ࣮ࣝࢢ࣭ࢺࢵࢤ࣮ࢱࡽ࠿ࢫࢡࢵ࣎ࢺࢫGroup Selectionࣜࠊࡓࡲࠋࡍࡲ
 ࠋࡍࡲࡁ࡛ࡶ࡜ࡇࡿࡍ設定ࠊࡋࢡࢵࣜࢡࢆRecordࠊࡋ

 ࠋࡍࡲࡁ࡛ࡶ࡜ࡇࡿࡍ使用ࢆRecord connectivity selection in a setࠊ࡟ࡽࡉ

 

結線ࡢࣈࢱ右࣮ࣗࢽ࣓࣭ࢡࢵࣜࢡ 

Connectivity Groups㸦結線ࣉ࣮ࣝࢢ㸧ࣈࢱ 

ࡢࣉ࣮ࣝࢢ結線ࠊࡣ࡛ࣝࣈ࣮ࢸࡢࡇ IDࡀ࡝࡞ࣝ࣋ࣛࠊ―࣮ࣛ࢝ࠊ編集࡛ࠋࡍࡲࡁIDࠊࡣConnectivitiesࣈࢱ中࡛使
用ࣉ࣮ࣝࢢࡿࢀࡉ ID࡟相当ࠊࡣࣉ࣮ࣝࢢࠋࡍࡲࡋAppend New Item࣓࣐ࢥ࣭࣮ࣗࢽン࡛ࢻ追加ࡲࡁ࡛ࡀ࡜ࡇࡿࡍ
ࠊࡣ࡟ࡿࡍ選択ࢆ結線ࠋࡍࡲࢀࡽ当࡚ࡾ割࡟ࣉ࣮ࣝࢢࡓࢀࡉ追加ࡃࡋ新ࡀ―࣮ࣛ࢝ࡢࢺ࢛ࣝࣇࢹࠋࡍ
Connectivitiesࢆࣈࢱ使用࣓ࡢࣉ࣮ࣝࢢࡢࡑࠊࡋンࢆ࣮ࣂ作成ࠋࡍࡲࡋ 

    



      FEMtools 4 Release Notes - 31  

 

結線ࡢࣈࢱ࣭ࣉ࣮ࣝࢢ右࣮ࣗࢽ࣓࣭ࢡࢵࣜࢡ 

 信号処理㸦DSP㸧ࣝࢱࢪࢹ

DSP機能ࠊࡣ以ୗࡼࡢう更新ࠋࡓࡋࡲࢀࡉ 

 ࡣ࡟ࢺࢵࣟࣉ FIT補完関数ࡀ使用ࠋࡍࡲࢀࡉ信号ࡀ DC成ศࢆ持ࡘ場合ࡢࡑࠊ信号ࡣ適ษࡲࢀࡉࢺࢵࣟࣉ࡟
 ࠋࡍ

 DSP CURVE࣐ࢥン࡛ࢻ生成࡛࣮࣮ࣛࣟࣉࢫࢡ࢚࣭ࢫ࣮࣋ࢱ࣮ࢹࠊࡣࣈ࣮࢝ࡓࢀࡉ生成ྠ࡜ࣈ࣮࢝ࡓࡋ一࢖ࢱ
 ࠋࡍࡲࡾ࡞࡟ࣝࢺ

 ࣐ࢥンࢻ DSP RESAMPLE࡜ DSP UPSAMPLEࡀ追加ࠋࡍࡲࢀࡉ 

FEMtoolsソ࣮ࣝࣂ 

 ࣮ࣔࢻ解析࢔ࢥ࣭ࣈ࣭࢜ࢺ࢘࢔ࡢ࣮ࣂࣝࢯ㸦out-of-core㸧ࢺ࣮࣏ࢧࡢ 

あࡀ制限࡟RAM容量ࠊࡵࡓࡢࡑࠋࡍ࡛࣮ࣂࣝࢯ㸦in-core㸧࢔ࢥン࣭࢖ࡣ࣮ࣂࣝࢯFEMtoolsࠊࡣ࡛ࢺ࢛ࣝࣇࢹ
解析㸦Lanczosࢻ࣮ࣔࠊࡤ例えࠋࡓࡋࡲࡾあࡀ場合ࡿࡌ生ࡀ࣮࢚ࣛࡿࡍ関࡟容量࣓ࣜࣔࠊࡣ࡛ࢱ࣮ࣗࣆンࢥࡿ
 ࠋࡓࡋࡲࡌ生ࡀ࣮࢚ࣛ࡞典型的࡞うࡼࡢ次ࠊい࡚࠾࡟㸧࣮ࣂࣝࢯ

ERROR : Numerical factorization failed [-2] : Not enough memory 
ERROR : SOLVER failed : No result file. 

ࢫ࢕ࢹ࡟ࡵࡓࡿࡍࣉンࢲࢆ記憶ෆ容࡟部ศ的ࠊࡣ࣮ࣂࣝࢯ࣭࢔ࢥ࣭ࣈ࣭࢜ࢺ࢘࢔ࠊ࡟ࡵࡓࡿࡍ克服ࢆ制限ࡢࡇ

依Ꮡ࡟性能ࡢࢫࢭࢡ࢔࣭ࢡࢫ࢕ࢹࠊࡣ解析速ᗘࡢࢬ࢖ࢧࣝࢹ大規模ࣔࠊ場合ࡢࡑࠋࡍࡲࡋ使用ࢆࢫ࣮࣌ࢫ࣭ࢡ

ࢡࢫ࢕ࢹࡢࡃ多ࠊࡣ࡟場合ࡿࡍ使用ࡢࢻ࣮࣮ࣔࣂࣝࢯ࣭࢔ࢥ࣭ࣈ࣭࢜ࢺ࢘࢔ࠊࡵࡓࡢࡑࠋࡍࡲࡋ I/O࡟応えࡿ
 ࠋࡍࡲࢀࡉ推奨ࡀ࡜ࡇࡿࡍ使用ࡢࢡࢫ࢕ࢹ࡞高速ࡾࡼࠊ࡟ࡵࡓ

ṇ規࣮ࣔࢻ解析㸦Lanczos࣮ࣂࣝࢯ㸧࠾࡟い࡚ࠊ㸰ࡢࡘ新ࡋいࡀࢻ࣮࣭ࣔ࢔ࢥ࣭ࣈ࣭࢜ࢺ࢘࢔追加ࡋࡲࢀࡉ
 ࠋࡓ

 選択的࢔ࢥ࣭ࣈ࣭࢜ࢺ࢘࢔解析㸦必要ࡿࢀࡉ࡜超過࣓ࣔࣜࡢ動的割ࡾ当࡚㸧 
 ࢔ࢥ࣭ࣈ࣭࢜ࢺ࢘࢔解析࣮ࣔ࡟ࢻ固定 

ࢻン࣐ࢥࡣࢻ࣮࣭ࣔ࢔ࢥ࣭ࣈ࣭࢜ࢺ࢘࢔ SET DYNAMICあࡿいࡣ DYNAMIC࡛選択ࠋࡍࡲࢀࡉ 
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SET DYNAMIC ... COREMODE int_val .... CORESIZE int_val ...  
DYNAMIC ... COREMODE int_val .... CORESIZE int_val ...  
COREMODE = 1 ：選択的࢔ࢥ࣭ࣈ࣭࢜ࢺ࢘࢔解析 
COREMODE=2： ࢔ࢥ࣭ࣈ࣭࢜ࢺ࢘࢔解析࣮ࣔ࡟ࢻ固定 

選択的ࡣ࢔ࢥ࣭ࣈ࣭࢜ࢺ࢘࢔ CORESIZEࢆ使用ࢫࢡࢵࣜࢺ࣐ࠋࡍࡲࡋ係数ࡢ格納࡟必要࡞総࣓ࣔࣜ㸦࣓࢞ࣂ
ࡓࢀࡉ指定ࠊࡀ単఩㸧ࢺ࢖ CORESIZE値未‶࡛あࡿ場合࢖ࡣン࣭ࡀ࣮ࣂࣝࢯ࣭࢔ࢥ使用ࠋࡍࡲࢀࡉ 

 ࢫࢡࢵࣜࢺ࣐࣭࣒ࢸࢫࢩ縮ᑠ機能ࡢ改善 

 ࢡࢵ࣑ࢼ࢖ࢲ解析ࢡࢵ࣑ࢼ࢖ࢲࠊ IRS解析ࡢ縮ᑠ機能ࡀ適ษ࡟処理ࡓࡗ࠿࡞ࢀࡉ問題ࡀ改善ࡋࡲࢀࡉ
 ࠋࡓ

 GUI࢖ン࢙ࣇ࣮ࢱｲࡢࢫ一㈏性࡟࡝࡞関ࡿࡍ問題ࡀ改善ࠋࡓࡋࡲࢀࡉ 
 標準 IRS࡜཯復 IRSࣙࢩࣉ࢜ࡢンࡢ組ࡳ合わྍࡀࡏ能ࠋࡓࡋࡲࡾ࡞࡟標準ࡢ཯復 IRSࡢ縮ᑠࢆ行࡞うࡓ

 ࠋࡍࡲࡋ使用ࢆNumber of Iterations = 1ࠊࡣ࡟ࡵ

 ࢫࢡ࣑ࢼ࢖ࢲ

 ࣐࣮ࢱࢫDOF選択࡟利用࡛ࡿࡁ K/M比ࢆ計算ࡿࡍ新ࡋい࣐ࢥンࢻ 

 要素解析࣮ࣃ࣮ࢫ

 CONDENSE࣐ࢥンࢥࡢࢻンࡀࢡࢵࣂࢻ࣮࢕ࣇ࣭࣮ࣝࢯ改善ࠋࡓࡋࡲࢀࡉ 

 㸦MBA:Modal-Based Assembly㸧ࣜࣈンࢭ࢔࣭ࢫ࣮࡭࣭ࣝࢲ࣮ࣔ

 ࣮ࣔࢭ࢔࣭ࢫ࣮࡭࣭ࣝࢲンࢥࠊࡣࣜࣈン࣏࣮ࢿンࢺ間ࡢ剛結合ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆ剛結合ࠊࡣRigid 
Connections as Coupling Method in the Modal Based Assembly Settings࢕࣭࢘ࢢࣟ࢔࢖ࢲン࢘ࢻ㸦࣓࢖ン࣭࣓ࢽ
ࠊࡋ使用ࢆࢻン࣐ࢥSET MBA COUPLING RIGIDࠊࡣいࡿTools > Modal Based Assembly > Settings㸧あࡢ࣮ࣗ
ࣉࣜࢡࢫࢆ使用方法ࡢࢢンࣜࣉࢵ剛結合࢝ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ࡟ࣈ࢕ࢸࢡ࢔

 FEMtools Dynamicsࠊࡣ例題ࡢࡑࠋࡍࡲࡋexamples/dynamic/mba/fea_substructure/ mba_fea_rigid.cmd࡛例証/..ࢺ
User’s Guide㸦ࢻ࢖࣮࢞ࢨ࣮࣭ࣘࢫࢡ࣑ࢼ࢖ࢲ㸧࡛解ㄝࠋࡍࡲࢀࡉ 

 解析と相関分析ࢺࢫࢸࣜࣉ

 解析ࢺࢫࢸࣜࣉ

 ࣮ࣝࢶ選択࣮ࢧンࢭ

 EIM࣮࣋ࢭࡢࢫン࣮ࢧ選択ࡀ改善ࠋࡓࡋࡲࡲࢀࡉ 

 Ᏻ定化手⥆ࡁ㸦stability procedure㸧ࢭࠊࡣン࣮ࢧ数ࡢࢻ࣮ࣔࡀ数ࡾࡼ少࡞い場合࡟ࡵࡓࡢ改善ࡋࡲࢀࡉ
 ࠋࡓ

 ࢭン࣮ࢧ数ࡀ  ࠋࡍࡲࡋ出力ࢆࢪ࣮ࢭࢵ࣓࣮࢚ࣛࠊ場合ࡢ0

 SEAMAC࣮࣋ࢭࡢࢫン࣮ࢧ選択ࡀ改善ࠋࡓࡋࡲࢀࡉ 

 SEAMAC࣮࣋ࢭࡢࢫン࣮ࢧ選択1ࠊࡣ軸ࢭンࡣࡓࡲࡳࡢ࣮ࢧṇ規表面ࢭࡢン࡛࣮ࢧ適応ࠋࡍࡲࢀࡉ 

 IGR࣮࣋ࢭࡢࢫン࣮ࢧ選択ࡀ改善ࠋࡓࡋࡲࢀࡉ 

 IGR手⥆ࢭࠊࡣࡁン࣮ࢧ数ࡀ  ࠋࡍࡲࡋ出力ࢆࢪ࣮ࢭࢵ場合࢚࣮࣓ࣛࡢ0
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 NMD࣮࣋ࢭࡢࢫン࣮ࢧ選択ࡀ改善ࠋࡓࡋࡲࢀࡉ 

 NMD࣮࣋ࢭࡢࢫン࣮ࢧ選択ࡣṇ規表面ࢭࡢン࠾࡟࣮ࢧい࡚適応ࠋࡍࡲࢀࡉ 
 CLEAR NMD࣐ࢥンࡀࢻ改善ࠋࡓࡋࡲࢀࡉ 

 NKE࣮࣋ࢭࡢࢫン࣮ࢧ選択ࡀ改善ࠋࡓࡋࡲࢀࡉ 

 ṇ規表面ࡢ NKEࡢ計算࠾࡟ࣝࢹ࣭࢙ࣔࣝࢩࡀい࡚ࠋࡍࡲࢀࡉࢺ࣮࣏ࢧ 
 CLEAR NKE࣐ࢥンࡀࢻ改善ࠋࡓࡋࡲࢀࡉ 

手動ࡼ࠾び自動ࢭࡢン࣮ࢧ選択 

次ࡢ修ṇࠊࡀManual Sensor Selection ࣝࢿࣃ 㸦Tools > Pretest Analysis > Manual Sensor Selection㸧࡟行わࡋࡲࢀ
 ࠋࡓ

 Show Sensor Node Numbering࢜ࣙࢩࣉンࡀPlot Settings࡟追加ࡣࢀࡇࠋࡓࡋࡲࢀࡉ選択ࢭࡓࢀࡉン࣮ࢧ఩置ࡢ
 ࠋࡍࡲࡋ࡟能ྍࢆ࡜ࡇࡿࡍ識別࡟迅速ࢆ番号ࢻ࣮ࣀ

次ࡢ修ṇࡼ࠾びᣑ張ࠊࡀAutomated Sensor Selection ࣝࢿࣃ㸦Tools > Pretest Analysis > Automated Sensor 
Selection㸧࡟行わࠋࡓࡋࡲࢀ 

 maximum’ metric࢜ࣙࢩࣉンࡀ削除ࣙࢩࣉ࢜ࡢࡇࠋࡓࡋࡲࢀࡉンࠊࡣ単࡟支持࣌ࢫࢧࡣࡓࡲンࣙࢩンࡢ఩置選
択࡟利用࡛ࠋࡓࡋࡲࡁ 

 Candidate Sensor Location㸦候補ࢭン࣮ࢧ఩置㸧ࡢPreview࣎ ࡋࡲࢀࡽ替え࡟ンࢱShow Candidates࣎ࠊࡣンࢱ
ࡢ最ᑠ距㞳࡜選択ࢻ࣮ࣀࠊ場合㸧࡞㸦適用ྍ能ࢡࢵࣜࢺ࣭ࢺࢫࢸࣜࣉࠊᢏ術ࢺࢫࢸࣜࣉࡓࡋ選択ࠊࡣࢀࡇࠋࡓ

指定࡟基࡙ࡃ選択候補఩置数ࢆ確認ྍࡀ࡜ࡇࡿࡍ能ࠋࡓࡋࡲࡾ࡞࡟ 
 Show Sensor Node Numbering࢜ࣙࢩࣉンࠊࡀPlot Settingsࣙࢩࢡࢭン࡟追加ࡣࢀࡇࠋࡓࡋࡲࢀࡉ選択ࢭࡓࢀࡉ

ン࣮ࢧ఩置ࢻ࣮ࣀࡢ番号ࢆ迅速࡟識別ྍࢆ࡜ࡇࡿࡍ能ࠋࡍࡲࡋ࡟ 

 刺激解析㸦MPA:Mode Participation Analysis㸧ࢻ࣮ࣔ

 ่࣮ࣔࢻ激解析㸦MPA㸧ࡀ改善ࠋࡓࡋࡲࢀࡉ 
 多ࡢࡃ入力 DOFࢆ考慮ࡿࡍ場合࣓ࣜࣔࠊ容量࡜ CPU時間ࡢ縮ᑠྍࢆ能ࠊࡵࡓࡿࡍ࡟MPA࢖ࡢン࣓ࣜࣉンࢸ

 ࠋࡓࡋࡲࢀࡉ改善ࡀンࣙࢩ࣮
 EXAMINE MPA࣐ࢥンࢥࡢࢻン࣮ࣝࢯ出力ࡀ改善ࠋࡓࡋࡲࢀࡉMPAࡢࡘ5ࠊࡣࢱ࣮ࢹ入力 DOFࢡࢵࣟࣈࡢ中

࡛示ࠊࡣࢀࡇࠋࡍࡲࢀࡉ多ࡢࡃ入力 DOFࢆ考慮ࡿࡍ場合ࢱ࣮ࢹࡢ検査ࢆ容易ࠋࡍࡲࡋ࡟ 
 ่࣮ࣔࢻ激解析ࡢࢻ࣮ࣔࠊࡣ特定࡟ࢺࢵࢭ対࡚ࡋ実行ࠊࡣࢀࡇࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍMode Participation 

Analysisࡢࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲCandidate Modes࢘ࢲࣉࢵࣟࢻンࣜࢆࢺࢫ使用ࠊ࠿ࡿࡍEXAMINE MPA࣐ࢥン
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇ行う࡚ࡋ使用ࢆいMODE補語ࡋ新ࡢࢻ

 MPA結果࡟基࡙いࡓ自動ࢺࢵࢭ生成࢖࣭࣮ࢨ࣮ࣘࡀンࠊࡣ࡟ࢀࡑࠋࡍࡲࢀࡉࢺ࣮࣏ࢧ࡛ࢫ࢖࢙ࣇ࣮ࢱCreate 
Target Mode Select Setsࢺࢵࢭࠊࡋࢡࢵ࢙ࢳࢆࢫࢡࢵ࣎ࢡࢵ࢙ࢳ生成基準ࢆ選択ࠋࡍࡲࡋ 

 ࡢ࡚࡭ࡍࡣࢀࡑ並進DOFࢆ使用࡚ࡗࡼ࡟ࢺࢵࣟࣉ࣭ࣗࢩࢵ࣓ࠊࡓࡲࠊࡋ結果ࢆ確認ࠊࡋMPAࢆ実行࡜ࡇࡿࡍ
 Tools > Pretest Analysis > Mode Participationࡽ࠿࣮ࣗࢽン࣭࣓࢖࣓ࠊࡣࣉࢵ激่࣐ࢻ࣮ࣔࡢࡑࠋࡍࡲࡁ࡛ࡀ
Map (MPM) ࢆ選択ࠊ࠿ࡿࡍEXAMINE MPM࣐ࢥンࢆࢻ使用࡚ࡗࡼ࡟࡜ࡇࡿࡍ計算่ࢻ࣮ࣔࠋࡍࡲࢀࡉ激࣐ࢵ
ࢻン࣐ࢥEXTRACT MPMࡣMPM結果ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ使用࡟ࡵࡓࡿࡍ識別ࢆ加振఩置ࣝࣕࢩンࢸ࣏ࡣࣉ
消去࡚ࡋ使用ࢆࢻン࣐ࢥCLEAR MPMࠊࡓࡲࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ出力࡟࢘ࢻン࢕࣭࣮࢘ࣝࢯンࢥ࡚ࡋ使用ࢆ
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ

 新ࡋい EXAMINE SPAMPA࣐ࢥンࠊࡣࢻ最適ࡢ加振఩置ࢆ識別่ࢻ࣮ࣔ࡟ࡵࡓࡿࡍ激࣐ࢆࣉࢵ使用ࠋࡍࡲࡋ 

Excitation Location Selection㸦加振位置選択㸧ࡢ新ࡋい࣮ࣝࢶ 

Excitation Location Selectionࣝࢿࣃ㸦Tools > Pretest Analysis > Excitation Location Selection㸧ࡀ追加ࠋࡓࡋࡲࢀࡉ
 ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆ機能ࡢ次ࡣࣝࢿࣃࡢࡇ
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 NMDࠊNKEࠊMPA࣐࡟ࣉࢵ基࡙いࡓ最適加振఩置ࢆ識別ࠋࡍࡲࡋ 
 手動࡛既Ꮡࡢ加振఩置選択ࢆ微調整ࠊ࠿ࡿࡍ手動࡛ FE࣓࢟ࢵࣆࡢୖࢺࢵࣟࣉ࣭ࣗࢩࢵンࢢ DOF操作࡚ࡗࡼ࡟

加振఩置選択ࢆ作成ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 
 ่࣮ࣔࢻ激解析㸦MPA㸧ࢆ使用ࠊࡋ現ᅾࡢ加振఩置選択ࢆ評価ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

最適ࢺ࣮࣏ࢧ選択用ࡢ新ࡋい࣮ࣝࢶ 

 最適ࢺ࣮࣏ࢧ఩置選択࣐ࢆࣉࢵ供給ࡿࡍ NMD࡜ NKEࢆࢱ࣮ࢹࡢ処理ࡿࡍ新ࡋいࡀ࣮ࣝࢶ追加ࠋࡓࡋࡲࢀࡉ
Tools > Pretest Analysis > Support Location Selectionࠊࡽ࠿࣮ࣗࢽン࣭࣓࢖࣓ࠊࡣ࡟ࡿࡍ生成ࢆࣉࢵ࣐ࡢࡽࢀࡇ
ࡣいࡿあࠊ࠿ࡿࡍ選択ࢆ EXAMINE SUPPORT࣐ࢥンࢆࢻ使用ࠋࡍࡲࡋ 

相関分析 

 EXAMINE MPF࣐ࢥンࡀࢻ改善ࠋࡓࡋࡲࢀࡉ 

 FILE補語ࡣ削除ࡢࡇࠋࡓࡋࡲࢀࡉ補語ࡣ௚࣐ࢥࡢンࢩࡢࢻン࡜ࢫࢡࢵࢱ一致࡚ࡋいࠋࡓࡋ࡛ࢇࡏࡲ結果
 ࠋいࡉࡔࡃ࡚ࡋ使用࡟ࡾ代わࢆࢻン࣐ࢥEXPORT MATRIXࠊࡣ࡟ࡿࡍࢺ࣮࣏ࢫࢡ࢚ࢆ

 FRFࡢᏑᅾࢆ確認ࡣࢡࢵ࢙ࢳࡿࡍ加えࠋࡓࡋࡲࢀࡽ 
 ࢥンࡀࢡࢵࣂࢻ࣮࢕ࣇ࣭࣮ࣝࢯ改善ࠋࡓࡋࡲࢀࡉ 

 EXAMINE NSE࣐ࢥンࡀࢻ改善ࠋࡓࡋࡲࢀࡉ 

 ྡࢺࢵࣟࣉ前ࡀ修ṇࠊࢀࡉNodal Strain EnergyࡀFEA Normal Modes࡚ࡗྲྀ࡟代わࠋࡓࡋࡲࡾ 
 ࢥンࡣࢡࢵࣂࢻ࣮࢕ࣇ࣭࣮ࣝࢯ改善ࠋࡓࡋࡲࢀࡉ 

 EXTRACT NKE࣐ࢥンࡀࢻ修ṇࠋࡓࡋࡲࢀࡉ 

 FEMtools࣐ࢥンࢻ言語࡜一致࡚ࡋいࡢࡑࠊࡵࡓࡓࡗ࠿࡞ UPPER࡜ LOWERࡢ補語ࡣ削除ࠋࡓࡋࡲࢀࡉ 

 EXTRACT NMD࣐ࢥンࡀࢻ修ṇࠋࡓࡋࡲࢀࡉ 

 FEMtools࣐ࢥンࢻ言語࡜一致࡚ࡋいࡢࡑࠊࡵࡓࡓࡗ࠿࡞ UPPER࡜ LOWERࡢ補語ࡣ削除ࠋࡓࡋࡲࢀࡉ 

 ࢟ࢵࣆ࣭ࢡࢵ࢕ࣇࣛࢢン࢖࣏/ࢻ࣮ࣀࡿࡼ࡟ࢢン࢔࣭࣌ࢺ定義ࠊࡀNode-Point Pair࡟追加ࡣࢀࡇࠋࡓࡋࡲࢀࡉ
࢔࣭࣌ࢺン࢖࣏/ࢻ࣮ࣀࠋ࡚ࡋ௓ࢆࢢン࢟ࢵࣆ࣭ࢡࢵ࢕ࣇࣛࢢࠋࢇࡏࡲࡁや利用࡛ࡣࡶࡣ࡛࣮ࣗࢽࢢン࢟ࢵࣆ
開ࢆ㸦Tools > Correlation Analysis > Node-Point Pairs㸧ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲNode-Point Pairࠊࡣ࡟ࡿࡍ作成ࢆ
ン࢟ࢵࣆࡣࢀࡇࠋࡍࡲࡋࢡࢵࣜࢡࢆンࢱOK࣎ࠊࡋ選択ࢆンࣙࢩࣉGraphical Picking of Node-Point Pairs࢜ࠊࡁ
ࣀ࡟最初ࠊࡣ࡟ࡿࡍ作成ࢆ࢔࣭࣌ࢺン࢖࣏/ࢻ࣮ࣀいࡋ新ࠋࡍࡲࡁ開ࢆࢺࢵࣟࣉNode/Point Pair࡛ࢻ࣮࣭ࣔࢢ
ࣟࣉ࣭࢔࣭࣌ࢺン࢖࣏/ࢻ࣮ࣀ࡟単ࠊࡣ࡟ࡿࡍ中断ࢆࢢン࢟ࢵࣆࠋࡍࡲࡋ選択ࢆࢺン࢖࣏࡟次ࠊࡋ選択ࢆࢻ࣮
 ࠋいࡉࡔࡃ࡚ࡌ閉ࢆࢺࢵ

 Auto-EVOࡢ計算࣐ࢥࠊࡣンࢻEXAMINE EVOࢆ使用ࠊ࠿ࡿࡍあࡿいࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲࡣ㸦Database > 
Verify > Auto-EVO…㸧ࡽ࠿実行࣮ࢱࢫ࣐ࠋࡍࡲࢀࡉDOFࠊࡣ࡚ࡋ࡜縮ᑠࡓࢀࡉFEA-to-FEA㸦非࣌࢔DOF㸧ࡀ
必要ࠊࡓࡲࠋࡍࡲࡾ࡞࡟Normalize࣎  Use Normalizedࡢ㸦=NORMALIZE ON㸧ࢺ࢛ࣝࣇࢹࠊࢀࡉ削除ࡣンࢱ
Mode Shapesࡀ使用ࠋࡍࡲࢀࡉ 

 手動࡛ࣜ࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮ࣔࡢン࢖ࠊࡣࢢン࡛࢔࣮ࣗࣅ࣭࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮࣭ࣔࣈ࢕ࢸࢡࣛࢱ定義ࡇࡿࡍ

 ࠋࡍࡲࡋ使用ࢆTools > Correlation Analysis > Mode Shape Pair Viewerࠊࡣ࡟ࢀࡑࠋࡍࡲࡁ࡛ࡀ࡜
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 ࢢン࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔ

感ᗘ解析とࣔ࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹンࢢ 

 新ࡋいࢱ࣮࣓ࣛࣃ D㸦材料ࡢ弾性࣐ࢫࢡࢵࣜࢺ係数ࣜࣉࢫ࡜ン࣮ࣝࢣࢫ࣭ࢢ係数㸧：࣮ࣅࠊࡣࢱ࣮࣓ࣛࣃࡢࡇ
次ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡍ表わࢆ࢕ࢸࣃࣟࣉࡢࢻࢵࣜࢯ࡜࢙ࣝࢩびࡼ࠾㸧ࡴ含ࢆࢫࢢン࣭ࣞࣟࢮ㸦ࢢンࣜࣉࢫ࡜࣒

 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆン例ࣙࢩ࣮ࣞࢺࢫンࣔࢹࡢ
\examples\updating\plate_modal\run06d.cmd  

 新ࡋいࢱ࣮࣓ࣛࣃ KT࡜ KRࣜࣉࢫࠊࡣンࢢ並進剛性ࡼ࠾࡜びࣜࣉࢫンࢢ回転剛性࣮ࣝࢣࢫࡢ係数ࢆ表ࡲࡋ
 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆン例ࣙࢩ࣮ࣞࢺࢫンࣔࢹࡢ次ࠋࡍ
\examples\updating\plate_modal\run06ktr.cmd  

Design of Experiments㸦実験計画法㸧 

 ࣝ࢖࢓ࣇࢺࢫ࢟ࢸ㸦Tools > Design of Experiments > Export DOE Data㸧࡟関ࡿࡍDOEࢧンࢺ࣮࣏ࢫࢡ࢚ࡢࣝࣉ
 ࠋࡓࡋࡲࢀࡉ改善ࡀ

Optimization㸦最適化㸧 

 ࠋࡓࡋࡲࢀࡉ改善ࡀ࣮ࣝࣗࢪ最適化ࣔࡢ㸦topometry㸧࣮ࣜࢺ࣓࣏ࢺ

 ࡢ࣮ࣜࢺ࣓࣏ࢺ最適化ࡢ例題ࡢヲ細ࠊࡀFEMtools Optimization User’s Guide㸦最適化࣮ࣘࢻ࢖࣮࢞ࢨ㸧࡟追加ࡉ
 ࠋࡓࡋࡲࢀ

 ศ散厚ࡢ࣮ࣜࢺ࣓࣏ࢺࡢࡉ最適化ࠊࡣ最ᑠ FRFࣞ࣋ࣝ設計問題࡟利用ྍ能࡛ࠋࡍ 
 ࡢ࣮ࣜࢺ࣓࣏ࢺ最適化࢜ࢺࢫ࣏ࠊࡣ࣮ࢨ࢖࣐࢕ࢸࣉ処理࠾࡟い࡚ࡢ初期厚ࡉ値ࡀ許ྍࡓࢀࡉ厚ࡉ範ᅖୖࡢ限࡜

 ࠋࢇࡏࡲࡋ生成ࢆ࣮࢚ࣛࡿࡍ関࡟結果ࡢ場合ࡓࡗࡔࡌྠ
 ࢥン࣮ࣝࢯ出力࡛報告ࡓࢀࡉศ散品質指数ࡀ改善ࠋࡓࡋࡲࢀࡉ 

ABAQUS࢖ン࢙ࣇ࣮ࢱｲࢫとࣂ࢖ࣛࢻ 

 ABAQUS࢖ン࢙ࣇ࣮ࢱｲࠊࡣࣂ࢖ࣛࢻ࡜ࢫfemtools_abaqusࢭ࢖࣭ࣛࢻ࣮ࢥࢺࢡࢲࣟࣉンࢆࢫ要求ࠋࡍࡲࡋ
FEMtools 3 ࡢ ABAQUSࢭ࢖࣭ࣛࢻ࣮ࢥࢺࢡࢲࣟࣉンࡀࡽࢀࡑࡣࢫ終了࡛ࡲ᭷効࡛ࠋࡍ 

 Abaqus 2016࡜ Abaqus 2017ࢺ࣮࣏ࢧࡢ 
 *TRANSFORM࣮࢝ࢻ㸦節点࣮ࣝ࢝ࣟࡢᗙ標系㸧ࢺ࣮࣏ࢧࡢ 

 
*TRANSFORM,NSET=nset,TYPE=type 
a1,a2,a3,b1,b2,b3 

ࡀࣉ࢖ࢱࠊ࡛ࡇࡇ RࠊSࠊ Tࡢ場合ࠊ㸦a1ࠊa2ࠊa3㸧㸦b1ࠊb2ࠊb3㸧࢖࣏ࠊࡣンࢺ a࡜ b ࡢᗙ標定義 
nsetࠊࡣ*TRANSFORM asࡀ適用ࠋࡍ࡛ࢺࢵࢭ࣭ࢻ࣮ࣀࡿࢀࡉ 

 補語 SIM=NOࡀ Abaqus 2016や Abaqus 2017࡛使用ࡿࢀࡉ*FREQUENCY࣮࢟ワ࣮࡟ࢻ追加ࠋࡓࡋࡲࢀࡉ 
 ࣮ࣃ࣮ࢫ要素ࡢ࡚ࡋ࡜剛性࡜質量ࢫࢡࢵࣜࢺ࣐ࡢ㸦.mtxࢺࢵ࣐࣮࢛ࣇ㸧࢖ࢆン࣏࣮ࡿࡍࢺ新ࡋいࡀࢺࣉࣜࢡࢫ

加えࡘ࡟ࢀࡇࠋࡓࡋࡲࢀࡽい࡚ࠊࡣ<installdir>\scripts\interfaces\abaqus\abqrselemx.basࢆ参照ࡉࡔࡃ࡚ࡋいࠋ 
㸦ྡ称ࢫࢡࢵࣜࢺ剛性࣐ࡢࡑࠊ࡟ࡵࡓࡿࡍࢺン࣏࣮࢖ࢆ要素࣮ࣃ࣮ࢫ xxx_STIF1.mtx㸧࢖ࢆン࣏࣮ࠊ࡜ࡿࡍࢺ
対応ࡿࡍ質量࣐ࢫࢡࢵࣜࢺ㸦ྡ称 xxx_MASS1.mtx㸧ࡶ自動的࢖࡟ン࣏࣮ࠋࡍࡲࢀࡉࢺabqrselem.bas࡛ࢫࠊࡣ
 ࠋࡍࡲࢀࡉ生成ࠊࢀࡉ定義ࡀࢻ࣮ࣀࡓࢀࡽࡅ参照付࡟要素࣮ࣃ࣮

 ABAQUSࡢ剛体࣮ࣔࢻ計算࡛࣮ࣂࣝࢯ࣭ࢫ࣮࣌ࢫࣈࢧࠊࡣ実行࣮ࣂࣝࢯ࣭ࢫ࣮࣌ࢫࣈࢧࠊࡋ࠿ࡋࠋࡍࡲࢀࡉ
ࡿࡍ対応࡟ࣝࢹ㸦未拘束㸧࣮ࣔࣜࣇࡣ 0値あࡿいࡣ最ᑠ周波数ཷࢆ理࡞ࡋいࠊࡵࡓFEMtoolsࡣ自動的࡟ 0࡛
指定ࢆ値ࢺ࢛ࣝࣇࢹࡢ最ᑠ周波数ࠊࡀࡓࡋࡲࢀࡉ固定࡟1E-3ࠊࡣ値ࡢࡇࠋࡍࡲࡋ変更࡟最ᑠ周波数ࡢい値࡞
い設定ࡋ新ࡢࡵࡓࡿࡍ interface.abaqus.fminfreeࡀ加え࢕ࢸࢵࢭࡢࡇࠋࡓࡋࡲࢀࡽンࡣࢢ Edit > Settings > Data 
Interfaces > ABAQUS > Minimum Frequency for Free Models࡛変更ࢺ࢛ࣝࣇࢹࡢࡑࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ値ࡣ
1E-3࡛ࠋࡍ 
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 いࡢ࠿ࡘࡃ ABAQUS警告࣓ࡣ࡟ࢪ࣮ࢭࢵ単語ࢆ࣮࢚ࠖࣛࠕ含࡛ࢇいࢪ࣮ࢭࢵ࣓࣮࢚ࣛࡢࡑࠋࡍࡲ例ࡣ次࡜ࡢ
 ࠋࡍ࡛ࡾ࠾
'HIGH CURVATUREࠊIT MAY LEAD TO SURFACE AREA INTEGRATION ERRORS 
ࠋࡓࡋࡲࡏࡉ中断ࢆࢫࢭࣟࣉࡢFEMtoolsࠊࢀࡉ解釈࡚ࡗ誤࡚ࡋ࡜ࢪ࣮ࢭࢵ࣓࣮࢚ࣛࠊࡣࢪ࣮ࢭࢵ࣓ࡢࡽࢀࡇ
ࢀࡉ修ṇࡀࢫｲ࢙ࣇ࣮ࢱン࢖ABAQUSࠊ࡟うࡼい࡞ࡏࡉ中断ࢆࢫࢭࣟࣉ࡚ࡗࡼ࡟ࢪ࣮ࢭࢵ࣓࣮࢚ࣛ࡞うࡼࡢࡑ
 ࠋࡍࡲ

 FEMtools ABAQUSࡣࣂ࢖ࣛࢻ実例࡚ࡋࢺ࣮࣏ࢧࢆいࠋࢇࡏࡲ実例࡚ࡋ࡜ ABAQUSࣔࢹ࣭ࣔࢺࢵࣛࣇࠕࡢࣝࢹ
ࢫｲ࢙ࣇ࣮ࢱン࢖ABAQUSࠊࡣࡁ⥆手ࡢࡇࠋࡓࡋࡲࢀࡽ加え࡟ࢺン࣓ࣗ࢟ࢻFEMtoolsࠊࡀࡁ⥆手ࡿ変え࡟ࠖࣝ
࢖࢙ࣇ࣮ࢱン࢖࣭ࣝ࢖࢓ࣇ࣭ࢱ࣮ࢹABAQUSࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡅࡘ見࡛ࢻ࢖࣮࢞ࢨ࣮ࣘࡢࣂ࢖ࣛࢻびࡼ࠾
 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆンࣙࢩࢡࢭࡢ保Ꮡࡢࢫ

ANSYS࢖ン࢙ࣇ࣮ࢱｲࡼ࠾ࢫびࣂ࢖ࣛࢻ 

 ANSYS࢖ン࢙ࣇ࣮ࢱｲࠊࡣࣂ࢖ࣛࢻ࡜ࢫfemtools_abaqusࢭ࢖࣭ࣛࢻ࣮ࢥࢺࢡࢲࣟࣉンࢆࢫ要求ࠋࡍࡲࡋ
FEMtools 3 ࡢ ANSYSࢭ࢖࣭ࣛࢻ࣮ࢥࢺࢡࢲࣟࣉンࡀࡽࢀࡑࡣࢫ終了࡛ࡲ᭷効࡛ࠋࡍ 

 ANSYS v18+ࢺ࣮࣏ࢧࡢ 
 CDB࣮ࣜࠊࡣࢲKEYOPT࡜ KEYOPࡢ変数ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆANSYS࢖ࡣン࣏࣮ࢺ時ࡢ KEYOP࡜ KEYOPT

ࡣKEYOPTࠋࡍࡲࡋࢺ࣮࣏ࢧࢆ ANSYS以外ࡢ CDB࡚ࣛࡗࡼ࡟࣮ࢱ࢖生成ࠋࢇࡏࡲࢀࡋࡶ࠿ࡿࢀࡉ 

LS-DYNA࢖ン࢙ࣇ࣮ࢱｲࢫとࣂ࢖ࣛࢻ 

 新ࡋい࢜ࢻ࢔ン࣭ࠊ࡚ࡋ࡜࣮ࣝࢶLS-DYNA᭷限要素࢖ࡢ࡜࢔࢙࢘ࢺࣇࢯン࢙ࣇ࣮ࢱｲࠊࢀࡉࢺ࣮࣏ࢧࡀࢫ感ᗘ
解析ࡼ࠾びࣔ࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹンࡢࡵࡓࡢࢢ外部࡚ࡋ࡜࣮ࣂࣝࢯ LS-DYNAࢆ使用ࡼࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ
 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆࢻ࢖࢞ࢨ࣮࣭ࣘࣂ࢖ࣛࢻびࡼ࠾ࢫｲ࢙ࣇ࣮ࢱン࢖LS-DYNAࠊࡣい࡚ࡘ࡟ヲ細ࡾ

 LS-DYNA࢖ン࢙ࣇ࣮ࢱｲࢻ࣮ࢥࢺࢡࢲࣟࣉࠊࡣࣂ࢖ࣛࢻ࡜ࢫ femtools_lsdynaࢭ࢖ࣛࡢンࢆࢫ要求ࠋࡍࡲࡋ 

NASTRAN࢖ン࢙ࣇ࣮ࢱｲࢫとࣂ࢖ࣛࢻ 

 MSC.Nastran 2017ࢺ࣮࣏ࢧࡢ 
 NASTRAN࢖ン࢙ࣇ࣮ࢱｲࢻ࣮ࢥࢺࢡࢲࣟࣉࠊࡣࣂ࢖ࣛࢻ࡜ࢫ femtools_nastranࢭ࢖ࣛࡢンࢆࢫ要求ࠋࡍࡲࡋ

FEMtools 3ࡢ ANSYSࢭ࢖࣭ࣛࢻ࣮ࢥࢺࢡࢲࣟࣉンࡀࡽࢀࡑࡣࢫ終了࡛ࡲ᭷効࡛ࠋࡍ 
 ࿧び出࡚ࡋ࡜ࣝ࢖࢓ࣇࡋ別࡟࣮ࢲ࢛ࣝࣇࡢ఩置࢖ࡢࣝ࢖࢓ࣇࡿࡍン࢙ࣇ࣮ࢱｲࠋࡍࡲࢀࡉࢺ࣮࣏ࢧࡀࢫ 
 routput4.basࠊࡣࢺࣉࣜࢡࢫSC.Nastran࡚ࡗࡼ࡟作成ࡓࢀࡉ OUTPUT4࢖ࢆࣝ࢖࢓ࣇン࣏࣮ࡲࡁ࡛ࡀ࡜ࡇࡿࡍࢺ

いࡋ新ࡣࢀࡇࠋࡍ int64ࢆࣉ࢖ࢱ࣭ࢱ࣮ࢹ利用ࠋࡍࡲࡋ 
 NASTRANࡣࣂ࢖ࣛࢻ縮ᑠࠊ࡚ࡋ࡜࣮ࣂࣝࢯNX Nastran࡟ࡵࡓࡿࡍࢺ࣮࣏ࢧࢆ修ṇࠋࡓࡋࡲࢀࡉ 
 MSC.Nastran 2016ࢥンࣙࢩ࣮ࣞࢢ࢕ࣇン࣭ࣝ࢖࢓ࣇ㸦nastxxxxx.rcf㸧中ࡢMODE࢕ࢸࢵࢭンࢺ࢛ࣝࣇࢹࡢࢢ値

ࡽ࠿i4ࠊࡀ i8࡟変わࠊࡣࢀࡇࠋࡓࡋࡲࡾFEMtools NASTRAN࡟ࣂ࢖ࣛࢻ関ࡿࡍ問題ࢆ引ࡁ起ࠋࡍࡲࡋࡇ 

 FEMtoolsࠊࡽ࠿MSC.Nastran2016ࠊࡣ࡟ࡿࡍࢺ࣮ࢱࢫࢆnastran.iniࣝ࢖࢓ࣇ中࡟ࢢࣛࣇࡢ'mode=i4'ࢆ追加
ࡢࡇࠋࢇࡏࡲࡾ࡞ࡤࢀࡅ࡞ࡋ i4࣮ࣔࢻ指定ࡀࢻ࣮ࣔࠊࡣ NASTRANࢥンࣙࢩ࣮ࣞࢢ࢕ࣇン࣭ࣝ࢖࢓ࣇ中
ࡢ i4࡜等࡞ࡃࡋい場合ࡢ問題ࢆ回避ࠋࡍࡲࡋ 

 検証手⥆ࡀࡁ NASTRAN࡟ࣂ࢖ࣛࢻ加えࠋࡓࡋࡲࢀࡽMODEࡀ i4࡜等࡞ࡃࡋい場合ࠊ診断࣮ࣔࢻ㸦Edit 
> Run Mode > Diagnostics Mode㸧࡛実行ࡿࢀࡉ場合ࡢࡇࠊ手⥆ࡣࡁ警告ࢆ生成ࡣࢀࡇࠋࡍࡲࡋ FEMtools中
 ࠋࡍࡲࡾ࡞࡟᭷用࡟ࡢࡿࡍ識別ࢆ問題ࡢ場合ࡿࡍ実行ࢆMSC.Nastranࠊࡽ࠿

 ࢕ࢸࢵࢭ࣭ࣂ࢖ࣛࢻンࣝ࢖࢓ࣇࠊࢢ<installdir>\scripts\drivers\nastran.iniࠊࡣMSC.Nastran࡜ NX Nastranࢪ࣮ࣂ
ࣙンࡢ形成方法ࢆ識別ࡿࡍ追加ࣛ࢖ンࢆ含࡛ࢇいࠋࡍࡲ 

 SOL200中࡛適ษ࡟ࢱ࣮࣓ࣛࣃ࡞参照付ࣜࣉࢫࠊ࡟ࡵࡓࡿࡅンࢢ要素ࠊࡣCELAS2ࡢ代わ࡟ࡾ CELAS1/PELAS
 ࠋࡍࡲࢀࡉࢺ࣮࣏ࢫࢡ࢚࡚ࡋ࡜ࢻ࣮࢝

 BGSET࣮࢝ࠋࡍࡲࢀࡉࢺ࣮࣏ࢧ࡟ࣂ࢖ࣛࢻࡀࢻ 
 要素剛性࣐࢖ࡢࢫࢡࢵࣜࢺン࣏࣮ࢺ時ࠕࢪ࣮ࢭࢵ࣓࣮࢚ࣛࡢMatrices are too large to store㸦࣐ࡀࢫࢡࢵࣜࢺ大ࡁ

過࡛ࡢࡿࡂ格納࡛ࠋࢇࡏࡲ㸧ࠖ  ࠋࡍࡲࡋ解決ࡾࡼ࡟࡜ࡇࡿࡏࡉ増大ࢆࢫ࣮࣌ࢫࡢෆ部記憶装置ࠊࡣ
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SAP2000࢖ン࢙ࣇ࣮ࢱｲࢫとࣂ࢖ࣛࢻ 

 SAP2000࢖ン࢙ࣇ࣮ࢱｲࢻ࣮ࢥࢺࢡࢲࣟࣉࠊࡣࣂ࢖ࣛࢻ࡜ࢫ femtools_sap2000ࢭ࢖ࣛࡢンࢆࢫ要求ࠋࡍࡲࡋ 
 SAP2000 v18ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆSAP2000 v18࢖ン࢙ࣇ࣮ࢱｲ࢕ࢸࢵࢭ࣭࣒ࢱࢫ࢝ࡣࢫンࢆࢢ必要ࠋࡍࡲࡋ࡜

SAP2000 v18ࡢ FEMtoolsࢥンࣙࢩ࣮ࣞࢢ࢕ࣇン手⥆ࠊࡣࡁSAP2000࢖ン࢙ࣇ࣮ࢱｲ࢖࢞ࢨ࣮࣭ࣘࣂ࢖ࣛࢻ࡜ࢫ
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡅࡘ見࡛ࢻ

 FEMtools࡞ࢀࡉࢺ࣮࣏ࢧ࡟࣮ࣂࣝࢯい࡞ࣈ࢕ࢸࢡ࢔ DOF選択ࢆ備え࢖ࡀࣝࢹࣔࡓン࣏࣮ࡿࢀࡉࢺ場合ࠊs2k
 ࠋࡍࡲࡋ生成ࢆࢪ࣮ࢭࢵ警告࣓ࡣࢲ࣮࣭ࣜࣝ࢖࢓ࣇ

 OAPI࢖ン࢙ࣇ࣮ࢱｲࠊࡣࢫ以ୗࡢ新ࡋいࠋࡍࡲࡋࢺ࣮࣏ࢧࢆࢱ࣮࣓ࣛࣃ 

 ࢚ࣜ࢔特性ࢱ࣮࣓ࣛࣃ：薄膜曲ࡆ f11㸦mf11㸧ࠊ薄膜曲ࡆ f22㸦mf22㸧ࠊ薄膜曲ࡆ f12㸦mf12㸧ࠊ曲ࡆ m11
㸦bm11㸧ࠊ曲ࡆ m22㸦bm22㸧ࠊ曲ࡆ m11㸦bm11㸧ࠊ曲ࡆ m22㸦bm22㸧ࠊ曲ࡆ m12㸦bm12㸧ࢇࡏࠊ断 v13
㸦sv13㸧ࢇࡏࠊ断 v23㸦sv23㸧ࠊ質量㸦m㸧ࠊ重量㸦w㸧 

 ࣝࣈ࣮ࢣ特性ࢱ࣮࣓ࣛࣃ：軸断面積㸦csa㸧ࠊ質量㸦m㸧ࠊ重量㸦w㸧 
 ColdC࣒࣮ࣞࣇ断面ࢱ࣮࣓ࣛࣃ：外ᚄ縦幅㸦ａ㸧ࠊ外ᚄᶓ幅㸦b㸧ࣉࢵࣜࠊ厚ࡉ㸦c㸧ࠊ角半ᚄ㸦r㸧ࠊ断面厚

 㸦t㸧ࡉ
 ColdHat࣒࣮ࣞࣇ断面ࢱ࣮࣓ࣛࣃ：外ᚄ縦幅㸦ａ㸧ࠊ外ᚄᶓ幅㸦b㸧ࣉࢵࣜࠊ厚ࡉ㸦c㸧ࠊ角半ᚄ㸦r㸧ࠊ断面厚

 㸦t㸧ࡉ
 ColdZ࣮࣒ࣞ断面ࢱ࣮࣓ࣛࣃ：外ᚄ縦幅㸦ａ㸧ࠊ外ᚄᶓ幅㸦b㸧ࣉࢵࣜࠊ厚ࡉ㸦c㸧ࠊ角半ᚄ㸦r㸧ࠊ断面厚ࡉ

㸦t㸧 
 連結ࣜࣉࢫンࢢ剛性ࢱ࣮࣓ࣛࣃ：U1-U1ࣜࣉࢫンࢢ剛性㸦11㸧ࠊU1-U2ࣜࣉࢫンࢢ剛性㸦12㸧ࠊU2-U2ࣉࢫ

ࣜンࢢ剛性㸦22㸧ࠊU1-U3ࣜࣉࢫンࢢ剛性㸦13㸧ࠊ…ࠊU6―U6ࣜࣉࢫンࢢ剛性㸦66㸧 
 DoubleAngle࣒࣮ࣞࣇ断面ࢱ࣮࣓ࣛࣃ：外側背々距㞳㸦dist㸧ࠊ外ᚄ深ࡉ㸦t2㸧ࠊ外ᚄ幅㸦t3㸧ࠊ水ᖹ脚厚ࡉ

㸦tf㸧ࠊ垂直脚厚ࡉ㸦tw㸧 
 DoubleChannel࣒࣮ࣞࣇ断面ࢱ࣮࣓ࣛࣃ：外側背々距㞳㸦dist㸧ࠊ外ᚄ深ࡉ㸦t2㸧ࠊ外ᚄ幅㸦t3㸧ࣛࣇࠊンࢪ

厚ࡉ㸦tf㸧ࠊ壁厚ࡉ㸦tw㸧 
 ࣒࣮ࣞࣇ特性ࢱ࣮࣓ࣛࣃ：軸断面積㸦csa㸧2ࠊ方向ࢇࡏ断࢚ࣜ࢔㸦sa2㸧3ࠊ方向ࢇࡏ断࢚ࣜ࢔㸦sa3㸧ࡌࡡࠊ

 重量㸦w㸧ࠊ質量㸦m㸧ࠊ㸦moi3㸧ࢺ3軸間慣性࣮࣓ࣔンࠊ㸦moi2㸧ࢺ2軸間慣性࣮࣓ࣔンࠊ定数㸦tc㸧ࢀ
 ࢺࢫࣕ࢟ࣞࣉ I࣒࣮ࣞࣇ断面ࢱ࣮࣓ࣛࣃ：水ᖹ断面寸法㸦b1ࠊ…ࠊb4㸧ࠊ底ࣛࣇンࢪ溝角㸦f㸧ࠊ縦断面寸

法㸦d1ࠊ…ࠊd6㸧ࠊ壁厚ࡉ寸法㸦tࠊt2㸧 
 ࢺࢫࣕ࢟ࣞࣉ U࣒࣮ࣞࣇ断面ࢱ࣮࣓ࣛࣃ：水ᖹ断面寸法㸦b1ࠊ…ࠊb6㸧ࠊ縦断面寸法㸦d1ࠊ…ࠊd7㸧 
 長方形࣒࣮ࣞࣇ断面ࢱ࣮࣓ࣛࣃ：断面幅㸦t2㸧ࠊ断面深ࡉ㸦t3㸧 
 T࣒࣮ࣞࣇ断面ࣛࣇ:ࢱ࣮࣓ࣛࣃンࢪ幅㸦t2㸧ࠊ断面深ࡉ㸦t3㸧ࣛࣇࠊンࢪ厚ࡉ㸦tf㸧ࠊ壁厚ࡉ㸦tw㸧 
 ྎ形࣒࣮ࣞࣇ断面ࡢࣉࢵࢺ：ࢱ࣮࣓ࣛࣃ断面幅㸦t2㸧ࠊ底断面幅㸦t2b㸧ࠊ断面深ࡉ㸦t3㸧 

 ࡣࢱ࣮࣓ࣛࣃ値ࡀ無指定ࡢ場合࡛ࡶ定義ࡢࡑࠋࡍࡲࢀࡉ場合ࢱ࣮࣓ࣛࣃࡢ値ࡣ SAP2000ࣔࡽ࠿ࣝࢹ検索ࢀࡉ
 ࠋࡍࡲ

 ࣐ࢥンࢻ SET INTERFACE SAPࡣ SAP2000࢖࣭ࢱ࣮ࢹン࢕ࢸࢵࢭ࣭ࢫ࢖࢙ࣇ࣮ࢱンࢆࢢ定義࡟ࡵࡓࡿࡍ付ࡅ
加えࠋࡓࡋࡲࢀࡽ 

 ン࢜ࢻ࢔࣭࣮ࢱࢡࣛࢺࢫࢡ࢚࣭ࢱ࣮࣓ࣛࣃ࣭ࣝࢲ࣮ࣔ

ࢡワ࣮࣒࣮ࣞࣇFEMtoolsࠊࡣࢻン࣐ࢥࡢwindowingࠊࣝࢿンࣕࢳ࡜ンࣙࢩDOF࣮ࣜࣞࠊ信号処理㸦DSP㸧ࣝࢱࢪࢹ
࡛含ࠊࢀࡲFEMtools MPEࢭ࢖ࣛࡢン࡛ࡋ࡞ࢫ利用ྍ能࡛ࡣࢀࡇࠋࡍ以ୗ࣐ࢥࡢン࡟ࢻ関係ࠋࡍࡲࡋ 

DSP CURVE, DSP DECIMATE, DSP DETREND, DSP FILTER, DSP FINDDEADCHANNELS, DSP FINDREFERENCES, 
DSP INFO, DSP RESAMPLE, DSP SPECTRUM, DSP UPSAMPLE, DSP WINDOW, DSP XPS, APPLY DOF RELATION, 
CLEAR DOF RELATION, DEFINE DOF RELATION, EXTRACT DOF RELATION CLEAR CHANNEL, CLEAR 
WINDOW, DEFINE CHANNEL, DEFINE WINDOW, EXTRACT CHANNEL, EXTRACT WINDOW 

APPLY DOF RELATIONࠊCLEAR DOF RELATIONࠊDEFINE DOF RELATION㸦EXTRACT DOF RELATION㸧 

CLEAR CHANNEL, CLEAR WINDOW, DEFINE CHANNEL, DEFINE WINDOW, EXTRACT CHANNEL, EXTRACT 
WINDOW 
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剛体特性࢚࢜ࢻ࢔࣭࣮ࢱࢡࣛࢺࢫࢡン 

 ࣮ࣘ࢖࣭࣮ࢨン࡟ࢫ࢖࢙ࣇ࣮ࢱ次ࡢ修ṇࡀ加えࠋࡓࡋࡲࢀࡽ 

 周波数ࣞンࡀࢪ修ṇࡓࢀࡉ場合ࠊ加振ࡢࣝࣈ࣮ࢸ RB࢚࣮ࣛ係数ࡶ更新ࠋࡍࡲࢀࡉ 
 ࣏ࣞࢫンࢫ選択ࡀ変更ࡓࢀࡉ場合ࠊ加振ࡢࣝࣈ࣮ࢸ条件番号ࡶ更新ࠋࡍࡲࢀࡉ 
 FRFࡢୖࢺࢵࣟࣉ周波数ࣞンࢪ選択ࠊࡣ加振選択ࡢ修ṇࡶ࡚ࡗࡼ࡟消えࠋࢇࡏࡲ 
 非ࡢࣈ࢕ࢸࢡ࢔加振ࡀ復活ࡓࡋ場合࣏ࢫࣞࠊンࢫ選択ࡶ回復ࠋࡍࡲࢀࡉ 
 加振࡚࡭ࡍࡀ非ࡓࡗ࡞࡟ࣈ࢕ࢸࢡ࢔場合࣏ࢫࣞࠊンࡣࣝࣈ࣮ࢸ࣭ࢫ無効ࠋࡍࡲࡾ࡞࡟ 

 選択 FRFࠊ࡟ࡵࡓࡿࡍࢺ࣮࣏ࢧࢆRBPE COMPUTE࣐ࢥン࡟ࢻ追加ࠋࡓࡋࡲࢀࡉ 
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コ࣐ンࢻ 

FEMtools࣐ࢥンࢻ言語ࡣいࡢ࠿ࡘࡃ新ࡋい࣐ࢥンࡀࢻᣑ張ࠊࡓࡲࠋࡍࡓࡋࡲࢀࡉ既Ꮡ࣐ࢥࡢンࡀࢻ増強ࡋࡲࢀࡉ
ࡢࣉFEMtools࣊ࣝࠊい࡚ࡘ࡟情報ࡢ࡚࡭ࡍࡢࡑࠋࡓ FEMtools Command Reference࡛参照ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

新ࡋいコ࣐ンࢻ 

 ࠋࡍࡲࡋい࡚記述ࡘ࡟ࢻン࣐ࢥいࡋ新࡞FEMtools 4࡛利用ྍ能ࠊࡣンࣙࢩࢡࢭࡢࡇ

CLEAR FMDRELATION ࣗࢩࢵ࣓࣮ࣜࣇ変形㸦FMD㸧࣮ࣜࣞࣙࢩンࢆ消去ࠋࡍࡲࡋ 

CLEAR MPM ่࣮ࣔࢻ激࣐ࢆࣉ࣮࢙ࢩࣉࢵ消去ࠋࡍࡲࡋ 

CLEAR NKE Normalized Kinetic Energy㸦ṇ規化運動࢚ࢠࣝࢿ㸧ࢆࣉ࣮࢙ࢩ消去
 ࠋࡍࡲࡋ

CLEAR NMD Normalized Modal Displacement㸦ṇ規化࣮ࣔࣝࢲ変఩㸧ࣉ࣮࢙ࢩ
 ࠋࡍࡲࡋ消去ࢆ

DEFINE FMDRELATION ࣗࢩࢵ࣓࣮ࣜࣇ変形㸦FMD㸧࣮ࣜࣞࣙࢩンࢆ定義ࠋࡍࡲࡋ 

DEFINE EULER ࣮࢜ࣛ࢖角ᗘࢆ使用࣮ࣝ࢝ࣟࡓࡋᗙ標系ࢆ定義ࠋࡍࡲࡋ 

DSP RESAMPLE 再ࢧンࣜࣉンࢢ時้歴 

DSP UPSAMPLE  ࢧ࣭ࣉࢵ࢔ンࣜࣉンࢢ時้歴 

EXAMINE MPM 加振఩置選択用่ࢻ࣮ࣔࡢ激࣐ࢆࣉࢵ計算ࠋࡍࡲࡋ 

EXAMINE SPAMPA ่࣮ࣔࢻ激解析࣐ࢆࣉࢵ使用ࡓࡋ最適加振఩置ࢆ識別ࠋࡍࡲࡋ 

EXAMINE SUPPORT 最適支持఩置選択用࣐ࢆࣉࢵ生成ࠋࡍࡲࡋ 

EXTRACT FMDRELATION ࣗࢩࢵ࣓࣮ࣜࣇ変形㸦FMD㸧情報ࢆ出力ࠋࡍࡲࡋ 

EXTRACT MPM ่࣮ࣔࢻ激࣐ࣉࢵ結果ࢆ出力ࠋࡍࡲࡋ 

FORMࠋࡍࡲࡋࢻ࣮ࣟࢆ࣒࣮࢛ࣇ ࠊ 

REPORT EXCEL CLOSE MS EXCEL࣓ࣗ࢟ࢻンࢆࢺ閉ࠋࡍࡲࡌ 

REPORT EXCEL LAUNCH 新ࡋいMS EXCELࣙࢩࢵࢭンࢆ開始ࠋࡍࡲࡋ 

REPORT EXCEL MATRIX ࡞ࣈ࢕ࢸࢡ࢔MS EXCEL࣓ࣗ࢟ࢻンࢆࢫࢡࢵࣜࢺ࣐࡟ࢺ出力ࡋ
 ࠋࡍࡲ

REPORT EXCEL MODEL ࡞ࣈ࢕ࢸࢡ࢔MS EXCEL࣓ࣗ࢟ࢻンࢆࣝࢹࣔ࡟ࢺ出力ࠋࡍࡲࡋ 

REPORT EXCEL NEW 新ࡋいMS EXCEL࣓ࣗ࢟ࢻンࢆࢺ作成ࠋࡍࡲࡋ 

REPORT EXCEL OPEN 既ᏑࡢMS EXCEL࣓ࣗ࢟ࢻンࢆࢺ開ࠋࡍࡲࡁ 
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REPORT EXCEL PAIR ࡞ࣈ࢕ࢸࢡ࢔MS EXCEL࣓ࣗ࢟ࢻン࢔࣌࡬ࢺ情報ࡾ㈞ࢆ付ࡲࡅ
 ࠋࡍ

REPORT EXCEL QUIT MS EXCELࣙࢩࢵࢭンࢆ閉ࠋࡍࡲࡌ 

REPORT EXCEL SAVE ࡞ࣈ࢕ࢸࢡ࢔MS EXCEL࣓ࣗ࢟ࢻンࢆࢺ保Ꮡࠋࡍࡲࡋ 

REPORT EXCEL SHAPES ࡞ࣈ࢕ࢸࢡ࢔MS EXCEL࣓ࣗ࢟ࢻンࢆࣉ࣮࢙ࢩ࡬ࢺ出力ࡲࡋ
 ࠋࡍ

REPORT EXCEL TITLE ࡞ࣈ࢕ࢸࢡ࢔MS EXCEL࣓ࣗ࢟ࢻンࢆࣝࢺ࢖ࢱ࡟ࢺ加えࠋࡍࡲ 

REPORT POWERPOINT ADDSLIDE 新ࡋい空ࢆࢻ࢖ࣛࢫࡢ加えࠋࡍࡲ 

REPORT POWERPOINT CLOSE MS POWERPOINT࣭࣓ࣗ࢟ࢻンࢆࢺ閉ࠋࡍࡲࡌ 

REPORT POWERPOINT LAUNCH 新ࡋいMS POWERPOINTࣙࢩࢵࢭンࢆ開始ࠋࡍࡲࡋ 

REPORT POWERPOINT MATRIX ࢮࣞࣉ࡞ࣈ࢕ࢸࢡ࢔ンࣙࢩ࣮ࢸンࢆࢫࢡࢵࣜࢺ࣐࡟出力ࠋࡍࡲࡋ 

REPORT POWERPOINT MODEL ࢮࣞࣉ࡞ࣈ࢕ࢸࢡ࢔ンࣙࢩ࣮ࢸンࢆࣝࢹࣔ࡟出力ࠋࡍࡲࡋ 

REPORT POWERPOINT NEW 新ࡋいࢮࣞࣉンࣙࢩ࣮ࢸンࢆ作成ࠋࡍࡲࡋ 

REPORT POWERPOINT OPEN 既Ꮡࢮࣞࣉࡢンࣙࢩ࣮ࢸンࢆ開始ࠋࡍࡲࡋ 

REPORT POWERPOINT PAIR ࢮࣞࣉ࡞ࣈ࢕ࢸࢡ࢔ンࣙࢩ࣮ࢸン࢔࣌ࡢ࡬情報ࢆ出力ࠋࡍࡲࡋ 

REPORT POWERPOINT QUIT MS POWERPOINTࣙࢩࢵࢭンࢆ閉ࠋࡍࡲࡌ 

REPORT POWERPOINT RMF ࣏࣮ࣞ࢕ࢸンࢢ過程ࢸࡢン࣏ࣛࣜࢆࣝ࢖࢓ࣇ削除ࠋࡍࡲࡋ 

REPORT POWERPOINT SAVE ࢮࣞࣉ࡞ࣈ࢕ࢸࢡ࢔ンࣙࢩ࣮ࢸンࢆ保Ꮡࠋࡍࡲࡋ 

REPORT POWERPOINT SHAPES ࢮࣞࣉ࡞ࣈ࢕ࢸࢡ࢔ンࣙࢩ࣮ࢸンࢆࣉ࣮࢙ࢩ࡬出力ࠋࡍࡲࡋ 

REPORT POWERPOINT TITLE 現ᅾࠋࡍࡲࡋࢺࢵࢭࢆࣝࢺ࢖ࢱࡢࢻ࢖ࣛࢫࡢ 

REPORT TEXT CLOSE ASCII࣓ࣗ࢟ࢻンࢆࢺ閉ࠋࡍࡲࡌ 

REPORT TEXT MATRIX ࡞ࣈ࢕ࢸࢡ࢔ ASCII࣓ࣗ࢟ࢻンࢆࢫࢡࢵࣜࢺ࣐࡟ࢺ出力ࠋࡍࡲࡋ 

REPORT TEXT MODEL ࡞ࣈ࢕ࢸࢡ࢔ ASCII࣓ࣗ࢟ࢻンࢆࣝࢹࣔ࡟ࢺ出力ࠋࡍࡲࡋ 

REPORT TEXT NEW 新ࡋい ASCII࣓ࣗ࢟ࢻンࢆࢺ作成ࠋࡍࡲࡋ 

REPORT TEXT OPEN 既Ꮡࡢ ASCII࣓ࣗ࢟ࢻンࢆࢺ開ࠋࡍࡲࡁ 

REPORT TEXT PAIR ࡞ࣈ࢕ࢸࢡ࢔ ASCII࣓ࣗ࢟ࢻン࢔࣌࡬ࢺ情報ࢆ出力ࠋࡍࡲࡋ 

REPORT TEXT SHAPES ࡞ࣈ࢕ࢸࢡ࢔ ASCII࣓ࣗ࢟ࢻンࢆࣉ࣮࢙ࢩ࡬ࢺ出力ࠋࡍࡲࡋ 

REPORT TEXT TITLE ࡞ࣈ࢕ࢸࢡ࢔ ASCII࣓ࣗ࢟ࢻンࢆࣝࢺ࢖ࢱ࡟ࢺ加えࠋࡍࡲ 
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REPORT TEXT VARIABLE ࡞ࣈ࢕ࢸࢡ࢔ ASCII࣓ࣗ࢟ࢻン࡟ࢺෆ部࢕ࢸࢵࢭンࢆࢢ出力ࡲࡋ
 ࠋࡍ

REPORT WORD CLOSE MS Word࣓ࣗ࢟ࢻンࢆࢺ閉ࠋࡍࡲࡌ 

REPORT WORD LAUNCH 新ࡋいMS Wordࣙࢩࢵࢭンࢆ開始ࠋࡍࡲࡋ 

REPORT WORD MATRIX ࡞ࣈ࢕ࢸࢡ࢔MS Word࣓ࣗ࢟ࢻンࢆࢫࢡࢵࣜࢺ࣐࡟ࢺ出力ࡲࡋ
 ࠋࡍ

REPORT WORD MODEL ࡞ࣈ࢕ࢸࢡ࢔MS Word࣓ࣗ࢟ࢻンࢆࣝࢹࣔ࡟ࢺ出力ࠋࡍࡲࡋ 

REPORT WORD NEW 新ࡋいMS Word࣓ࣗ࢟ࢻンࢆࢺ作成ࠋࡍࡲࡋ 

REPORT WORD OPEN 既ᏑࡢMS Word࣓ࣗ࢟ࢻンࢆࢺ開ࠋࡍࡲࡁ 

REPORT WORD PAIR ࡞ࣈ࢕ࢸࢡ࢔MS Word࣓ࣗ࢟ࢻン࢔࣌࡬ࢺ情報ࢆ出力ࠋࡍࡲࡋ 

REPORT WORD QUIT MS Wordࣙࢩࢵࢭンࢆ閉ࠋࡍࡲࡌ 

REPORT WORD RMF ࣏࣮ࣞ࢕ࢸンࢢ過程ࢸࡢン࣏ࣛࣜࢆࣝ࢖࢓ࣇ削除ࠋࡍࡲࡋ 

REPORT WORD SAVE ࡞ࣈ࢕ࢸࢡ࢔MS Word࣓ࣗ࢟ࢻンࢆࢺ保Ꮡࠋࡍࡲࡋ 

REPORT WORD SHAPES ࡞ࣈ࢕ࢸࢡ࢔MS Word࣓ࣗ࢟ࢻンࢆࣉ࣮࢙ࢩ࡬ࢺ出力ࠋࡍࡲࡋ 

REPORT WORD TITLE ࡞ࣈ࢕ࢸࢡ࢔MS Word࣓ࣗ࢟ࢻンࢆࣝࢺ࢖ࢱ࡟ࢺ加えࠋࡍࡲ 

SET INTERFACE SAP SAP2000࢖࣭ࢱ࣮ࢹン࢖࣭ࢱ࣮ࢹࡢࡵࡓࡢࢫ࢖࢙ࣇ࣮ࢱンࣇ࣮ࢱ
 ࠋࡍࡲࡋ定義ࢆࢢン࢕ࢸࢵࢭ࣭ࢫ࢖࢙

修正済ࡢコ࣐ンࢻ 

 ࠋࡍࡲࡋい࡚記述ࡘ࡟変更点ࡢ࡬ࢻン࣐ࢥࠊࡣンࣙࢩࢡࢭࡢࡇ

DEFINE SELEM 補語 GEࠊALPHAࠊBETAࡀ構造㸦Structural㸧減衰ࡼ࠾び࣮ࣞࣜ
࣮粘性㸦Rayleigh viscous㸧減衰ࢆ定義࡟ࡵࡓࡿࡍ付ࡅ加えࡲࢀࡽ
 ࠋࡓࡋ

DEFINE SET 補語 ATTACHEDࡣ現ᅾ࡟࣒ࢸ࢖࢔ࡢ選択ࢆ࣒ࢸ࢖࢔追加ࡲࡋ
 ࠋࡍ

EXAMINE MPA  補語MODEࢻ࣮ࣔࡀ選択ࢆ指定࡟ࡵࡓࡿࡍ追加ࠋࡍࡲࢀࡉ 

EXAMINE MPF 補語 FILEࡣᪧ式ࡵࡓࡢ削除ࠋࡍࡲࢀࡉ 

EXTRACT NKE  補語 UPPER࡜ LOWERࡣ削除ࠋࡍࡲࢀࡉ 

EXTRACT NMD  補語 UPPER࡜ LOWERࡣ削除ࠋࡍࡲࢀࡉ 

GUI ࣝ࢖ࢱࢫ SGIࠊMOTIFPLUSࠊPLATINUMࠊTITANIUMࠊXPࠊࡣ
 ࠋࢇࡏࡲࢀࡉࢺ࣮࣏ࢧやࡣࡶ
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ࣝ࢖ࢱࢫ CLEANLOOKSࠊPLASTIQUEࠊWINDOWSVISTAࡼ࠾
びWINDOWSXPࡀ加えࠋࡓࡋࡲࢀࡽ 

MODIFY MBA SUBSTRUCTURE 補語 Bࠊࡣ吸཰器ࡢ減衰特性ࢆ修ṇ࡟ࡵࡓࡿࡍ追加ࠋࡍࡲࢀࡉ
 ࠋࡍࡲࡾ࡞࡟別ྡࡢDAMPING補語ࠊࡣࢀࡑ

MODIFY MBA SUBSTRUCTURE 補語 B1ࠊB2ࠊB4ࠊB5ࡀ減衰修ṇ要素㸦ࣛࢢンࢻ間㸧ࡢ減衰特
性ࢆ修ṇ࡟ࡵࡓࡿࡍ追加ࠋࡓࡋࡲࢀࡉ 

MODIFY MBA SUBSTRUCTURE  補語 K1ࠊK2ࠊK4ࠊK5ࣜࣉࢫࡀンࢢ修ṇ要素㸦ࣛࢢンࢻ間㸧ࡢ
剛性特性ࢆ修ṇ࡟ࡵࡓࡿࡍ追加ࠋࡓࡋࡲࢀࡉ 

SET MBA  補語 COUPLING࡟伴う SET MBA A RIGID値ࡀ追加ࠋࡓࡋࡲࢀࡉ 

FEMtoolsࢺࣉࣜࢡࢫ 

FEMtoolsࢺࣉࣜࢡࢫ言語ࡣ新ࡋい機能ࢆ伴࡚ࡗᣑ張ࠋࡓࡋࡲࢀࡉ全࡚ࡢ情報ࠊࡣFEMtools࣊ࣝࡢࣉ FEMtools API
 ࠋࡍࡲࡁ参照࡛ࢆࢫンࣞ࢓ࣇࣜ

新ࡋいࢺࣉࣜࢡࢫ関数 

いࡋ新ࡣンࣙࢩࢡࢭࡢࡇ FEMtoolsࢺࣉࣜࢡࢫ関数ࡘ࡟い࡚記述ࠋࡍࡲࡋ 

一般関数 

Do … Loop  Do࣮ࣝࢆࣉ追加ࠋࡿࡍ 

For … Next  For繰ࡾ返ࢆࡋ追加ࠋࡿࡍ 

ScreenSize  ࣮ࣔࣜࢡࢫ࣭࣮ࢱࢽンࢬ࢖ࢧࣝࢭࢡࣆࡢ(x,y)ࢆ返ࠋࡍࡲࡋ 

Dictionary Object㸦辞書࢜ࢺࢡ࢙ࢪࣈ㸧 

.Add 辞書࢜ࢆ࣒ࢸ࢖࢔࡟ࢺࢡ࢙ࢪࣈ追加ࠋࡍࡲࡋ 

.CompareMethod 辞書࢜ࢺࢡ࢙ࢪࣈ中ࡢ比較ࣜࢺࢫンࡢ࣮࣭࢟ࢢ比較方法ࢆ設定ࡲ

 ࠋࡍࡲࢀࡉ実行ࡀ検索ࡣࡓ

.Count 辞書中࣒ࢸ࢖࢔ࡢ数ࢆ数えࠋࡍࡲ 

.Exists 辞書ࡀ࣒ࢸ࢖࢔Ꮡᅾ࠿ࡿࡍ否࠿識別ࠋࡍࡲࡋ 

.Item 辞書࢜ࢆ࣒ࢸ࢖࢔ࡢࢺࢡ࢙ࢪࣈ修ṇࡣࡓࡲ検索ࡀ実行ࠋࡍࡲࢀࡉ 

.Items 辞書࡚࢜࡭ࡍࢆ࣒ࢸ࢖࢔ࡽ࠿ࢺࢡ࢙ࢪࣈ検索ࠊࡋ異ࡿ࡞配列ࡑ࡟

 ࠋࡍࡲࡋ格納ࢆࡽࢀ

.Key ࢆ࣮࢟ࡢ࣒ࢸ࢖࢔修ṇࠋࡍࡲࡋ 

.Keys 辞書࢜࡟ࢺࢡ࢙ࢪࣈ格納ྡࡢ࣒ࢸ࢖࢔ࡢ࡚࡭ࡍࡓࢀࡉ前ࢺࢫࣜࡢ

 ࠋࡍࡲࡋ返ࢆ
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.Load Matlab 5࡜互換ࡢࣝ࢖࢓ࣇ࣭ࢱ࣮ࢹ辞書ࠋࡍࡲࡋࢻ࣮ࣟࢆ 

.Remove 辞書࢜ࡾྲྀࢆ࣒ࢸ࢖࢔ࡽ࠿ࢺࢡ࢙ࢪࣈ除ࠋࡍࡲࡁ 

.RemoveAll 辞書࢜ࡾྲྀ࡚࡭ࡍࢆ࣒ࢸ࢖࢔ࡽ࠿ࢺࢡ࢙ࢪࣈ除ࠋࡍࡲࡁ 

.Save Matlab 5࡜互換ࡢࣝ࢖࢓ࣇ࣭ࢱ࣮ࢹ辞書ࢆ保Ꮡࠋࡍࡲࡋ 

修正済ࢺࣉࣜࢡࢫ関数 

 ࠋࡍࡲࡋい࡚記述ࡘ࡟変更点ࡢ関数ࢺࣉࣜࢡࢫFEMtoolsࠊࡣンࣙࢩࢡࢭࡢࡇ

CreateObject 辞書࢜ࢆࢺࢡ࢙ࢪࣈ作成ࡢࡵࡓࡿࡍ入力値’dictionary’ࢺ࣮࣏ࢧࢆ
 ࠋࡍࡲࡋ

RmDir ࣓ࢺ࣮ࢸࢫンࢺあࡿいࡣ関数࡚ࡋ࡜࿧び出ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡍ 

FEMtools API 

FEMtools APIࡢいࡢ࠿ࡘࡃ新ࡋい関数ࡀᣑ張ࠊࡓࡲࠊࢀࡉ既Ꮡࡢ関数ࡀ増強ࠋࡓࡋࡲࢀࡉ全࡚ࡢ情報࡟関ࠊࡣ࡚ࡋ
FEMtools࣊ࣝࡢࣉ FEMtools API Referenceࡽ࠿参照ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

新ࡋい FEMtools API関数 

Ft_CheckOutFeature 解析機能ࢭ࢖ࣛࡢンࡀࢫ᭷効࡝࠿うࠋࡍࡲࡋࢡࢵ࢙ࢳ࠿ 

Ft_FormCommand ࣐ࢥ࡟࣒࣮࢛ࣇンࢆࢻ㏦ࠋࡍࡲࡾ 

Ft_GetForm ࡽ࠿࣒࣮࢛ࣇ情報ࢆ得ࠋࡍࡲ 

Ft_GetProperties ANALYSE࣐ࢥンࡢ࡬ࢻ引ࡁ数ࢆ渡ࠋࡍࡲࡋ 

Ft_LoadForm ࢆࣝࢿࣃ࠿ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲࡢࢫ࣮࣒࣮࢛࣋ࣇ開ࠋࡍࡲࡁ 

Ft_SetForm ࡟࣒࣮࢛ࣇ情報ࢆ㏦ࠋࡍࡲࡾ 

修正済ࡢ FEMtools API関数 

 ࠋࡍࡲࡋい࡚記述ࡘ࡟変更点ࡢFEMtools API関数ࠊࡣンࣙࢩࢡࢭࡢࡇ

Ft_GetItemList ࡢࡇ関数ࡀ返ࡿࡁ࡛ࡀ࡜ࡇࡍ要素ࣜ࡟ࢺࢫ基࡙ࢆࢺࢫࣜࢻ࣮ࣀࡃ

返ࠋࡍࡲࡋFt_GetItemList(ST_NODE, "ELEMENT", elist)ࡼࡢう࡟
使用ࠋࡍࡲࡋ 

Ft_HasFeature ࡢࡇ関数ࡣࡶࠊࡣや重要࡞機能࡛ࡣあࠊࡋࡔࡓࠋࢇࡏࡲࡾ利用ྍ

能ࢭ࢖ࣛ࡞ンࢫ数࡝࠿0<ࡀうࠊࡣࢀࡇࠋࡍࡲࡋࢡࢵ࢙ࢳࢆ࠿単
ࠋࡍࡲࢀࡉ使用࡟ࢡࢵ࢙ࢳ࡞うࡼࡿࡍ計算ࢆ数ࡢ機能࡞᭷効࡟

Ft_HasFeatureࡣ常࡟真値㸦True㸧ࢆ返ࠊࡋ機能ࣙࢩࢵࢭࡀン間
࡛᭷効࡝࠿うࠋࡍࡲࡋࢡࢵ࢙ࢳ࠿ 

Ft_HostInfo 付属ࡢ Safenet HASP HLࢻンࣝࢢ情報ࡢࡵࡓࡿࡍࢺ࣮࣏ࣞࢆ引
数’hl’ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆ 
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Ft_ProductInfo 引数’server’ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆ 

Ft_SendWindowCommand 引数’Activate’ࢺࢵࢤ࣮ࢱࡀMDI࢘࢕ンࡿࡍ࡟ࣈ࢕ࢸࢡ࢔ࢆ࢘ࢻ
 ࠋࡍࡲࢀࡽ加えࡅ付࡟ࡵࡓ

Ft_SetGUIStyle GUIࠊ࡚ࡋ࡜ࣝ࢖ࢱࢫsgi, motifplus, platinum, titanium, xpࡣࡶࠊࡣ
やࢺ࣮࣏ࢧ対象外࡛ࠊࡀࡍcleanlooks, plastique, windowsvista and 
windowsxpࡀ加えࠋࡓࡋࡲࢀࡽ 

新ࡋい API環境変数 

 ࢢンࣜࢺࢫと࣮ࣛ࢝ࢫ

interface.abaqus.fminfree ABAQUSࢆ࣮ࣂࣝࢯ࣭ࢫ࣮࣌ࢫࣈࢧࡢ使用ࠊࡋ剛体࣮࢙ࣔࢩࢻ
 ࠋࡍࡲࡋ指定ࢆ最ᑠ周波数ࡢࡵࡓࡿࡍ計算ࢆࣉ࣮

interface.show.extra FEࣙࢩ࣮ࢣࣜࣉ࢔ン㸦Algor, Femap, MSC.Marc,…㸧ࣝ࢖࢓ࣇࡢ
࣭ࢺン࣏࣮࢖ࣝ࢖࢓ࣇࡣᣑ張子ࡢࡽࢀࡑࠋࡍࡲࡋ出力ࢆᣑ張子ࡢ

ࡽࢀࡑࠊࡣ࡛ࢺ࢛ࣝࣇࢹࠋࡍࡲい࡚ࢀࡲ含࡟ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ

 ࠋࢇࡏࡲい࡚ࢀࡉ定義ࡣ
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FEMtools 4.0.1 更新情報  

ࡣ更新情報ࡢࡇ FEMtools 4.0.1.1850ࣙࢪ࣮ࣂン࡟対応ࡾࡼࠋࡍࡲࡋヲ細ࡘ࡟い࡚ࠊࡣFEMtools 4.0.1࣓ンࢼࢸン
 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆࢺ࣮ࣀࢫ࣮࣭ࣜࣜࢫ

以ୗ࣓ࣗ࢟ࢻࡢン࡜ࢺ例題࡟関ࡿࡍ変更点ࡘ࡟い࡚解ㄝࠋࡍࡲࡋ 

 変更点ࡢࢺキ࣓ࣗンࢻ

ࡢ࡚࡭ࡍ FEMtools࣓ࣗ࢟ࢻンࡀࢺ更新ࠋࡓࡋࡲࢀࡉ 

 追加情報ࠊ࡚ࡋ࡜USBࢻン࢖࣭ࣂ࢖ࣛࢻࡢࣝࢢン࣮ࣝࢺࢫ方法࡟関ࡀࣝ࢔ࣗࢽ࣐ࡿࡍ追加࡚ࢀࡉいࡲࠋࡍࡲ
ࢺࢵࢭࡢび環境変数ࡼ࠾࣮ࣕࢪ࣮ࢿ࣐࣭ࢫンࢭ࢖FEMtoolsࣛࠊࡣい࡚ࡘ࡟使用方法ࡢࣝࢢンࢻFEMtoolsࠊࡓ
方法ࢆ参照ࡉࡔࡃ࡚ࡋいࠋ 

 ࡢࡑࠊࡓࡲ௚ࡢ追加情報ࠊ࡚ࡋ࡜FEMtools Getting Started㸦入門㸧࣐ࢆࣝ࢔ࣗࢽ参照ࡉࡔࡃ࡚ࡋいࠋ 
 Test Model Editor㸦ࢱ࢕ࢹ࢚࣭ࣝࢹ࣭ࣔࢺࢫࢸ㸧ࡢ使用方法࡟関ࡿࡍ新ࡋい章ࡀ FEMtools࣓࣮ࢨ࣮࣭ࣘࣗࢩࢵ

 ࠋࡍࡲい࡛ࢇ含ࢆ定義方法例ࡢび࣮ࣟ࢝ࣝ෇柱ᗙ標系ࡼ࠾記述ࡢࣝࢿࣃࡣࢀࡑࠋࡓࡋࡲࢀࡉ追加࡟ࢻ࢖࢞
 ANSYS ࣮ࣃ࣮ࢫ要素ࡢ処理ࡘ࡟い࡚ࣙࢩࢡࢭࡢンࡀ ANSYS࢖ン࢙ࣇ࣮ࢱｲࡼ࠾ࢫび࡟ࢻ࢖࢞ࡢࣂ࢖ࣛࢻ追加

 ࠋࡓࡋࡲࢀࡉ

例題ࡢ変更点 

 新ࡋい例題࣮ࢲ࢛ࣝࣇࡀࣝ࢖࢓ࣇ..\examples\mesh\test_model_editor.࡟追加ࠋࡓࡋࡲࢀࡉ 
 SIM࡜接⥆ࡢ࡜ࡇࡿࡍ新ࡋい例ࡣ..\examples\interfaces\abaqus.࡟追加ࠋࡓࡋࡲࢀࡉ 

 新ࡋい例題ࡣ࣮ࢲ࢛ࣝࣇ FRF࡜ HRAࡢ検証例題࡚ࡋ࡜追加ࡋࡲࢀࡉ
 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆexamples\dynamic\harmonic\verification\..ࠋࡓ

 新ࡋい例題࣮ࢲ࢛ࣝࣇ..\examples\dynamic\selem\nastranࡀ追加ࠋࡓࡋࡲࢀࡉ 
 新ࡋい例題ࡀ࣮ࢲ࢛ࣝࣇMEFࡢ計算ࢆ実証ࡘ࠿ࠊࡋ結果ࢆ NASTRAN࡜比較࡟ࡵࡓࡿࡍ追加ࡋࡲࢀࡉ

 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆexamples\pretest\mef\.ࠋࡓ
 新ࡋい例題࡚ࡋ࡜஧次近似係数ࢆ推定ࡢࡵࡓࡿࡍ高精ᗘ࣮࣮࢜ࢲ関数㸦曲線適合㸧実証例ࡀ追加ࡋࡲࢀࡉ

 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆexamples\nlp\fit\..ࠋࡓ
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FEMtools࣒࣮ࣞࣇワ࣮ࢡ 

FEMtools࣒࣮ࣞࣇワ࣮ࡢࢡ変更点ࢆ概ㄝࠋࡍࡲࡋ 

一般機能 

 SQLiteࠊࡀࣂ࢖ࣛࢻFEMtools࣐ࢥン࢖ࣛࢻン࣭ࣙࢪ࣮ࣂン㸦FTCMD㸧࡛ࠋࡓࡋࡲࢀࡉࢺ࣮࣏ࢧ 
 24時間ࢆ越えࡿ時間ࡓࡗ࠿࠿解析ࡢṇ確࣑࢖ࢱ࡞ンࢢ情報ࠋࡍࡲࡋࢺ࣮࣏ࣞࢆ 

 生成ࣗࢩࢵ࣓

ࡀい章ࡋ新ࡿࡍ関࡟使用方法ࡢࢱ࢕ࢹ࢚࣭ࣝࢹ࣭ࣔࢺࢫࢸ FEMtools࣓࡟ࢻ࢖࣮࢞ࢨ࣮࣭ࣘࣗࢩࢵ追加ࡋࡲࢀࡉ
ࡣࣝ࢖࢓ࣇい例題ࡋ新ࡢࡑࠋࡍࡲい࡛ࢇ含ࢆ定義方法例ࡢび࣮ࣟ࢝ࣝ෇柱ᗙ標系ࡼ࠾ヲ細記述ࡢࣝࢿࣃࡣࢀࡑࠋࡓ

 ࠋࡍࡲࢀࡉ追加࡟examples\mesh\test_model_editor\..࣮ࢲ࢛ࣝࣇ

 ࣉࢵࢺࢡࢫࢹ

 ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲと࣮ࣗࢽ࣓

 複数ࢆࢫࣃ指定࣮ࢲ࢛ࣝࣇ࣭ࢫࣃ࣭ࢪ࣮࣓࢖ࡿࡍ㸦path.image㸧ࢆ設定ࡿࡍ場合ࡢ潜ᅾ的࡞問題ࡀ解決ࡲࢀࡉ
 ࠊࡤ例えࠋࡓࡋ
 
path.image=c:\femtools\4\images;d:\home\ft4\new_images  
 
ࡋ࡛ࢇࡏࡲࡁ࡛ࡀ࡜ࡇࡿࡅࡘ見ࢆࣝ࢖࢓ࣇ࣭ࢫࢡࢵ࢕ࣇࣛࢢࡿࡍᏑᅾ࡟ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲࡢ複数ࠊ場合ࡢࡇ

関数ࠊࡣ࡟解決ࢆ問題ࡢࡇࠋࡓ Ft_LocateFileࠊࡀBuildPathࡢ代わ࡟ࡾ使用ࠋࡍࡲࢀࡉ 
 Only add spring components for the blocked BC ࢆ示ࡼࡍう࡟ Convert Boundary Conditions to Springs࣎ࢢࣟ࢔࢖ࢲ

一࡛ྠ࡜ࢻン࣐ࢥBC2SPRINGࠊࡣ舞いࡿ振ࡢࡑࠋࡍࡲࢀࡉ使用࡚ࡋ࡜ࢺ࢛ࣝࣇࢹࡀࢀࡇࠊࢀࡉ修ṇࡀࢫࢡࢵ
 ࠋࡍ

 ࢘ࢻン࢕࣭࢘ࢱ࢕ࢹ࢚

 Edit > Decrease Indent㸦Ctrl+[㸧࣐ࢥンࡀࢻṇ常࡟動作ࠋࡍࡲࡋ 

 ࢫ࣮࣋ࢱ࣮ࢹ

 ࣮ࣟ࢝ࣝᗙ標ࡀ使用ࡿࢀࡉ場合ࡢ RBE2ෆ部処理࡟関ࡿࡍ DOFࡢࣝࣂ࣮ࣟࢢࡽ࠿࣮ࣝ࢝ࣟࡢᗙ標系ࡢ࡬変換
計算ࡀṇ常化ࠋࡓࡋࡲࢀࡉ 

 ࣮ࣔࠊࡣࣉ࣮࢙ࢩࢻSORT࣐ࢥン࡛ࢻ共振周波数ࢆ並࡭替えࡣࢀࡇࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿ昇㡰࡚ࡗ࡞࡟い࡞い࢖
ン࣏࣮࡟࡝࡞ࢻ࣮࣭ࣔࢺࢫࢸࢺ使用ࠋࡍࡲࢀࡉ 

 ࣝࣈ࣮ࢸ

ࡢࣝࣈ࣮ࢸ Create/Editࡿࡅ࠾࡟ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲMove Up/Down࣎ࢱン操作ࡀ࣮࢚ࣛࡢ修ṇࠋࡓࡋࡲࢀࡉ 

Parametersࢆ࣭ࣝ࣋ࣛࢱ࣮࣓ࣛࣃࡢࣝࣈ࣮ࢸ編集ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

 ࢫࢡࢵ࢕ࣇࣛࢢ

ࡇࡓࢀ現ࡀ࢘ࢻン࢕࣭࢘ࢫࢡࢵ࢕ࣇࣛࢢ黒いࡤࡋࡤࡋࠋࡓࡋࡲࢀࡉ修ṇࡀ࣮࢚࣭ࣛࣗࢩࢵࣞࣇ࣭ࣜࢫࢡࢵ࢕ࣇࣛࢢ

 ࠋࡓࡋࡲࢀࡉ修ṇࡀ࡜
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 信号処理ࣝࢱࢪࢹ

 DSP FILTER࣐ࢥンࡣࢻ ZEROPHASEࣜࢱࣝ࢕ࣇン࡟ࡵࡓࡢࢢ新ࡋい࢜ࣙࢩࣉンࢆ追加0ࠋࡓࡋࡲࡋ఩相࢕ࣇ
పいࡾࡼࡣい場合࡞ࢀࡉ補間ࡀࢀ఩相遅ࠋࡍࡲࢀࡉ補間ࡀࢀ఩相遅ࠊࡾࡼ࡟࡜ࡇࡿࡍ࡟ン࢜ࢆࢢンࣜࢱࣝ

ORDER番号ࢆ使用ࡉࡔࡃ࡚ࡋいࠋ 
 非ࢧンࣜࣉンࠊࢢ縮ᑠࢧンࣜࣉンࡼ࠾ࢢび再ࢧンࣜࣉンࡢࡵࡓࡢࢢ DSP࣐ࢥンࣉࢵ࢔ࢺ࣮ࢱࢫࠊࡣࢻ時ࡼ࠾

び終了時ࡢ過渡現象ࢆ縮ᑠࡓࡲࠊࡋ振幅࣮ࣜࢣࢫンࢆࢢ保Ꮡ࡟ࡵࡓࡿࡍ使用ࠋࡍࡲࢀࡉ 

FEMtools Dynamic 

ソ࣮ࣝࣂ 

 ࢔ࢥ外解析ࢥࢆン࢕ࢸࢵࢭࡿࡍ࣮ࣝࣟࢺン࡟ࢢ関࣓ࣗ࢟ࢻࡿࡍンࡀࣉࣝ࣊ࠊࢺ追加ࠋࡓࡋࡲࢀࡉ 

SET DYNAMIC COREMODE  
SET DYNAMIC CORESIZE  
DYNAMIC COREMODE  
DYNAMIC CORESIZE 

周波数解析と調和応答解析 

 調和応答解析㸦Harmonic response analysis㸧ࣝࢲ࣮ࣔࠊࡣ法࡜直接法ࢆṇ確࡟使用࡟ࡵࡓࡿࡍ改善ࡋࡲࢀࡉ
 ࠋࡓ

 FRF࡜HRAࡢ検証例ࠊ࡚ࡋ࡜新ࡋい例題࣮ࢲ࢛ࣝࣇ：..\examples\dynamic\harmonic\verificationࡀ追加ࡋࡲࢀࡉ
 ࠋࡓ

 要素࣮ࣃ࣮ࢫ

 NASTRAN࢖࣭ࢫࢡࢵ࣑࡜࣮ࣜࣇン࣮ࣃ࣮ࢫ࣭ࢫ࢖࢙ࣇ࣮ࢱ要素ࠊࡽ࠿既࡟支持ࠊ拘束࢖ࡓࢀࡉン࢖࢙ࣇ࣮ࢱ
࡜࣮ࣜࣇࡢࡽࢀࡇࠊࡣ࣮ࣂࣝࢯFEMtoolsࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍࡁ書ࡳㄞ࡟DMIGࠊ加え࡚࡟要素࣮ࣃ࣮ࢫ࣭ࢫ
ࡵࡓࡢ目的ࡢࡇࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ計算ࢆࢻṇ規࣮ࣔࡓ備えࢆ要素࣮ࣃ࣮ࢫ࣭ࢫ࢖࢙ࣇ࣮ࢱン࢖࡞ࢫࢡࢵ࣑

 ࠋࡓࡋࡲࢀࡉ更新ࡀࣂ࢖ࣛࢻࡢcdsolver.bas࡜nastran.basࠊ࡟
 ANSYS ࣮ࣃ࣮ࢫ要素ࢫࢭࣟࣉ㸦Processing ANSYS Superelements㸧ࣙࢩࢡࢭࡢンࠕࠊࡀANSYS࢖ン࢙ࣇ࣮ࢱｲ

 ࠋࡍࡲࢀࡉ追加࡟ࠖࢻ࢖࢞ࢨ࣮࣭ࣘࣂ࢖ࣛࢻ࡜ࢫ

 解析ࢺࢫࢸࣜࣉ

 選択࣮ࢧンࢭ࣭ࣝ࢔ࣗࢽ࣐

 RBEࡀࢻ࣮ࣀ選択ྍ能ࠋࡓࡋࡲࡾ࡞࡟ 
 ࢻ࣮ࣀ選択࡟ࢻ࣮ࣀ࣭ࢫ࢖࢙ࣇ࣮ࢧࠊࡣ制限ࠋࢇࡏࡲࢀࡉ 

 ᭷効質量㸦MEF:Modal Effective Mass㸧ࣝࢲ࣮ࣔ

MEFࡢ計算ࠊࡣ剛体࣮ࣔࢻ質量ࢆ計算࡟ࡁ࡜ࡿࡍ非拘束 DOFࢺࢵࢭ㸦A-Set㸧࡟制限ࡓࢀࡉ剛体࣮ࣔࡶ࡟ࢻ実行ࡉ
 ࠋࡍࡲࢀ

新ࡋい例題ࠊࡀ࣮ࢲ࢛ࣝࣇMEFࡢ計算ࢆ実証ࡘ࠿ࠊࡋ結果ࢆ NASTRAN࡜比較࡟ࡵࡓࡿࡍ付ࡅ加えࡲࢀࡽ
 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆexamples\pretest\mef\.ࠋࡍ
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 刺激解析㸦MPA: Mode Participation Analysis㸧ࢻ࣮ࣔ

Mode Participation Analysisࡢࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ Edit ࡜ Deleteࢱ࣎ࡢンࡀṇࡃࡋ動作ࠋࡍࡲࡋ 

 ン編集࢖ࣛࢫ࣮ࣞࢺ

ࢸࢵࢭいࡋ新ࠊ࡟ࡵࡓࡍ示ࢆࢺࢵࣟࣉ࣭࢔࣌ࢺン࢖࣏࣭ࢻ࣮ࣀ࡟ࡾ代わࡢࢺࢵࣟࣉ࣭ࣝࢹ࣭ࣔࢺࢫࢸ࣭ࢺ࢛ࣝࣇࢹ

ࡣࢀࡇࠋࡍࡲࢀࡉ追加࡟ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲEdit Tracelinesࠊࡀࢢン࢕ FEࣔࢆࣝࢹ表示࢖ࣛࢫ࣮ࣞࢺࠊࡋンࡢ生
成や編集࡟ࢫࢭࣟࣉࡢ᭷用࡛ࠋࡍ 

ࢆUse Node-Point Pairs Plotࠊࡁ開ࢆࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲࠊTools > Pretest Analysis > Edit Tracelines࡛ࠊࡣ࡟ࢀࡑ
࢜ンࠋࡍࡲࡋ࡟ 

 

相関分析 

EVO計算と修正 

 ࡢࢫࢡࢵࣜࢺ࣐࣭࣒ࢸࢫࢩ縮ᑠࠊࡣ常࣮ࣝ࢝ࣟࠊ࡟ᗙ標系࡛実行ࠋࡍࡲࢀࡉ 
 ࣮ࣟ࢝ࣝᗙ標系ࠊࡀFEMtoolsࡼ࠾びNASTRANࡢ࣮ࣂࣝࢯ両方ࡢ中ࡢ参照CS ID-1࡟関࡚ࡋ強化ࠋࡍࡲࢀࡉ以前

ࡋࡲࡾあࡀ࡜ࡇࡍࡇ起ࡁ引࡟୙ṇ使用ࡢCS࣮ࣝ࢝ࣟࠊࡵࡓࡢ1ࠊࡣNASTRAN࡛ࠊࡾ0࡛あࠊࡣFEMtools࡛ࠊࡣ
 ࠋࡓ

 ࣮ࣟ࢝ࣝࡢMPCࠋࡍࡲࢀࡉࢺ࣮࣏ࢧࡀ 
 縮ᑠ࣐࡜ࢫࢡࢵࣜࢺ縮ᑠࡀࣉ࣮࢙ࢩ互換性ࡼࡘࡶࢆう࣮ࢱࢫ࣐ࠊ࡟DOF࣮࢜࢔࣌࡜࣮ࢲDOF࣮࢜ྠࡀ࣮ࢲ期ࡉ

 ࠋࡍࡲࢀࡽࡏ
 ࣐࣮ࢱࢫDOFࡀ境界条件あࡿいࡣ孤立ࡼࡢࢻ࣮ࣀࡓࡋう࡟非ࣈ࢕ࢸࢡ࢔DOF࡚ࡋ࡜定義ࡿࢀࡉ場合ࢳࡣࢀࡑࠊ

 ࠋࢇࡏࡲࢀࡉや許ࡣࡶࠊࢀࡉࢡࢵ࢙
 複素ࡀࢺ࣮࣏ࢧࡢࢻ࣮࣭ࣔࢺࢫࢸ追加ࠋࡍࡲࢀࡉ 

 ࢢン࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔ

 選択ࡢࢫン࣏ࢫとࣞࢱ࣮࣓ࣛࣃ

 ࣙࢩ࣮࣭ࣞࣜࢱ࣮࣓ࣛࣃン࡟関࣓ࣗ࢟ࢻࡿࡍンࡀࢺ改訂ࠊࢀࡉ多ࡢࡃ例証࡛ᣑ張ࠋࡍࡲࢀࡉ 
 総括的࡚ࡋ࡜ࢱ࣮࣓ࣛࣃ使用࣐ࢥ ࡢࢺࣉࣜࢡࢫ࣭ࢫࢭࣟࣉࡿࢀࡉンࢻSET PARAMETER SCRIPTࡀSHOW 

PARAMETER࡛表示ࠋࡍࡲࢀࡉ 
 ࣐ࢥンࢻMODIFY PARAMETERࠊࡣLABELࠋࡍࡲࡋࢺ࣮࣏ࢧࢆ 
 ࣝࣈ࣮ࢸ࣭ࢱ࣮࣓ࣛࣃࠊࡣ࣭ࣝ࣋ࣛࢱ࣮࣓ࣛࣃ中࡛編集ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 
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感ᗘ解析 

 感ᗘ࣮࢝ࣛ―࣭ࢥンࠊࡣࢺࢵࣟࣉ࣭࣮ࢱ総括的࡟ࢱ࣮࣓ࣛࣃ作用ࠋࢇࡏࡲࡋ材料あࡿいࡣ幾何学的࡞要素ࣟࣉ
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇ選ぶ࡟ࢺࢵࣟࣉ࣭࣮ࢱンࢥ࣭―࣮ࣛ࢝ࡀࡳࡢࢱ࣮࣓ࣛࣃࡿࡍ関係࡟࢕ࢸࣃ

 ࡢ࣒࣮ࣅIYࠊIZࡼ࠾びࣜࣉࢫンࡢࢢKTࠊKRࡢࢱ࣮࣓ࣛࣃࡢṇ規化感ᗘ値࡟0ࠊࡣ設定ࡢࡽࢀࡑࠋࡍࡲࢀࡉ初
期値0࡛ࡀࢱ࣮࣓ࣛࣃあࡿ場合0ࡢࡇࠊ値ࠊ࡚ࡗࡼ࡟NaNࡀⓎ生ࢆ࡜ࡇࡿࡍ回避ࠋࡍࡲࡋ 

 値ࡢࢱ࣮࣓ࣛࣃࡢ番号࡟関ࡿࡍ警告ࠕWarning : … zero valued parameter(s) were detected, starting at parameter 
 ࠋࡓࡋࡲࢀࡉ追加ࡀࠖ.The corresponding sensitivities are set to zeroࠕࠊࠖ…

最適化解析 

NLP 

新ࡋい例題ࡀ高次関数㸦࣮࢝ࢺࢵ࢕ࣇࣈ㸧ࡢ஧次近似係数ࢩࡿࡼ࡟ンࢺࢡ࢙ࢪࣈ࣭࢜ࣝࢢ最適化問題ࢆ実証ࡓࡿࡍ

 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆexamples\nlp\fit\..ࠋࡍࡲࢀࡽ加えࡅ付࡟ࡵ

ABAQUS࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

SIMࣝ࢖࢓ࣇ 

新ࡋい࢖ン࢙ࣇ࣮ࢱｲࠊ࡚ࡋ࡜ࢫSIMࠊࢀࡉࢺ࣮࣏ࢧࡀࣝ࢖࢓ࣇ要素࣐࢖ࢆࣉ࣮࢙ࢩࢻ࣮ࣔ࡜ࢫࢡࢵࣜࢺン࣏࣮ࢺ
 ࠋࡍࡲࢀࡉ生成࡚ࡋ࡜.ᣑ張子.simࣝ࢖࢓ࣇ࡚ࡗࡼ࡟ABAQUSࠊࡣࣝ࢖࢓ࣇࡢࡽࢀࡇࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ

ࡢ次ࠊ࡚ࡋ࡜ࣝ࢖࢓ࣇ࣭ࢢン࢕ࢸࢵࢭFEMtoolsࠊ࡟ࡵࡓࡴ込ࡳㄞࢆࣉ࣮࢙ࢩࢻ࣮ࣔ࡜ࢫࢡࢵࣜࢺ要素࣐ࡢࡽࢀࡑ
 ࠋࡍࡲࢀࡉ追加ࡀsimᣑ張子設定.࡞うࡼ

STIFFNESS.ABAQUS.RB=ABAQUS (Binary):*.fil;*.sim 
MASS.ABAQUS.RB=ABAQUS (Binary):*.fil;*.sim 
MODE.ABAQUS.RB=ABAQUS (Binary):*.fil;*.odb;*.sim 

SIMࡢࣝ࢖࢓ࣇ生成方法 

次ࡼࡢうࡀࣉࢵࢸࢫ࡞ INP࡟ࣝ࢖࢓ࣇ追加ࠋࢇࡏࡲࡾ࡞ࡤࢀࡅ࡞ࡋ 

*STEP  
*MATRIX GENERATE, ELEMENT BY ELEMENT, STIFFNESS, MASS  
*END STEP 

入力ࡀྡࣝ࢖࢓ࣇ jobname.inpࡢ場合ࢫࢡࢵࣜࢺ࣐ࠊ出力ࣉࢵࢸࢫ数࡟応ࢆࣉࢵࢸࢫࡓࡌ伴う
 ࠋࡍࡲࢀࡉ生成ࡀࣝ࢖࢓ࣇࡓࢀࡽࡅ前付ྡ࡜jobname_X<step>.simࠖ"ࠕ

SIMࢆࣉ࣮࢙ࢩࢻ࣮ࣔࡢࢺࢵ࣐࣮࢛ࣇ生成ࠊࡣ࡟ࡿࡍ解析࡛ࣉࢵࢸࢫ"*RESTART, WRITE"࣐ࢥンࢆࢻ指定ࡲࡋ
 ࠊࡤ例えࠋࡍ

*STEP  
*FREQUENCY, EIGENSOLVER=LANCZOS, NORMALIZATION=MASS  
50, 10, 1e+030  
*RESTART,WRITE *END STEP 

ࡢいうྡ࡜jobname.simࠖࠕࠊ࡟最初ࠊࡋ追加出力ࢆࣉ࣮࢙ࢩࢻ࣮ࣔ࡟࡜ࡈࣉࢵࢸࢫࡿࡍ対応ࠊࡣࢀࡇ SIMࣝ࢖࢓ࣇ
 ࠋࡍࡲࡋ生成ࢆࣝ࢖࢓ࣇいう࡜ "<jobname_X<step"ࠊ࡟࡜ࡈࣉࢵࢸࢫࡃ⥆ࠊࡋ出力ࢆ

Abaqus 6.12ࡼ࠾ 6.14ࠊ6.13ࠊび現ᅾ㸦2016 &2017㸧ࣙࢪ࣮ࣂࡢンࠋࡍࡲࢀࡉࢺ࣮࣏ࢧࡀ 
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SIMと ODBࣉ࣮࢙ࢩࢻ࣮ࣔࡢ 

SIMࢆࢻ࣮࡚ࣔࡋ࡜出力ࠊࡣ࡜ࡇࡿࡍODB࡜比較࡚ࡋ長所ࡀあࠋࢇࡏࡲࡾ 

SIMࠊࡣࢱ࣮ࢹODBࡼࡢう࡞複素࣮࣮ࣔࣝ࢝ࣟࡣࢻ࣮ࣔࠊࡓࡲࠋࢇࡏࡲࡋࢺ࣮࣏ࢧࢆࢻᗙ標系࡛出力ࠋࡍࡲࢀࡉ
 ࠋࡍࡲࡾ࡞࡟必要ࡀ補足処理ࡿࡼ࡟写像ࠊࡣ࡟ࡿࡍ変換࡬ᗙ標ࣝࣂ࣮ࣟࢢࢆᗙ標系࣮ࣝ࢝ࣟࡢࡑ

格納ࡣ࡟FEMtoolsࠊࡀࡍࡲい࡚ࢀࡉࢺ࣮࣏ࢧ࡚ࡗࡼ࡟ࢫｲ࢙ࣇ࣮ࢱン࢖SIMࠊࡣ᭷効質量ࠊ激係数่ࠊ質量ࢻ࣮ࣔ
 ࠋࢇࡏࡲࢀࡉ

SIM࣮ࣔࡢࢻ要素ෆ部 DOF㸦C3D8iࡼࡢう࡞㸧ࣝࢲ࣮ࣔࡢ変఩ࡣㄞࡳ込ࠊࡀࡍࢀࡲ実際ࡢ物理的ࡣ࡟ࢻ࣮ࣀ࡞写
像ࡢࡽࢀࡑࠋࡓࡋ࡛ࢇࡏࡲࢀࡉෆ部 DOFࠊ࡟ࡵࡓࡿࡍࢺ࣮࣏ࢧࢆࢱ࣮ࢹ要素࣐࡟ࢫࢡࢵࣜࢺ写像ࠊࢀࡉDOF計算
㡯ࡢ.sim࣐࡜ࢫࢡࢵࣜࢺ完全࡞互換性ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆ 

SIMと要素࣐ࢫࢡࢵࣜࢺ用ࡢ FILࡢ比較 

SIMࡽ࠿ㄞࡳ込ࡣࢫࢡࢵࣜࢺ࣐ࡿࢀࡲいࡢ࠿ࡘࡃ長所ࢆ持ࠋࡍࡲࡕ 

 FILࡣࡶࠊࡣࢺࢵ࣐࣮࢛ࣇやᪧ式ࠋࡍ࡛ࢺࢵ࣐࣮࢛ࣇࡢ 
 FILࠊࡣࢺࢵ࣐࣮࢛ࣇFEM解析ࡀ実行࡞ࢀࡉい場合࡟生成ࠊࡀࢇࡏࡲࢀࡉSIMࡢࡑࠊࡣ࡛ࢺࢵ࣐࣮࢛ࣇ生成ࡀ

 ࠋࡍࡲࢀࡉࢺン࣓ࣜࣉン࢖࡟㸦abaqus.bas㸧中ࣂ࢖ࣛࢻ方法࡛ABAQUSࡢ次ࡣࢀࡇࠋࡍࡲࢀࡉࢺ࣮࣏ࢧ
 
'FEM Derivation  
Case 4  
Call Dgn_TimeStamp("abaqus", "Write FEM derivation tmp  
data.")  
If UCase(MatrixFormat) = "SIM" Then  
Print #1, "*STEP"  
Print #1, "*MATRIX GENERATE, ELEMENT BY ELEMENT,  
STIFFNESS, MASS"  
Print #1, "*END STEP"  
Else ...  
Because there is no need 
 
解࡞ࡓ新ࠊࡶい࡚࠾࡟NASTRANやANSYSࠋࢇࡏࡲࡋ࡜必要ࢆ時間࡞ࡓ新ࡿ࠿࠿࡟保Ꮡࡢ解析時࡚ࡗࡼ࡟ࢀࡇ
析ࢆ必要࡞ࡋ࡜い個別ࢫࢡࢵࣜࢺ࣐ࡢ出力ࠋࡍࡲࢀࡉࢺ࣮࣏ࢧࡀ 
 
FILࠊࡣ࡛ࢺࢵ࣐࣮࢛ࣇ解析ࢆ行࡞わࢆࢱ࣮ࢹ࣭ࢫࢡࢵࣜࢺ࣐ࠊ࡟ࡎ出力ࣙࢩ࣮ࣗࣜࢯࡿࡍンࢀࡉࢺ࣮࣏ࢧࡣ
 ࠋࢇࡏࡲ

 ࡢ࡚࡭ࡍ要素࣐ࠊࡀࢫࢡࢵࣜࢺSIM࠾࡟い࡚利用ྍ能࡛あࠊࡾFIL࣐ࡣ࡟ࣝ࢖࢓ࣇ࣭ࢫࢡࢵࣜࢺ出力࡞ࢀࡉい
DOFࠋࡍࡲࢀࡉࢺ࣮࣏ࢧࡀFEMtools SIM࢖ン࢙ࣇ࣮ࢱｲࠊࡣࢫ必要࡟応࡚ࡌ要素DOF㸦C3D8i㸧ࡢᅽ縮ࢆ行࡞
いࠋࡍࡲ 

 ࣐࢖࣭ࢫࢡࢵࣜࢺン࣏࣮ࢫࢭࣟࣉࡢࢺ情報ࢆ示ࠋࡍࡲࡋ 
 将来的ࠊࡣ࡟*MATRIX GENERATEࠊELSET=要素ࢫࢡࢵࣜࢺ࣐࡚ࡗࡼ࡟ྡࢺࢵࢭ要素ࢆᢳ出ྍࡀ࡜ࡇࡿࡍ能

 ࠋࡍࡲࡾ࡞࡟能ྍࡀ࡜ࡇࡿࡍࢫࢭࢡ࢔࡟ࢫࢡࢵࣜࢺ࣐ࡢ指定ࠊ࡚ࡗࡼ࡟ࢫࢡࢵࢹン࢖SIM要素ࡢࡇࠋࡍ࡛

例 

SIM࢖ン࢙ࣇ࣮ࢱｲ࡟ࢫ関ࡿࡍ新ࡋい次ࡢ例題ࠊࡀ..\examples\interfaces\abaqus࡟追加ࠋࡓࡋࡲࢀࡉ 

FE Model: small_plate*.inp  
Modes : small_plate*.sim  
Stiffness and Mass Element Matrices: small_plate*_X2.sim 
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 ࢢン࢕ࢸࢵࢭ࣭ࣂ࢖ࣛࢻࡢ用ࢺࢵ࣐࣮࢛ࣇ࣭ࢫ࢖࢙ࣇ࣮ࢱン࢖࣭ࢺ࢛ࣝࣇࢹ

SIM࢖ン࢙ࣇ࣮ࢱｲࠊࡣࢫᪧ FIL࡟ࢺࢵ࣐࣮࢛ࣇ代わࡿ要素࣐࢖ࡢࢫࢡࢵࣜࢺン࣏࣮࢖࣭ࢺ࢛ࣝࣇࢹ࡟ࡵࡓࡢࢺン
࡜ࡇࡿࡍ࡟ࢺࢵ࣐࣮࢛ࣇࡢࢺ࢛ࣝࣇࢹࢆFILࠊࡋ使用ࢆࣝ࢖࢓ࣇFILࠊࡋࡔࡓࠋࡍࡲࢀࡉ設定࡚ࡋ࡜ࢫ࢖࢙ࣇ࣮ࢱ
 ࠋࡍ能࡛ྍࡶ

࡜ࢫࢡࢵࣜࢺ要素࣐ࠊࡋ࠿ࡋࠋࡍ࡛ࢺ࢛ࣝࣇࢹࡀࢺࢵ࣐࣮࢛ࣇODBࠊ࡚ࡗ代わ࡟FILࠊࡣい࡚ࡘ࡟ࣉ࣮࢙ࢩࢻ࣮ࣔ
ྠ様ࠊ࡟FIL࡚ࡋ࡜ࢺ࢛ࣝࣇࢹࢆ設定ྍࡶ࡜ࡇࡿࡍ能࡛ࠋࡍ 

ࡽ加えࡅ付࡟ࣝ࢖࢓ࣇscripts\drivers\abaqus.ini\..ࡀࣜࢺン࢚࡞うࡼࡢ次ࠊࡣ࡟ࡿࡍ設定ࢆࢺࢵ࣐࣮࢛ࣇࡢࢺ࢛ࣝࣇࢹ
 ࠋࡍࡲࢀ

ifile.format=odb  
matrix.format=sim  

"file.format" can be set to FIL or ODB  
"matrix.format" can be set to FIL or SIM 

ABAQUSࠊࡣࣂ࢖ࣛࢻabaqus.iniࡢࡽࢀࡇ࡟ࣝ࢖࢓ࣇ変更࡟ࡵࡓࡿࡍࢺ࣮࣏ࢧࢆ修ṇࠋࡍࡲࢀࡉ 

修正さࢀた ODBࣉࢵࢸࢫ選択 

interface.abaqus.step変数ࡣ次ࢆࡢࡶࡢㄞࡴ込ࢆࣉࢵࢸࢫࡴ指定࡟ࡵࡓࡿࡍ使用ࠋࡍࡲࢀࡉ 

 ṇࡢ値ࠊࡣඛ頭ࡢࡽ࠿昇㡰ࢆࣉࢵࢸࢫ示ࠋࡍ 
 ㈇ࡢ値ࠊࡣ最終ࡢࡽ࠿降㡰ࢆࣉࢵࢸࢫ示ࠋࡍ 

-1=最終2-ࠊࣉࢵࢸࢫ=最終ࡽ࠿㸰番目࡝࡞ࣉࢵࢸࢫࡢ 
 0ࡀ指定ࡓࢀࡉ場合࢖ࠊン࣏࣮ࢱ࣮ࢹࡁ࡭ࡿࡍࢺ最終ࡀࣉࢵࢸࢫ示ࠋࡍࡲࢀࡉ 

 ࠋࡓࡋࡲࢀࡉ変更࡟0ࠊࡀࡓࡋ1࡛-ࡣ以前ࠊࡣࢺ࢛ࣝࣇࢹ

例 

静的ࠊࣉࢵࢸࢫṇ規࡜複雑ࡢࢻ࣮ࣔࡢ解析 

Step 1 : 'Step-1' (StaticStep)  
Step 2 : 'Step-2' (StaticStep)  
Step 3 : 'Step-3' (FrequencyStep)  
Step 4 : 'Step-4' (ComplexFrequencyStep)  

FEMtools࣐ࢥンࢻ 

search mode format abaqus 

 ࠊࡣࢻン࣐ࢥࡢ次ࠊࢀࡉ使用ࡀStep 4(ComplexFrequencyStep)ࠊࡣࢀࡇ

search displacement format abaqus 

Step 2  (StaticStep)ࡀ使用ࠋࡍࡲࢀࡉ 

関連付࡟ࣉࢵࢸࢫࡢࢱ࣮ࢹい静的線形࡞ࡲ含ࢆ関連情報ࡢ.odbࠊࡣࡽࢀࡑࠊ場合ࡿࢀࡉ出力࡟sim.ࡀࢫࢡࢵࣜࢺ࣐
 ࠋࡍࡲࢀࡽࡅ

例えࠊࡤ次ࢆࣉࢵࢸࢫࡢ含ࡴ解析࡛ࠊࡣ 
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Step 1 : 'Step-1' (FrequencyStep)  
Step 2 : 'Step-2' (StaticLinearPerturbationStep) 

 ࠋࡍࡲࡋ指ࢆstep=1㸦frequencystep㸧ࠊࡣstep=0ࠊࡁ࡜ࡿࢀࡉࢺン࣏࣮࢖ࡀࢻ࣮ࣔࠊ場合ࡢࡇ

ANSYS࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

 ANSYS ࣮ࣃ࣮ࢫ要素ࢫࢭࣟࣉ㸦Processing ANSYS Superelements㸧ࣙࢩࢡࢭࡢンࠕࠊࡀANSYS࢖ン࢙ࣇ࣮ࢱｲ
 ࠋࡍࡲࢀࡉ追加࡟ࠖࢻ࢖࢞ࢨ࣮࣭ࣘࣂ࢖ࣛࢻ࡜ࢫ

NASTRAN࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

 MSC.Nastran 2018ࢺ࣮࣏ࢧࡢ 
 NASTRAN࢖࣭ࢫࢡࢵ࣑࡜࣮ࣜࣇン࣮ࣃ࣮ࢫ࣭ࢫ࢖࢙ࣇ࣮ࢱ要素ࠊࡽ࠿既࡟支持ࠊ拘束࢖ࡓࢀࡉン࢖࢙ࣇ࣮ࢱ

࡜࣮ࣜࣇࡢࡽࢀࡇࠊࡣ࣮ࣂࣝࢯFEMtoolsࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍࡁ書ࡳㄞ࡟DMIGࠊ加え࡚࡟要素࣮ࣃ࣮ࢫ࣭ࢫ
ࡵࡓࡢ目的ࡢࡇࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ計算ࢆࢻṇ規࣮ࣔࡓ備えࢆ要素࣮ࣃ࣮ࢫ࣭ࢫ࢖࢙ࣇ࣮ࢱン࢖࡞ࢫࢡࢵ࣑

 ࠋࡓࡋࡲࢀࡉ更新ࡀࣂ࢖ࣛࢻࡢcdsolver.bas࡜nastran.basࠊ࡟
 新ࡋい例題ࠊࡣ࣮ࢲ࢛ࣝࣇ..\examples\dynamic\selem\nastran࡟追加ࠋࡓࡋࡲࢀࡉ 
 PSOLIDࠊࡣࢻ࣮࣭࢝ࢱ࣮ࢹ࣭ࢡࣝࣂIN㸦BUBBLEࠊTWOࠊTHREE㸧࡟保Ꮡࠊࡓࡲࠊࢀࡉ冗長的࡟形成ࡓࢀࡉ

要素ࢆ࣮࢚ࣛࡿࡼ࡟回避ࠊ࡟ࡵࡓࡿࡍISOP㸦REDUCEDࠊFULL㸧ࡀࢢࣛࣇ᥇用ࠋࡓࡋࡲࢀࡉ 
 HVM1ࠊHVM2㸦Hencky-VonMises㸧ࡢCTRIA6࡜CQUAD8ࡢ要素ࠊࡣOP2࢖ࡽ࠿ࣝ࢖࢓ࣇン࣏࣮ࠋࡍࡲࢀࡉࢺ 
 MSC.Nastran࡜NX Nastranࡢ互換性ࠊ࡟ࡵࡓࡢALTER࣓ࢺ࣮ࢸࢫンࠊࡣࢺNASTRANࣂ࢖ࣛࢻ中࡛修ṇࡲࢀࡉ

 ࠋࡍ

SAP2000࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

 SAP2000 v19ࢺ࣮࣏ࢧࡢ 
 ࣮ࣔࡀࣉ࣮࢙ࢩࢻSAP2000結果࡛ࣝ࢖࢓ࣇ見࡞ࡽ࠿ࡘい場合ࡀ࣮࢚ࣛࠊ示ࠋࡍࡲࢀࡉ 
 改善ࡓࢀࡉ構造㈈産࢖ン࣏࣮ࡼ࠾ࢺび構造ࡢࡵࡓࡢ資料割ࡾ当࡚ࠋ 
 ࢱ࣮࣓ࣛࣃ：LINK/SUPPORT LINEAR ("linklinear"), K11...K66 B11...B6㸦組ࡳ合わࠊࡏ非組ࡳ合わࡏ㸧࣮࣏ࢧࡢ

 ࢺ
 ࢱ࣮࣓ࣛࣃ：FRAMEMODIFIER処理ࡢ修ṇ 
 SAP2000࢖ン࢙ࣇ࣮ࢱｲ࣮ࣗࣅࣞࡢࢻ࢖࢞ࢨ࣮࣭ࣘࣂ࢖ࣛࢻ࡜ࢫ 

剛体࣮ࢱࢡࣛࢺࢫࢡ࢚࣭࢕ࢸࣃࣟࣉ㸦RBPE㸧 

 FRFࡢ選択ࠊ非選択ࡀṇࡃࡋ考慮ࠋࡍࡲࢀࡉ 

コ࣐ンࢻ 

新ࡋいコ࣐ンࢻ 

SORT ࣮ࣔࡢࡽࢀࡑࠊࡋࢺ࣮ࢯࢆࢻ共振周波数㡰ࡀ付ࠋࡍࡲࢀࡽࡅ 

修正コ࣐ンࢻ 

DSP FILTER 補語 ZEROPHASE0ࠊࡀ఩相ࣜࢱࣝ࢕ࣇン࡟ࡵࡓࡢࢢ追加ࠋࡓࡋࡲࢀࡉ 

MODIFY PARAMETER 補語 LABELࡀ追加ࠋࡓࡋࡲࢀࡉ 
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FEMtools 4.0.1࣓ンࢼࢸンࢫ࣮࣭ࣜࣜࢫ 

FEMtools 4.0.1.1851㸦2018年 1᭶ 5日㸧 

 ࡀࣝ࢖࢓ࣇ࣭ࢺࢵࢤ࣮ࢱ：ࢺࣉࣜࢡࢫ既࡟Ꮡᅾࡿࡍ場合ࡢ FileCopy関数ࢆ実行࡟前ࣝ࢖࢓ࣇ࣭ࢺࢵࢤ࣮ࢱ࡟
 ࠋࡍࡲࡋ削除ࢆ

FEMtools 4.0.1.1860㸦2018年 2᭶ 23日㸧 

 相関ศ析：RBE2 DOF中࣮ࢱࢫ࣐࡟DOFࢆ備えࡓ EVOࢆ実証ࡢࡵࡓࡿࡍ新ࡋい例題ࢆ追加ࠋࡓࡋࡲࡋ 
 RBPE：࣮ࣟ࢝ࣝᗙ標系ࡢࢺ࣮࣏ࢧࡢ改良 
 ࣓ࣗ࢟ࢻンࡢࣝ࢔ࣗࢽ࣐：ࢺ改訂 

FEMtools 4.0.1.1861㸦2018年 3᭶ 13日㸧 

 MMU：Strainࡼ࠾び総括的࣏ࣞࢫンࡢࢫMMUࢺ࣮࣏ࢧࡿࡼ࡟ 
 ࣐ࢥンࢻ COPY FEM FRFࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲࡢ㸦Database > Copy FEM and Database > Copy Test㸧対応 
 MMU：mmu.basࡢࢺࣉࣜࢡࢫ修ṇ 
 ANSYS࢖ン࢙ࣇ࣮ࢱｲࢫ：大࡞ࡁ RST࢖ࡢࣝ࢖࢓ࣇン࣏࣮ࢭ࢖ࣛࢆࢺンࡿࡍࢫ  ࢺ࣮࣏ࢧࡢ࣮ࢱン࢖64࣏

FEMtools 4.0.1.1862㸦2018年 4᭶ 26日㸧 

 ABAQUS࢖ン࢙ࣇ࣮ࢱｲࣂ࢖ࣛࢻ࡜ࢫ：古い ABAQUSࣙࢪ࣮ࣂンࡢ࡜互換性ࢆ保証ࡢࡵࡓࡿࡍ修ṇ 
 NASTRAN࢖ン࢙ࣇ࣮ࢱｲࣂ࢖ࣛࢻ࡜ࢫ：Strain࣏ࣞࢫンࡢࡵࡓࡿࡍࢺ࣮࣏ࢧࢆࢫ QUAD4要素用ࢺ࡜࣒ࢺ࣎ࡢ

 ࢺ࣮࣏ࢧࡢ࣮ࣂ࢖࢓ࣇ࣭ࣉࢵ
 ࣐ࢥンࢻ RESPONSE STRAIN：ࢥン࣏࣮ࢿンࢺ成ศࡢ  ࢺ࣮࣏ࢧࡢ値ࡢࡘ6
 ࣮࣎ࣂ࢖࢓ࣇࡢࣉࢵࢺ࡜࣒ࢺStrainࢆ指定ࡿࡍ例題：..\updating\strain 
 ࢕ࢸࢵࢭンࢢ：ABAQUS file.format࡜ matrix.formatࡢ改善 
 FRFࢩン࡚ࡋ࡜ࢺ࢛ࣝࣇࢹࢆࢫ࣮࣭࣋ࣝࢲ࣮ࣔ：ࢫࢩࢭ使用ࠋࡿࡍ 
 ࣓ࣗ࢟ࢻンࡢࣝ࢔ࣗࢽ࣐：ࢺ改訂 

FEMtools 4.0.1.1880㸦2018年 8᭶ 28日㸧 

 ࡀࢺࢡ࢙ࢪࣟࣉ FEMtools最新ࣙࢪ࣮ࣂン࡛生成࢖ࢆࣝ࢖࢓ࣇ࣭ࢺࢡ࢙ࢪࣟࣉࡓࢀࡉン࣏࣮ࡓࡋࢺ場合࣏ࣞ࡟
 ࠋࡍࡲࡋࢺ࣮

 材料特性࡜幾何学特性ࢭ࢔࣭ࢫ࣮࣭࣋ࣝࢲ࣮ࣔࢆンࣜࣈ㸦MBA㸧࡟ࢱ࣮࣓ࣛࣃ使用ࡢࡵࡓࡿࡍ修ṇ 
 ࣮ࣔࢭ࢔࣭ࢫ࣮࣭࣋ࣝࢲンࣜࣈ㸦MBA㸧ࡢ改良 
 DEFINE MBA SUBSTRUCTURE࡜ EXTRACT MBA SUBSTRUCTURESࡢ修ṇ：FEM要素ࡀࣉ࢖ࢱ修ṇ要素ࡢ

場合ࢆࣉ࢖ࢱࣈࢧࡢ格納࡚ࡋᢳ出 
 MPE例題ࠕCalibrationࠖࢆ࣮ࢲ࢛ࣝࣇ damping࣒࣮ࢿ࡚ࣜࡋ࡜ 
 ABAQUS࢖ン࢙ࣇ࣮ࢱｲࢫ：剛性࣐ࢡࢵ࢙ࢳࡢࢫࢡࢵࣜࢺ 
 ANSYS࢖ン࢙ࣇ࣮ࢱｲࢫ：ᣑ張子 DATࢺ࣮࣏ࢧࡢࣝ࢖࢓ࣇ㸦CDBࡢ追加㸧 
 SAP2000࢖ン࢙ࣇ࣮ࢱｲࢫ：SAP BACKUP࣐ࢥンࡢࢻ修ṇ 
 RBPE࢜ࢻ࢔ン࣭࣮ࣔࣝࣗࢪ：࣮ࣟ࢝ࣝᗙ標系ࢺ࣮࣏ࢧࡢ 
 ࣓ࣗ࢟ࢻンࡢࣝ࢔ࣗࢽ࣐：ࢺ改訂 

FEMtools 4.0.1.1885㸦2019年 4᭶ 19日㸧 

 ࢺࢫ࣭ࣜࣝ࢖࢓ࣇ：重複ࢆྡࣝ࢖࢓ࣇ非表示ࡢࢢࣂ修ṇ 
 ࣓ࣙࢩ࣮࣓ࢽ࢔：࣮ࣗࢽ࣓࣭ࢫࢡࢵ࢕ࣇࣛࢢ࣭ࣗࢩࢵンࡢ修ṇࡼ࠾び୚え࢕ࢸࢵࢭࡿンࢢ 
 ANSYS࢖ン࢙ࣇ࣮ࢱｲࢫ：大࡞ࡁ入力ࣛ࢖ン長㸦200文Ꮠ180ࠊ前㸧ࢆ CDBࡢࣝ࢖࢓ࣇ新ࡋい㸦19i10㸧

EBLOCKࡢ࡬ࢺࢵ࣐࣮࢛ࣇ変換ࢺ࣮࣏ࢧࡢ㸦ansys.dll㸧 
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 NASTRAN࢖ン࢙ࣇ࣮ࢱｲࢫ：ply定義ࢱ࣮ࢹ㸦PCOMP㸧࢖ࡢン࣏࣮ࢺ࣮࣏ࢧࡢࢺ㸦nastran.dll㸧 
 NASTRAN࢖ン࢙ࣇ࣮ࢱｲࢺࢵࢭࣇ࢜：ࢫ慣性ࢆ࢕ࢸࣃࣟࣉ持ࡘ集中質量㸦CONM2㸧ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆ

CONM2࢖ࡣン࢙ࣇ࣮ࢱｲ࡚ࡗࡼ࡟ࢫ CONM1࡚ࡋ࡜変換ࡢࡑࠊࡀࡍࡲࢀࡉࢺ࣮࣏ࢫࢡ࢚ࢀࡉ CONM࡟ࢻ࣮ࣀ
࣮ࣟ࢝ࣝ軸ࡢ計算ࡀ使用ࢆࢁࡇ࡜ࡁ࡭ࡿࢀࡉ෇筒ᗙ標系ࡢ原点࣮ࣝ࢝ࣟࡢ軸ࡀ計算࡟使用ࠊࢀࡉ慣性ࡢࢱ࣮ࢹ

変換ࡣ୙ṇ確࡛ࠋࡓࡋ 
 ࣐ࡢࣝ࣋ࣛ：ࢺ࣮࣏ࢫࢡ࢚ࡢࢫࢡࢵࣜࢺ修ṇ㸦row ࡜ columnࡀࣝ࣋ࣛࡢษࡾ替え㸧㸦EXPORT MATRIX 

FORMAT MATRIX; File > Export > FEMtools Matrices㸧 
 ࣮ࣔࢻ解析：࣐࣮ࢱࢫDOFࡢ縮ᑠࡀ選択࡚ࢀࡉいࡿ場合ࠊ要素࣐ࢫࢡࢵࣜࢺ Kࡼ࠾び㸦ࡣࡓࡲ㸧Mࢱ࣮ࢹࡀ

 ࠋࡍࡲࢀࡉ計算࡚ࡋ使用ࢆࢢン࢕ࢸࢵࢭ࣭ࢺ࢛ࣝࣇࢹࠊい場合࡞ࡋᏑᅾ࡟ࢫ࣮࣋
 DFRFࡢ代わ࡟ࡾ DIRECTFRF࣐ࢥンࢆࢻ使用ࡓࡋ dynamic\frf\pade\pade_sms_beam.cmd例題ࡢ修ṇ：࣐ࢥンࢻ

DFRFࡣᪧ式࡛ࠋࡍ 
 例題：ࣝ࢖࢓ࣇ updating\jimbeam\2D_SI\jimbeam.pdfࡢ修ṇ 
 例題：..\updating\text_parametersࡢࣂ࢖ࣛࢻ࣭࣮ࣂࣝࢯ࣭࣒ࢱࢫ࢝ࡢ修ṇࠊࡋࡔࡓࠊ相関性結果ࡣ更新ࡲࢀࡉ

  ࠋࢇࡏ
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FEMtools 4.1 更新情報  

FEMtools 4.1ࠊࡣFEMtools࣒࣮ࣞࣇワ࣮ࡼ࠾ࢡびࢺࢫࢸࣜࣉ解析ࢆࢻ࣮ࣞࢢࣉࢵ࢔ࡢ࣮ࣝࢶ含ࡴ新ࣙࢪ࣮ࣂン࡛
 ࠋࡍ

FEࢺࢫࢸ相関ศ析ࠊ感ᗘ解析࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࠊンࠊࡣࢢStrain㸦歪ࡳ㸧࣏ࣞࢫンࡲࠋࡍࡲࡋࢺ࣮࣏ࢧࢆࢫ
最新ࠊࡀࣂ࢖ࣛࢻ࡜ࢫ࢖࢙ࣇ࣮ࢱン࢖࣭ࢱ࣮ࢹFEࠊࡓ FE࡟ࡵࡓࡢࢺ࣮࣏ࢧࡢ࣒ࣛࢢࣟࣉ更新ࠋࡍࡲࢀࡉ 

 ࠋࡍࡲࡋ要約࡟以ୗࢆࢺ࢖ࣛ࢖ࣁࡢࢫ࣮ࣜࣜࡢࡇ

 ンと構成ࣙࢩ࣮ࣞࢺࢫン࢖

新ࡋい Sentinel HL Pro Driverlessࡀࢺ࣮࣏ࢧࡢ追加ࢻࡢࡇࠋࡓࡋࡲࢀࡉンࠊࡣࣝࢢWindowsࡼ࠾び Linux OSୖࣀࡢ
 ࠋࡍࡲࢀࡉ使用࡟共࡜ࢫンࢭ࢖࣭ࣛࢡࢵࣟࢻ࣮

 㸦Framework㸧ࢡワ࣮࣒࣮ࣞࣇ

 一次要素ࡽ࠿஧次要素ࡢ࡬変換機能ࡢ追加 
 ࢖ࣛࢫ࣮ࣞࢺࡢࣝࢹ࣭ࣔࢺࢫࢸン㸦tracelines㸧ࡢࡽ࠿表面要素ࡢ自動生成 
 ࢺ࣮ࢹࣉࢵ࢔ࡢࣉ࣮࢙ࢩࢻ࣮࣭ࣔࢺࢫࢸ 
 ࢖ンࢺ࣮ࢹࣉࢵ࢔ࡢࢱ࢕ࢹ࢚࣭࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮࣭ࣔࣈ࢕ࢸࢡࣛࢱ 
 Strain࡜ Stressࢸࡢンࡢࣝࢯෆ部計算࡟伴う FEMtools࢖࣭ࢱ࣮ࢹࡓࡲࠊࢺ࣮࣏ࢧࡢࢫ࣮࣋ࢱ࣮ࢹン࢖࢙ࣇ࣮ࢱ

 ࢺ࣮࣏ࢧࡢ機能ࢺン࣏࣮࢖ࡢࢫ
 ࡢ࡛ୖࣝࣈ࣮ࢸ Strain࡜ Stressࢸࡢンࢺ࣮࣏ࢧࡢࣝࢯ 
 長いࣜࢺࢫ㸦例えࠊࡤ要素ࣜࢺࢫ㸧ࢆ選択ྍࡀ࡜ࡇࡿࡍ能ࢥ࡞ン࣎࣎ࡀࢫࢡࢵ使用ࡢࡑࠊࢀࡉ操作ࡿࡅ࠾࡟迅

速性ࡀ計ࠋࡍࡲࢀࡽ 
 新ࡋいࢻ࣮࣎ࣉࢵࣜࢡࡀ࣮ࣝࢶ࣭࣮ࣕࢳࣉ࣭ࣕ࢟ࢫࢡࢵ࢕ࣇࣛࢢあࡿいࡿࡍ࣮ࣆࢥ࡬ࣝ࢖࢓ࣇࡣ前࢕ࣇࣛࢢ࡟

 ࠋࡍࡲࢀࡉ追加࡟ࡵࡓࡿࡍࢆ変更ࢬ࢖ࢧや࣮ࣕࢳࣉࣕ࢟ࡢ࢘ࢻン࢕࣭࢘ࢡࢵ
 回転㸦ࢡࢵ࣑ࢼ࢖ࢲ㸧中心ࢆ設定ࡢࡵࡓࡿࡍ新ࡋい࣎ࢱン࡟࣮ࣂ࣮ࣝࢶ࣭ࢫࢡࢵ࢕ࣇࣛࢢࡀ追加ࠋࡓࡋࡲࢀࡉ 
 新ࡋいࣙࢩ࣮࣓ࢽ࢔ン࣭ࢥンࣉࢵࢸࢫࠊࣉࢵࢺࢫ／ࢺ࣮ࢱࢫࡀࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ࣭࣮ࣝࣟࢺ前進／後㏥ࡓࡢ

ࡲࡾ࡞࡟能ྍࡶ࡜ࡇࡿࡍ࣮ࣝࣟࢺンࢥࢆ࣮ࣝࢣࢫび振幅ࡼ࠾ン速ᗘࣙࢩ࣮࣓ࢽ࢔ࠊࡓࡲࠋࡓࡋࡲࢀࡉ追加࡟ࡵ

 ࠋࡓࡋ
 ࣮࢝ࡢࢻ࣮࣮࣎࢟ࡣ࣮࢝ࢵࣛࢺࣈ矢印࣎ࢱンࢆ使用ࠊࡋ移動ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 
 ࣙࢩ࣮࣓ࢽ࢔࣭ࣉ࣮࢙ࢩンࡀ࣮ࣛ࢝ࡢ変形振幅࡟応࡚ࡌ設定ྍ能ࠋࡓࡋࡲࡾ࡞࡟ 
 ࢥン࡟ࢺࢵࣟࣉ࣭࣮ࢱ使用ࡿࢀࡉ間隔数ࡼ࠾び凡例࣮࢝ࣛࢆ指定ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 
 10࡛ࡲ㸦毎秒㸧ࣉࢵ࢔ࢻ࣮ࣆࢫࡢ係数ࢆ指定ࡼࡿࡍうࡢࢻ࣮ࢥ࡞最適化࡟対応ࢼ࢖ࢲࡾࡼ࡟ࢀࡇࠋࡓࡋࡲࡋ

 ࠋࡍࡲࡋ回避ࢆపୗࡢ表示機能ࢡࢵ࣑
 ࡣ࢔࣮ࣗࣅ࣭ࢫࢡࢵ࢕ࣇࣛࢢ Strain࡜ Stressࢸࡢンࣝࢯ表示ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆ 
 QUAD8要素公式ࡢ改善ࡾࡼ࡟Ᏻ定性࡜高速化ࡀ計ࠋࡓࡋࡲࢀࡽ 
 FEMtoolsࡣ࣮ࣂࣝࢯ ILP64㸦8ࢺ࢖ࣂ㸧整数࢖ンࢫࢡࢵࢹ付ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆࡅILP64ᣑ張࣏࢖ン࢖࣭࣮ࢱ

ンࢫࢡࢵࢹ付ࡾࡼ࡚ࡗࡼ࡟ࡅ大࡟ࢺࢵࢭࢱ࣮ࢹ࡞ࡁ対応ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 
 静解析ࣝࢲ࣮ࣔࠊ Stressࡼ࠾び Strainࡢ計算ࡀᣑ張2ࠊࢀࡉD࡜ 3Dࡢ要素ࠋࡍࡲࢀࡉࢺ࣮࣏ࢧࡀStrainࡣ節点

ࡢ࡚࡭ࡍࠊࢀࡉ計算࡚ࡋ࡜値ࡢび要素中心ࡼ࠾ Strainࢸンࢥ࣭ࣝࢯン࣏࣮ࢿンࡀࢺ計算ࠊࢀࡉ所定ࡢᗙ標系࡬
ࡣ変更ࡢࡽࢀࡇࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡏࡉ回転ࢆࣝࢯンࢸ Strain࣮࣋ࡢࢫ FEࢺࢫࢸ相関性ྍࢆ能࡟ࡵࡓࡿࡍ࡟
必要࡞条件ࠋࡍࡲࡾ࡞࡟ 

 Strain࣏ࣞࢫンࡢࢫ選択ࢥࠊࡣ࡟ン࣏࣮ࢿンࢺ㸦ṇ規方向㸧࡜ Faceࡢ選択ࡀ必要ࡢࡑࠋࡍࡲࡾ࡞࡟ᗙ標系ࡢ指
定࡛ࡣ自動࣮ࣔࢆࢻ使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

 ࢺࣉࣜࢡࢫ開Ⓨࡢ25ࠊ࡟ࡵࡓࡿࡍࢺ࣮࣏ࢧࢆ新ࡋい FEMtools API関数ࡀ追加ࡢࡽࢀࡑࠋࡍࡲࢀࡉうࡢࡕ ࡣ15
࡜㸦Stressࣝࢯンࢸ Strain㸧࡟ࡵࡓࡢ使用ࠋࡍࡲࢀࡉ 

 ࢫ࢖࢙ࣇ࣮ࢱン࢖࣭ࢱ࣮ࢹ

 Abaqus 2019ࢺ࣮࣏ࢧࡢ 
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 Ansys 19.4㸦2019R2㸧ࢺ࣮࣏ࢧࡢ 
 MSC.Nastran 2019ࢺ࣮࣏ࢧࡢ 
 静的変఩ࠊStrain解析࡟ࢺ࣮࣏ࢧࡢ伴いࠊAbaqusࠊAnsysࠊNastran࢖ン࢙ࣇ࣮ࢱｲࡀࣂ࢖ࣛࢻ࡜ࢫᣑ張ࡋࡲࢀࡉ

 ࠋࡓ
 Nastran࢖ン࢙ࣇ࣮ࢱｲྠ࡜ࢫ様ࠊ࡟AbaqusࠊAnsys࢖ン࢙ࣇ࣮ࢱｲࢼ࣭ࢻ࣮ࣔࡀࢫン࡜࣮ࣂ周波数ࣞン࡟ࢪ基࡙

い࢖ࡢࣉ࣮࢙ࢩࢻ࣮ࣔࡓン࣏࣮ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆࢺ 
 SAP2000 v20ࢺ࣮࣏ࢧࡢ 

動解析㸦Dynamic Analysis㸧 

 ࣮ࣔࢭ࢔࣭ࢫ࣮࣭࣋ࣝࢲンࣜࣈ㸦MBA㸧ࡢ改良 

 解析ࢺࢫࢸࣜࣉ

 ࢖ࣛࢫ࣮ࣞࢺン自動生成ࡣ࣮ࣝࢶ新ࡋい࡚ࡗࡼ࡟࣒ࢬࣜࢦࣝ࢔ᣑ張ࡢࡑࠋࡓࡋࡲࢀࡉ結果ࡣ改善ࡾࡼࠊࢀࡉ多

ࢩࢵ࣓࡞密ࠊࡋ増ࡀ処理速ᗘ࡟ࡵࡓࡿࡍ対応࡟ࢺン࢖࣏ࡢࡃ多࡟特ࠋࡓࡋࡲࡾ࡞࡟能ྍࡀ࣮ࣝࣟࢺンࢥࡢࡃ

࣮ࢹ定義ࢫ࢖࢙ࣇ࣮ࢧࡿࡼ࡟ン装置ࣕ࢟ࢫ࣮ࢨ࣮ࣞࠊࡤ例えࠋࡍࡲࡁ使用࡛ࡶ࡟処理ࡢࢱ࣮ࢹ࣭ࢻࢵࣜࢢࠊࣗ

 ࠋࡍࡲࢀࡉ使用ࡶ࡟ࢱ
 FE࣮ࣔࡢࣉ࣮࢙ࢩࢻ計算࢖ࡣࡓࡲン࣏࣮ࠊࡃ࡞࡜ࡇࡿࡍࢺFEࣔࢭ࣭ࣝ࢔ࣗࢽ࣐ࡢୖࣝࢹンࢆ࣮ࢧ選択ࡇࡿࡍ

 ࠋࡍࡲࡁ࡛ࡀ࡜
 FEࣔࡼ࠾ࣝࢹび࣮ࣔ࢖ࢆࣝࢹ࣭ࣔࢺࢫࢸࠊࡶ࡚ࡃ࡞࡟ࢫ࣮࣋ࢱ࣮ࢹࡀࣉ࣮࢙ࢩࢻン࣏࣮ࠊࡋࢺRotateࢭンࢧ

 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ使用ࢆࣝࢿࣃ࣭࣮
 既Ꮡࢆࣝࢹ࣭ࣔࢺࢫࢸࡢ使用ࠊࡋFEࣔࢆࢀࡑ࡟ࣝࢹ写像࢔࣌ࡢ࡚ࡋ࡜ࣝࢹ࣭ࣔࢺࢫࢸࣜࣉࠊࡋ DOFࢆ使用ࡋ

ン࢖ࣛࢫ࣮ࣞࢺ࡟任意ࠋࡍࡲࡁ࡛ࡀ編集ࡢ࡝࡞移動ࠊ削除ࡢ࣮ࢧンࢭࠊ追加ࡣࣝࢹ࣭ࣔࢺࢫࢸࣜࣉࡢࡑࠋࡍࡲ

 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ追加ࢆ
 自動ࢭン࣮ࢧ選択方法㸦ṇ規表面఩置ࠊ統計計算ࠊ最大MAC表記ࠊ固定ࢭン࣮ࢧ఩置ࡢ使用方法࡝࡞㸧ࡀ修

ṇࠋࡓࡋࡲࢀࡉ 

相関分析 

 静的変఩ࡼ࠾び Strain࣮࣋ࡢࢫ相関ศ析࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔ࡜ンࡢࢢ新ࡋい例題ࡀ追加ࠋࡓࡋࡲࢀࡉ 

感ᗘ解析とࣔ࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹンࢢ 

 Strain࣏ࣞࢫンࡀࢺ࣮࣏ࢧࡢࢫ追加ࠋࡓࡋࡲࢀࡉ 
 いࢫࢭࣟࣉࢺࢫ࣏ࡀࢺࣉࣜࢡࢫ࣭࢕ࢸ࢕ࣜ࢕ࢸ࣮ࣘࡢ࠿ࡘࡃ感ᗘ解析用࡟追加ࠋࡓࡋࡲࢀࡉ例えࡣࡽࢀࡑࠊࡤ

感ᗘࣞ࣋ࣝ࡟基࡙い࣏ࢫࣞࡓンࢆࢱ࣮࣓ࣛࣃ࡜ࢫ削除ࠊࡋあࡿいࡣ感ᗘ࡟基࡙いࡓ要ࢆࢺࢵࢭࡢ作成ࠋࡍࡲࡋ 
 静的変఩࣮࣋࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࡢࢫン࡟ࢢ伴いࠊFEMtoolsࠊAnsysࠊAbaqusࠊNastranࢺ࣮࣏ࢧ࡛࣮ࣂࣝࢯ

 ࠋࡓࡋࡲࢀࡉ
 静的 Strain࣮࣋࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࡢࢫンࠊࡀࢢFEMtoolsࠊAnsysࠊAbaqusࠊNastranࡉࢺ࣮࣏ࢧ࡛࣮ࣂࣝࢯ

   ࠋࡓࡋࡲࢀ
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 変更ࡢࢫンࢭ࢖ンとࣛࣙࢩ࣮ࣞࢺࢫン࢖

 ࠋࢇࡏࡲࡾあࡣ変更࡟特࡚ࡋ関࡟必要条件࣒ࢸࢫࢩࡢ最ᑠࠊࡁ⥆手࣮ࣝࢺࢫン࢖

 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆ構成ࠖ࡜ࢫンࢭ࢖ࣛࠊンࣙࢩ࣮ࣞࢺࢫン࢖ࠕࠊࡣい࡚ࡘ࡟ヲ細ࡾࡼ

FEMtools 3.xࠕࠊࡣࢻ࣮ࣞࢢࣉࢵ࢔ࡢࡽ࠿FEMtools 3.xࢆࠖࢻ࣮ࣞࢢࣉࢵ࢔ࡢ参照ࡉࡔࡃ࡚ࡋいࠋ 

FEMtools 4.0.xࠕࠊࡣࢻ࣮ࣞࢢࣉࢵ࢔ࡢࡽ࠿FEMtools 4ࢆࠖࢺ࣮ࢹࣉࢵ࢔ࡢ参照ࡉࡔࡃ࡚ࡋいࠋ 

 㸦License Configurator㸧࣮ࢱ࣮ࣞࢢ࢕ࣇコン࣭ࢫンࢭ࢖ࣛ

FEMtools License Configuratorࡀࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ修ṇࠋࡓࡋࡲࢀࡉ 

 License Settings࣎ࢱンୖࡀ部࡟移動ࠋࡓࡋࡲࢀࡉ 
 ࢺࢵࢿワ࣮ࢭ࢖࣭ࣛࢡン࢔࢖ࣛࢡ࣭ࢫンࣙࢩࢡ࢔࣭ࢺン࢔࢖ࣛࢡ࣭ࢡࢵࣟࢻ࣮ࣀࠊンࣙࢩࢡ࢔࣭ࢺンࡼ࠾びࢿ

 ࠋࡓࡋࡲࢀࡉ化ࣉ࣮ࣝࢢ࡟ンࣙࢩࢡ࢔࣭࣮ࣂ࣮ࢧࢫンࢭ࢖࣭ࣛࢡワ࣮ࢺࢵ

 

FEMtools License Configuratorࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ 

 FEMtools最新版࡟࣮ࣂ࣮ࢧ接⥆ࡿࡍ場合࢝ࢭ60000࣑ࣜࠊンࢻ㸦60 secs㸧ࢺ࢘࢔࣒࢖ࢱ࣭ࢺ࢛ࣝࣇࢹࡢ値ࡀ使
用ࢡࢵ࢙ࢳࡢࡇࠋࡍࡲࢀࡉ間隔᪥数ࠊࡶCheck for Updates Settings࡛ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ形成ࡁ࡛ࡀ࡜ࡇࡿࡍ
 ࠋࡍࡲ
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Check for Updates Settingsࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ 

 追加情報㸦環境変数ࡢ設定方法࡝࡞㸧ࡘ࡟い࡚ࠊࡣFEMtools Getting Started㸦入門㸧࣐࡟ࣝ࢔ࣗࢽ記述ࡲࢀࡉ
参ࢆ章ࡢ使用方法㸦Using the FEMtools Dongle㸧ࡢࣝࢢンࢻࠊ管理㸦License Management㸧ࢫンࢭ࢖ࣛࡢࡑࠋࡍ
照ࡉࡔࡃ࡚ࡋいࠋ 

 ࣝࢢンࢻ

 新ࡋい Sentinel HL Pro Driverless構成ࡀࢺ࣮࣏ࢧࡢ追加ࢻࡢࡇࠋࡓࡋࡲࢀࡉンࡣࣝࢢWindowsࡼ࠾び Linux OS
 ࠋࡍࡲࢀࡉ使用࡟共࡜ࢫンࢭ࢖࣭ࣛࢡࢵࣟࢻ࣮ࣀࡢୖ

 追加情報㸦USBࢻンࣝࢢ用࢖ࢆࣂ࢖ࣛࢻン࣮ࣝࢺࢫ方法࡝࡞㸧ࡘ࡟い࡚ࠊࡣFEMtools Getting Started㸦入門㸧
 使用方法㸦Using theࡢࣝࢢンࢻࠊ管理㸦License Management㸧ࢫンࢭ࢖ࣛࡢࡑࠋࡍࡲࢀࡉ記述࡟ࣝ࢔ࣗࢽ࣐
FEMtools Dongle㸧ࡢ章ࢆ参照ࡉࡔࡃ࡚ࡋいࠋ 

 変更ࢺキ࣓ࣗンࢻ

ࡢ࡚࡭ࡍ FEMtools 4࣓ࣗ࢟ࢻンࡢࡇࡣࢺ  ࠋࡍࡲࢀࡉ伴い更新࡟ࢫ࣮ࣜࣜࡢ4.1

例題ࡢ変更 

 新ࡋい࣓ࣗࢩࢵ例題..\examples\mesh\generation\diskࡀ追加ࠋࡓࡋࡲࢀࡉ 
 DFRFࡢ代わ࡟ࡾ DIRECTFRF࣐ࢥンࢆࢻ使用ࡿࡍ..\examples\dynamic\frf\pade\pade_sms_beam.cmdࡀ修ṇࢀࡉ

ࢻン࣐ࢥࠋࡓࡋࡲ DFRFࡣᪧ式࡛ࠋࡍ 
 例題࣮ࢲ࢛ࣝࣇ..\examples\updating\doe_beamࡣ\doe_beamࠋࡓࡋࡲࢀࡉ࣒࣮ࢿࣜ࡟新ࡋい DOE例

題..\examples\updating\doe\doe_plate.cmdࡀ ortho2d࢕ࢸ࣮ࢹࣉࢵ࢔ࡢ࢕ࢸࣃࣟࣉンࢆࢢ示࡟ࡵࡓࡍ追加ࡋࡲࢀࡉ
 ࠋࡓ

 ..\examples\updating\text_parametersࡀࣂ࢖ࣛࢻ࣭࣮ࣂࣝࢯ࣭࣒ࢱࢫ࢝ࡢ修ṇࡢࡑࠋࡓࡋࡲࢀࡉ相関ศ析結果ࡣ
更新ࡣࢀࡇࠋࢇࡏࡲࢀࡉMACࡀ各཯復࡛更新ࠊࡵࡓࡓࡗ࠿࡞ࢀࡉ཰束࡟影響ࠋࡓࡋࡲࡋ 

 ࣔ࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹンࡢࢢ新ࡋい例題..\examples\updating\cweldࡀ追加ࡢࡇࠋࡓࡋࡲࢀࡉ例題ࠊࡣNASTRAN 
CWELDࢆࢺ࣮ࢹࣉࢵ࢔ࡢࢱ࣮࣓ࣛࣃ実証ࠋࡍࡲࡋ選択ࡣࢱ࣮࣓ࣛࣃ弾性係数㸦FEMtoolsࣛ࣋ࣝ E㸧࡜直ᚄ
㸦FEMtoolsࣛ࣋ࣝ OD㸧࡛ࠋࡍCWELD要素ࠊࡣPARTPATࠊELPATࠊELEMIDࠊGRIDIDࠊALIGNࢆࣝ࢖ࢱࢫ
 ࠋࡓࡋࡲࢀࡉࢺ࣮࣏ࢧࡶ࡟ࢫｲ࢙ࣇ࣮ࢱン࢖NASTRANࠊࡋࢺ࣮࣏ࢧ

 新ࡋい例題࣐ࢥンࢺࣉࣜࢡࢫ࣭ࢻ run05_angle.cmd࣮ࣖ࢖࡚ࣞࡋ࡜ࢱ࣮࣓ࣛࣃ࣭ࢺ࣮ࢹࣉࢵ࢔ࡀ㸦ᒙ㸧角ᗘࢆ
使用ࡿࡍ例題..\examples\updating\cylinder࡚ࡋ࡜追加ࠋࡓࡋࡲࢀࡉ 

 静的変఩࣮࣋࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࡢࢫンࢢ例題..\examples\updating\strain
 ࠋࡓࡋࡲࢀࡉ࣒࣮ࢿࣜ࡟examples\updating\static_strain_1\..ࠊࡀ

 静的変఩࣮࣋ࡼ࠾ࢫび Strain࣮࣋࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࡢࢫンࡢࢢ FEMtoolsࠊAnsysࠊAbaqusࠊNastranࣂࣝࢯ
ࡉ追加ࡀい例題..\examples\updating\static_strain_2\static_strain_2ࡋ新ࡓ備えࢆࢺࣉࣜࢡࢫ࣭ࢻン࣐ࢥࡢࡵࡓࡢ࣮
 ࠋࡓࡋࡲࢀ
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 静的 Strain࣮࣋࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࡢࢫンࡢࢢ FEMtoolsࠊAnsysࠊAbaqusࠊNastran࣐ࢥࡢࡵࡓࡢ࣮ࣂࣝࢯン
 ࠋࡓࡋࡲࢀࡉ追加ࡀい例題..\examples\updating\static_strain_3ࡋ新ࡓ備えࢆࢺࣉࣜࢡࢫ࣭ࢻ

 Ansys࡜ Abaqusࢆ࣮ࣂࣝࢯࡢ使用࣐ࢥࡿࡍンࠊࡀࢺࣉࣜࢡࢫ࣭ࢻ..\examples\updating\static_1 
 ࠋࡓࡋࡲࢀࡉ追加࡟examples\updating\static_2\..࡜

FEMtools Framework 

 ࠋࡍࡲࡋい࡚概ㄝࡘ࡟変更点ࡢࢡワ࣮࣒࣮ࣞࣇFEMtoolsࠊンࣙࢩࢡࢭࡢࡇ

 管理ࢫ࣮࣋ࢱ࣮ࢹ

 拡張ࡢࣉ࣮࢙ࢩࢻ࣮࣭ࣔࢺࢫࢸ

ࡣいࡿあࢻン࣐ࢥᣑ張㸦EXPANDࡢࢱ࣮ࢹ࣭ࢺࢫࢸ Database > Truncate/Expand > Expand Test Data㸧ࡀ修ṇࠊࢀࡉ以
ୗࡢ特徴ࢆ含ࠋࡍࡲࢀࡲ 

 DOF࣐࣌ࢥࡀ࢔ン࡚ࡗࡼ࡟ࢻ追加ࡿࢀࡉ場合ࠊ警告࣓ࢆࢪ࣮ࢭࢵ示ࠋࡍࡲࡋ 
 SEREPࡢ࢔࣌ࡀ DOF数࡜共࡟ FE࣮ࣔࢻ数ࡾࡼపい場合ࠊ警告࣓ࢆࢪ࣮ࢭࢵ示ࠋࡍࡲࡋ 
 SEREP࠾࡟い࡚使用࣮ࣔࢆࢻ選択ྍࡿࡍ能性ࡀ追加ࠋࡓࡋࡲࢀࡉ 
 ࡣࡓࡲ0ࠊࡣࢀࡑ一定ࡢ中央周波数ࢡࢵ࣑ࢼ࢖ࢲࡿࡼ࡟ᣑ張操作ࢆ行うࡢ0ࠋࡍࡲࡁ࡛ࡀ࡜ࡇ中央周波数ࢆ使

用ࠊࡣ࡜ࡇࡿࡍGuyan࣮࣋ࡢࢫ縮ᑠ法࡜等価࡛ࠋࡍ 
 ࡀࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ新ࡋい࢜ࣙࢩࣉンࢆ含࡟ࡵࡓࡿࡵ修ṇࠋࡓࡋࡲࢀࡉ 

ARTeMIS࢖ン࢙ࣇ࣮ࢱｲࢫ 

 6ࡼ࠾び い࡞ࡢ7࣒࢝ࣛ CFGࣕࢳࡽ࠿ンࣝࢿ定義ࢆㄞࡴ ARTeMIS READCFG࣐ࢥンࡢࢻ修ṇ 
 ࣉ࢖ࢱ࣭ࣝ࢖࢓ࣇ ARTeMIS構成ࣝ࢖࢓ࣇ㸦*.cfg㸧࢖ࡢࣝࢹ࣭ࣔࢺࢫࢸࡀン࣏࣮ࡼ࠾ࢺび࢚࢖ࡢࢺ࣮࣏ࢫࢡン

 ࠋࡍࡲࢀࡉ中࡛示ࢺࢫ࣭ࣜࢫ࢖࢙ࣇ࣮ࢱ
 ..\scripts\interfacesࡢ新ࡋいࠕ࣮ࢲ࢛ࣝࣇࣈࢧartemisࠖࣝ࢖࢓ࣇ࣭ࣝ࢖࢓ࣇ࡟ impcfg.bas࡜ expcfg.basࡀ追加ࡉ

ࡲࢀࡉ使用࡟File > Import Test Model and Shapesࠊࢀࡉ選択ࡀࣝ࢖࢓ࣇARTeMIS構成ࠊࡣࡽࢀࡇࠋࡓࡋࡲࢀ
 ࠋࡍ

 参照ࡀ CFG࡚ࡗࡼ࡟ࣝ࢖࢓ࣇ参照付ࡿࢀࡽࡅ場合ࠊARTeMIS CFG࢖ࢆࣝࢹ࣭ࣔࢺࢫࢸࡽ࠿ン࣏࣮ࡁ࡜ࡿࡍࢺ
 ࠋうࡻࡋ࡛ࡿࡍࢺン࣏࣮࢖ࡶ時้歴࡟

要素ᗙ標系㸦ECS㸧 

 ECSࡣ Stress࡜ Strain࡟ࢻ࣮ࣝ࢕ࣇࡢ関連付ࡢࢀࡒࢀࡑࠋࡍࡲࢀࡽࡅ数値ࢸࡣン࡚ࡋ࡜ࢱ࣮ࢹ࣭ࣝࢯ格納ࡉ
ࡽ࠿ࢫ࣮ࢯࡌྠࠊࢀ Stress࡜ Strainࡀ推定ࠋࡍࡲࢀࡉ 

 ECSࡢ表示࢚ࣜ࢜ࡣンࣙࢩ࣮ࢸンࢆ決定付ࡿࡅ第 ࡢ1 Stress／Strainࢆࢻ࣮ࣝ࢕ࣇ使用ࡢࡑࠋࡍࡲࡋ Customize 
Meshࡣࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ要素ᗙ標系㸦ECS㸧ࢆ表示࢕ࢸࢵࢭࡢࡵࡓࡿࡍンࢆࢢ含࡛ࢇいࠋࡍࡲ 

 ECSࠊࡣNASTRAN/ANSYS/ABAQUSࡽ࠿ Stress／Strainㄞ࢖࡟ࡁ࡜ࡴン࣏࣮ࠊ࠿ࡿࢀࡉࢺあࡿいࡣ FEMtools
ࡢ Strain／Stressࡢ計算࡟応࡚ࡌ定義ࠋࡍࡲࢀࡉ 

 Strain／Stressࡣ要素質量中心ࡓࡲ各要素ࡢ節点࡟関࡚ࡋ格納ࠋࡍࡲࢀࡉ節点ࢆ共᭷ࡿࡍ要素ࡣ節点用࡜異ࡿ࡞
ECSࢆ持ࠋࢇࡏࡲࢀࡋࡶ࠿ࡘ 

 ECSࡼ࠾࢙ࣝࢩࡣびࡢࢻࢵࣜࢯ要素࡟ࣉ࢖ࢱ利用ࡣࡽࢀࡑࠋࡍࡲࢀࡉ自動的ࣝࣂ࣮ࣟࢢ࡟ᗙ標系ࡏࡲࡾ࡞ࡣ࡟
 ࠋࢇ

 ࢺࣉࣜࢡࢫ..\scripts\tools\project_strain.bas࣮ࣝ࢝ࣟࡀ要素ᗙ標系ࡢ Strainࢸンࢆࣝࢯ生成࡟ࡵࡓࡿࡍ追加ࡲࢀࡉ
 ࠋࡍࡲࡋ類似ࡢࡶࡿࢀࡉ使用࡛ࢺ࢛ࣝࣇࢹࡢABAQUSࠊࡣࢀࡇࠋࡍ

 ࣮ࣝ࢝ࣟࡢࢺ࢛ࣝࣇࢹ 1方向ࣝࣂ࣮ࣟࢢࡢୖࢫ࢖࢙ࣇ࣮ࢧࡣ x軸ࡢ方向࡛ࣝࣂ࣮ࣟࢢࠋࡍ x軸ࢫ࢖࢙ࣇ࣮ࢧࡀ
ࡢࡑࡣࡓࡲ垂直࡟ 0.1ᗘ以ෆ࡛あࡿ場合࣮ࣝ࢝ࣟࠊ ࣝࣂ࣮ࣟࢢࡢୖࢫ࢖࢙ࣇ࣮ࢧࡣ方向ࡢ1 z軸ࡢ方向࡛ࠋࡍ
場合࣮ࣟ࢝ࣝࡢࡑ ࣮ࣝ࢝ࣟࡣ方向ࡢ2 ࣮ࣝ࢝ࣟࠊ結果ࡢࡑࠋࡍࡲࡾ࡞࡟直角࡜方向ࡢ1 ࣮ࣝ࢝ࣟ࡜1 方向ࡢ2
要࡚ࡗࡼ࡟右手回転࣮ࣝࣝࡢࡾ節点周ࡢ要素ࡣṇ方向ࡢࡑࠋࡍࡲࡾྲྀ࡟ṇࢆࢫ࢖࢙ࣇ࣮ࢧࡿࢀࡉ右手系࡛表ࡣ

素࡟定義ࠋࡍࡲࢀࡉ 
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 変更ࡢ他ࡢそࡢ管理ࢫ࣮࣋ࢱ࣮ࢹ

 静的0.0ࠕࠊࡣࣝ࣋ࣛࡢࣉ࣮࢙ࢩHzࠖࢆ示ࠋࢇࡏࡲࡋ 
 FEMtoolsࡣࢫ࣮࣋ࢱ࣮ࢹ Strain࡜ Stressࢸࡢンࡢࣝࢯෆ部計算࢖࣭ࢱ࣮ࢹࠊࡓࡲࠊࡋࢺ࣮࣏ࢧࢆン࢖࢙ࣇ࣮ࢱ

 ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆࢺン࣏࣮࢖ࡢࡽࢀࡑࡿࡼ࡟使用ࡢࢫ
 ࣮ࣟ࢝ࣝ z軸ࢆ備え࣮ࣝ࢝ࣟࡓᗙ標系ࢆ定義ࣔࢹࡢࡵࡓࡿࡍンࣙࢩ࣮ࣞࢺࢫン࣭ࢺࣉࣜࢡࢫ defcsnts.bas

 ࠋࡓࡋࡲࢀࡉ追加࡟scripts\demo\..ࡀ
 0ࣝࢲ࣮ࣔࡢ変఩ࢆ備え࢖࣏࣭ࢺࢫࢸࡓンࢆࢺ削除ࣔࢹࡢࡵࡓࡿࡍンࣙࢩ࣮ࣞࢺࢫン࣭ࢺࣉࣜࢡࢫ

compress_test.basࡀ....\scripts\demo࡟追加ࠋࡓࡋࡲࢀࡉ 
 ࡽ࠿ࢻ࣮࣭ࣔࢺࢫࢸ K࡜Mࡢ計算ࢆ実証ࣔࢹࡢࡵࡓࡿࡍンࣙࢩ࣮ࣞࢺࢫン࣭ࢺࣉࣜࢡࢫ

compute_matrices_from_modes.basࡀ..\scripts\demo࡟追加ࠋࡓࡋࡲࢀࡉ 
 ࣐ࢥンࢻ DSP SWAPCHANNELSࡀ追加ࠋࡓࡋࡲࢀࡉ㸦以前ࡣMPE SWAPCHANNELS㸧 
 ᪧࡢࢺࢵ࣐࣮࢛ࣇ࣭ࢱ࣮ࢹ SNFࠊNEUTRALࠊFREEࡢ言及ࡾྲྀࡽ࠿ࣝ࢔ࣗࢽ࣐ࡣ除ࡣࡽࢀࡇࠋࡓࡋࡲࢀ࠿古

いࣙࢪ࣮ࣂンࡢ FEMtools㸦v3.1以前㸧࡛ࢺࢵ࣐࣮࢛ࣇ使用࡚ࢀࡉいࠋࡓࡋࡲ 
 ࣒ࢸࢫࢩ情報㸦Help > System Informatio㸧ࡣMB࡛࣓ࣔࣜ容量ࢆ示ࠋࡍࡲࡋ 
 FEMtoolsࢺࣉࣜࢡࢫ関数 OSInfoࡢ࡜混乱ࢆ回避ࢺࣉࣜࢡࢫ࡟ࡵࡓࡿࡍ....\scripts\tools\osinfo.basࡣ meminfo.bas

 ࠋࡓࡋࡲࡋ࣒࣮ࢿࣜ࡜

 ࢫ࢖࢙ࣇ࣮ࢱン࢖࣭࣮ࢨ࣮ࣘ

 ࠋࡍࡲࡋい࡚概ㄝࡘ変更点ࡢࢫ࢖࢙ࣇ࣮ࢱン࢖࣭࣮ࢨFEMtools࣮ࣘࠊࡣンࣙࢩࢡࢭࡢࡇ

 ࣮ࣛࣟࣉࢫࢡ࢚

 ࣛࣈンࢆࢡ備え࣮ࢨ࣮ࣘࡓ定義࣐ࡀྡࢫࢡࢵࣜࢺ許容ࠋࡍࡲࢀࡉ従来ࢫࢡࣜࢺ࣐࡜ࣝࣈ࣮ࢸࡢࡽࢀࡑࠊ表示࡛

 ࠋࡓࡋࡲࡋࡇ起ࡁ引ࢆ࣮࢚ࣛࡣ
 生成࣐ࢥンࢻ㸦ࣈ࣮࢝ࠊࣗࢩࢵ࣓ࠊࢫࢡࢵࣜࢺ࣐ࠊࣝࣈ࣮ࢸ㸧࡟ࣝ࢖࢓ࣇ࣭ࣝࢼ࣮ࣕࢪࡣ出力ࠋࡍࡲࢀࡉ 

 ࣮ࣂ࣮ࣝࢶ

 回転中心ࢆ設定ࢥ࢖࢔ࡢࡵࡓࡿࡍン࡟࣮ࣂ࣮ࣝࢶ࣭ࢫࢡࢵ࢕ࣇࣛࢢࡀ追加ࠋࡍࡲࢀࡉ 

 ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ

 要素ࡼࡢࢺࢫ࣭ࣜࢺࢵࢭう࡟非常࡟長い࡟ࢱ࣮ࢹ対応ࢥࡢࡵࡓࡿࡍン࣎࣎ࡀࢫࢡࢵ最適化ࢥࡢࡑࠋࡓࡋࡲࢀࡉ

ン࣎࣎ࠊࡣ࡛ࢫࢡࢵ迅速ྍࢆࢫࢭࢡ࢔࡞能ࢱ࣮ࢹ࡟ࡵࡓࡿࡍ࡟構造ࢆࣝࢹࣔࠊ割ࡾ当࡚手法ࡲࢀࡉࢺ࣮࣏ࢧࡀ

 ࠋࡓࡋ
 FRFࢆࡳࡢ選択ࡿࡍ場合ࡢ Copy FEA Database to Test Databaseࡼ࠾ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲび COPY FEM࣐ࢥンࢻ

 ࠋࡓࡋ必要࡛ࡀ選択ࡢࢫࢡࢵ࣎ࢡࢵ࢙ࢳCopy FE Mesh Dataࠊࡣ従来ࠋࡓࡋࡲࢀࡉ修ṇࠊ追加ࡀ
 Strainࠊ࡟ࡵࡓࡿࡍࢺ࣮࣏ࢧࢆCreate Responseࡀࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ修ṇࠋࡓࡋࡲࢀࡉ 
 Customize Meshࠊࡣࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ要素ᗙ標系㸦ECS㸧ࢆ表示࢕ࢸࢵࢭࡢࡵࡓࡿࡍンࢆࢢ含࡛ࢇいࠋࡍࡲ 
 Export Matrixࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ㸦File > Export > FEMtools Matrices㸧ࡀ修ṇ࣐࣮࢛ࣇ࣭ࣝ࢖࢓ࣇࠋࡓࡋࡲࢀࡉ

ࡣࢺࢵ 2段目࡟移動࡟ࣝ࢖࢓ࣇ࣭ࣝࢼ࣮ࣕࢪࡣࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲࡢࡑࠊࡋ EXPORT MATRIX࣐ࢥンࢥࡢࢻ
࣐ン࢖ࣛࢻンࢆ生成ࠋࡍࡲࡋ 

 Expand Test Mode Shapesࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ㸦(Database > Truncate/Expand > Expand Test Data㸧ࡀ修ṇࡋࡲࢀࡉ
 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆᣑ張ࠖࡢࣉ࣮࢙ࢩࢻ࣮࣭ࣔࢺࢫࢸࠕࠋࡓ

 Check for Updates –Settingsࡀࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ修ṇࠋࡓࡋࡲࢀࡉ 

 ࢻコ࣐ン࣭࣮ࣗࢽ࣓

 File > Import㸦ࡼ࠾び Toolbar > Import㸧ࡀ FEAࡢ Strain࡜ Stress࡟ࢱ࣮ࢹ関࡚ࡋᣑ張ࠋࡓࡋࡲࢀࡉ 
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FEAࡢ Strain࡜ Stress࢖ࢆࢱ࣮ࢹン࣏࣮ࡿࡍࢺ新ࡋい࣐ࢥン࢖࡜ࢻン࣏࣮࣮ࣗࢽ࣓ࢺ 

 View > Dynamic Viewing࣓ࠊࡣ࣮ࣗࢽPin Rotation Center࣐ࢥンࢆࢻ含ࠋࡍࡲࡳ 
 View > XY-Curves࣓ࠊࡣ࣮ࣗࢽMove Tracker to Left ࡜ Move Tracker to Right࣐ࢥンࢆࢻ含࡛ࢇいࠋࡍࡲ 
 Help > Manuals࣓ࢭ࢖ࣛࠊࡣ࡟࣮ࣗࢽンࡀࢫ利用ྍ能ࡀࣝ࢔ࣗࢽ࣐ࡢ࡚࡭ࡍࠊࡃ࡞ࡣ࡛ࡅࡔࡢࡶ࡞示ࣛࠊࢀࡉ

ࡿࡼ࡟構成ࢫンࢭ࢖ LAN/WANࣛࢭ࢖ンࡢࢫ཯応性ࢆ改善ࠋࡍࡲࡋ 
 ࣓࣐ࢥ࣭࣮ࣗࢽンࠊ࡚ࡋ࡜ࢻGenerate Tracelines, Edit Tracelines, Generate Surfaces, Test Model Editorࡀ Database > 

Mesh Tools࣓࡟࣮ࣗࢽ追加ࠋࡓࡋࡲࢀࡉ 
 ࣓࣐ࢥ࣭࣮ࣗࢽンࢻ Test Model Editorࡀ Tools > Pretest Analysis࣓࡟࣮ࣗࢽ追加ࠋࡓࡋࡲࢀࡉ 
 Tools > Pretest Analysis࣐ࢥࡢ࣮ࣗࢽ࣓ࣈࢧࡢンࢆࢻ使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍFEࣔࠊࣝࢹ幾何学特性ࠊ材料

特性ࡢ未定義あࡿいࡣࣉ࣮࢙ࢩࢻ࣮ࣔࡣ利用ྍ能࡛࡞い場合ࡶ࡟使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ例えࠊࡤFE࣮ࣔ
 ࠋࡍ能࡛ྍࡣ選択࣮ࢧンࢭ࣭ࣝ࢔ࣗࢽ࣐ࡶ࡚ࡃ࡞࡟ࢫ࣮࣋ࢱ࣮ࢹࡀࣉ࣮࢙ࢩࢻ

 ࣓࣐ࢥ࣭࣮ࣗࢽンࡢࢻ Tools > Pretest > Modal Effective MassࠊࡣTools > Pretest > Modal Effective Mass Fraction 
(MEF)ࡼࡢうࠋࡓࡋࡲࢀࡉ࣒࣮ࢿࣜ࡟ 

 ࣓࣐ࢥ࣭࣮ࣗࢽンࡢࢻ Tools > Correlation Analysis > Mode Shape Pair ViewerࠊࡣTools > Correlation Analysis > 
Mode Shape Pairs Editorࡼࡢうࠋࡓࡋࡲࢀࡉ࣒࣮ࢿࣜ࡟ 

 ࢻコ࣐ン࣭࣮ࣗࢽ࣓࣭ࣉࢵ࢔ࣉࢵ࣏

 ࣓࢕࣭࢘ࢫࢡࢵ࢕ࣇࣛࢢ࣭ࣈ࣮࢝ࠊࢫࢡࢵࣜࢺ࣐ࠊࣗࢩࢵンࠊࡣ࡟࣮ࣗࢽ࣓࣭ࣉࢵ࢔ࣉࢵ࣏ࡢ࢘ࢻCaptureࢥ
࣐ンࡀࢻ追加࣐ࢥࡢࡇࠋࡓࡋࡲࢀࡉン࡟ࣝ࢖࢓ࣇࡣࡓࡲ࣮ࣆࢥ࡟ࢻ࣮࣎ࣉࢵࣜࢡࡣࢻ保Ꮡࡿࡍ前ࢵ࢕ࣇࣛࢢ࡟

使࡚ࡋ࡜ࡾ代わࡢ㸧ࣉࢵ࣐ࢺࢵࣅ㸦࣮ࣆࢥࠊࡁ開ࢆCapture Toolࠖࠕࡢࡵࡓࡿࡍ変更ࢬ࢖ࢧࢆ࢘ࢻン࢕࣭࢘ࢡ
用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍࡋ 

 Save As, Use Maximized Windows, Close࣐ࢥンࢻ用ࢥ࢖࢔ࡢンࡀ追加ࠋࡓࡋࡲࢀࡉ 
 ࣓࢕࣭࢘ࢫࢡࢵ࢕ࣇࣛࢢ࣭ࣗࢩࢵンࡢ࣮ࣗࢽ࣓࣭ࣉࢵ࢔ࣉࢵ࣏ࡢ࢘ࢻ Dynamic Viewing࡟࣮ࣗࢽ࣓ࣈࢧ Pin 

Rotation Center࣐ࢥンࡀࢻ追加ࠋࡓࡋࡲࢀࡉ 
 ࣮࢝࢕࣭࢘ࢫࢡࢵ࢕ࣇࣛࢢ࣭ࣈンࠊ࡟࣮ࣗࢽ࣓࣭ࣉࢵ࢔ࣉࢵ࣏ࡢ࢘ࢻMove Tracker to Left ࡜ Move Tracker to 

Right࣐ࢥンࡀࢻ追加ࠋࡓࡋࡲࢀࡉ 

 ࢺࢵ࢝ࢺ࣮ࣙࢩ

ࡲࡾ࡞࡟ࢺࢵ࢝ࢺ࣮ࣙࢩࡢࢻン࣐ࢥࡢMove Tracker to Right࡜ Move Tracker to Leftࠊࡣ矢印ࡢᕥ右ࡢࢻ࣮࣮࣎࢟
 ࠋࡍ

 ࣝࣈ࣮ࢸ

 ࡣࣝࣈ࣮ࢸ Strainࡼ࠾び Stressࢸࡢンࡢࣝࢯ表示ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆStrain࡜ Stressࠊࡣࣝࣈ࣮ࢸࡢExplorer > 
Tables.ࡽ࠿開ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡃ 
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 ࢫࢡࢵ࢕ࣇࣛࢢ

࣮࢝ࣛ表示ࢬ࢖࣐ࢱࢫ࢝ࡢ 

い࣮࣭ࣛ࢝ࣗࢩࢵ࣓࣭ࢫࢡࢵ࢕ࣇࣛࢢࡢ࠿ࡘࡃ表示機能ࡀ追加ࠋࡓࡋࡲࢀࡉ 

 ࣙࢩ࣮࣓ࢽ࢔࣭ࣉ࣮࢙ࢩン࡛ࡣ変形振幅࡟応ࢆ࣮ࣛ࢝ࡓࡌ設定ࠋࡍࡲࡋ 
MESH … FOLLOW … あࡿいࠊࡣEdit > Settings > Style > Mesh Graphics > Colors > Contours Colors Followingࢆ使
用ࠋࡍࡲࡋ 

 凡例値ࡢ補間࢜ࣙࢩࣉン 
MESH…ROUNDING…ࢆ使用ࠋࡍࡲࡋ 

 ࢥン࡟ࢺࢵࣟࣉ࣭࣮ࢱ使用ࡿࢀࡉ間隔値 
MESH … INTERVAL …あࡿいࠊࡣEdit > Settings > Style > Mesh Graphics > Colors > Number of Legend Intervalsࢆ
使用ࠋࡍࡲࡋ 

 凡例࣮࢝ࣛࢆ指定ࡣ࣮ࣛ࢝ࡢࡑࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ INIࡢࣝ࢖࢓ࣇ graphic.customcolormap.colornn変数ࡋ࡜
࡚定義ࠊࡣࣉࢵ࣐࣮࣭࣒ࣛ࢝ࢱࢫ࢝ࠋࢇࡏࡲࡾ࡞ࡤࢀࡅ࡞ࡋMESH…CMAP CUSTOM…࡛選択ࠋࡍࡲࢀࡉ 

 ࣮࣭࢝ࣛ࢕ࢹ࣮࢙ࢩン࢕ࢹ࣮࢙ࢩ࣭ࢺࢵࣛࣇ：ࢢンࢢ機能ࡣ࡚ࡋ࡜連⥆的ࣂ࡜ンࡲࢀࡉࢺ࣮࣏ࢧࡀࢻ࣮ࣔࡢࢻ

 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆびMATRIXࡼ࠾MESHࡢࠖࢻン࣐ࢥModified Commandsࠕࠊࡓࡲࠋࡓࡋ

回転原点ࡢ変更 

ンࢥ࢖࢔いࡋ新ࠊ࡟ࡵࡓࡿࡍ設定ࢆ回転原点ࢡࢵ࣑ࢼ࢖ࢲ  ࠋࡓࡋࡲࢀࡉ追加࡟࣮ࣂ࣮ࣝࢶ࣭ࢫࢡࢵ࢕ࣇࣛࢢࡀ 

ࡣいࡿあ࣮ࣗࢽ࣓࣭ࣉࢵ࢔ࣉࢵ場合㸦࣏࡞ࣈ࢕ࢸࢡ࢔ࡀンࢱ࣎ࡢࡇ View > Dynamic Viewing࣓࣮ࣗࢽ㸧࣭ࢫ࣐࢘ࠊ
 ࠋࡍࡲࡋ選択ࢆᗙ標ࢢン࢟ࢵࣆ࡚ࡋ࡜い原点ࡋ新ࡿࡍ回転ࢆࣗࢩࢵ࣓ࠋࡍࡲࡾ変わࡀࣝࢯ࣮࢝

 

回転原点ࢆ変更ࣆࡢࡵࡓࡿࡍン࣭࣎ࢱンࡢ使用例 
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᭷効࡞఩置ࣝࣂ࣮ࣟࢢ࡜ࡿࢀࡉࢡࢵࣜࢡࡀᗙ標系ࡢ新ࡋい回転原点ᗙ標ࢥࡀン࡟࣮ࣝࢯ出力ࠋࡍࡲࢀࡉ 

例えࠊࡤ 

Selected new rotation center at (+5.34302E+00, +3.85077E+00, 9.23082E-03) 

回転࡜࣮ࣗࣅ࣭ࢺ࢛ࣝࣇࢹࡢ原点ࢆ回復࢕࣭࢘ࢺࢵ࢕ࣇࠊࡣ࡟ࡿࡍンࢥ࢖࢔࣭࢘ࢻン  ࠋࡍࡲࡋࢡࢵࣜࢡࢆあࡽ
ࡲࡾ࡞࡟ࢻ࣮࣭ࣔࢡࢵ࢕ࣇࣛࢢࠊࡋ終了ࢆࢻ回転࣮ࣔࢡࢵ࣑ࢼ࢖ࢲࠊ場合ࡓࢀࡉ選択ࡀンࣙࢩࢡ࢔ン࣭ࣆ࡚ࡵࡓ

 ࠋࡍ

回転ࢺ࢛ࣝࣇࢹࡢ原点࣮ࣗࣅࡣᗙ標系ࣝࢹࣔࡢ境界࣎ࡢࢫࢡࢵ中央ࠋࡍࡲࡾ࡞࡟ 

 ࣮ࣝࣟࢺン࣭コンࣙࢩ࣮࣓ࢽ࢔

Start࡜ Stopࢱ࣎ࡢンࡼ࠾び Step ForwardࠊStep BackwardࠊGoto LastࠊGoto First buttons࣎ࢱンࢆ備えࡓ新ࡋいࢥン
࣓ࢽ࢔ࠊࡓࡲࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ࣮ࣝࣟࢺンࢥࢆン表示ࣙࢩ࣮࣓ࢽ࢔ࠊࡋ使用ࢆࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ࣭࣮ࣝࣟࢺ

 ࠋࡍࡲࡁ࡛ࡶ࡜ࡇࡿࡍ࣮ࣝࣟࢺンࢥࢆࢢン࣮ࣜࢣࢫ振幅࡜ン速ᗘࣙࢩ࣮

 

Animation Controlࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ 

 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡃ方法࡛開ࡢ以ୗࡣࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ࣭࣮ࣝࣟࢺンࢥࡢࡇ

• Mesh࣏࣮ࣗࢽ࣓࣭ࣉࢵ࢔ࣉࢵ㸦࣓࢕࣭࢘ࢫࢡࢵ࢕ࣇࣛࢢ࣭ࣗࢩࢵン࢘ࢻ中࡛右ࡉࡔࡃ࡚ࡋࢡࢵࣜࢡい㸧ࡽ࠿
ࡢ Animation > Animation Controlࢆ選択ࠋࡍࡲࡋ 

• View > Animation > Animation Controlࢆ選択ࠋࡍࡲࡋ 

開ࢆンࣙࢩ࣮࣓ࢽ࢔ࡣࢀࡑࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ利用ࢆࢻン࣐ࢥ࣭࣮ࣗࢽ࣓ࡢࡇࠊ場合ࡿい࡚ࢀࡉ表示ࡀࣉ࣮࢙ࢩ

始࡟ࡵࡓࡿࡍ使用ࠊ࠿ࡿࡍあࡿいࣙࢩ࣮࣓ࢽ࢔ࡣンࡀ実行࡚ࢀࡉいࡿ場合㸦Animate࣎ࢱンࢆ実行ࣗࢽ࣓ࠊ࠿ࡿࡍ
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡃ開ࠊ㸧ࠋࡍࡲࡋ使用ࢆࢻン࣐ࢥ࣭࣮

Step ForwardࠊStep BackwardࠊGoto Last and Goto First࣎ࢱンࣙࢩ࣮࣓ࢽ࢔ࡣンࡀ実行中࠿休Ṇ࡚ࡋい࡟ࡁ࡜ࡿ作動
 ࠋࡍࡲࡋ

 㸦Tracker Control㸧࣮ࣝࣟࢺコン࣭࣮࢝ࢵࣛࢺ

ࣇࣛࢢ࣭ࣈ࣮࢝ࡣ࣮ࣝࣟࢺンࢥࡢࡑࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ矢印࡛移動ࢻ࣮࣮࣎࢟ࡢᕥ／右ࡣ࣮࢝ࢵࣛࢺࡢ中ࣈ࣮࢝

びࡼ࠾࣮ࣗࢽ࣓࣭ࣉࢵ࢔ࣉࢵ࣏࣭࢘ࢻン࢕࣭࢘ࢫࢡࢵ࢕ View > XY-Curves࣓ࡲࡁ࡛ࡀ࡜ࡇࡿࡍࢫࢭࢡ࢔ࡽ࠿࣮ࣗࢽ
 ࠋࡍ
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キ࣮ࣕࣝࢶ࣭࣮ࣕࢳࣉ㸦Capture Tool㸧 

Capture Tool࢕࣭࢘ࢫࢡࢵ࢕ࣇࣛࢢ࣭ࣈ࢕ࢸࢡ࢔ࡣンࢥࡢ࢘ࢻンࢸンࢆࢶ示࢖ࡣࢀࡑࠋࡍ࡛ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲࡍ
ࠋࡍࡲࢀࡉ使用࡟ࡵࡓࡿࡍ変更ࢬ࢖ࢧ࡟前ࡿࡍ保Ꮡ࡟ࣝ࢖࢓ࣇࡣࡓࡲࠊ࡟前ࡿࡍ࣮ࣆࢥ࡟ࢻ࣮࣎ࣉࢵࣜࢡࢆࢪ࣮࣓

びࡼ࠾㸧࡚ࡋ࡜ࣉࢵ࣐ࢺࢵࣅCopy㸦ࠊࡣࢻン࣐ࢥࡢࡇ Save Asࡢ代わ࡚ࡋ࡜ࡾ使用ࢢࡣࢀࡑࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ
 ࡍࡲࢀࡉࢫࢭࢡ࢔ࡽ࠿࣮ࣗࢽ࣓࣭ࣉࢵ࢔ࣉࢵ࣏ࡢ࢘ࢻン࢕࣭࢘ࢫࢡࢵ࢕ࣇࣛ

 

ࡢ࣮ࣗࢽ࣓࣭ࣉࢵ࢔ࣉࢵ࣏࣭࢘ࢻン࢕࣭࢘ࣗࢩࢵ࣓ Capture࣐ࢥンࢻ 

ࢬ࢖ࢧ࣭ࢪ࣮࣓࢖ࠊࡓࡲࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ修ṇࡾࡼ࡟ࢢࢵࣛࢻࡢࢪࢵ࢚࣭࢘ࢻン࢕࢘ࡣࢬ࢖ࢧ࣭ࢡࢵ࢕ࣇࣛࢢ

࡟ࡵࡓࡿࡍ変更ࢆࢬ࢖ࢧ࣭ࢡࢵ࢕ࣇࣛࢢࠊࡋ指定ࢆ数ࣝࢭࢡࣆ࡟中ࢫࢡࢵ編集࣎ࡢప部ᕥ隅ࠊࡣ Apply࣎ࢱンࢆᢲ
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡍ

Copy࣎ࢱンࢆᢲࢬ࢖ࢧ࡟ࢻ࣮࣎ࣉࢵࣜࢡࡾࡼ࡟࡜ࡇࡍ変更ࠊ࠿ࡿࡍ࣮ࣆࢥࢆࢪ࣮࣓࢖ࡓࢀࡉあࡿいࡣ Save As࣎ࢱ
ンࢆ使用࡟ࣝ࢖࢓ࣇ࡚ࡋ保Ꮡࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 
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Capture Tool࢘࢕ンࢆ࢘ࢻ閉࡟ࡵࡓࡿࡌ Closeࢆ使用ࠋࡍࡲࡋ 

 

 ࣮ࣝࢶ࣭࣮ࣕࢳࣉࣕ࢟

Strainと Stressࢸࡢンソࣝ㸦Strain and Stress Tensors㸧ࡢ表示 

 ࡣ࢔࣮ࣗࣅ࣭ࢫࢡࢵ࢕ࣇࣛࢢ Strain࡜ Stressࢸࡢンࡢࣝࢯ表示ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆ 

 

静的要素 Stress㸦ᕥ㸧࡜変఩㸦右㸧࣮ࣛ࢝ࡢศᕸࢺࢵࣟࣉ 

 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ選択ࢆ㸧࣮ࣂ࢖࢓ࣇࠊ中央ࠊప部ࠊ㸦ୖ部ࢺンࢿン࣏࣮ࢥࡢࡘ4ࠊࡣ表示ࣝࢯンࢸ

 ࠋࡍࡲい࡚ࢀࡽ伝え࡚ࡋ࡜௙様ࡢANSYSࠊࡣࢀࡇࠋࡍࡲࡾあࡶい場合࡞ࡁ利用࡛࣮ࣂ࢖࢓ࣇ࡜中央ࠊࡋࡔࡓ
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ࣞンࡢࢫࢡࢵ࢕ࣇࣛࢢ࣭࣮ࢲ改良 

 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ࣮ࣝࣟࢺンࢥࢆࢻ࣮ࣆࢫ表示ࡾࡼ࡟設定ࢻ࣮ࢥࡢ࡛ࡲ10

 ࠋࡓࡋࡲࢀࡉ改善ࡀ投射ᅗ法࡟ࡵࡓࡿࡍ回避ࢆ࡜ࡇࡿ࡞࡟非表示ࡀ一部ࡢࣝࢹࣔࡿࡼ࡟ࢢン࣑࣮ࢬ

重ࡡ合わࣗࢩࢵ࣓ࡏ㸦FE+ࢻ࣮࣭ࣔࢺࢫࢸ㸧ࡢ画質ࡀ改善ࠋࡓࡋࡲࢀࡉ 

ᥥ画࡟使用࢔ࡓࢀࡉンࢩ࢔ࣜ࢖࢚ࢳンࢢ法ࢥࢆンࡢࡵࡓࡿࡍ࣮ࣝࣟࢺ新ࡋい࢕ࢸࢵࢭンࡀࢢ INI࡟ࣝ࢖࢓ࣇ追加ࡉ
ࡿࢀࡉࢺ࣮࣏ࢧFEMtools࡛ࠋࡍࡲࢀ OpenGL࢖ࣛࡢン࣭࢔ンࢩ࢔ࣜ࢖࢚ࢳンࢢ法ࡣ࡟  ࠋࡍࡲࡾあࡀ方法ࡢࡘ2

1. Line smooth：ࡣࢀࡇ少数ࡢ線ศࢆࣝࢹࣔࡿࡼ࡟適ษ࡟ᥥ画ࡿࡍ手法࡛ࡣࢀࡑࠋࡍ一般的ࠊ࡟多ࡢࡃ線ศࡼ࡟ࢆ
 ࠋࡍ࡛ࢢン࢕ࢸࢵࢭ࣭ࢺ࢛ࣝࣇࢹࡣࢀࡇࠋࡍࡲࡾ࡞ࡃ遅ࡣᥥ画࡛ࡢࣝࢹࣔ࡞複雑ࡿ

2. Multisampling：ࣝࢭࢡࣆ࣭ࣈࢧࡣࢀࡇ原点࡜ᖹ均化࡟基࡙い࡚ࢆࢪ࣮࣓࢖ᥥ画࢔࢙࢘ࢻ࣮ࣁࡿࡍᢏ術࡛ࠋࡍ 

変数 graphic.antialiaslimitࢧࢳ࣐ࣝࡣンࣜࣉン࡟ࢢ変更ࡿࡍ前࢔࡟ンࢩ࢔ࣜ࢖࢚ࢳンࢢ法࡛効率的࡟ᥥ画ࡿࡍ
wireframe線ศࡢ最大数ࢆ指定ࢺ࢛ࣝࣇࢹࠋࡍࡲࡋ値ࡣ ࡣࢀࡑࠊࡁ指定࡛࡛ࡲ8192 INIࣝ࢖࢓ࣇ中࡛指定࡜ࡇࡿࡍ
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ設定࡛ࢻン࣐ࢥ࡞うࡼࡢ次ࡣࢀࡑࠋࡍࡲࡁ࡛ࡀ

SET VARIABLE graphic.antialiaslimit int_val 

 改善ࡢࢢン࢖࣮ࣗࣅ࣭࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮ࣔ

重ࡡ合わࢆ࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮ࣔࡏ表示ࡿࡍ場合 180ᗘࡢ఩相ࢺࣇࢩ値ࢆ適用ྍࡀ࡜ࡇࡿࡍ能࡛ࡣࢀࡇࠋࡍṇ規ࣔ
ࣔࠊ࡟共࡜ࢻン࣐ࢥMESH PAIRࠊࡣ࡟ࡿࡍ適用ࢆ変更ࡢࡑࠋࡍࡲࢀࡉ適用࡟ࣉ࣮࢙ࢩࢻ複素࣮ࣔ࡜ࣉ࣮࢙ࢩࢻ࣮
 ࠋࡍࡲࡋ使用ࢆ番号࢔࣭࣌ࢻ࣮

ࡓࡋ使用ࢆ࣮࣭ࣛ࢝ࢺࢫࣛࢺンࢥࠊ࣒࣮ࣞࣇ࣮ࣖ࢖ワࠊࢪࢵ࢚ࠊࡣ㸧ࣝࢹ࣭ࣔࢺࢫࢸ+㸦FE࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮ࣔ
ワࠊࢪࢵ࢚ࠊ一方ࠊࢀࡉ赤色࡛表示࡟常ࠊࡣࣝࢹ࣭ࣔࢺࢫࢸࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍᥥ画࡛࡝࡞表示ࢢン࢕ࢹ࣮࢙ࢩ

ࡣ表示ࡢ࣒࣮ࣞࣇ࣮ࣖ࢖ FEࣔࣝࢹ要素ࡀ࣮ࣛ࢝ࡢ割ࡾ当࡚࢖࣭ࣛࢪࢵ࢚ࠊࡓࡲࠋࡍࡲࢀࡽンࢆࡳࡢ使用ࠊࡋFEࣔ
ࡢࡇࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ表示ࢆࣝࢹ FEࣔ࢖ࣛࢺ࢘࢔ࡢࣝࢹン࣭࡜ࣝࢹ࣭ࣔࢺࢫࢸࡣࢺࢵࣟࣉ相似ࠋࡍࡲࡋ 

  

  

異࢕ࢸࢵࢭࡿ࡞ン࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮ࣔࡿࡼ࡟ࢢ 
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 ࢱ࢕ࢹ࢚࣭࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮ࣔ

いࡢ࠿ࡘࡃ改良࢖ࡀンࣈ࢕ࢸࢡࣛࢱMode Shape Pairs Editor࣮ࣝࢶ㸦Tools > Correlation Analysis > Mode Shape Pair 
Editor㸧࡟行わࠋࡍࡲࢀ 

• 交互࡟観察ࡢࡵࡓࡿࡍMap FE on Testࡢࢫࢡࢵ࣎ࢡࢵ࢙ࢳ追加 
ࡢࡵࡓࡿ替わࡾษࢆ࣮ࣗࣅ࣭ࢻࢵࣜࢯ࡜࣮ࣗࣅ࣭࣐࣮ࣝࣀ • Solid Viewࡢࢫࢡࢵ࣎ࢡࢵ࢙ࢳ追加ࠋ以前ࢵࣜࢯࡣ

 ࠋࡓࡋ機能࡛ࡢ唯一ࡀ࣮ࣗࣅ࣭ࢻ
• 追加࢔࣌ࠊࡣ࣮ࣙࢩ DOFࡢ఩置ࡼ࠾び方向ࢆ示ࢆ࣮࣮࣐࢝ࡍ加えࡢࡵࡓࡿ Show Paired DOFsࢡࢵ࣎ࢡࢵ࢙ࢳ

 ࠋ追加ࡢࢫ
 ࠋࡍ能࡛ྍࡀࢢン࢕ࢸࢵࢭwireframeࠊtransparencyࠊPhotoࠊ࡜ࡿࡍ変更ࢆ࢔࣭࣌ࢻ࣮ࣔࣈ࢕ࢸࢡ࢔ •

 ࠋいࡉࡔࡃ࡚ࡋ注意࡟࡜ࡇࡓࢀࡤ࿧࡜Mode Shape Pairs Viewer࡟以前ࡀࢱ࢕ࢹ࢚ࡢࡇ

 

 ࢱ࢕ࢹ࢚࣭࢔࣭࣌ࣉ࣮࢙ࢩࢻ࣮ࣔ

Customizing Changes  

• Customize Meshࡢࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ変更 
• 要素ᗙ標系㸦ECS: Element Coordinate System㸧࢕ࢸࢵࢭンࡢࢢ表示 
࡛ࢺン࣓ࣜࢡン࢖ࡢࣉࢵࢸࢫ0.1 • ン࡛背࢖ࣛࡢ1㸦0.5㸧>ࡉ厚ࠋࡍࡲࡁ設定࡛ࢆࡉ厚࣮ࣖ࢖範ᅖ࡛ワࡢ10～0.1

景࡟対࢔࡚ࡋンࢩ࢔ࣜ࢖࢚ࢳンࡓࡋࢢ薄い線ࢆᥥ画࡟ࡢࡿࡍ᭷用࡛ࠋࡍ 
• Customize Matrixࠊࡣࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲRow／Columnࣛ࣋ࣝࢆ設定ࡢࡵࡓࡿࡍ新規ࢆࢻ࣮ࣝ࢕ࣇ含࡛ࢇいࡲ

 ࠋࡍ
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Customize Matrix Displayࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ 

 ࣮ࣝࢶ࣭ࣗࢩࢵ࣓

一次要素ࡽ࠿二次要素ࡢ࡬変換 

Element Type Conversionࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ㸦Database > Mesh Tools > Element Type Conversion㸧࡛ࠊࡣTRIA3ࠊ
QUAD4ࠊTETR4ࠊPENT6ࠊHEXA8ࡼࡢう࡞一次要素ࢆ஧次要素ࡢ TRIA6ࠊQUAD8ࠊTET10ࠊPEN15ࠊHEX20࡟
変換ࡿࡍ新ࡋい機能ࡀ追加ࠋࡓࡋࡲࢀࡉ但ࡢࡑࠊࡋ変換࡟ LINE2ࡣ含ࠋࢇࡏࡲࢀࡲ 

 ࠋࡍ要素࡛ࡢ࡚࡭ࡍࡣ変換対象ࡣ࡛ࢺ࢛ࣝࣇࢹࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ指定ࢆࢺࢵࢭび要素ࡼ࠾ࣉ࢖ࢱ変換ࡢ௚ࡢࡑ

 

Element Type Conversionࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ 

 ࠋࡍGENERATE CONVERT…TYPE QUAD࡛ࠊࡣࢻン࣐ࢥ相当ࡢࡑ
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஧次要素ࡢ࡬変換前 

 

஧次要素ࡢ࡬変換後 

 要素生成ࢫ࢖࢙ࣇ࣮ࢧࡢࡽ࠿ン㸦Tracelines㸧࢖ࣛࢫ࣮ࣞࢺ

࡜TRIA3ࠊࡽ࠿ン࢖ࣛࢫ࣮ࣞࢺ QUAD4ࡢ要素ࢆ生成ࡿࡍ新ࡋいࡀ࣮ࣝࢶ追加ࡣ࣮ࣝࢶࡢࡇࠋࡓࡋࡲࢀࡉ高機能ࢢ
 ࠋࡍࡲい࡚ࡋ意ᅗࢆ࡜ࡇࡿࡍ利用ࢆ要素ࢫ࢖࢙ࣇ࣮ࢧࡢࣝࢹ࣭ࣔࢺࢫࢸ࡛ୖ࢖ࣞࣉࢫ࢕ࢹ࣭ࣝ࢝࢕ࣇࣛ

開ࢆࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲElement Type Conversionࠊࡽ࠿Database > Mesh Tools > Element Type Conversionࠊࡣ࡟ࢀࡑ
 ࠋࡍࡲࡋ選択ࢆGenerate surface elements from tracelinesࠊࡁ
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 ࠋࡍࡲࡁ࡛ࡶ࡜ࡇࡿࡍࢫࢭࢡ࢔ࡽ࠿࣮ࣗࢽ࣓ࡢ次ࡣࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲࡢࡇ

Database > Mesh Tools > Generate Surfaces 

Model Updating࣓࣮ࣗࢽ構成 
Tools > Pretest Analysis > Generate Surfaces Pretest Analysis࣓࣮ࣗࢽ構成 
Tools > Generate Surfaces    

 ࠋࡍGENERATE CONVERT…TYPE SURFACE࡛ࠊࡣࢻン࣐ࢥ相当ࡢࡑ

 ࠋࡍࡲࡋ示ࢆ例ࢪ࣮࣓࢖ࡢࡑ

 

 変換前ࡢ࡬要素ࢫ࢖࢙ࣇ࣮ࢧ
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 変換後ࡢ࡬要素ࢫ࢖࢙ࣇ࣮ࢧ

要素公式 

QUAD8要素公式ࡾࡼࡣᏳ定性࡜高速化࡟ࡵࡓࡢ改善ࡢࡑࠋࡓࡋࡲࢀࡉ要素ࡣෆ部剛性対応ࡢ 3x3࢞࢘࢖࣏࣭ࢫン
 ࠋࡍࡲࡋ使用ࢆࢺ

内部ソ࣮ࣝࣂ㸦線形静解析と࣮ࣔࢻ解析㸧 

FEMtoolsෆ部ࠊ࡚ࡋ࡜࣮ࣂࣝࢯILP64㸦8ࢺ࢖ࣂ㸧整数࢖ンࠊࡣࢻ࣮ࣔࡢࡇࠋࡍࡲࡋࢺ࣮࣏ࢧࢆࢫࢡࢵࢹfta.exeࢯ
 ࠋࡍࡲࢀࡉ化ࣈ࢕ࢸࢡ࢔ࡾࡼ࡟࡜ࡇࡿࡍ指定ࢆ"数"-8ࡁ引࡟起動時ࡢ࣒ࣛࢢࣟࣉ࣮ࣂࣝ

 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ࡟ࣈ࢕ࢸࢡ࢔ࢆILP64ࠊ࡚ࡗࡼ࡟ࢻン࣐ࢥࡢ次ࠊࡓࡲ

SET ILP64 ON 

FEMtoolsࠕࠊࡣࣂ࢖ࣛࢻ࣭࣮ࣂࣝࢯILP64࣮ࠖࣝࣈ変数࡟関ࡿࡍ ILP64ࢺ࣮࣏ࢧ関数ࢆ使用ࢺ࣮ࢹࣉࢵ࢔࡟ࡵࡓࡿࡍ
 ࠋࡍcbsolver.bas࡛ࠊexpand.basࠊlib_reduction.basࠊfemtools.basࠊࡣࣂ࢖ࣛࢻ修ṇࡢࡑࠋࡓࡋࡲࢀࡉ

ILP64ࡣᣑ張࣏࢖ン࢖࣭࣮ࢱンࡾࡼ࡚ࡗࡼ࡟ࢫࢡࢵࢹ大ྍࢆࢺ࣮࣏ࢧࡢࢺࢵࢭࢱ࣮ࢹ࡞ࡁ能64ࠊࡋࡔࡓࠋࡍࡲࡋ࡟-
bit整数ࡀ 多ࡾࡼ࡟逆ㄝ的ࡣILP64ࠊࡵࡓࡢࢫࢡࢵࣜࢺ࣐ࡿࢀࡉ使用࡚ࡋ࡜ࢫࢡࢵࢹン࢖࡟ࡾ代わࡢ整数ࢺࢵࣅ32
ࡣࢀࡑ㸦࣮ࣟࣇ࣮ࣂ࣮࢜ࡢ整数ࢺࢵࣅ32ࠊ࡚ࡗࡀࡓࡋࠋࡍࡲࡋ使用ࢆ࣓ࣜࣔࡢࡃ DOF数࡜関係ࠋࡍࡲࡋ㸧ࡀ生ࡿࡌ
場合ࢆ考慮ࠊࡋILP64ࡢ使用ࠋࡓࡋࡲࢀࡉࢺ࣮࣏ࢧࡀ 

Strainと Stress解析㸦Strain and Stress Analysis㸧 

Stress࡜ Strainࡢ計算ࡢ修ṇ点／ᣑ張点ࢆ以ୗ࡟示ࠋࡍࡲࡋ 

 2D࡜ 3Dࡢ要素ࠋࡍࡲࢀࡉࢺ࣮࣏ࢧࡀ 
 Strainࡣ要素節点置ࡼ࠾び要素中心఩置ࡢ値࡚ࡋ࡜計算ࠋࡍࡲࢀࡉ 
 節点ᖹ均値ࡣ計算ࠋࢇࡏࡲࢀࡉ 
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 ࡢ࡚࡭ࡍ Strainࢸンࢥ࣭ࣝࢯン࣏࣮ࢿンࡀࢺ計算ࢸ࡚ࡗࡼ࡟ࢀࡇࠋࡍࡲࢀࡉンࢆࣝࢯ任意ࡢᗙ標系࡬回転ࡏࡉ
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿ

ࢻン࣐ࢥ STRESS࡜ STRAINࢩࡢンࡀࢫࢡࢵࢱ修ṇࠊࢀࡉFEMtools 4.0࡛使用ࢩࡓࢀࡉンࡣ࡜ࢫࢡࢵࢱ互換性ࡀあ
 ࠋࢇࡏࡲࡾ

ࡀࣝࣈ࣮ࢸ࡜ࢫࢡࢵ࢕ࣇࣛࢢ Strain࡜ Stress࡟ࡵࡓࡢࢺ࣮࣏ࢧࡢ修ṇࠋࡓࡋࡲࢀࡉ 

ࢻン࣐ࢥ EXTRACT TENSORࢥࡀンࢸ࡟࣮ࣝࢯンࣝࢯ値ࢆ出力࡟ࡵࡓࡿࡍ追加ࠋࡓࡋࡲࢀࡉ 

Strainࡣ相関ศ析ࠊ感ᗘ解析࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࠊン࣏ࢫࣞࡢࢢン࡚ࡋ࡜ࢫ使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

静解析㸦Static Analysis㸧 

Staticࠊࡣࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲFEMtoolsࠊABAQUSࠊANSYSࠊNASTRAN࡟ࢫࢭࢡ࢔ࡿࡼ࡟ࣂ࢖ࣛࢻ対応ࠋࡍࡲࡋ
 ࠋࡓࡋࡲࢀࡉ追加ࡀࢫࢡࢵ࣎ࢡࢵ࢙ࢳStrains / Stressࠊ࡟ࡵࡓࡢ計算ࡢࡽࢀࡑ

 

Staticࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ 

FEMtoolsソࣝࡢ࣮ࣂそࡢ他ࡢ変更 

 FEMtools࡟࣮ࣂࣝࢯ関ࡿࡍ静的変఩࡜ Strainࡢ解析ࡀࣂ࢖ࣛࢻ更新ࠋࡓࡋࡲࢀࡉ 

FEMtoolsࣂ࢖ࣛࢻ࣭࣮ࣂࣝࢯ㸦femtools.bas㸧ࣈ࢕ࢸࢡ࢔ࠊࡣ DOF࣮ࣂࣝࢯࡀ方程式࡟使用ࡲࡋࢡࢵ࢙ࢳ࠿ࡿࢀࡉ
ࡢ࡚࡭ࡍࡾࡼ࡟ࢀࡇࠋࡍ DOF࡟関ࡢࢪ࣮ࢭࢵ࣓࣮࢚ࣛࡿࡍ出力ࢆ回避ࠋࡍࡲࡋ 

FEMtools Dynamics 

 ࡢࢫࢡࢵࣜࢺ࣐࣭࣒ࢸࢫࢩࡢࢻ࣮࣭ࣔࢺࢫࢸ K࡜Mࡢ計算ࢆ実証ࣔࢹࠊ࡟ࡵࡓࡿࡍンࣙࢩ࣮ࣞࢺࢫン࣭ࢡࢫ
ࢺࣉࣜ compute_matrices_from_modes.basࡀ....\scripts\demo࡟追加ࠋࡓࡋࡲࢀࡉ 

 ࣮ࣔࢭ࢔࣭ࢫ࣮࣭࣋ࣝࢲンࣜࣈ㸦MBA㸧ࠊࡣࣝࢿࣃMBAࡢ現ᅾ値ࢆ使用࢕ࢸࢵࢭࠊࡋンࢆࢢ計算ࠋࡍࡲࡋ 
 DEFINE MBA SUBSTRUCTURE࡜ EXTRACT MBA SUBSTRUCTURESࡢ修ṇ：FEM要素ࡀࣉ࢖ࢱ修ṇ要素ࡢ

場合ࢆࣉ࢖ࢱࣈࢧࠊ格納ࠊࡋᢳ出ࠋࡍࡲࡋ 
 ࣓ࣗ࢟ࢻンࠊࡣ࡟ࢺMBA COMPUTE࣐ࢥンࠕࡢࢻnumber of modes㸦࣮ࣔࢻ数㸧ࠖ ࡋ記述ࢆ意味ࡢࢢン࢕ࢸࢵࢭ

ࣔࡢ࣒ࢸࢫࢩ修ṇ済ࡿࢀࡉ中࡛維持ࢫ࣮࣋ࢱ࣮ࢹࡃ࡞ࡣ数࡛ࢻ࣮ࣔࡿࢀࡉ使用࡚ࡗࡼ࡟MBAࠊࡣࢀࡑࠋࡍࡲ
ࡋ維持ࢆࢻい࣮ࣔ࡞少ࠋࡍ数࡛ࢻ初期࣮ࣔࣝࢲ࣮ࣔࡢ未変更ࡣnumber of modesࠖࠕࡢࢺ࢛ࣝࣇࢹࠋࡍ数࡛ࢻ࣮
 ࠋࢇࡏࡲࡾ࡞ࡤࢀࡅ࡞ࡋ指定ࢆ値ࡢࡑࡣ࣮ࢨ࣮ࣘࠊࡳࡢい場合࡞ࡽ࡞ࡤࢀࡅ࡞
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FEMtoolsࢺࢫࢸࣜࣉ解析と相関分析  

 ン㸦Traceline㸧自動生成࢖ࣛࢫ࣮ࣞࢺ

ࢺンࢥࡢࡃ多ࡾࡼࠊࢀࡉ改善ࡶ結果ࡢࡑࠋࡓࡋࡲࢀࡉ修ṇ࡛࣒ࢬࣜࢦࣝ࢔いࡋ新ࡣ࣮ࣝࢶン自動生成࢖ࣛࢫ࣮ࣞࢺ

密ࠊࡣ࣮ࣝࢶいࡋ新ࡢࡇࠋࡍࡲࡋ対応ࡶ࡟ࢺン࢖࣏ࡢࡃ多ࠊࢀ行わ࡟迅速ࡣ処理ࡢࡑࠋࡓࡋࡲࡾ࡞࡟能ྍࡀ࣮ࣝࣟ

ࡉ使用࡟ࡵࡓࡢࢱ࣮ࢹ࣭ࢫ࢖࢙ࣇ࣮ࢧࡓࢀࡉン装置࡛生成ࣕ࢟ࢫ࣮ࢨ࣮ࣞࠊࡤ例えࠊࡋ対応ࡶ࡟処理ࡢࢻࢵࣜࢢ࡞

 ࠋࡍࡲࢀ

࢓ࣇ外部ࡣいࡿあࠊࢱ࣮ࢹ群ࢺン࢖࣏ࡢࢺン࢖࣏࣭ࢺࢫࢸࡓࢀࡽ選択࡛得࣮ࢧンࢭࡢ手動ࡣࡓࡲ自動ࡣ࣮ࣝࢶࡢࡇ

使用ࢆࣝࢹ࣭ࣔࢺࢫࢸࡢ既Ꮡࡓ備えࢆン࢖ࣛࢫ࣮ࣞࢺࠋࡍࡲࡋ使用ࢆࢱ࣮ࢹ࣭ࢺン࢖࣏ࡓࢀࡉࢺン࣏࣮࢖ࡽ࠿ࣝ࢖

 ࠋࡍࡲࡁ࡛ࡶ࡜ࡇࡿࡍ再編集ࢆン࢖ࣛࢫ࣮ࣞࢺࡢ既Ꮡࠊ場合ࡢࡇࠋࡍࡲࡁ࡛ࡶ࡜ࡇࡿࡍ

い࢕ࢸࢵࢭࡢ࠿ࡘࡃンࢢ㸦࢖ࣛࢫ࣮ࣞࢺンࡢ角ᗘ࢖࣏ࠊンࢺ間ࡢ最大距㞳࡝࡞㸧࢖ࣛࢫ࣮ࣞࢺࠊ࡚ࡗࡼ࡟ン࣮࢜ࣂ

 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ回避ࢆࣉࢵ࣮ࣛ

Tools > Pretest Analysis > Generate Tracelines ࠊࡽ࠿Generate Tracelinesࢆࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ開ࠋࡍࡲࡁ 

 

Generate Tracelinesࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ 

 ࠋࡍGENERATE TRACELINES࡛ࠊࡣࢻン࣐ࢥ相当ࡢࡑ

 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆࣝ࢔ࣗࢽ࣐࣭ࢫンࣞ࢓ࣇࣜࢻン࣐ࢥࡣࡓࡲ情報ࣉࣝ࣊ࠊࡣヲ細ࡢい࡚ࡘ࡟ࢢン࢕ࢸࢵࢭࡢࡑ

以ୗ࡟いࢪ࣮࣓࢖ࡢ࠿ࡘࡃ例ࢆ示ࠋࡍࡲࡋ 
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自動࢖ࣛࢫ࣮ࣞࢺン生成例㸦ᕥᅗ：࢜ࣜ࢖࣏࣭ࣝࢼࢪンࢺ群ࠊ右ᅗ：生成ࣝࢹ࣭ࣔࢺࢫࢸ㸧 

生成࢖ࣛࢫ࣮ࣞࢺン࢖࣏࡟ࣝࢹ࣭ࣔࢺࢫࢸࠊࡣンࢺ接⥆ࢆ追加ࢺ࣮ࢱࢫࡢࡇࠋࡍࡲࡋ方法ࠊ࡚ࡋ࡜Tools > Pretest 
Analysis > Edit Tracelines, Tools > Pretest Analysis > Generate Surfaces あࡿいࠊࡣDatabase > Mesh Tools > Test Model 
Editorࢆ使用ࠋࡍࡲࡋ 

 必要条件ࢱ࣮ࢹࡢためࡢ解析ࢺࢫࢸࣜࣉ

Tools > Pretest Analysis࣐ࢥࡢୖ࣮ࣗࢽ࣓ࣈࢧンࠊࡣࢻFEࣔࡀࣝࢹ無い場合ࠊ幾何学特性ࡣࡓࡲ材料特性ࡀ未定義
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ使用ࡶい場合࡛࡞ࡁ利用࡛ࡣࣉ࣮࢙ࢩࢻ࣮ࣔࡣいࡿ場合あࡢ

ࢻン࣐ࢥ PRETEST ADDࠊPRETEST MOVEࠊPRETEST REMOVEࡀࢱ࣮ࢹࢻ࣮ࣔࠊࡣ無ࡀࡳࡢࣝࢹ࣭ࣔࢺࢫࢸࠊࡃ
Ꮡᅾࡿࡍ場合ࠋࡍࡲࡋࢺ࣮࣏ࢧࡶ 

新ࡋい補語ࡢ DOF PAIREDࠊࡀDOF࣌࡟ࣝࢹ࣭ࣔࢺࢫࢸࣜࣉࢆࣝࣈ࣮ࢸ࣭࢔変換ࡿࡍ PRETEST ADD࣐ࢥン࡟ࢻ
追加ࠋࡍࡲࢀࡉ 

 ࠋࡍࡲࡋ࡟能ྍࢆ以ୗࡣ変更ࡢࡽࢀࡇ

ࢧンࢭRotateࠊࡶ࡚ࡃ࡞ࡋᏑᅾ࡟ࢫ࣮࣋ࢱ࣮ࢹࡀࣉ࣮࢙ࢩࢻび࣮ࣔࡼ࠾ࣝࢹFEࣔࠊࡋࢺン࣏࣮࢖ࢆࣝࢹ࣭ࣔࢺࢫࢸ
࢔࣌ࠊࢢンࣜ࢔DOF࣌ࠊ࣮ࣆࢥࡢ࡬FEMࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ使用ࢆࣝࢿࣃ࣭࣮ DOF࡟基࡙いࢭࡓン࣮ࢧ生成ࡀ
自動的࡟実行࢘ࣛࢢࢡࢵࣂࡢࡵࡓࡿࢀࡉンࣙࢩ࣮࣭ࣞ࣌࢜ࢻン࢕ࢸࢵࢭ࣭ࢺ࢛ࣝࣇࢹࡣンࢆࢢ使用࢛ࣇࢹࠋࡍࡲࡋ

 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ手動࡛設定ࡣ場合ࡿࡍ使用ࢆ以外ࢢン࢕ࢸࢵࢭ࣭ࢺࣝ

FE࣮ࣔࡀࣉ࣮࢙ࢩࢻ利用ྍ能࡛࡞い場合ࠊManual Sensor Selectionࢭࡢࣝࢿࣃンࢆ࣮ࢧ削除࠿ࡿࡍ移動ࡔࡃ࡚ࡏࡉ
 ࠋいࡉ

ࡉࡔࡃ࡚ࡗ行ࢆ選択࣮ࢧンࢭ࣭ࣝ࢔ࣗࢽ࣐ࡢୖࣝࢹFEࣔࠊ無い場合ࡀ必要ࡿࡍࢺン࣏࣮࢖ࡣࡓࡲ計算ࢆࣉ࣮࢙ࢩ
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いࠋ 

既Ꮡࢆࣝࢹ࣭ࣔࢺࢫࢸࡢ使用ࠊࡋFEࣔࢆࢀࡑ࡟ࣝࢹ写像࢔࣌ࡢ࡚ࡋ࡜ࣝࢹ࣭ࣔࢺࢫࢸࣜࣉࠊࡋ DOFࢆ使用ࡃ࡚ࡋ
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿ加えࢆン࢖ࣛࢫ࣮ࣞࢺ࡟任意ࠊࡓࡲࠋいࡉࡔ

Test Model Editor㸦Database > Mesh Tools ࡣࡓࡲ Tools > Pretest Analysis ࣓࣮ࣗࢽ㸧ࡶ使用࡛࡟࡜ࡇࡿࡁ注意ࡔࡃ࡚ࡋ
 ࠋいࡉ

 変更点ࡢ他ࡢそࡢ解析ࢺࢫࢸࣜࣉ

 統計計算㸦statistics㸧ࢥ࡜ンࡢࢺ࣮࣏࣭࣮ࣞࣝࢯᣑ張ࡀ自動ࢭン࣮ࢧ選択用ࡢ SEAMAC࡜ EIM法࡟追加ࢀࡉ
 ࠋࡓࡋࡲ

 Fixed Sensor locations㸦固定ࢭン࣮ࢧ఩置㸧ࡀ新ࡋいࢭンࡢ࣮ࢧ最ᑠࢭン࣮ࢧ距㞳ࢆ決定࡟ࡵࡓࡿࡍ考慮ࢀࡉ
 ࠋࡓࡋ能࡛ྍࡀࢢンࣜࢱࢫࣛࢡࡢ間࣮ࢧンࢭいࡋ新࡜࣮ࢧンࢭ固定ࡣ以前ࠋࡓࡋࡲ

 いࡢ࠿ࡘࡃ自動ࢭン࣮ࢧ選択方法㸦normal-tosurface placement; EIM statistics, Maximum MAC Alias,…㸧ࡀ修ṇ／
ᣑ張ࠋࡓࡋࡲࢀࡉ例えࠊࡤ最పMAC値ࡽ࠿0%ࠊࡣ  ࠋࡓࡋࡲࢀࡉ変更࡟1%

 Excitation Location Selection㸦加振఩置ࡢ選択㸧形式ࡀ修ṇࠋࡓࡋࡲࢀࡉ以前ࠊࡣShow Candidatesࣈ࢕ࢸࢡ࢔ࡀ
 ࠋࡓࡋ࡛ࢇࡏࡲࡾあࡣ࡛

 ࢻコ࣐ン࣭࢕ࢸ࢕ࣜ࢕ࢸ相関分析࣮ࣘࢫࢭࣟࣉࢺࢫ࣏

次ࡀࢺࣉࣜࢡࢫ࣭࢕ࢸ࢕ࣜ࢕ࢸ࣮ࣘࡢ..\scripts\utilities࡟追加ࠋࡓࡋࡲࢀࡉ 

csc13ob.bas  1/3࢜ࣂࣈ࣮ࢱࢡンࢻ用ࡢ CSC FRF相関関数ࢆ計算ࠋࡍࡲࡋ  

checkfrfpair.bas  ࣌࢔ FRFࡢ DOF࢖ࢧンࠊࡋࢡࢵ࢙ࢳࢆ必要࡟応࡚ࡌ自動的࢖ࢧ࡟ンࢆ
ษࡾ替えࠋࡍࡲ 

相関分析ࡢそࡢ他ࡢ変更点 

 いࡢ࠿ࡘࡃ改良࢖ࡀンࣈ࢕ࢸࢡࣛࢱMode Shape Pairs Editor࣮ࣝࢶ㸦Tools > Correlation Analysis > Mode Shape 
Pair Viewer㸧࡟行わࠋࡓࡋࡲࢀヲ細ࠕࠊࡣMode Shape Pairs Editorࠖࢆ参照ࡉࡔࡃ࡚ࡋいࠋ 

 静的変఩ࡼ࠾び Strain࣮࣋ࡢࢫ相関ศ析ࡼ࠾びࣔ࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹンࡢࢢ例題ࡀ追加ࠋࡓࡋࡲࢀࡉ 
ヲ細ࠕࠊࡣ例題ࡢ変更ࠖࢆ参照ࡉࡔࡃ࡚ࡋいࠋ 
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 選択ࡢࢱ࣮࣓ࣛࣃとࢫン࣏ࢫࣞ

Strain㸦歪み㸧࣏ࣞࢫンࡢࢫ計算 

FEMtools 4.1ࡣ相関ศ析ࠊ感ᗘ解析ࡼ࠾びࣔ࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹンࡢࡵࡓࡢࢢ Strain࣏ࣞࢫンࡲࡋࢺ࣮࣏ࢧࢆࢫ
 ࠋࡍ

Strain࣏ࣞࢫン࡟ࢺ࣮࣏ࢧࡢࢫ応ࠊ࡚ࡌCreate Responseࠊࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲRESPONSE STRAIN࣐ࢥンࡼ࠾ࢻび
Responsesࡶࣝࣈ࣮ࢸ更新ࠋࡓࡋࡲࢀࡉ 

Create Responseࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ 

Strain用ࡢ Create Responseࢥࡣࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲン࣏࣮ࢿン࡜ࢺ Face࡟ࡵࡓࡿࡍࢺ࣮࣏ࢧࢆ修ṇࠋࡓࡋࡲࢀࡉ 

 

Create Responseࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ㸦ᕥᅗ：ࠊࣉ࢖ࢱ右ᅗ：࢕ࢸࣃࣟࣉ㸧 

RESPONSE STRAINコ࣐ンࢻ 

RESPONSE STRAIN࣐ࢥンࡣࢻ新ࡋい引ࡁ数ࡢ追加ࡾࡼ࡟修ṇࠋࡓࡋࡲࢀࡉ 

RESPONSE STRAIN   

<  
ELEMENT element_id,   
COMPONENT (SX | SY | TXY | int_val),  
FACE (TOP | BOTTOM | int_val),   
CS (GLOBAL | LOCAL | AUTOMATIC | int_val),   
LOAD int_val,   
SCATTER real_val,   
VALUE real_val  
>  

 DIRECTIONࡣ COMPONENTࡾྲྀ࡜替えࠊࡋࡔࡓࠋࡓࡋࡲࢀࡽDIRECTIONࠋࡍࡲࢀࡉࢺ࣮࣏ࢧࡔࡲࡣ 
 SXࠊSYࠊTXYࢥࡢン࣏࣮ࢿンࢺ定義࡜整数値ࡿࡼ࡟定義ࠊࡣSX=1ࠊSY=2ࠊTXY=3࡛指定࡛ࠋࡍࡲࡁ 
 FACE補語ࡀ追加ࢻࢵࣜࢯࡣࢀࡇࠋࡓࡋࡲࢀࡉ要素ࡢ Faceあࡿいࡣ 2D要素ࡢ Faceࢆ指定ࠋࡍࡲࡋ 
 ࡞ࡁ࡛ࢫࢭࢡ࢔い࠿見え࡞いࢻࢵࣜࢯ要素 FACEࡀ選択࡚ࢀࡉいࡿ場合ࡀࢪ࣮ࢭࢵ࣓࣮࢚ࣛࠊ出力ࠋࡍࡲࢀࡉ 
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Faceࡀ選択࡞ࢀࡉい場合： 

ࡢࡘ1ࠊࡣ要素࡛ࢻࢵࣜࢯ - Faceࡀࡳࡢ見えࡿ場合ࡢࡑࠊ Faceࡀ自動的࡟選択ࡑࠊࢀࡉう࡛࢚ࣛࡤࢀࡅ࡞
 ࠋࡍࡲࢀࡉ出力ࡀࢪ࣮ࢭࢵ࣓࣮
 

 ࠋࡍࡲࢀࡉ選択࡚ࡋ࡜ࢺ࢛ࣝࣇࢹࡀFace㸦TOP=1㸧࣮ࣂ࢖࢓ࣇࡢ部ୖࠊࡣ要素࡛࢙ࣝࢩ -
 
TOP=1, BOTTOM=2   

 AUTOMATICࡣ選択ࡓࢀࡉ Face࡟垂直࡞ Z軸ࡼ࠾び Faceᖹ面ୖࣝࣂ࣮ࣟࢢࡢ X軸ࢆ CSࡢ X軸ࡼࡿࡍ࡜う࡟
定義ࣝࣂ࣮ࣟࢢࠋࡍࡲࡋ X軸ࠊࡀFace࡟垂直㸦0.1ᗘࡢ許容角㸧࡞場合ࣝࣂ࣮ࣟࢢࠊࡣ Z軸ࡀ使用ࠋࡍࡲࢀࡉ 

 ࡣࢀࡇ Abaqus࢚࣭࢙ࣜ࢜ࣝࢩ࣭ࢺ࢛ࣝࣇࢹࡢンࣙࢩ࣮ࢸン法࡟準ᣐࠊࡋ直観的࡟最適࣮ࣝ࢝ࣟ࡞軸ࢆ生成ࡋ
ࡢࢻࢵࣜࢯࡀࢀࡑࡣFEMtools࡛ࠋࡍࡲ Face࡟ࡵࡓࡢ使用ࠋࡍࡲࢀࡉ 

 ࣝࣂ࣮ࣟࢢࡢୖࢫ࢖࢙ࣇ࣮ࢧ軸ࡢࢀࡒࢀࡑࠊࡣ軸࣋ࡢࣝࢺࢡ積࡚ࡗࡼ࡟決定ࠋࡍࡲࢀࡉ 
 
GLOBAL=0, LOCAL=-1, AUTOMATIC=-2   
 
 要素例㸦static_strain_3 helix example㸧ࢻࢵࣜࢯ
 

 ࢻࢵࣜࢯ要素ࡢ ࡢ645 Faceࡀ見えࡿ場合ࡢ࣮ࣝ࢝ࣟࠊ SX測定方向ࢆ定義࡟ࡵࡓࡿࡍ自動࣮ࣟ࢝ࣝᗙ標系ࢆ使
用ࠊࡋSX=-2.207E-6ࡢ Strain値ࢆ指定ࠋࡍࡲࡋ 
 
response strain load 10 element 645 component 1 face 0 as auto value -2.2070E-06 scatter 1 

 ࣝࣈ࣮ࢸ࣭ࢫン࣏ࢫࣞ

 ࣏ࣞࢫンࣝࣈ࣮ࢸ࣭ࢫ㸦TABLE RESPONSE㸧ࡣ Strain࣏ࣞࢫンࢫ情報ࢆ表示࡟ࡵࡓࡿࡍ更新ࠋࡓࡋࡲࢀࡉ 
 
例：Index/Source/Load/Element/Component/Face/CS/Scatter 

 

Strain࣏ࣞࢫンࢆࢫ示࣏ࢫࣞࡍンࣝࣈ࣮ࢸ࣭ࢫ 
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Strain࣏ࣞࢫンࢆࢫ示࣏ࢫࣞࡍンࣝࣈ࣮ࢸ࣭ࢫ 

EXTRACT RESPONSE࣐ࢥンࡣࢻヲ細情報ࢆ表示ࠋࡍࡲࡋ 

例 

Source  Load  Element  Component Face  CS  Scatter (%)  Value  
1 Test  10  94  TXY  3037  1001  1  -2.30440E-04  
2 Test  20  3117  SX  3037  1002  1  5.24840E-04  
3 Test  20  3117  TXY  3037  1002  1  1.36680E-04  
4 Test  30  3117  SX  3037  1002  1  2.31240E-04  
5 Test  30  3117  TXY  3037  1002  1  4.75640E-05 

 変更ࡢ他ࡢそࡢ選択ࢫン࣏ࢫࣞ

 ࣏ࣞࢫンࢫ定義࣐ࢥンࢆ࣮࢚࡛ࣛࢻ引ࡁ起ࡓࡋࡇ場合࡛࣏ࢫࣞࡶンࣝࣈ࣮ࢸ࣭ࢫ全体ࢆ破壊ࡣ࡜ࡇࡿࡍあࡲࡾ

 ࠋࢇࡏ
 ࡢࢺ࢛ࣝࣇࢹ Scatter値0ࠊ࡚ࡋ࡜あࡿいࡣ㈇ࡢ値ࡀ定義࡛ࠋࡍࡲࡁ 
 重複࣏ࣞࢫンࢫ定義ࠊࡣ最後ࡢ定義࣏ࢫࣞࡓࢀࡉンࡀࢫ維持ࠋࡍࡲࢀࡉ 
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FEMtoolsࣔ࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹンࢢ 

 ࢻコ࣐ン࣭࢕ࢸ࢕ࣜ࢕ࢸ感ᗘ解析࣮ࣘࢫࢭࣟࣉࢺࢫ࣏

次ࡀࢺࣉࣜࢡࢫ࣭࢕ࢸ࢕ࣜ࢕ࢸ࣮ࣘࡢ..\scripts\࣮ࣘ࡟࢕ࢸ࢕ࣜ࢕ࢸ追加ࡍࡲࢀࡉ: 

delparamsens.bas  delparamsens.basࠊࡣ感ᗘࣞ࣋ࣝ࡟基࡙いࠊࡓ選択࣭ࢱ࣮࣓ࣛࣃࡓࢀࡉ
ࢫࢡࢵࢱンࢩࠊࢻン࣐ࢥࡢࡇࠋࡍࡲࡋ削除ࢆࢱ࣮࣓ࣛࣃࡽ࠿ࣝࣈ࣮ࢸ

ࢱࢆHELP DELRESPSENSࠊ࡟ࡵࡓࡿࡍ参照ࢆヲ細情報ࡢび例証ࡼ࠾
 ࠋいࡉࡔࡃ࡚ࡋࣉ࢖

defsetsens.bas  defsetsens.basࠊࡣ感ᗘࣞ࣋ࣝ࡟基࡙いࢆࢺࢵࢭࡓ作成ࠋࡍࡲࡋ感ᗘ間
隔࡟基࡙いࢆࢺࢵࢭࡓ作成ࠊ࠿ࡿࡍあࡿいࠊࡣ例えࢆ0.1%ࠕࡤ越えࡿ
E変更感ᗘࢆ備えࡢ࡚࡭ࡍࡓ要素ࠖࡼࡢうࢆࢺࢵࢭ࡞作成ࡀ࡜ࡇࡿࡍ
ࠋࡍࡲࡋ対応࡟㸧࡜ࡈ㸦要素ࢱ࣮࣓ࣛࣃ࣭࣮ࣝ࢝ࣟࠊ現ᅾࠋࡍࡲࡁ࡛

ࡍ参照ࢆヲ細情報ࡢい࡚ࡘ࡟び例証ࡼ࠾ࢫࢡࢵࢱンࢩࠊࢻン࣐ࢥࡢࡇ

 ࠋいࡉࡔࡃ࡚ࡋࣉ࢖ࢱࢆHELP DELPARAMSENSࠊ࡟ࡵࡓࡿ

静的変位࣮࣋࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࡢࢫンࢢ 

FEMtoolsࠊ࡟ࡶ࡜࡜࣮ࣂࣝࢯ静的変఩࣮࣋࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࡢࢫンࠊࡀࢢAnsysࠊAbaqusࠊNastran࡛࣮ࣂࣝࢯ
 ࠋࡓࡋࡲࢀࡉࢺ࣮࣏ࢧ

 ࠋࡓࡋࡲࢀࡉ追加ࡀ例題ࡢ次࡟ࡵࡓࡿࡍ実証ࢆࢢン࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࡢࡑ

..\examples\updating\static_1  

..\examples\updating\static_2 ..\examples\updating\static_strain_2  

Strain㸦歪み㸧࣮࣋࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࡢࢫンࢢ 

Strain࣮࣋࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࡢࢫンࠊࡣࢢFEMtoolsࠊAnsysࠊAbaqusࠊNastranࡋࡲࢀࡉࢺ࣮࣏ࢧ࡛࣮ࣂࣝࢯ
ࢫStrainࣞࠋࡍࡲࡋ動作࡟様ྠ࡜ࣉ࢖ࢱ࣭ࢺ࣮ࢹࣉࢵ࢔ࡢ࡚࡭ࡍࡢ௚ࡢࡑࡶ場合ࡿࢀࡉ選択ࡀࢫン࣏ࢫStrainࣞࠋࡓ
࣏ンࡣࢫ᭷限要素࡟ࢫ࢖࢙ࣇ࣮ࢧ関࡚ࡋ計算ࠊࢀࡉ静的荷重変形࡟起因ࡿࡍ面ෆ Strain値㸦sxࠊsyࠊtxy㸧࡛ࡇࠋࡍ
ࡢ要素ࢻࢵࣜࢯࡣࢀ Face2ࠊD要素ࡢ Faceあࡿいࡢ࣮ࣂ࢖࢓ࣇࡣ Top／Bottom࡛生成ࠋࡍࡲࢀࡉ 

࡟特ࠊࡣࡽࢀࡑࠋࢇࡏࡲࡾ遊いあ࡟ࡿ物理特性࡛あࡢ要素࡞うࡼࡢࡉ厚ࢺ࣮ࣞࣉࡣいࡿ材料特性あࠊࡣࢱ࣮࣓ࣛࣃ

要素 Strainࡣ࡟高感ᗘ࡛ࠋࡍ 

次ࢺ࣮ࣞࣉࠊ࡟厚ࡢࡉ Strain࣮࣋ࢺ࣮ࢹࣉࢵ࢔ࡢࢫ例ࢆ示࣮ࣜࢡࢫࡢࡑࠋࡍࡲࡋンࡣࢺࢵࣙࢩ཰束࣮࢝ࣈ㸦ୖᕥ
ᅗ㸧ࠊ静的変఩㸦ୖ右ᅗ㸧ࠊ静的要素 Strain㸦ୗᕥᅗ㸧ࢱ࣮࣓ࣛࣃࠊ変更㸦ୗ右ᅗ㸧ࢆ示ࠋࡍࡲࡋ 
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Strain࣮࣋ࢺ࣮ࣞࣉࡢࢫ厚ࢺ࣮ࢹࣉࢵ࢔ࡢࡉ例 

新ࡋいࢺ࣮ࢹࣉࢵ࢔解析ࢆ実証ࡿࡍ例題ࡀ追加ࠋࡍࡲࢀࡉ 

..\examples\updating\static_strain_1  

..\examples\updating\static_strain_2  

..\examples\updating\static_strain_3  

ABAQUS࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

 Abaqus 2019ࢺ࣮࣏ࢧࡢ 
 静的変఩࡜ strain解析ࢺ࣮࣏ࢧࡢ 
 ࣮ࣔࢻ番号࡜周波数ࣞン࡟ࢪ基࡙い࢖ࢆࢻ࣮ࣔࡓン࣏࣮ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍࢺ関連ࠊ࡚ࡋ࡜SEARCH 

MODE࣐ࢥンࢆࢻ参照ࡉࡔࡃ࡚ࡋいࠋ 
 大࡞ࡁ.SIMࣝ࢖࢓ࣇ㸦10GBࢆࢬ࢖ࢧ実証㸧࢖ࢆン࣏࣮ࡼࡿࡁ࡛ࢺう࡟改善ࠋࡓࡋࡲࢀࡉ 

ANSYS࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

 ANSYS/2019R2 19.4ࢺ࣮࣏ࢧࡢ 
 RSTࡣࢲ࣮࣭ࣜࣝ࢖࢓ࣇ大ࣝ࢖࢓ࣇ࡞ࡁ㸦ILP64㸧ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆ 
 静的変఩࡜ strain解析ࢺ࣮࣏ࢧࡢ 
 ࣮ࣔࢻ番号࡜周波数ࣞン࡟ࢪ基࡙い࢖ࢆࢻ࣮ࣔࡓン࣏࣮ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍࢺ関連ࠊ࡚ࡋ࡜SEARCH 

MODE࣐ࢥンࢆࢻ参照ࡉࡔࡃ࡚ࡋいࠋ 
 ᣑ張子 DATࡣࣝ࢖࢓ࣇࡢ CDBࡌྠ࡜方法࡛᥈索ࠋࡍࡲࢀࡉ 
 FEM準ᣐࡢ場合ࠊࡣ࡟ANSYS࡟ࣂ࢖ࣛࢻ EMATWRITE࣓ࢺ࣮ࢸࢫンࢆࢺ追加ࡣࢀࡇࠋࡍࡲࡋ自動的࡟ EMAT

い࡞࠿書ࢆ ANSYS 18+࡟ࡵࡓࡢ必要ࠋࡍࡲࡾ࡞࡟警告：ansys.runࡣ EMATWRITEࢆ含࡛ࢇいࡀࡓࡋࠋࢇࡏࡲ
ࡢ既Ꮡࠊ࡚ࡗ ansys.run࡜一緒࡟ ansys.basࢆ実行ࡿࡍ場合ࠊANSYS 18+ࢆࢫࢡࢵࣜࢺ࣐࡟出力ࠋࢇࡏࡲࡋ 

 CDWRITEࡓࢀࡉࢺ࣮࣏ࢫࢡ࢚࡚ࡗࡼ࡟ ANSYS CDBࠊࡣࣝ࢖࢓ࣇᪧࣙࢪ࣮ࣂンࡢ 180文Ꮠ／ࣛ࢖ン࡜異ࡿ࡞
190文Ꮠ／ࣛ࢖ンࢆ使用ࡣࢀࡇࠋࡍࡲࡋ主࡚ࡋ࡜ HEXA8要素࢖ࡢン࣏࣮࡟ࢺ影響ࠋࡍࡲࡋCDB࣮ࣜࡢࡇࡣࢲ
長いࣛ࢖ン長ཷࢆ理࡟ࡵࡓࡿࡍ修ṇࠋࡓࡋࡲࢀࡉ 

 ࢚ࡓࢀࡉࢺ࣮࣏ࢫࢡ CDBࣝ࢖࢓ࣇ中ࡢ節点ᗙ標精ᗘࠊࡣANSYS࡟生成ࡓࢀࡉ CDB࡚ࡗࡼ࡟ࣝ࢖࢓ࣇ使用ࡉ
 ࠋࡓࡋࡲࢀࡉ変更࡟ࣝ࣋ࣞࡌྠ࡜ࡢࡿࢀ

 ANSYSࠊࡣࣂ࢖ࣛࢻ結節点ࡢ変఩ࢆࡳࡢ必要ࡿࡍ࡜場合ࠊ要素ࡢࢱ࣮ࢹ出力ࢆ回避ࠊࡋStrain出力ࢆ検知ࡲࡋ
出࡟常ࡀ力㸧ࠊ㸦Stress／Strainࢱ࣮ࢹ要素ࡃࡘ結び࡟ࣝ࢖࢓ࣇ࡞ࡁ大ࡢ必要以ୖࠊࡣ࡛ࢺ࢛ࣝࣇࢹࡢ以前ࠋࡍ
力ࠋࡓࡋࡲࢀࡉ 
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 ANSYSࡿࡼ࡟ࣂ࢖ࣛࢻᅽ縮 RSTࡢࣝ࢖࢓ࣇ生成ࢆ回避ࠊ࡟ࡵࡓࡿࡍ/FCOMP RST 0ࡀ実行࡟ࣝ࢖࢓ࣇ追加ࡉ
 ࠋࡍࡲࢀ

 解析結果࡚ࡋ࡜生成ࡿࢀࡉ荷重ࣝ࢖࢓ࣇ࣭ࢫ࣮ࢣ㸦inter.s***㸧ࡣ作業ࡽ࠿࣮ࣜࢺࢡࣞ࢕ࢹ削除ࠋࡍࡲࢀࡉ 

NASTRAN࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

 MSC.Nastran 2019ࢺ࣮࣏ࢧࡢ 
 静的変఩࡜ strain解析ࢺ࣮࣏ࢧࡢ 
 要素ࢺࢵࢭ定義࡟対応ࠊࡓࡲࠊ外部要素 IDࡀෆ部 IDࡣ࡜異ࡿ࡞場合ࡢ修ṇ 
 ASET1入力ࣛࣈࡢンࢺ࣮࣏ࢧࡢࢻ࣮ࣝ࢕ࣇ࣭ࢡ 
 PCOMP࣮࢝ࢻ中ࣛࣈࡢン࡟ࢡ遜遇ࡓࡋ場合࢖ࠊン࢙ࣇ࣮ࢱｲࡣࢫ終了࡚ࡋいࠋࡓࡋࡲ現ᅾࣛࣈࠊン࡟ࢡ遜遇ࡋ

 ࠋࡍࡲࢀࡉࣉࢵ࢟ࢫࡣ場合ࡓ
 ෇筒ᗙ標系ࡢ中心軸࡟近い節点࢚ࣜ࢜ࡢンࣙࢩ࣮ࢸンࡀ修ṇࡢࡇࠋࡍࡲࢀࡉ場合࢚ࣜ࢜ࠊンࣙࢩ࣮ࢸンࡣ曖昧

ࢆンࣙࢩ࣮ࢸン࢚࣭ࣜ࢜ࢺ࢛ࣝࣇࢹࠊࡋ認識ࢆ状況ࡀ許容値ࠊ࡚ࡗࡀࡓࡋࠋࢇࡏࡲࢀࡋࡶ࠿ࡓい࡚ࢀࡉ決定࡟

適用࡟ࡵࡓࡿࡍ必要ࡢࡑࠋࡍࡲࢀࡉ࡜許容値ࡣMSC.NASTRAN࡚ࡗࡼ࡟使用ࠋࡍࡲࡾ࡞࡟ࡌྠ࡜ࡢࡶࡿࢀࡉ 
 CONM1ࢺࢵࢭࣇ࢜ࡢ慣性値ࢆ備えࡓ CONM2ࡢ変換ࡢࡑࡣ慣性値࡚ࡗࡼ࡟修ṇࠋࡍࡲࢀࡉCONM節点࡟ᣑ張

 ࠋࡍࡲࢀࡉ使用࡟ࡵࡓࡢ計算ࡀ軸࣮ࣝ࢝ࣟࡢ෇筒ᗙ標系原点ࠊ場合ࡿࡍ࡜軸࣮ࣝ࢝ࣟࡓࢀࡉ
 PBEAMLࠕࡢLࠖࣙࢩࢡࢭンࡽ࠿ PBEAMࡢ࡬変換ࡣMSC.NASTRANࣜࣞ࢓ࣇンࡢࣝ࢔ࣗࢽ࣐࣭ࢫ定式ࢆ使

用࡚ࡋ再実行ࠋࡍࡲࢀࡉ以前ࡢ変換ࡾࡼṇ確࡟変換ࠋࡍࡲࢀࡉ 

SAP2000࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

 SAP2000 v20ࢺ࣮࣏ࢧࡢ 

 㸦MPE㸧࣮ࢱࢡࣛࢺࢫࢡ࢚࣭ࢱ࣮࣓ࣛࣃ࣭ࣝࢲ࣮ࣔ

 異ࡿ࡞周波数帯࣮࣏ࣝࡢ㸦極㸧値ࠊࡣRemoving unextracted pole(s)࢜ࣙࢩࣉン࡛灰色㸦࣮ࣞࢢ表示㸧ࡲࡾ࡞࡟
 ࠋࡍ

 ࢚࣮࣓ࣛࠕࢪ࣮ࢭࢵNot enough frequency lines available to compute specified model order ..㸦ࣔࡢ࣮ࢲ࣮࣭࢜ࣝࢹ
指定ࡀ୙十ศ..㸧ࠖ ࡍࢡࢵࣜࢡࢆンࢱExtract Poles࣎ࠊࡋ修ṇࢆࢢン࢕ࢸࢵࢭࠊン࢖周波数ࣛࡢࡑࠊ伴う場合ࢆ
 ࠋࡍࡲࡾ࡞࡟ࣈ࢕ࢸࢡ࢔再びࡀ実行ࡢ計算ࠊ࡚ࡗࡼ࡟࡜ࡇࡿ

 ୖ限࡜ୗ限ࣗࢹࢪࣞࡢ㸦残余値㸧ࡢ計算ࡀ追加ࠋࡍࡲࢀࡉ 
 ࣐ࢥンࢻMPE SWAPCHANNELSࡣ DSP SWAPCHANNELSࡾྲྀ࡜替えࠋࡍࡲࢀࡽ 

剛体特性࢚࣮ࢱࢡࣛࢺࢫࢡ㸦RBPE㸧 

 ࣮ࣟ࢝ࣝ軸ࡀࢺ࣮࣏ࢧࡢ追加ࠋࡓࡋࡲࢀࡉ 
 ࣮ࣟ࢝ࣝ CSࡼ࠾びࣝࣂ࣮ࣟࢢ CSࡢ使用ࢆ実証ࡢࡵࡓࡿࡍ修ṇ࣐ࢥンࢺࣉࣜࢡࢫ࣭ࢻ

 ࠋࡓࡋࡲࢀࡉ追加࡟example\rbpe\engine\..ࠊࡀ
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コ࣐ンࢻ 

新ࡋいコ࣐ンࢻ 

CLEAR TENSOR  ࢸンࢱ࣮ࢹ࣭ࣝࢯ㸦Stress／Strain㸧ࢆ削除ࠋࡍࡲࡋ 
DSP SWAPCHANNELS  以前ࠊࡣMPE SWAPCHANNELS࡛ࠋࡓࡋ  
EXTRACT TENSOR  Stressࡣࡓࡲ Strainࢸンࢆࢱ࣮ࢹ࣭ࣝࢯ示ࠋࡍࡲࡋ 

GENERATE TRACELINE  自動的࢖࣏࡟ンࢺ群中࢖࣏ࡢンࢺ間࢖ࣛࢫ࣮ࣞࢺ࡟ンࢆ生成ࡋ

ࠊ最ᑠ角ᗘࡢン࢖ࣛࢫ࣮ࣞࢺ㸦ࢢン࢕ࢸࢵࢭࡢ࠿ࡘࡃいࠋࡍࡲ

ࣂ࣮࢜ࡢン࢖ࣛࢫ࣮ࣞࢺࠊࡣ㸧࡝࡞最大距㞳ࡢン࢖ࣛࢫ࣮ࣞࢺ

 ࠋࡍࡲࢀࡉ利用࡟ࡵࡓࡿࡍ回避ࢆࣉࢵ࣮ࣛ

SET CUSTOM COLORMAP  ࣮࣭࢝ࣛࢻ࣮ࢥ化ࢆࢺࢫ࣭࣮ࣜࣛ࢝ࡢࡵࡓࡢ指定ࣛ࢝ࠋࡍࡲࡋ

ࡣࡓࡲ標準色ࣛ࣋ࣝࡣ࣮ RGB࡚ࡗࡼ࡟ࢺࢵࣞࣉࣜࢺ表わࢀࡉ
 ࠋࢇࡏࡲࢀࡋࡶ࠿ࡿ

例：࢝ࣉࢵ࣐࣮࣭࣒ࣛ࢝ࢱࢫ㸦黒褐色：0 250 240㸧 

STRAIN  

 

要素 Strainࢆ計算ࠋࡍࡲࡋ 

修正さࢀたコ࣐ンࢻ 

EXAMINE MEF  新ࡋい補語 KEEPࠊALLࠊSETࡀ追加ࠋࡓࡋࡲࢀࡉ  
EXPAND  ࢩンࢫࢡࢵࢱ変更ࡾࡼࠊヲ細ࡢࣉ࣮࢙ࢩࢻ࣮࣭ࣔࢺࢫࢸࠕࠊࡣᣑ

張ࠖࢆ参照ࡉࡔࡃ࡚ࡋいࠋ 

GENERATE CONVERT  QUADࡢ一次要素ࡽ࠿஧次要素ࡢ࡬変換࢖ࣛࢫ࣮ࣞࢺࠊンࡽ࠿
2D要素ࡢ生成ࡢ機能ࡀ追加ࠋࡓࡋࡲࢀࡉ 

MATRIX  新ࡋい補語 XLABEL࡜ YLABELࡀ追加ࠋࡓࡋࡲࢀࡉ  
MESH  新ࡋい補語： 

ROUNDING boolean_val 

INTERVAL int_val 

FOLLOW boolean_val  

CMAP CUSTOM：࢝ࡣࣉࢵ࣐࣮࣭࣒ࣛ࢝ࢱࢫ SET CUSTOM 
COLORMAP PAIR࡛指定ࠋࡍࡲࢀࡉ 

PAIR –int_val：࣮ࣔࡢࣉ࣮࢙ࢩࢻ ࡟ࡘ1 180ᗘࡢ఩相ࢆࢺࣇࢩ適
用࡟ࡵࡓࡿࡍ使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

MESH MARK ELEMENT ECS：要素ᗙ標系࣐࣮࣮࢝ࢆ追加ࡲࡋ
 ࠋࡍ

TENSOR：࣓ࢸࡢୖࣗࢩࢵンࢆࢱ࣮ࢹ࣭ࣝࢯ写像ࠋࡍࡲࡋ 
SEARCH   STRAIN࡜ STRESSࠋࡓࡋࡲࢀࡉࢺ࣮࣏ࢧࡀ 
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SEARCH MODE  補語[int_val1[TO int_val2]]࡜ BETWEEN freq1 freq2ࡀ ANSYS
びࡼ࠾ ABAQUS࢖ン࢙ࣇ࣮ࢱｲࠋࡍࡲࢀࡉࢺ࣮࣏ࢧ࡛ࢫ㸦以前
 㸧ࠋࡓࡋ࡛ࢺ࣮࣏ࢧࡢࡳࡢNASTRANࠊࡣ

RESPONSE STRAIN  新ࡋい引ࡁ数ࡀ追加ࠋࡓࡋࡲࢀࡉ 

SET STATIC  ࢩンࡀࢫࢡࢵࢱ修ṇࠋࡓࡋࡲࢀࡉ 

STRESS  ࢩンࡀࢫࢡࢵࢱ修ṇࠋࡓࡋࡲࢀࡉ 

TABLE  補語 TENSORࡀ追加ࠋࡓࡋࡲࢀࡉ  

削除さࢀたコ࣐ンࢻ 

 PRETEST FRF࣐ࢥンࡣࢻ DEFINE FRFSࡾྲྀ࡜替えࠋࡍࡲࢀࡽ 
 CLEAR STRESS࣐ࢥンࡣࢻ CLEAR TENSORࡾྲྀ࡜替えࠋࡍࡲࢀࡽ 

FEMtoolsࢺࣉࣜࢡࢫ 

ENCODE࣐ࢥン࢚࡛ࢻンࠊࡣࢺࣉࣜࢡࢫ࣭࣒ࣛࢢࣟࣉࡿࢀࡉࢻ࣮ࢥᣑ張子࡞ࡢいࢆࣝ࢖࢓ࣇ Include࣓ࢺ࣮ࢸࢫン
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ指定࡛ࢺ

࢚ンࠊࡣࢲ࣮ࢥincludeࢫࣃ中ࢆ᥈索ࠊࡋINCLUDEPATH補語࡛指定࣐ࢥࡓࢀࡉンࡢࢻᣑ張子 BASあࡿいࡣ EBAࢆ
備えࢆࣝ࢖࢓ࣇࡓ᥈索ࠋࡍࡲࡋ 

ᪧࣙࢪ࣮ࣂン࡛ࠊࡣᣑ張 BASあࡿいࡣ EBA࡛含ࢆࣝ࢖࢓ࣇࡓࢀࡲ指定ࠋࡓࡋ࡛ࢇࡏࡲࡾ࡞ࡤࢀࡅ࡞ࡋ 

FEMtools API 

新ࡋい FEMtools API関数 

いࡋ新ࡣンࣙࢩࢡࢭࡢࡇ FEMtools API関数ࡘ࡟い࡚記述ࠋࡍࡲࡋ 

Ft_GetMatrix  ࣐ࢆ࢕ࢸࣃࣟࣉ࣭ࢫࢡࢵࣜࢺ返ࡍࡲࡋ 
Ft_GetObject   ࣈ࢕ࢸࢡ࢔ OLE࣮࢜ࣙࢩ࣮࣓ࢺン㸦ActiveX㸧࢜ࣁ࡟ࢺࢡ࢙ࢪࣈンࢆࣝࢻ

返ࠋࡍࡲࡋ 

Ft_GetShapeData  個々ࢆ࢕ࢸࣃࣟࣉ࣭ࣉ࣮࢙ࢩࡢ返ࠋࡍࡲࡋ 

Ft_GetShapeProp  ࢆ࢕ࢸࣃࣟࣉ࣭ࣉ࣮࢙ࢩ࣭ࣝࣂ࣮ࣟࢢ返ࠋࡍࡲࡋ  
Ft_GetWindows   ࡢࡇ関数ࡣ機能別࡟ Ft_GetGraphicࠊFt_GetTableࠊFt_GetEditorࡢ関数ࢢ࡟

 ࠋࡍࡲࡋ化ࣉ࣮ࣝ

Ft_MatrixCommand ࣐ࢫࢡࢵࣜࢺ演算࡟使用ࡢࡇࠋࡍࡲࢀࡉ新ࡋい関数ࠊࡣFt_NewMatࠊ 

Ft_DelMatࠊFt_GetMatListࠊFt_MatExistsࠊFt_GetMatࠊFt_PutMatࠊ
Ft_MatSizeࡢ࡝࡞古い API関数࡜重複ࠋࡍࡲࡋ 

 ࠋࡍࡲࢀࡉ推奨ࡀ使用ࡢ関数ࡋ新ࡣ࡟ࡵࡓࡢ互換性ࡢࡑ

Ft_SetMatrix  ࣐ࢆ࢕ࢸࣃࣟࣉ࣭ࢫࢡࢵࣜࢺ設定ࠋࡍࡲࡋ 

Ft_SetShapeData  個々ࢆ࢕ࢸࣃࣟࣉ࣭ࣉ࣮࢙ࢩࡢ設定ࠋࡍࡲࡋ  
Ft_SetShapeProp  ࢆ࢕ࢸࣃࣟࣉ࣭ࣉ࣮࢙ࢩ࣭ࣝࣂ࣮ࣟࢢࡣ設定ࠋࡍࡲࡋ   
Ft_SetWindows   ࡢࡇ関数ࡣ機能別࡟ Ft_GetGraphicࠊFt_GetTableࠊFt_GetEditorࡢ関数ࢢ࡟

 ࠋࡍࡲࡋ化ࣉ࣮ࣝ
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以ୗࡢ関数ࢸࡣン࡟ࣝࢯ関ࡿࡍ新ࡋいࡣࡽࢀࡑࠋࡍ࡛ࢫࣛࢡ Strain࡜ Stressࢆࢱ࣮ࢹࡢ格納࡟ࡵࡓࡿࡍ使用ࡲࢀࡉ
 ࠋࡍ

Ft_ClearTensor  ࢸンࣝࢯ㸦Strainࡣࡓࡲ Stress㸧ࢆ削除ࠋࡍࡲࡋ 
Ft_DefTensor  ࢸンࣝࢯ㸦Strainࡣࡓࡲ Stress㸧ࢆ定義ࠋࡍࡲࡋ 

Ft_GetTensor  ࢸンࣝࢯ㸦Strainࡣࡓࡲ Stress㸧ࢆ返ࠋࡍࡲࡋ 

Ft_GetTensorComp  ࡢࢻࢵࣜࢯࡣࡓࡲ࢙ࣝࢩ Face࡟関ࢸࡿࡍンࣝࢯ構成要素値ࢆ返ࠋࡍࡲࡋ 

Ft_GetTensorCS  ࢸンࡢࣝࢯ 3x3変換࣐ࢆࢫࢡࣜࢺ返ࠋࡍࡲࡋ 

Ft_GetTensorData  特定࢖ンࢫࢡࢵࢹ㸦࣮ࣟࢻ࣮ࣔࡣࡓࡲࢫ࣮ࢣ࣭ࢻ㸧ࢸࡢンࢆࢱ࣮ࢹ࣭ࣝࢯ

返ࠋࡍࡲࡋ  
Ft_GetTensorProp  ࢸンࣝࢯ特性ࢆ返ࠋࡍࡲࡋ 

Ft_MoveTensor  ࢸンࢆࣝࢯ改ྡࠋࡍࡲࡋ  
Ft_PutTensor  既Ꮡࢸࡢンࢆࣝࢯ交換ࠋࡍࡲࡋ 

Ft_PutTensorCS  Ft_PutTensorCSࡣ要素ࣜ࡟ࢺࢫ変換࣐ࢫࢡࣜࢺ㸦3x3㸧ࢆ割ࡾ当࡚ࠋࡍࡲ
ෆ部࢚࢜ࣜンࣙࢩ࣮ࢸン࣭࣐ࡣࢫࢡࢵࣜࢺ四元数࡚ࡋ࡜格納ࠋࡍࡲࢀࡉ 

Ft_SetTensorData  定࢖ンࢫࢡࢵࢹ㸦࣮ࣟࢻ࣮ࣔࡣࡓࡲࢫ࣮ࢣ࣭ࢻ㸧ࢸࡢンࢆࢱ࣮ࢹ࣭ࣝࢯ設

定ࠋࡍࡲࡋ 

Ft_SetTensorProp  ࢸンࣝࢯ特性ࢆ設定ࠋࡍࡲࡋ 
Ft_SetupTensor  複数఩置ࡼ࠾びࢸ࡟࣮ࣂ࢖࢓ࣇンࡀࣝࢯᏑᅾࢆ࡜ࡇࡿࡍ明示ࠋࡍࡲࡋ 

Ft_SetupTensorCS  複数఩置ࡼ࠾びࢸࡀ࣮ࣂ࢖࢓ࣇン࢚࣭ࣜ࢜ࣝࢯンࣙࢩ࣮ࢸンࢆ持ࢆ࡜ࡇࡘ

明示ࠋࡍࡲࡋ 

Ft_TensorCount  ࢸン࡟ࣝࢯ格納ࢻ࣮ࣔࡣࡓࡲࢫ࣮ࢣ࣭ࢻ࣮ࣟࡓࢀࡉ数ࢆ返ࠋࡍࡲࡋ 

修正さࢀた FEMtools API関数 

ࡢ࡛ࢫ࣮ࣜࣜࡢࡇࠊࡣンࣙࢩࢡࢭࡢࡇ FEMtools API関数ࡢ変更点ࡘ࡟い࡚記述ࠋࡍࡲࡋ 

Ft_ConvertElements  新ࡋい補語ࠕlintoquad 変ࡢ࡬஧次要素ࡽ࠿一次要素ࠊࡣtracetosurfࠖࠕࠊࠖ
換࢖ࣛࢫ࣮ࣞࢺࠊンࡽ࠿ 2D要素ࢆ生成࡟ࡵࡓࡿࡍ追加ࠋࡓࡋࡲࢀࡉ変換
ࡣ数ࡢࣉ࢖ࢱ quadtolinࠕࠊ࡚ࡋ࡜補語ࡢ௚ࡢࡑࠊࢀࡉࡽ減࡟5 ࠊࠖ
quadtotriaࠕ  ࠋࡓࡋࡲࢀࡉ追加ࡀsurftoline2ࠖࠕࠊࠖ

Ft_Set/GetForm  属性ࠕnotificationlevelࠖ追加ࡢࡇࠋࡓࡋࡲࢀࡉ属性ࡣ全形式࡟当࡚ࡲࡣ
࡛ࡀ࡜ࡇࡃ࠾࡚ࡋ࡟ࢡンࣛࣈࡣྡ࣮ࣝࣟࢺンࢥࠊ࡚ࡗࡀࡓࡋࠋࡍࡲࡾ

 ,"")Ft_SetForm "", "notificationlevel", ival = Ft_GetFormࠋࡍࡲࡁ
"notificationlevel")  
if ival >= 1：任意஦象+ࣜཷࢆࢪ࣮ࢭࢵ࣓࣭ࣗࢩࢵࣞࣇ理ࢀࡇࠋࡍࡲࡋ
 ࠋࡍ࡛ࢺ࢛ࣝࣇࢹࡣ
ival >=2：更新ཷࢆࢪ࣮ࢭ࣮࣮࣓࣭ࢡࢵ࢕ࣇࣛࢢ理ࠋࡍࡲࡋ 

Ft_GetGraphic   新ࡋい属性："rounding", "intervals", "follow" 

ヲ細ࠕࡣ環境変数ࠖࢆ参照ࡉࡔࡃ࡚ࡋいࠋ 

 ࠋࡓࡋࡲࢀࡉ追加ࡀ ”ylabel“ ࡜ ”い属性 “xlabelࡋ新ࡿࡍ関࡟ࢫࢡࢵࣜࢺ࣐
Ft_GetRespProp  Ft_GetResponse࡟対応ࡿࡍ FEA࣏ࣞࢫンࢫ特性ࢆ検索ࠊ࡟ࡵࡓࡿࡍ㈇࢖ࡢ

ンࡣࢀࡇࠋࡍࡲࢀࡉࢺ࣮࣏ࢧࡀࢫࢡࢵࢹ擬似荷重感ᗘࢆ検索ࢯ࡟ࡵࡓࡿࡍ

 ࠋࡍࡲࢀࡉ中࡛使用ࣂ࢖ࣛࢻ࣭࣮ࣂࣝ

௚ࡢ変更：Ft_SetRespPropࢆ参照ࡉࡔࡃ࡚ࡋいࠋ 
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Ft_GetRespStrain  補語ࡢ追加ࠊ࡚ࡗࡼ࡟Face࡜ dirࢥࡀン࣏࣮ࢿンࡾྲྀ࡜ࢺ替えࡋࡲࢀࡽ
ࡢ両方ࡀdir補語ࠊࡣ以前ࠋࡓ Strainࢥン࣏࣮ࢿン࡜ࢺ Face࡟ࡵࡓࡢ使用
 ࠋࡓࡋࡲࢀࡉ

 ࢫࢡࢵࢱンࢩ
 
Ft_GetRespStrain i, id, elem, dir, component, face, csid 

Ft_Import  “strain” ࡜ “stress” ࡟関ࡀࢺ࣮࣏ࢧࡿࡍ追加ࠋࡓࡋࡲࢀࡉ 

Ft_SendGraphicCommand  新ࡋい補語"capture "ࣉࣕ࢟ࡓࡲࠊࡵࡓࡿࡍ࣮ࣕࢳࣉࣕ࢟ࢆࢡࢵ࢕ࣇࣛࢢࡀ
 ࠋࡓࡋࡲࢀࡉ追加࡟ࡵࡓࡃ開ࢆ࣮ࣝࢶ࣭࣮ࣕࢳ

 い属性ࡋ新ࡿࡍ࣮ࣝࣟࢺンࢥࢆンࣙࢩ࣮࣓ࢽ࢔࣭ࣉࢵࢸࢫ

"step.suspend"：ࣙࢩ࣮࣓ࢽ࢔ン࣭ࢆ࣮࣐࢖ࢱ保留ࠊࡾࡼ࡟࡜ࡇࡿࡍ現ᅾࡢ
 ࠋࡍࡲࡋ凍結ࢆ࣒࣮ࣞࣇン࣭ࣙࢩ࣮࣓ࢽ࢔

"step.resume"：保留࡚ࢀࡉいࣙࢩ࣮࣓ࢽ࢔ࡿンࢆ再開ࠋࡍࡲࡋ 

"step.backward"：表示ࢆ࣒࣮ࣞࣇ戻ࠋࡍࡲࡋ 

"step.forward"：表示ࢆ࣒࣮ࣞࣇ進ࠋࡍࡲࡵ 

"step.first"：最初ࡢ表示ࠋࡍࡲࡋࣉࢵ࢟ࢫ࡟࣒࣮ࣞࣇ 

"step.last "：最後ࡢ表示ࠋࡍࡲࡋࣉࢵ࢟ࢫ࡟࣒࣮ࣞࣇ 

新ࡋい補語"tracker.move"ࡀ Ft_SetGraphic࡛指定ࡓࢀࡉ新ࡋい఩置ࢸࢡ࢔࡟
 ࠋࡓࡋࡲࢀࡉ追加࡟ࡵࡓࡿࡏࡉ移動ࢆ࣮࢝ࢵࣛࢺࣈ࣮࢝ࣈ࢕

Ft_SetGraphic   新ࡋい属性: "rounding", "intervals", "follow" 
 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆ環境変数ࡣヲ細ࡢࡽࢀࡑ

属性"tracker "：値 ࡟ࣈ࢕ࢸࢡ࢔ࢆン中心㸧ࣆࡢ㸦回転ࢻン࣭࣮ࣔࣆࡣ15
 ࠋࡍࡲࢀࡉ追加࡟ࡵࡓࡿࡍ

  "い属性："xlabel", "ylabelࡋ新ࡢࡵࡓࡢࢺࢵࣟࣉ࣭ࢫࢡࢵࣜࢺ࣐
Ft_SetRespProp  RD_DIRECTIONࡶ使用࡛ࠊࡀࡍࡲࡁ次ࡼࡢうࢥ࡟ン࣏࣮ࢿンࢺ+Faceࢆ組

 ࠋࡍࡲࡏ合わࡳ

direction = (face1)*3+component  

RD_COMPONENTࡣ Strainࢥン࣏࣮ࢿンࢺ㸦SX=1ࠊSY=2ࠊTXY=3㸧 

RD_FACEࠊࡣStrain要素 Face㸦TOP=1ࠊBOTTOM=2ࡢࢻࢵࣜࢯࠊ Face㸧
 ࠋࡍࡲࢀࡉ使用࡟ࡵࡓࡿࡍ設定ࢆ

Ft_ShowDialog  "IMPORT_FEA_STRAIN" & "IMPORT_FEA_STRESS"ࡀ追加ࠋࡓࡋࡲࢀࡉ 

࡜Strainࠊࡽ࠿࣮ࣗࢽ࣓ࢺン࣏࣮࢖ࡣࢀࡇ Stressࢸࡢン࢖ࡢࣝࢯン࣏࣮ࢺ
 ࠋࡍࡲࢀࡉ使用࡟ࡵࡓࡿࡍ࡟能ྍࢆ
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Ft_Parseࡢコ࣐ン࣭ࣝ࣋ࣞࢻ応答ࢺ࣮࣏ࢧࡢ 

ࡍ返ࢆ番号࣭ࣝ࣋ࣞࢻン࣐ࢥ Ft_Parse関数࡟属性“level”ࡀ追加ࠋࡓࡋࡲࢀࡉ 

Ft_Parse "level", iLevel  

ࣞ࣋ࣝ番号ࡣ iLevel࣮ࢱࣜ࡟ンࠋࡍࡲࢀࡉ 

ࡣiLevelࠊ場合ࡢࢻン࣐ࢥ࣭࣮ࣝࢯンࢥ  ࠋࡍ0࡛

 階ᒙ+1㸧ࣝ࢖࢓ࣇ࣭ࢻン࣐ࢥ場合㸦ࡢࣝ࢖࢓ࣇ࣭ࢻン࣐ࢥ：0 <

 場合㸦Ft_Command㸧ࡢ࣒ࣛࢢࣟࣉ：0 >

例 

次࢕ࢸࢵࢭࡢࡑࠊࡣࢻ࣮ࢥࡢンࡢࢢ指定方法ࢆ示࣐ࢥࠊࡋンࢻ SET REDUCTION࣐ࢥࡀン࢖ࣛࢻンࡽ࠿出ࡿࢀࡉ
場合ࢥࠊン࣮ࣝࢯ中࡟出力ࠋࡍࡲࢀࡉ 

…  ft_parse "level", level  if level = 0 then    'Print output  

    iSilent = Ft_GetInt("console.silent")  

    If bHasSilent = True Then Ft_PutInt "console.silent", 1     Ft_Report "title", "REDUCTION SETTINGS :"  

    If (bHasSolver = True Or bNoComplements = True) Then _   

       Ft_Report "text", "Solver                : " & sSolver  

    If (bHasMethod = True Or bNoComplements = True) Then _  

       Ft_Report "text", "Method                : " & sMethodList(iMethod)  

    If (bHasFrequency = True Or bNoComplements = True) Then _  

       Ft_Report "text", "Frequency             : " & dFrequency     If (bHasIterations = True Or bNoComplements 
= True)  Then _  

       Ft_Report "text", "Number of iterations  : " & nIteration  

    If (bHasCore = True Or bNoComplements = True) Then _  

       Ft_Report "text", "Core                  : " & sCoreList(iCore+1)  

    Ft_PutInt "console.silent", iSilent  end if …  

[extract from script set_reduction.bas]  

定数 

RT_STRAIN㸦=13㸧࣏ࣞࢫンࠊࡣࣉ࢖ࢱ࣭ࢫFEMtools定数࡚ࡋ࡜定義ࠋࡍࡲࢀࡉ 
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環境変数 

 ࢢンࣜࢺࢫと࣮ࣛ࢝ࢫ

mesh.contour.rounding  BOOLEAN  

NOTࡀ設定ࡿࢀࡉ場合ࠊtrue min/max値ࡣ中間値࣮࢝ࣛࢥ࡛ࡋ࡞ン࣮ࢱ表示
 ࠋࡍࡲࢀࡉ

࠾࡜ࡢ次ࡣ修ṇ部ศࠋࡍࡲࢀࡉ中࡛設定ࣝ࢖࢓ࣇINIࠊࡣ値ࢺ࢛ࣝࣇࢹࡢࡑ
 ࠋࡍ࡛ࡾ

MESH .... ROUNDING boolean_val ....  

ࡶ࡜ࡇࡿࡍ使用ࢆ"Ft_Set/GetGraphic: "roundingࠊࡣ࡟ࡿࡍࢫࢭࢡ࢔࡟値ࡢࡇ
 ࠋࡍࡲࡁ࡛

mesh.contour.intervals  INTEGER  

࡞ࢀࡉ使用ࡀ補間㸦rounding㸧ࠋࡍࡲࡋ指定ࢆ表示間隔数ࡢࢻ࣮࣮ࣔࢱンࢥ
い場合㸦mesh.contour.rounding=false㸧ࠊ使用ࣂࡿࡍンࡢࢻṇ確࡞数ࡣ指定ࡉ
 ࠋࡍ࡛ࡁ࡭ࡿࢀ

࠾࡜ࡢ次ࡣ修ṇ部ศࠋࡍࡲࢀࡉ中࡛設定ࣝ࢖࢓ࣇINIࠊࡣ値ࢺ࢛ࣝࣇࢹࡢࡑ
 ࠋࡍ࡛ࡾ

MESH .... INTERVAL int_val .... 

 ࠋࡍ16間隔࡛ࠊࡣ最大値ࡢࡑ

ࡶ࡜ࡇࡿࡍ使用ࢆ"Ft_Set/GetGraphic: "intervalsࠊࡣ࡟ࡿࡍࢫࢭࢡ࢔ࢆ値ࡢࡇ
 ࠋࡍࡲࡁ࡛

mesh.contour.animation  BOOLEAN  

 ࠋࡍࡲࡋ明示࠿う࡝࠿ࡿࡏࡉ対応࡟変形振幅ࢆ࣮࣭࣮ࣛ࢝ࢱンࢥ

࠾࡜ࡢ次ࡣ修ṇ部ศࠋࡍࡲࢀࡉ中࡛設定ࣝ࢖࢓ࣇINIࠊࡣ値ࢺ࢛ࣝࣇࢹࡢࡑ
 ࠋࡍ࡛ࡾ

MESH ..... FOLLOW boolean_value .....  

FOLLOWࠊࡣANIMATE࡜矛盾࡞ࡋいࡼう࡟使用ࠋࡍࡲࢀࡉ 

 ࠋࡍࡲࢀࡉ適用࡟両方ࡢࣉ࣮࢙ࢩ複素数ࡣࡓࡲࣉ࣮࢙ࢩ実数ࡣࢀࡑ

節点࣐࣮࣮࣭࣮࢝ࣔࡢࢻ場合ࣙࢩ࣮࣓ࢽ࢔ࡣ࣮࣭࣮࣮࣐ࣛ࢝࢝ࡢࡑࠊン振幅

ࡇࡿࡏࡉ移動࡟࠿ࡎわࢆࡽࢀࡑ操作࡛ࢢン࢟ࢵࣆࡢ࣮࣮࣐࢝ࠋࡍࡲࡋ対応࡟

 ࠋࡓࡋࡲࢀࡉ改善ࡀ表示処理ࢺࢫࣛࢺンࢥࡢࣗࢩࢵ࣓ࡿࡼ࡟࡜

࡛ࡶ࡜ࡇࡿࡍ使用ࢆ"Ft_Set/GetGraphic: "followࠊࡣ࡟ࡿࡍࢫࢭࢡ࢔࡟値ࡢࡇ
 ࠋࡍࡲࡁ
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graphic.customcolormap.colornn  HEXADECIMAL  

及ぶ࡟16～01ࠊ࡚ࡋ࡜ࢫࢡࢵࢹン࢖ࡢࣉࢵ࣐࣮࣭࣒ࣛ࢝ࢱࢫ࢝ nnࢆ指定ࡋ
ࢫ࢝ࡢࡇ࡟場合ࡿい࡚ࢀࡉ設定࡟ࢻ࣮࣭ࣔࢻンࣂࡀmesh.contour.styleࠋࡍࡲ
 ࠋࡍࡲࢀࡉ使用ࡀࣉࢵ࣐࣮࣭࣒ࣛ࢝ࢱ

例 

graphic.customcolormap.color01=FF0000 
graphic.customcolormap.count  INTEGER  

ࣛ࢝ࡢࡃ多ࡾࡼࠋࡍࡲࡋ指定ࢆ数ࢻンࣂ࣭࣮ࣛ࢝ࡢࣉࢵ࣐࣮࣭࣒ࣛ࢝ࢱࢫ࢝

 ࠋࡍࡲࢀࡉ使用࡟場合ࡿࡍ指定ࢆ࣮
graphic.antialiaslimit  INTEGER  

࡜ࡇࡃ引࡟効率的࡛ࢢンࢩ࢔ࣜ࢖࢚ࢳン࢔࡟前ࡿ変わ࡟ࢢンࣜࣉンࢧࢳ࣐ࣝ

ࡿࡁ࡛ࡀ wireframe線ศࡢ最大ࡢ数ࢆ指定ࠋࡍࡲࡋ 

 8192=ࢺ࢛ࣝࣇࢹ
Ilp64  BOOLEAN  

FEMtoolsࡢ࣮ࣂࣝࢯ ILP64࣮ࣔࢥࢆࢻンࠋࡍࡲࡋ࣮ࣝࣟࢺ  
static.strain  静的 Strainࡢ計算ࢥࢆンࠋࡍࡲࡋ࣮ࣝࣟࢺ 

static.stress  静的 Stressࡢ計算ࢥࢆンࠋࡍࡲࡋ࣮ࣝࣟࢺ  

INI変数 

修正さࢀた設定 

mesh.contour.banded=Yes  

新ࡋい設定  

mesh.contour.rounding=No mesh.contour.intervals=16 
mesh.contour.animation=No graphic.customcolormap.color01=FF0000 
graphic.customcolormap.color02=FF8080 
graphic.customcolormap.color03=FFFFFF 
graphic.customcolormap.color04=8080FF 
graphic.customcolormap.color05=0000FF graphic.customcolormap.count=5 
graphic.antialiaslimit=8192 graphic.mode=1  

削除さࢀた設定 

static.strfield static.master 
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FEMtools 4.1.1ࡢ概要 

FEMtools 4.1.1ࠊࡣいࡢ࠿ࡘࡃ機能ᣑ張ࡼ࠾びࢢࣂ修ṇࢆ伴う࣓ンࢼࢸンࣙࢪ࣮ࣂ࣭ࢫ࣮࣭ࣜࣜࢫン࡛ࠋࡍ 

 構成、ࢫンࢭ࢖ࣛ、ンࣙࢩ࣮ࣞࢺࢫン࢖

 ンࣙࢩ࣮ࣞࢺࢫン࢖

 ࢖ンࣙࢩ࣮ࣞࢺࢫン手⥆࡟ࡁ関࣒ࢸࢫࢩࡿࡍ必要条件ࡘ࡟い࡚ࠊ前ࣙࢪ࣮ࣂンࡽ࠿変更ࡣあࠋࢇࡏࡲࡾ 
 View File࣎ࢱンࡀWindows࢖ンࢭ࢖ࣛࡢ࣮࣮ࣛࢺࢫン࡟ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ࣭ࢫ追加ࢹࡣࢀࡇࠋࡓࡋࡲࢀࡉ

ࢺ࢛ࣝࣇ PDFࡢ࢔࣮ࣗࣅ PDFࣝ࢖࢓ࣇ dds_sla.pdfࢆ開ࠊࡁ必要࡟応ࣜࣉ࡚ࡌンࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍࢺ 
 Microsoftࣟࢦ必要条件࡟対応ࡢ࡚࡭ࡍࠊࡵࡓࡿࡍ FEMtools EXEࠊDLLࡼ࠾ࣝ࢖࢓ࣇび࢖ン࣮࣮ࣛࢺࢫEXEࡣ

ࡢ࢕ࢸࣜࣗ࢟ࢭࡢ最高ࠊ従い࡟㸧ࢫンࢭ࢖㸦ࣛࢢンࢽ࢖ࢧࢻ࣮ࢥ࣭ࣝࢱࢪࢹ SHA256ࢆ࣒ࢬࣜࢦࣝ࢔使用ࡲࡋ
 㸧ࡳࡢンࣙࢪ࣮ࣂ㸦Winndowsࠋࡍ

 ࢫンࢭ࢖ࣛ

 ࣮࣑ࣟンࢭ࢖࣭ࣛࢢンࡢࢫ期限㸦残ࡢࡾ᪥数㸧࡟ࢀࡇࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍࢡࢵ࢙ࢳࢆ関ࢡࢵ࣎ࢡࢵ࢙ࢳࡿࡍ

ࡣ期限ࡢࡑࠋࡓࡋࡲࢀࡉ追加࡟ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲFEMtools License Configurator - Roaming Licensesࠊࡀࢫ
最終᪥ࡢ真夜中ࢆ࡛ࡲ意味࡟࡜ࡇࡿࡍ注意ࡉࡔࡃ࡚ࡋいࠋ 
 

 

コ࣐ン࢖ࣛࢻン࣭ࢱ࣮࣓ࣛࣃ࣭ࣉࢵ࢔ࢺ࣮ࢱࢫ 

 -e࣐ࢥン࢖ࣛࢻン࣭ࡢࢱ࣮࣓ࣛࣃ指定ࢭ࢖ࣛࠊ࡚ࡗࡼ࡟ンࢡࢵ࢙ࢳࡢࢫ後ࣝ࢖࢓ࣇ࣭ࢺࢡ࢙ࢪࣟࣉ࡟㸦ࡋࡶ指
定ࡤࢀࢀࡉ㸧ࢻ࣮ࣟࢆ後ࣉࢵ࢔ࢺ࣮ࢱࢫࠊ時࡟実行ࡿࢀࡉ FEMtools࣐ࢥンࢆࢺࣉࣜࢡࢫࡣࡓࡲࢻ実行ࡇࡿࡍ
 ࠋࡓࡋࡲࡋࡇ起ࡁ引ࢆ࣮࢚ࣛ࡟使用時ࡢࢻン࣐ࢥࡢࡇࡣン࡛ࣙࢪ࣮ࣂ前ࠋࡍࡲࡁ࡛ࡀ࡜
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 ンࣙࢩ࣮ࢸキ࣓ࣗンࢻ

FEMtools࣓ࣗ࢟ࢻンࣙࢩ࣮ࢸン࡟ࢫ࣮ࣜࣜࡢࡇࡀ伴い更新ࠋࡓࡋࡲࢀࡉ 

例題ࡢ更新 

 新ࡋい例題ࠊ࡚ࡋ࡜PARAMETER MATERIAL࣐ࢥンࢆࢻ実証ࠊࡀࢺࣉࣜࢡࢫࡢࡵࡓࡿࡍ
\examples\updating\disk_modal࡟追加ࠋࡓࡋࡲࢀࡉ 
 
run08_material_sensitivity.cmd  
run08_material_updating.cmd 
 

 新ࡋい例題..\dynamics\selem\nastran_op4：NASTRAN Ouput4ࡢࣝ࢖࢓ࣇ使用࣮ࣃ࣮ࢫࠊࡋ要素࣐ࡢࢫࢡࢵࣜࢺ
 ࠋࡍࡲࡋ実証ࢆࢺン࣏࣮࢖

 例題ࡢ\dynamics\selem\nastranࡀ\dynamics\selem\nastran_dmigࠋࡓࡋࡲࢀࡉ࣒࣮ࢿࣜ࡟ 

FEMtools࣒࣮ࣞࣇワ࣮ࢡ 

 ࣗࢩࢵ࣓

 ศ㞳ࡢࢻࢵࣜࢯࡓࢀࡉ஧次要素ࢆ一次要素࡟変換ࡿࡍ場合ࡢ処理ࡀ修ṇࠋࡓࡋࡲࢀࡉ前ࣙࢪ࣮ࣂン࡛ࣜࣇࠊࡣ

 ࠋࡓࡋࡲࡾあࡀ㸦ศ㞳㸧問題ࢪࢵ࢚࣮

 ࣝࣈ࣮ࢸ

 ᗙ標系㸦CS: Coordinate Systems㸧ࡢࣝࣈ࣮ࢸ編集࠾࡟い࡚ࠊCSࢆ追加࡜ࡿࡍ対象ࣕࢪ࡟ࣈࢱンࠋࡍࡲࡋࣉ
㸦例： 3ࢆࣈࢱ࣭ࢻ࣮ࣀࡢࡘ指定ࡢࡘ9ࠊࡋ CSࢆ追加ࠊ࡜ࡿࡍあ࡚ࡵࡓࡽ 㸧以前ࠋࡍࡲࢀࡉ表示ࡀࣈࢱࡢࡘ9
 ࠋࡓࡋࡲ見え࡟うࡼい࡞い࡚ࢀࡉ更新ࡀࣝࣈ࣮ࢸCSࠊࡣ

 ᗙ標系㸦CS㸧࡟参照ࡀ付ࡓࢀࡽࡅ FEࢻ࣮ࣀあࡿいࡣ測定࣏࢖ンࢆࢺ削除ࡓࡋ場合ࡢࡑࠊ対象 CSࡶ削除ࢀࡉ
 ࠋࡍࡲ

 ࡼ࠾ࢻ࣮ࣀࡢ࡚࡭ࡍび࣏࢖ンࢻ࣮ࣝ࢕ࣇ࣭ࢺ㸦ࠊࢻ࣮ࣀ要素࢖࣏ࠊࢫ࣮ࣞࢺࠊン࢖࣏ࢻ࣮ࣀࠊࢺンࢸ࣭࢔࣌ࢺ

ࡢ整数ࢺࢵࣅ10桁㸦32ࠊࡣࢺࢵ࣐࣮࢛ࣇࡢ㸧ࣝࣈ࣮ 2＾32㸧ࠋࡍࡲࡾ࡞࡟ 

 ࢫࢡࢵ࢕ࣇࣛࢢ

 NVidia࣮࢝ࡼ࠾ࢻびࣙࢪ࣮ࣂ࣭ࣂ࢖ࣛࢻンࢆ備えࢫࢡࢵ࢕ࣇࣛࢢࡢࣝࢹࣔࡓ表示ࡀ修ṇࠋࡓࡋࡲࢀࡉ適ษࢢ࡞
ࡢࣝ࢖࢓ࣇ࣭ࢢン࢕ࢸࢵࢭ࣭࣮ࢨ㸦࣮ࣘࠋࡍࡲࢀࡉ設定࡛ࢺ࢛ࣝࣇࢹࡀࢳࢵ࢖ࢫࡢ表示ࢫࢡࢵ࢕ࣇࣛ

graphic.mode࡟  㸧ࠋࡍࡲࢀࡉ設定ࡀ1
 FRF࣮࢝ࡢࣈ重ࡡ合わࡏ表示࠾࡟い࡚ࠊ第 ࡢ2 FRF࡞ࣈ࢕ࢸࢡ࢔ࡀ場合࠾࡟い࡚ࡶ第 ࡢ1 FRFࡣ常ࢸࢡ࢔࡟

 ࠋࡍࡲࢀࡉ࡞見࡜ࣈ࢕
 FRFࣜࡿࡍ࣮ࣝࣟࢡࢫࢆࢺࢫ場合ࠊFRF࣮࢝ࡢࣈ水ᖹ成ศࠋࡍࡲࢀࡉ࣒࣮ࢬࡀ 
 ࢖࣏ࡢ࡚࡭ࡍンࡢࢺṇ規表面ୖ࡜限࡞ࡽい場合ࠊ表面࢕ࢹ࣮࢙ࢩンࡢୖࢢ要素顔番号ࡢ表示ࡀ修ṇࠋࡍࡲࢀࡉ 

ソ࣮ࣝࣂ 

 ILP64࢕ࢸࢵࢭン࡚ࡋ࡜ࢺ࢛ࣝࣇࢹࡣࢢ設定ࠋࡍࡲࢀࡉᑠ࡞ࡉ FEࣔࡢࣝࢹ解析࡛ࡢࡑࠊࡣ ILP64ࢆࢳࢵ࢖ࢫ
ษࡀ࡜ࡇࡿ推奨ࠋࡍࡲࢀࡉ 

 FEMtoolsࡢ࣮ࣂࣝࢯ DYNAMIC࣐ࢥンࢆࢻ使用ࠊࡋ縮ᑠ࣮ࣔࢆࢻ解析ྍࡀ࡜ࡇࡿࡍ能ࠋࡓࡋࡲࡾ࡞࡟以前
ࢻン࣐ࢥࠊࡣ REDUCEࢆ必要ࠋࡓࡋࡲࡋ࡜ 
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 選択ࡢࢫン࣏ࢫとࣞࢱ࣮࣓ࣛࣃ

材料特性ࢱ࣮࣓ࣛࣃと幾何学特性ࢱ࣮࣓ࣛࣃ 

新ࡋい࣐ࢥンࢻ PARAMETER MATERIAL࡜ PARAMETER GEOMETRYࠊ࡚ࡗࡼ࡟要素 IDࢆ参照ࠊࡃ࡞࡜ࡇࡿࡍ
直接ࠊ材料特性࡜幾何学的特性ࢆ指定ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

ࢢࡣࡓࡲ࣮ࣝ࢝ࣟࠊࡃ࡞࡜ࡇࡿࡅ付ࢆ参照࡟ࢺࢫび要素ࣜࡼ࠾ࣝࣈ࣮ࢸࡢ幾何学特性ࡣࡓࡲ材料特性ࡣࢱ࣮࣓ࣛࣃ

ࡢ幾何学特性ࡣࡓࡲ材料特性ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ設定ࢆࢱ࣮࣓ࣛࣃࡢࣝࣂ࣮ࣟ IDࠊࡣ間接的ࠊ࡟一群ࡢ要素࡟
ࡢࡇ ID࡟参照付ࠊࡅ新ࡋい材料特性ࡣࡓࡲ幾何学特性ࡢ IDࡀ作成ࠋࡍࡲࢀࡉ 

ࡢ幾何学特性ࡣࡓࡲい材料特性ࡋ新ࡣࢻン࣐ࢥࡢࡇ IDࢆ生成ࡿࡍ必要࡞ࡀい場合࡟᭷用࡛ࠋࡍ即ࠊࡕ
PARAMETER GLOBALࡣࡓࡲ PARAMETER LOCALࡢ代わ࣐ࢥࡢࡇ࡟ࡾンࢆࢻ使用ྍࡀ࡜ࡇࡿࡍ能ࠋࡍࡲ࡞࡟ 

 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ操作࡛ࢻン࣐ࢥい࡞少ࡾࡼࠊࡵࡓࡿࡍ関係࡟数ࡢ幾何学特性࡜材料特性ࡣࡽࢀࡑ

Nastran࣮ࣘࡢ࡬࣮ࢨ注意点 

 材料特性ࠊࡣࢱ࣮࣓ࣛࣃPSHELL変換ࢆ使用ࠊࡃ࡞࡜ࡇࡿࡍPCOMP࣮ࣞࣖ࢖幾何学特性ࡼ࠾びMIDࢆ直接使
用ࠋࡍࡲࡋ 

 MID1ࠊMID2ࠊMID3ࠊMID4ࢱ࣮࣓ࣛࣃࡢ Dࢱ࣮࣓ࣛࣃࠊ࡚ࡗࡼ࡟ࢀࡇࠋࡍࡲࢀࡉࢺ࣮࣏ࢧࡀ数ࡀ縮ᑠࡉ
ࢱ࣮࣓ࣛࣃࠋࢇࡏࡲࡾあࡣ必要ࡿࡍ定義ࢆ関係ࡢ㡯ࢫࢡࢵࣜࢺ弾性࣐ࡢ異方性ࠋࡍࡲࡾ࡞ࡃ扱い易ࠊࢀ D
 ࠋࡍ係数࡛࣮ࣝࢣࢫࡢࢫࢡࢵࣜࢺ各弾性࣐ࡢMID4ࠊMID3ࠊMID2ࠊMID1ࠊࡣ

FEMtoolsࢺࢫࢸࣜࣉࡢ解析と相関分析  

 MAC࡜ POCࡢ基準ࡢ計算࠾࡟い࡚ࠊDOF࣌ࡀࣝࣈ࣮ࢸ࣭࢔Ꮡᅾ࡞ࡋい場合ࠊDOFࢺࢵࢤ࣮ࢱࡀ࣮ࢱࣝ࢕ࣇ
 ࠋࡍࡲࢀわ࡞行࡟暗黙ࡀࢢンࣜ࢔DOF࣌ࠊࡋ使用ࢆࣉ࣮࢙ࢩࢻ࣮࣭ࣔࢺࢫࢸࡢ࡚ࡋ࡜

 Manual Sensor Selectionࡢࣝࢿࣃ Show Sensor Node Numberingࡿࢀࡉࢡࢵ࢙ࢳࡀ場合ࠊAdd SensorsࠊRemove 
SensorsࠊMove Sensorsࡀ᭷効ࠋࡍࡲࡾ࡞࡟ 

 ่࣮ࣔࣝࢲ激解析㸦MPA㸧ࡼ࠾び่࣮ࣔࣝࢲ激࣐ࣉࢵ㸦MPM㸧࠾࡟い࡚ࠊ質量ࢆ持࡞ࡓいࡀࢻ࣮ࣀ入力 DOF
 ࠋࡍࡲࢀࡉ使用࡚ࡋ࡜

FEMtoolsࣔ࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹンࢢ 

 要素 IDࢆ参照ࠊࡃ࡞࡜ࡇࡿࡍ直接的࡟材料特性࡜幾何学的特性ࢆ指定ࢆࢱ࣮࣓ࣛࣃࠊ࡚ࡗࡼ࡟࡜ࡇࡿࡍ選択
ࢻン࣐ࢥいࡋ新ࡢࡵࡓࡿࡍ PARAMETER MATERIAL࡜ PARAMETER GEOMETRYࠋࡍࡲࢀࡉࢺ࣮࣏ࢧࡀ 

 PARAMETER MATERIAL࣐ࢥンࢆࢻ実証ࡿࡍ新ࡋいࢺࣉࣜࢡࢫ例ࠊࡀ..\examples\updating\disk_modal࡟追加ࡉ
 ࠋࡓࡋࡲࢀ
run08_material_sensitivity.cmd  
run08_material_updating.cmd 

 Correction㸦཰束㸧計算࠾࡟い࡚ࠊ外部ࡀ࣮ࣂࣝࢯ使用ࡿࢀࡉ場合ࡢ要素࣐ࢺ࣮ࢹࣉࢵ࢔ࡢࢫࢡࢵࣜࢺ処理ࢆ
回避ࠊ࡟ࡵࡓࡿࡍDOE COMPUTE࣐ࢥンࠋࡓࡋࡲࢀࡉࢺ࣮࣏ࢧࡀࢻFEMtoolsࡀ࣮ࣂࣝࢯ使用ࡿࢀࡉ場合ࡳࡢ
要素࣐ࡀࢺ࣮ࢹࣉࢵ࢔ࡢࢫࢡࢵࣜࢺ実行ࠋࡍࡲࢀࡉ 

ANSYS࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

 集中要素質量࣐ࠋࡓࡋࡲࢀࡉࢺ࣮࣏ࢧࡀࢺࢵ࣐࣮࢛ࣇ࣭ࢫࢡࢵࣜࢺ以前ࡼࡢࡑࡣう࡞集中質量࣐ࢫࢡࢵࣜࢺ

ࡲࡋ計算ࢆࢫࢡࢵࣜࢺ質量࣐ࡓࡋ一㈏ࠊࡣ࡛ࢺ࢛ࣝࣇࢹࡢANSYSࠋࡓࡋࡲࢀࡉ格納ࡀࢫࢡࢵࣜࢺ࣐ࡢ0ࠊࡣ
ࡢࡃ多ࠊࡓࡲࠋࡍ FE࣒ࣛࢢࣟࣉ㸦FEMtoolsࡶ含ࡴ㸧ࠊࡣ࡛ࢺ࢛ࣝࣇࢹࡢ集中要素質量࣐ࢆࢫࢡࢵࣜࢺ生成ࡍ
 ࠋいࡉࡔࡃ࡚ࡋ注意࡟࡜ࡇࡿ

 異方性材料ࠊࢀࡉࢺ࣮࣏ࢧࡀTB㸦ANEL㸧ࠊTBTEMࠊTBDAT࣮࢟ワ࣮ࠊࡀࢻFEMtools ANISO3D材料特性࢖ࢱ
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ࢹࣝࣈ࣮ࢸANSYS TB,ANELࠊࡣFEMtools ANISO3D材料特性ࠊࡶ࡚ࡋ際࡟ࢺ࣮࣏ࢫࢡ࢚ࠋࡍࡲࢀࡉ変換࡟ࣉ
 ࠋࡍࡲࢀࡉࢺ࣮࣏ࢫࢡ࢚࡚ࡋ࡜ࢱ࣮

 倍精ᗘ値࡞0࡛ࠊࡣい基数ࡢ指数ࢆࢺࢵ࣐࣮࢛ࣇ使用ࠊࡋANSYS࢖ン࢙ࣇ࣮ࢱｲ࡚ࡗࡼ࡟ࢫ出力ࡇࠋࡍࡲࢀࡉ
引ࢆ誤差ࠊࢀࡉ出力࡚ࡋ使用ࢆ0ࠊ࡚ࡋ࡜基数ࡢ値ࡢࡽࢀࡇࡣ更新前ࠋࡍࡲࡋ準ᣐ࡟ANSYS CDWRITEࠊࡣࢀ
 ࠋࡓࡋࡲい࡚ࡗ࡞࡟要因ࡍࡇ起ࡁ

例 
更新前 MPDATA,R5.0, 1,EX , 1, 1, 0.684338600E+11, 
更新後 MPDATA,R5.0, 1,EX , 1, 1, 6.843386000E+10,  

LS-DYNA࢖ン࢙ࣇ࣮ࢱｲࢫとࣂ࢖ࣛࢻ 

 MAT_ANISOTROPICࠊ࡟ࡵࡓࡿࡍࢺ࣮࣏ࢧࢆLS-DYNA࢖ン࢙ࣇ࣮ࢱｲࡀࢫᣑ張ࠊ࡚ࡗࡼ࡟ࢀࡇࠋࡓࡋࡲࢀࡉ
弾性࣐ࢫࢡࢵࣜࢺ㸦C11, C12,...㸧ࢫࢭࢡ࢔࡟ᶒࡀ୚えࠊࢀࡽ_TET4TOTET10ࢻࢵࣜࢯࡢ要素࢜ࣙࢩࣉン࡛᭷効
 ࠋࡍࡲࡾ࡞࡟

NASTRAN࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

NASTRANࣝ࢖࢓ࣇ࣭ࢱ࣮ࢹ࣭ࢡࣝࣂࡢ㸦BDF㸧ࢆ解析ࡿࡍ場合ࠊ対象࣐ࢫࢡࢵࣜࢺ係数ࡀᏑᅾ࡞ࡋい㸦ࡀ࡚࡭ࡍ
修࡟うࡼい࡞ࡋ出力ࢆDMIGࠊ場合࡞うࡼࡢࡑࠋࡓࡋࡲࡋࡇ起ࡁ引ࢆ࣮࢚࣭ࣛࢺン࣓ࢺ࣮ࢸࢫDMIGࠊ㸧場合ࣟࢮ
ṇࠋࡓࡋࡲࡋ 

Output4࡛ࢺࢵ࣐࣮࢛ࣇ࣭ࣝ࢖࢓ࣇ格納ࡓࢀࡉ Superelement㸦SELEM㸧࣐ࡼ࠾ࢫࢡࢵࣜࢺび対応ࡿࡍ外部࡜ࢻ࣮ࣀ
DOF࢖ࢆン࣏࣮ࡣࢀࡑࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍࢺ関連ࣃࡿࡍンࣝ࢖࢓ࣇ࣭ࢳ㸦PCH㸧࢖ࡽ࠿ン࣏࣮ࡓࢀࡉࢺ構成要素
 ࠋࡍࡲࢀࡉ追加࡟定義ࢻ࣮ࣔࡢ
以前ࠊࡣDMIG࣮࢝ࡀࡅࡔࢻ Superelement࣐࢖ࢆࢫࢡࢵࣜࢺン࣏࣮࡚ࢀࡉࢺ࣮࣏ࢧ࡟ࡵࡓࡿࡍࢺいࠋࡓࡋࡲ 

 ࣂ࢖ࣛࢻとࢫｲ࢙ࣇ࣮ࢱン࢖ࡢࢱ࣮ࢹ࣭ࣝ࢖࢓ࣇ࣭ࣝࢧ࣮ࣂࢽࣘ

 IDEAS㸦ࣘࣝ࢖࢓ࣇ࣭ࣝࢧ࣮ࣂࢽ㸧ྡࢫࢡࢵࣜࢺ࣐ࡣ以外ࠊ࡚ࡋ࡜ࣉ࢖ࢱ࣭ࢱ࣮ࢹࡢ࡚࡭ࡍࡢUniversal File࡟
変更ࠋࡍࡲࢀࡉ 

SAP2000࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

 SAP2000࢖ン࢙ࣇ࣮ࢱｲࠊࡣࢫSAP2000 v21ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆ 
 新ࡋい CSiAPIv1.DLLࠊࡀCSiBridge࡜ ETABS࡜互換性ࢆ保࡟ࡵࡓࡘ使用ࠋࡍࡲࢀࡉ 
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 ࢺࣉࣜࢡࢫ࣭࣒ࣛࢢࣟࣉ࣭࣮࢕ࢸࣜ࢕ࢸ࣮ࣘ

以ୗࡢ新ࡋい࣮ࣘࡀࢺࣉࣜࢡࢫ࣭࢕ࢸࣜ࢕ࢸ..\scripts\utilities࡟追加ࠋࡓࡋࡲࢀࡉ 

makecustommap 10%以ୖࡢ変更㸦値ࡀ ࢱࢫ࢝ࡿࡍࢺ࢖ࣛ࢖ࣁࢆ場合㸧ࡿࡍ変化࡟100%～0
࡜MATRIXࠊࡣࣉࢵ࣐࣮࣭࣒ࣛ࢝ࢱࢫ࢝ࠋࡍࡲࡋ定義ࢆࣉࢵ࣐࣮࣭࣒ࣛ࢝
MESH࣐ࢥࡢン࡛ࢻ CMAP補語࡜共࡟使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

xfrfpair.bas xfrfpair.basࡣ選択ࡓࢀࡉ FRF࣌࢔振幅ࢆᢳ出ࢥࠊࡋン࣮ࣝࢯ表示値あࡿいࡣ
ࡲࡁ࡛ࡀ࡜ࡇࡿࡍ指定ࢆ周波数ࡢ最大࡜最ᑠࠋࡍࡲࡋ調整ࢆ表示値ࢱンࣜࣉ

 ࠋࡍ

matmove.ba ࣐ࡣࢀࡇࠋࡍࡲࡋ࣒࣮ࢿࣜࢆࢫࢡࢵࣜࢺ௚࢕ࢸࢵࢭࡢンࢆࢢ使用࡚ࡋ得ࢀࡽ

含ࢆ㸧ࢫࢡࢵࣜࢺ感ᗘ࣐ࡤ結果㸦例え࡟うࡼࡿࡁ࡛ࡀ࡜ࡇࡿࡍ比較࡜結果ࡓ

 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ使用࡟ࡵࡓࡿ作ࢆࣉࢵ࢔ࢡࢵࣂࡢࢫࢡࢵࣜࢺ࣐ࡴ

copy_cs_paired.bas 対応࢖࣏࣭࢔࣌ࡿࡍン࡟ࢺ FEᗙ標系㸦CS㸧ࠋࡍࡲࡋ࣮ࣆࢥࢆ 

decimate_mesh.bas ࢻ࣮ࣀ間ࡢ最ᑠ距㞳ࢆ使用ࡢࢺࢵࢭ1ࠊࡋ対象ࢆࢻ࣮ࣀ 10ศࡢ ࠋࡍࡲࡋ࡟1
ࣔࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ使用࡟解析ࢺࢫࢸࣜࣉࠊࡋ縮ᑠࡢࢻ࣮ࣀ対象ࡣࢀࡑ

 ࠋࢇࡏࡲࡋ࡜必要࡟ࡵࡓࡿࡍ使用ࢆࢻン࣐ࢥࡢࡇࡣࣉ࣮࢙ࢩࢻ࣮

updbounds.bas ࢺ࣮ࢹࣉࢵ࢔処理後ࢺ࣮ࢹࣉࢵ࢔ࡢࢱ࣮࣓ࣛࣃࡢୗ限ୖ࡜限ࢆ調節ࠋࡍࡲࡋ

ࢺ࣮ࢹࣉࢵ࢔ࡢ一ྠࡀ処理ࢺ࣮ࢹࣉࢵ࢔࡞ࡓ新࡞的⥆⥅ࠊ࡚ࡗࡼ࡟調節ࡢࡇ

ୗ限ୖ࡜限ࢆ使用ࠊࡋ異࣏ࢫࣞࡿ࡞ン࡟ࢫ対࡚ࡋ始ࡏࡲࢀࡋࡶ࠿ࡿࢀࡽࡵ

ࡿあࢫン࣏ࢫࣞࡿ࡞異ࠊࡋ使用ࢆ境界値ࢱ࣮࣓ࣛࣃ࡞相対的ࠊࡣࡃࡋࡶࠋࢇ

いࠊ࡚ࡗࡼ࡟ࢱ࣮࣓ࣛࣃࡣ新ࢆࢺ࣮ࢹࣉࢵ࢔࡟ࡓ実行ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

viewmidparam.bas ࢖ࣞࣉࢫ࢕ࢹ PSHELL MIDࠊࡣPARAMETER MATERIAL࣐ࢥン࡛ࢻ選択ࡉ
 ࠋࡍࡲࡅ関連付ࢆࢱ࣮࣓ࣛࣃࡓࢀ

コ࣐ンࢻ 

修正さࢀたコ࣐ンࢻ 

EXAMINE MEF 新ࡋい補語 NODE࡜ LOCATIONࡀ追加ࠊࢀࡉ剛体質量࣐ࡢࢫࢡࣜࢺ計算ࡢ
 ࠋࡍࡲࡁ基࡙࡟ᗙ標系ࡢ原点ࠊࡣ࡛ࢺ࢛ࣝࣇࢹࠋࡍࡲࡋ指定ࢆ఩置ࡢࡵࡓ

PARAMETER MATERIAL 要素 IDࢆ参照ࠊࡃ࡞࡜ࡇࡿࡍ直接的࡟材料特性ࢆ指定ࡾࡼ࡟࡜ࡇࡿࡍ材料
特性ࢆࢱ࣮࣓ࣛࣃ定義ࠋࡍࡲࡋ 

PARAMETER GEOMETRY 要素 IDࢆ参照ࠊࡃ࡞࡜ࡇࡿࡍ直接的࡟幾何学特性ࢆ指定ࡾࡼ࡟࡜ࡇࡿࡍ幾
何学特性ࢆࢱ࣮࣓ࣛࣃ定義ࠋࡍࡲࡋ 
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FEMtoolsࢺࣉࣜࢡࢫ 

修正さࢀた FEMtoolsࢺࣉࣜࢡࢫ関数 

OpenFileName 4番目ࣙࢩࣉ࢜ࡢン引ࡁ数ࢆྡࣝ࢖࢓ࣇ࣭ࢺ࢛ࣝࣇࢹࠊ࡚ࡗࡼ࡟指定ࡿࡍ機
能ࢆ追加ࡀࢀࡑࠋࡓࡋࡲࡋ指定ࡓࢀࡉ場合ࠊOpen Fileࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ
ࡲࡁ࡛ࡀ࡜ࡇࡿࡍ選択ࢆࣝ࢖࢓ࣇࡢࡑࠊࡋ示ࢆ࣮ࣜࢺࢡࣞ࢕ࢹ࣭ࣝ࢖࢓ࣇࡣ

 ࠋࡍ

WriteIni 最初ࡢ 次ࡣࣗࢩࢵࣕ࢟ࡢ中࣓ࣜࣔࠊ場合ࡿࢀࡉ渡࡟WriteIniࡀ数ࡁ引ࡢࡘ3
ࡢ ReadIni関数ࡀ実行ࡿࢀࡉ場合࡟ࣝ࢖࢓ࣇࡢ引ࡣࢀࡇࠋࡍࡲࢀࡀ⥅ࡁ外部
࡛変更ࡓࢀࡉ㸦編集ࡓࢀࡉ㸧INIࡢ࡬ࣝ࢖࢓ࣇ対処࡟᭷効࡛ࡢࡇࠋࡍ機能
࡜ࡇࡿ見࡟常ࢆࣝ࢖࢓ࣇINIࠊࡣWindows࡛ࠊࡾ必要࡛あࡳࡢLinux࡛ࠊࡣ
 ࠋࡍࡲࡁ࡛ࡀ

FEMtools API 

修正さࢀた FEMtools API関数 

 ࠋࡍࡲࡋい࡚記述ࡘ࡟変更ࡢ࡬FEMtools API関数ࠊࡣン࡛ࣙࢩࢡࢭࡢࡇ

Ft_SetGraphic 属性 pick.extendࡀ現ᅾࢻ࣮ࣀ࡞ࣈ࢕ࢸࢡ࢔あࡿいࡣ要素࢟ࢵࣆࡢࢺࢵࢭࡢン
 ࠋࡍࡲࢀࡽ加えࡅ付࡟ࡵࡓࡿࡍ࡟能ྍࢆࢢ

Ft_Set/GetTable 属性 indexࡀ現ᅾࢥࡢン࣎㸦combo㸧࢖࣭ࣈࢱࡣࡓࡲンࢆࢫࢡࢵࢹ変更ࡿࡍ
 ࠋࡍࡲࢀࡽ加えࡅ付࡟ࡵࡓ
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FEMtools 4.1.2ࡢ概観 

FEMtools 4.1.2࣓ࣗ࢟ࢻࡣンࢺ化ࢢࣂࡢ修ṇࠊいࡢ࠿ࡘࡃ増強ࡼ࠾び少数ࡢ付加物ࢆᥦ供࣓ࡿࡍンࢼࢸン࣭ࣜࣜࢫ
 ࠋࡍ࡛ࢫ࣮

 構成、ࢫンࢭ࢖ࣛ、࣮ࣝࢺࢫン࢖

 ࣮ࣝࢺࢫン࢖

 初期ࣙࢪ࣮ࣂン࡜比較࢖ࠊࡋン࣮ࣝࢺࢫ手⥆࣒ࢸࢫࢩࡢࡁ必要条件࡟関࡚ࡋ変更ࡣあࠋࢇࡏࡲࡾ 

 変更ࡢンࣙࢩ࣮ࢸキ࣓ࣗンࢻ

 FEMtools࣓ࣗ࢟ࢻンࣙࢩ࣮ࢸンࡢࢫ࣮ࣜࣜࡢ࡚࡭ࡍࡣ変化ࢆ཯映࡟ࡵࡓࡿࡍ更新ࠋࡍࡲࢀࡉ 

例変更 

 例ࠕBoxBeamࠖྡࡢ前ࠕࡣBoxFrameࠖ࡟修ṇࠋࡍࡲࢀࡉ 

FEMtools࣒࣮ࣞࣇワ࣮ࢡ 

 ࣮ࣗࢽ࣓

 Window > Tile VerticallyࠊࡣTile Side-by-Side࡟修ṇࠋࡍࡲࢀࡉ 
 Window > Tile HorizontallࠊࡣStack Windows࡟修ṇࠋࡍࡲࢀࡉ 

 ࣝࣈ࣮ࢸ

 Record in Set࣏࣐ࢥ࣭࣮ࣗࢽ࣓࣭ࣉࢵ࢔ࣉࢵンࠊࡣࢻDOF࠾࡟ࣝࣈ࣮ࢸい࡚ࢺ࢖࣋࢕ࢸࢡ࢔化ࠋࡍࡲࢀࡉ 
 DOFࣝࣈ࣮ࢸ中ࡢࢻ࣮ࢥࣞࡢ削除ࡣ防ࠋࡍࡲࢀࡀ 
 ࣉ࢖ࢱ SHELLࡢ幾何学࢕ࢸࣃࣟࣉ Add/Ediࠊࡣࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲMID1~MID4ࡲࡋࢺ࣮࣏ࢧࢆ࢕ࢸࣃࣟࣉ

ࡲい࡚ࡋ編集ࢆࢪ࣮ࢭࢵ࣓࣮࢚ࣛ࡜値ࡢ௚ࡢࡑࠊࢀࡉ示ࡀࡅࡔMID4ࠊࡣ互換性㸧以前࡜ࡳࡢ㸦NASTRANࠋࡍ
 ࠋࡓࡋ

 ࢺࢫࢸ DOF関係࣓ࣗ࢟ࢻࡢンࣙࢩ࣮ࢸンࡣᣑ張ࢀࡉ改善ࠋࡓࡋࡲࢀࡉ 

 ࢫࢡࢵ࢕ࣇࣛࢢ

 ࣮࢝ࡢ࣮࢝ࢵࣛࢺࣈ配置࡟ࢀࡑࡣ修ṇࢺ࢛ࣝࣇࢹࠊࡍࡲࢀࡉ఩置࢕࣭࢘ࢫࢡࢵ࢕ࣇࣛࢢ࣭ࣈ࣮࢝ࡣンࡢ࢘ࢻ中

心࡛ࠋࡍ以前ࠊࡀ࣮࢝ࢵࣛࢺࠊ࡟時々ࠊFRFࡼ࠾び関連ࡿࡍ機能ࢢࣟࡢ目盛ྍࡾࡼ࡟ࡾ視࣭ࢫࢡࢵ࢕ࣇࣛࢢࡢ
 ࠋࡓࡋࡲࢀ外࡛現わࡢ表面࢘ࢻン࢕࢘

 DOF関係㸦MPC㸧ࢆ含ࡀࢫࢡࢵ࢕ࣇࣛࢢ࣭ࣗࢩࢵ࣓ࡴ最適化ࠋࡓࡋࡲࢀࡉ 

FEMtools Dynamics 

 ࢝ࣜࣉࢵン࡜ࢢMBA࣓ࣗ࢟ࢻࡢンࣙࢩ࣮ࢸンࡣ改善ࠋࡓࡋࡲࢀࡉ 
 Compute Rigid Body Shapes࡜ Compute Rotational DOFsࡢࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲࡢ Help࣎ࢱンࡣ接⥆ࠋࡍࡲࢀࡉ 
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FEMtoolsࢺࢫࢸࣜࣉと相関分析 

 Mode Participation Analysisࡢ EXAMINE MPA࣐ࢥン࡛ࢻ ࡢࢺࢵࢭ1 FEM DOFࢆ指定ࡇࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ
࡜ࢻン࣐ࢥࠊ࡚ࡗࡀࡓࡋࠋࡓࡋ能࡛ྍ࡟い࡚既࠾࡟ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲMPAࠊࡣࢀ GUIࡢ両方࠾࡟い࡚ࡢࡇ
ྍ能性ࢆᥦ示ࠋࡍࡲࡋ 

 MPAࠊࡣࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲTools > Pretest Analysis > Mode Participation Analysis࡚ࡗࡼ࡟開ࡢࡘ3ࠊࢀ࠿変換
DOF࡟代わ࡟ࡾ ࡾࡓ当ࢻ࣮ࣀࡢࡘ1 ࡢࡘ6 DOFࠊࡣࢀࡇࠋࡍࡲࡋࢺ࣮࣏ࢧࢆEXAMINE MPAࢵ࣎ࢢࣟ࢔࢖ࢲ
࡜ࢻン࣐ࢥࠊ࡚ࡗࡀࡓࡋࠋࡓࡋ能࡛ྍ࡟い࡚既࠾࡟ࢫࢡ GUI࢕ࢸࢵࢭࡌྠࡣンࢆࢢᥦ示ࠋࡍࡲࡋEXAMINE 
MPA࣐ࢥン࡜ࢻMPAࡢࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ両方࣮࢚࡚ࣛࡗࡼ࡟状態ࢆ防ࠋࡍࡲࡂ 

 DOFࡀࢺࢵࢭ選択ࡿࢀࡉ場合ࠊMPAࡢࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ OK࣎ࢱンࠋࡍࡲࡾ࡞࡟ࣈ࢕ࢸࢡ࢔ࡀ 
 EXAMINE MLS࣐ࢥンࢭ࣭ࢺ࢛ࣝࣇࢹࡌྠࡣ࣒࣮࢛ࣇ࡜ࢻン࣮ࢧ質量ࢆ使用ࠋࡍࡲࡋ以前࣒࣮࢛ࣇࠊ࡟値ࡣ

極ᗘ࡟丸ࠋࡓࡋࡲࢀࡉࡃ値ࣝࢹࣔࡣ質量ࡢ  ࠋࡍࡲࢀࡉࡃ10進数࡛丸ࠊࢀࡉ計算࡚ࡋ࡜0.1%

ABAQUS࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

 ABAQUS 2020ࢺ࣮࣏ࢧࡢ 
 ABAQUS࢕ࢸࢵࢭ࣭ࣂ࢖ࣛࢻンࠊࡣࢢEdit > Settings࡛ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ修ṇࠋࡍࡲࢀࡉ 

ANSYS࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

 ANSYS 2020R1ࢺ࣮࣏ࢧࡢ 
 要素ࡢ第 1実数定数ࡀ 幾何学ࡢࢺン࣏࣮࢖CDBࠊ場合ࡢ0 ID生成ࡢ修ṇ 
 Strain結果ࡣᅽ縮 RSTࣝ࢖࢓ࣇ㸦FCOMPࣈ࢕ࢸࢡ࢔㸧ࡽ࠿ㄞࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡴANSYSࡀࣂ࢖ࣛࢻ現ᅾ

FCOMP࡟࡜ࡇࡿࡍࢺࢵࢭࢆ注目ࠊࡣࢀࡇࠊࡋFCOMPࢆ備えࡓ RSTࢆࣝ࢖࢓ࣇ生産ࡓࡋ ANSYS࣮ࣘ࡟࣮ࢨ
 ࠋࡍ適ษ࡛࡚ࡗ࡜

NASTRAN࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

 ࢺࣉࣜࢡࢫ rselemop4.basࠊࡣNASTRAN OP4࣮ࣃ࣮ࢫ要素࣐࡜ࢫࢡࢵࣜࢺ PCHࣝ࢖࢓ࣇ㸦OP4ྡࣝ࢖࢓ࣇ㸧
 ࠋࡍࡲࢀࡽ加えࡅ付࡟ࡵࡓࡿࡍࢺン࣏࣮࢖ࢆ

Modal Parameter Extractor (MPE) 

 新ࡋい࣐ࢥンࢻMPE PANEL[LOCAL][CLOSE]ࠊࢀࡉࢺ࣮࣏ࢧࡀ自動化࡟使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

剛体࢕ࢸࣃࣟࣉ抽出者㸦RBPE㸧 

 新ࡋい࣐ࢥンࢻ RBPE PANEL[CLOSE]ࠊࢀࡉࢺ࣮࣏ࢧࡀ自動化࡟使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

 ࢺࣉࣜࢡࢫ࣭࣒ࣛࢢࣟࣉ࣭࣮࢕ࢸࣜ࢕ࢸ࣮ࣘ

 ࢺࢫࢸ FRFࢆ ODS࡟変換ࢺࣉࣜࢡࢫ࣭࢕ࢸ࢕ࣜ࢕ࢸ࣮ࣘࡿࡍ frf2ods.basࠊࡀ引ࡁ数 TO࡜ STEPࢆ使用ࡋ
 ࠋࡍࡲࢀࡉ使用ࡀ周波数ࡿい࡚ࡋ接近ࡶ最ࡢ範ᅖࠊࡋࢺ࣮࣏ࢧࢆࢺࢫࣜࡢ周波数ࠊ࡚

 次ࡢ新ࡋい࣮ࣘࡀࢺࣉࣜࢡࢫ࣭࢕ࢸ࢕ࣜ࢕ࢸ..\scripts\utilities࡟加えࠋࡍࡲࢀࡽ 

computemodalscatter.bas 変換࣮ࣔࣝࢲ変఩࣮ࢱࣕ࢟ࢫࡢ値ࢆ計算ࡣࢀࡑࠊ࡟ࡽࡉࠋࡍࡲࡋ

共振周波数࡜周波数間ࡢ遊いࢆ報告ࠊࡋ連⥆ࣉ࣮࢙ࢩࢻ࣮ࣔࡿࡍ

ࡿ࡞࡟対ࡣ࡟場合ࡢ軸対称構造ࡣ情報ࡓࢀࡉ報告ࠋࡍࡲࡋศ散ࢆ

ࡢࡵࡓࡢࣉ࣮࢙ࢩࢻ࣮ࣔ SET CORRELATION DOUBLE࡜ SET 
CORRELATION MATCHࡢ値ࢆ決定࡟ࡢࡿࡍ᭷用࡛ࠋࡍ 

fixscale.bas ࢕࣭࢘ࢡࢵ࢕ࣇࣛࢢ࣭ࣗࢩࢵ࣓࡞ࣈ࢕ࢸࢡ࢔ン࡟࢘ࢻ表示ࡓࢀࡉ
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ࢩࡣࢀࡑࠋࡍࡲࡋ適用ࢆ係数ࢢン࣮ࣜࢣࢫ絶対ࡢ固定࡟ࣉ࣮࢙ࢩ

ࢢン࣮ࣜࢣࢫࡢࡇࠋࡍࡲࡁ基࡙࡟最大変換変఩ࡢࣝࢺࢡ࣋ࣉ࣮࢙

係数࡟ࣈ࢕ࢸࢡ࢔ࡣあࢥࡀ࣮ࢨ࣮ࣘࡾン࡚࣎ࡗࡼ࡟現ᅾ表示ࢀࡉ

ࢱࢫ࢝ࢆࢢࣟ࢔࢖ࢲ࣭ࣗࢩࢵ࣓ࡣいࡿあࠊ࠿ࡿࡍ変更ࢆࢻ࣮ࣔࡓ

 ࠋうࡻࡋ࡛ࡿࡍࢬ࢖࣐

ࠊ࡟ࡵࡓࡿ計ࢆࢻ࣮ࣝ࢕ࣇ変఩ࡢ最大ࡿあࡢ関連࡟ࢬ࢖ࢧࣝࢹࣔ

ࠊࡋ࠿ࡋࠋࡍࡲࢀࡉ使用ࡀࢺ࢛ࣝࣇࢹࡣmesh.deformation.ratioࠖࠕ
fixscale ratio %_valueࠕࡣࢀࡇ 㸦ࠖ例えࠊࡤfixscale ratio 20)ࢆ使用ࡋ
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿ代わ࡚ࡗྲྀ࡚

化ࢺ࢖࣋࢕ࢸࢡ࢔非࡚ࡋfixscale off"ࠖ使用ࠕࡣ固定縮尺比率ࡢࡇ
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ

 ࢺࣉࣜࢡࢫ࣭࣒ࣛࢢࣟࣉ࣭ࢫ࣮࢙ࣇ࣮ࢱン࢖

次ࡢ新ࡋい࣮ࣘࡀࢺࣉࣜࢡࢫ࣭࢕ࢸ࢕ࣜ࢕ࢸ..￥scripts￥࢖ン࢙ࣇ࣮ࢱｲ࡬ࢫ加えࠋࡍࡲࢀࡽ 

imp_hypermesh_sets.bas ࠊࡣࢺࣉࣜࢡࢫࡢࡇHypermeshࡣࡓࡲ Patranࡉࢺ࣮࣏ࢫࢡ࢚ࡽ࠿
ン࣏࣮࢖ࢆࢺࢵࢭࡢ要素࠿ࢻ࣮ࣀࡽ࠿ࣝ࢖࢓ࣇン࣭ࣙࢩࢵࢭࡿࢀ

 ࠋࡍ࡛࡜ࡇࡿࡍࢺ
rselemop4.bas ࠊࡣࢺࣉࣜࢡࢫࡢࡇOP4࡜ࣝ࢖࢓ࣇ PCHࣝ࢖࢓ࣇ㸦OP4ࣝ࢖࢓ࣇ

ࢺ要素࣐࣮ࣃ࣮ࢫNASTRAN OP4ࠊࡋ使用ࢆ前㸧ྡࡿࡍ由来࡟ྡ
 ࠋࡍࡲࡋࢺン࣏࣮࢖ࢆࢫࢡࢵࣜ
例：..\examples\dynamic\selem\nastran_op4 

Command 

New Command  

MPE PANEL MPE PANELࠊࡣMPEࢆࣝࢿࣃ開ࡓࡲࠊࡁ閉ࠋࡍࡲࡌ 
RBPE PANEL RBPE PANELࠊࡣRBPEࢆࣝࢿࣃ開ࡓࡲࠊࡁ閉ࠋࡍࡲࡌ 

Modified Command 

EXAMINE MPA 入力 DOF࡚ࡋ࡜ ࡢࢺࢵࢭ1 FEM DOFࢆ指定࡟ࡵࡓࡿࡍ新ࡋい引
数ࡁ SETࢆ修ṇࠋࡓࡋࡲࡋ 

DEFINE GEOMETRY ࣉ࢖ࢱ SHELLࡢ DEFINE GEOMETRY幾何学ࠊࡣMIDxࢸࣃࣟࣉ
 互換性㸧ࡢ࡜㸦NASTRANࠋࡍࡲࡋࢺ࣮࣏ࢧࢆ࢕

MBA PANEL CLOSEࡣMBAࢆࣝࢿࣃ閉࡟ࡵࡓࡿࡌ付ࡅ加えࠋࡓࡋࡲ 

FEMtools API 

新ࡋい FEMtools API関数 

いࡋ新ࠊࡣンࣙࢩࢡࢭࡢࡇ FEMtools API関数ࡘ࡟い࡚記述ࠋࡍࡲࡋ 

Ft_GetType ࢫ࣮࣋ࢱ࣮ࢹࡢࣉ࢖ࢱ࣭ࢱ࣮ࢹ実体ࢆ返ࠋࡍࡲࡋ 
Ft_GetRespGeneric 総括的࣏ࢫࣞ࡞ンࢆࢱ࣮ࢹ࣭ࢫ返ࠋࡍࡲࡋ 
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修正済ࡢ FEMtools API機能 

 ࠋࡍࡲࡋい࡚記述ࡘ࡟変更ࡢ࡬FEMtools API関数ࠊࡣンࣙࢩࢡࢭࡢࡇ

環境変数 

 ࢢンࣜࢺࢫと࣮ࣛ࢝ࢫ

gui.file.dialog INTEGER 
 ࣝ࢖ࢱࢫ࣭ࢬ࢘ࢻン࢖࢘=0
1=Qtࠕnativeࠖࣝ࢖ࢱࢫ 
࡜ࡇࡿࡍ使用࡟ࡵࡓࡿࡍ変更ࢆ外観ࡢࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲࡣࢀࡇ

ࢬ࢘ࢻン࢖࢘ࠊࡀࡿࡁ࡛ࡀ API࣮ࣜࢺࢡࣞ࢕ࢹ࣭ࣝ࢖࢓ࣇࡀ㸦ࣂ
利用࡟集中的ࢆ㸧࣮࣮ࣖࣞࣉ音楽ࠊࢫࣝ࢕࢘ࢳン࢔ࠊࣉࢵ࢔ࢡࢵ

場合ࡿい࡚ࡋ対処࡟ࢫࢭࣟࣉࡣいࡿンあࣙࢩ࣮ࢣࣜࣉ࢔ࡢ௚ࡿࡍ

 ࠋࢇࡏࡲࢀࡋࡶ࠿ࡿࡍ影響࡟

FEMtools 4.1.2࣓ンࢼࢸンࢫ࣮࣭ࣜࣜࢫ 

FEMtools 4.1.2.1998(2020年 5᭶ 28日) 

 Show Candidates࣎ࢱンࢆࢪ࣮ࢭࢵ࣓࣮࢚ࣛࡢࡁ࡜ࡿࡍࢡࢵࣜࢡࢆ解決ࡢࡵࡓࡿࡍ Automated Sensor Selectionࣃ
 ࠋ修ṇࡢ࡬ࣝࢿ

 多࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࡢࡃン࢕ࢸࢵࢭ࣭ࢢン࢕ࢸ࣮ࢹࣉࢵ࢔ࡀࢢンࣉ࣮࣭ࣝࢢෆ࡛初期化ࡣࢀࡇࠋࡍࡲࢀࡉ

ࡤ例えࠊࡋ࡟能ྍࢆ࡜ࡇࡿࡍ࣮ࣝࣟࢺンࢥࢆࡽࢀࡑ࡛ࢺࣉࣜࢡࢫ࣭ࢡࢵ࣍ SET TUNE ISCRIPT࡛指定ࢫࡓࢀࡉ
 ࠋࡍࡲࢀ行わ࡟うࡼࡢࢺࣉࣜࢡ

 AutoMAC Test࣐ࠊࡣࢫࢡࢵࣜࢺModel: Testࡢୗ࡛示ࠋࡍࡲࢀࡉ㸦Correlation࡟代わࡾ㸧ࡀࣝࢹ࣭ࣔࢺࢫࢸ削除
 ࠋࡍࡲࢀࡉ削除ࡣࢀࡑࠊ場合ࡿࢀࡉ

 AutoMAC FEM࣐ࠊࡣࢫࢡࢵࣜࢺModel: FEࡢୗ࡛示ࠋࡍࡲࢀࡉ㸦Correlation࡟代わࡾ㸧FEࣔࡀࣝࢹ削除ࡿࢀࡉ
場合ࡣࢀࡑࠊ削除ࠋࡍࡲࢀࡉ 

 新ࡋい࣐ࢥンࢻ UNLOCKࡀ加え࣐ࢥࡢࡇࠋࡍࡲࢀࡽン࢕ࢸ࣮ࢹࣉࢵ࢔࣭࣮ࣝ࢝ࣟࡣࢻンࡢࢱ࣮࣓ࣛࣃ࣭ࢢ定
義ࡢ結果別࣐ࢥࡢンࢻ㸦例えࡤ生成ࡿࡍ新ࡋい幾何学的特性ࠊ材料㸧࡚ࡗࡼ࡟始ࢫ࣮࣋ࢱ࣮ࢹࡿࢀࡽࡵ修ṇࢆ

終えࠋࡍࡲ 
 EXTRACT PARAMETER࣐ࢥンࡁࡋࡣࢻい値ࢆ使用ࢱ࣮࣓ࣛࣃࠊࡋ変更ࠕࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍࢺࢫࣜࢆあࡿい

 ࠋ基準ࠖࡾࡼࠊ࡞ࡁ大ࡾࡼࡣ
 EXTRACT MREC࣐ࢥンࢆࢫࢡࢵࣜࢺ࣐ࡣࢻ指定ࢡࢫࣜࢱࢫ࢔࡟ࡵࡓࡿࡍ(*)ワࢆࢻ࣮࢝ࢻࣝ࢖使用ࠋࡍࡲࡋ 
 ࢺࣉࣜࢡࢫ expset.bas࡜ impset.basࠊ࡜ࡿࡍࢺࢵࢭࢆෆ部࣮ࣘࢺ࣮࣏ࢫࢡ࢚ࡿࡍࢺࢵࢭࡀ࢕ࢸࣜ࢕ࢸあࡿいࡣ

 ࠋࢇࡏࡲ行いࢆࢺン࣏࣮࢖
 ᑠࢻ࣮ࣝ࢕ࣇ࡞ࡉ㸦第 ࡴㄞࢆ࣮࢚ࣛࠊ場合ࡿࡍ混合ࢆン㸧࢖ࣛ⥆⥅形式㸦ࢻ࣮ࣝ࢕ࣇ࡞大規模࡜ン㸧࢖1ࣛ

TABLEM1࣮࢝࡟ࢻ対処ࡿࡍ NASTRAN࢖ン࢙ࣇ࣮ࢱｲࡢࢫ修ṇࠋࡓࡋࡲࡋࡽࡓࡶࢆ 
 ANSYS࢖ン࢙ࣇ࣮ࢱｲࡼ࠾ࢫびࣂ࢖ࣛࢻ 

 前ࡢ実行ࡢࡽ࠿ ANSYS.DMP࡟含࡚ࢀࡲいࠊ࡛ࡢࡓinter.cdb㸦ANSYS࢖ン࢙ࣇ࣮ࢱｲ࣮࣏ࢫࢡ࢚࡚ࡗࡼ࡟ࢫ
ࡓࢀࡉࢺ CDBࣝ࢖࢓ࣇ㸧࡟ࢺ࣮࣏ࢫࢡ࢚ࡢ際ࠊࡋANTYPEࠊMODOPTࠊMXPANDࠊMATWRITEࡼࡢう࡞
いࡀࢻ࣮࢝ࡢ࠿ࡘࡃ複写࡞ࢀࡉいࡼうࠊ࡟RST࡚ࡗࡼ࡟ࢲ࣮࣭ࣜࣝ࢖࢓ࣇ生成ࡿࢀࡉ ANSYS.DMP࢖࢓ࣇ
ࣝ㸦ࢲンࣝ࢖࢓ࣇ࣭ࣉ㸧ࠋࡍࡲࢀࡉ࣮ࢱࣝ࢕ࣇࡣ 

 ࢳ࣮ࣝࣈࢧ࣭ࣝ࢖࢓ࣇンࡀ࢔ࣜࢡࡢ加算ࠊࡣࢀࡑࠋࡓࡋࡲࢀࡉinter0.*ࠊ&inter1.*ࠊinter2+.*ࡼࡢう࡟並列
運転ࢆࣝ࢖࢓ࣇࡿࡍ削除ࡣࢀࡑࠊ࡟ࡽࡉࠋࡍࡲࡋ inter.modeࠊinter.statࠊinter.esavࠊinter.fullࠊinter.dspࠊ
inter.mlbࠊinter.dbࡢ࡝࡞必要࡞ࡋ࡜いࢆࣝ࢖࢓ࣇ削除ࠋࡍࡲࡋ 

 ࡓࢀࡉࢺࢵࣜࣉࢫ EMATࠊRST࡟ࣝ࢖࢓ࣇࡢ࡝࡞関ࠊࡿࡍANSYS࢖ン࢙ࣇ࣮ࢱｲ࢞ࢨ࣮࣭ࣘࣂ࢖ࣛࢻ࡜ࢫ
 ࠋࡍࡲࡋ追加ࢆࣝ࢖࢓ࣇン࣭ࣙࢩࣉ࢜ࡢ࡚ࡋ࡜ࠖࣝ࢖࢓ࣇ࡞無関係ࠕびࡼ࠾ࢻ࢖
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FEMtools 4.2ࡢ概観 

FEMtools 4.2ࡣ FEMtools࣒࣮ࣞࣇワ࣮࢖࣭ࢱ࣮ࢹࠊࢡンࠊࢫ࢖࢙ࣇ࣮ࢱ解析ࡢ࣮ࣝࢶ新ࣙࢪ࣮ࣂン࡛ࠋࡍFE࣮ࢹ
ࡣࣂ࢖ࣛࢻࠊࢫ࢖࢙ࣇ࣮ࢱン࢖࣭ࢱ FEࡢ࣒ࣛࢢࣟࣉ現行版࡟ࡵࡓࡿࡍࢺ࣮࣏ࢧࢆ更新ࠋࡍࡲࢀࡉ 

࡚ࡋ࡜ࢱ࣮࣓ࣛࣃࡣࢫ࣮ࣜࣜࡢ4.2 ANSYSࣔࣝࢹ中ࢆ࢕ࢸࣃࣟࣉࡢ選択ࡿࡍ新ࡋい革新的対処法ࢆᑟ入ࡵࡓࡿࡍ
ANSYS࣮࡚ࣘࡗ࡜࡟࣮ࢨ重要࡛あࠊࡾANSYS࡜ FEMtoolsࡢ感ᗘ解析࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࠊン࡟ࢢ᭷効࡛ࠋࡍ 

 ࠋࡍࡲࡋ示ࢆࢺ࢖ࣛ࢖ࣁࡢࢫ࣮ࣜࣜࡢࡇ

 と構成࣮ࣝࢺࢫン࢖

 ࣐ࢥ࣭ࣉࢵ࢔ࢺ࣮ࢱࢫン࢖ࣛࢻン࣭ࢱ࣮࣓ࣛࣃ-m࢖࣭࣮ࢨ࣮ࣘࡣンࡀ࣮ࣛࣟࣉࢫࢡ࢚ࡢࢫ࢖࢙ࣇ࣮ࢱ使用ࡍ
 ࠋࡍࡲࢀࡽ加えࡅ付࡟ࡵࡓࡿࡍ指定ࢆࣝ࢖࢓ࣇ辞書ࡿ

 EMA࡜ OMAࡢ追加例ࡣWindows用ࡢ FEMtools࢖ンࡢ࣮࣮ࣛࢺࢫ一部࡛ࠋࡍ 

 ࢡワ࣮࣒࣮ࣞࣇ

 最新ࣞࡢンࣜࢲンࢢᢏ術࣭ࣞࢡࢵ࢕ࣇࣛࢢࡿࡼ࡟ンࣜࢲンࢩࠊࢢン࣎ࣝや࣮࣮࣐࣭࢝ࢺࢫ࢟ࢸ表示ࡢ改良 
 新ࡋいࣂン࣓ࢢࢭ࣭ࣈ࣮࢝ࡀ࣮࢝ࢵࣛࢺࢻンࢡ࣮ࣆࡢࢺ値ࢆ見࡟ࡵࡓࡿࡅࡘ付ࡅ加えࠋࡍࡲࢀࡽ 
 ࣮࢝࢖࣭ࣛࢺࢵࣟࣉࣈンࣂ࡜ンࠊ࣮࢝ࢵࣛࢺࢻ実数部࣭虚数部あࡿいࢺࢵࣟࣉࢻ࣮࣎ࡣ㸦振幅࡜఩相㸧ࡢ機

能ࢆ持ࣈ࣮࢝ࡘ 
 新ࡋいMACࡓࢀࡉࢬ࢖࣐ࢱࢫ࢝ࡣࣝࢿࣃ࣭࣮ࣗࣅࣉࢵࢺ報告ࡿࡍ目的࡟ࡵࡓࡢ加えࠋࡍࡲࢀࡽ 
 FRFࢆ備えࡓ多数ࡢࣝ࢖࢓ࣇࡢ選択࢖࡜ン࣏࣮ࢺ 
 6ࡢࡘ新ࡋい࣮ࣘࡀࢺࣉࣜࢡࢫ࣭࢕ࢸࣜ࢕ࢸ様々ࢆࢡࢫࢱ࣭ࢫ࣮࣋ࢱ࣮ࢹ࡞実行࡟ࡵࡓࡿࡍ追加ࠋࡓࡋࡲࢀࡉ 

 ࢫ࢖࢙ࣇ࣮ࢱン࢖࣭ࢱ࣮ࢹ

 ABAQUS 2021ࢺ࣮࣏ࢧࡢ 
 ANSYS 2021R11ࢺ࣮࣏ࢧࡢ 
 ANSYS࢖ン࢙ࣇ࣮ࢱｲࡿࡼ࡟ࣂ࢖ࣛࢻ࡜ࢫ新ࡋい革新的 FE࢖ン࢙ࣇ࣮ࢱｲࢫ 
 新ࡋいࡣࢺ࣮࣏ࢧࡢࢺࢵ࣐࣮࢛ࣇ ANSYS 2021 RST結果ࡢࣝ࢖࢓ࣇ中࡛使用ࠋࡓࡋࡲࡋ 
 ANSYS࡟ FEMtools FEࣔࡿࡍࢺ࣮࣏ࢫࢡ࢚ࢆࣝࢹ場合ࠊ新ࡋいࢺ࢛ࣝࣇࢹ要素ࡀࣉ࢖ࢱ使用ࠋࡍࡲࢀࡉ 
 LS-Dyna R11.1.0ࢺ࣮࣏ࢧࡢ 
 MSC.Nastran 2020࡜MSC.Nastran 2021ࢺ࣮࣏ࢧࡢ 
 SAP2000 v22ࢺ࣮࣏ࢧࡢ 
 DIANA DATࡢࣝ࢖࢓ࣇ新ࡋい࢖ンࢺࣉࣜࢡࢫ࣭ࢫ࢖࢙ࣇ࣮ࢱ 

解析 

 ࢺࢫࢸࣜࣉ解析用ࠊ࣮ࣝࢶࡢ速ᗘࡢࡵࡓࡢ書ࡁ直࡜ࡋ最適化࣓ࣜࣔࠊ必要条件ࡢ縮ᑠ 
 ࢭンࡢࢺࢵࢭ࣭࣮ࢧ異ࣉ࢖ࢱࡿ࡞㸦uni-軸ࠊtri-軸㸧ࠊ異࢚ࣜ࢜ࡿ࡞ンࣙࢩ࣮ࢸン㸦ࣝࣂ࣮ࣟࢢ軸࣮ࣝ࢝ࣟࠊ

軸࣐࣮ࣝࣀࠊ表面㸧ࡢ組ࡳ合わྍࡀࡏ能ࡼ࡞う࡟改善ࠋࡍࡲࢀࡉ 
 抑制ࢺࢫࢸࣜࣉࡀࣝࢹࣔࡓࢀࡉ解析࡛ࠋࡍࡲࢀࡉࢺ࣮࣏ࢧ即ࠊࡕ候補ࢁࢆࡽࢀࡑࡽ࠿ࢺࢵࢭ過ࡼ࡟࡜ࡇࡿࡍ

ࡓࢀࡉ抑制ࡾ DOFࢆ許ྍࠋࢇࡏࡲࡋ 
 ࠊࢻ࣮ࣔࡣࢀࡑ残余࣋ࣝࢺࢡ㸦ࡾࡼపୖࡣࡓࡲࡘ࠿ࡃ部㸧あࡿい࡜ࢻ࣮ࣔࡣ残余ࢆ使用ࠊࡋFRF合成ࡲࢀࡉ

ࡢRigid Body Properties Extraction (RBPE)ࠊࡣࢀࡇࠋࡍ FRFࢆ合成࡟ࡵࡓࡿࡍ使用ࠋࡍࡲࢀࡉ 
 新ࡋい ANSYSࡀࣉ࢖ࢱ࣭ࢱ࣮࣓ࣛࣃ感ᗘ解析࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࠊンࡢࡵࡓࡢࢢ新ࡋい FE࢖ン࢙ࣇ࣮ࢱｲ

 ࠋࡍࡲࢀࡽ加えࡅ付࡟ࡵࡓࡿࡍ実証ࢆい特徴ࡋ新࡞主ࡢࡇࡀ例ࡢ࠿ࡘࡃいࠋࡍࡲࡋ使用ࢆᢏ術ࢫ
 新ࡋいࠊࡀࢫࢡࢵ࣎ࣟ࢔࢖ࢲ࣭࣮ࢨ࢘ࣛࣈ࣭ࢱ࣮࣓ࣛࣃANSYSࡋࢺࢫࣜࢆࢱ࣮࣓ࣛࣃ選択࡟ࡵࡓࡿࡍ付ࡅ加

えࠋࡍࡲࢀࡽ 
 相関ศ析ࠊ感ᗘ解析࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࠊン࣏ࢫ࣭ࣞࢫࣞࢺࢫࡢࡵࡓࡢࢢンࠋࡍࡲࡋࢺ࣮࣏ࢧࢆࢫ 
 実㦂計画法㸦DOE㸧ࢧࡢンࣜࣉンࡀࢢ線形指数関数ࢆ使用࡚ࡋ行うࠋࡍࡲࡁ࡛ࡀ࡜ࡇ 
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 異࢖࣭ࢻ࣮ࣔࡢࣉ࢖ࢱࡿ࡞ンࢱ࣮ࢣࢪ関数ࠊࡣFEMtools MPE㸦࣮࣮ࣔࢱࢡࣛࢺࢫࢡ࢚࣭ࢱ࣮࣓ࣛࣃ࣭ࣝࢲ㸧
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ中࡛選択ࣈࢱ࣭࣮ࢱࢡࣛࢺࢫࢡ࢚࣭࣮࣏ࣝࡢ

 質量ࣛ࢖ン範ᅖࡀ狭࠿ࡿࡂࡍ㦁々ࡋい場合ࠊFEMtools RBPE㸦Rigid Body Properties Extractor㸧ࡵࡓࡢࢫ࣮ࢣࡣ
ࡓࢀࡉ改善࡟ FRFࢆ使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

 ࠋࡍࡲい࡚ࢀࡲ含࡟ンࣙࢩࢡࢭࡢ次ࡣヲ細ࡢい࡚ࡘ࡟変更ࡢࡽࢀࡇ

 構成、ࢫンࢭ࢖ࣛ、࣮ࣝࢺࢫン࢖

 ࣮ࣝࢺࢫン࢖

 ࢖ン࣮ࣝࢺࢫ手⥆ࡣࡓࡲࡁ最ᑠ࣒ࢸࢫࢩ必要条件࡟関࡚ࡋ変更ࡣあࠋࢇࡏࡲࡾ 
 補足 OMA࡜ EMA例࢖ࡢンࠊࡣࢪ࣮ࢣࢵࣃ࣭࣮ࣝࢺࢫWindows用ࡢ FEMtools࢖ンࡢ࣮࣮ࣛࢺࢫ一部࡛ࡲࠋࡍ

㸦ᅗࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ࣮ࣝࢺࢫン࢖ࡽ࠿ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ࣭࣮ࣕࢪ࣮ࢿン࣭࣐࢜ࢻ࢔直接ࡣࡽࢀࡑࠊࡓ

1参照㸧 

  

ᅗ 1 補足 EMA࡜ OMA例࢖ࡢン࢜ࢻ࢔࣭࣮࣮ࣛࢺࢫン࣭࣐ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ࣭࣮ࣕࢪ࣮ࢿ 

Linuxࡢ FEMtools࢖ン࢖ࡢࡽࢀࡇࡣ࣮࣮ࣛࢺࢫンࢆࢪ࣮ࢣࢵࣃ࣭࣮ࣝࢺࢫ含࡛ࢇいࡣࡽࢀࡑࠊࡓࡲࠋࢇࡏࡲ
FEMtools࢘ࢲࡽ࠿ࢺ࢖ࢧ࣭ࢺ࣮࣏ࢧン࣮ࣟࠊࢀࡉࢻ前ࡢ FEMtoolsࣙࢪ࣮ࣂンࡌྠ࡜方法࡛࢛ࣝࣇ࣭ࢪ࣮ࢣࢵࣃࠊ
 ࠋࡍࡲࡋ増ࢆ࣮ࢲ

 ࢫンࢭ࢖ࣛ

 FEMtools 4.2ࠊࡣReprise License Manager㸦RLM㸧v14.1࡟付属ࠋࡍࡲࡋ 
RLM v14.1ࡢ࣮ࣝࢶ࣭࣮ࣂ࣮ࢧ個別࢖ࡢン࢘ࢲࡣࢪ࣮ࢣࢵࣃ࣭࣮ࣝࢺࢫン࣮ࣟࡓࢀࡉࢻ FEMtools 4࣮ࣜࣜ
 ࠋࡍ࡛࢔࢕ࢹ࣓࣭࣮ࣝࢺࢫン࢖FEMtoolsࠊࡣࡓࡲReprise Software websiteࠊࢺ࣮ࣀ࣭ࢫ

 FEMtools License Configurator ࣙࢩࢡ࢔ࡢンࠊnodelockedࢭ࢖ࣛࡓࢀࡉン࡟ࢫ属ࡼࡿࡍうࡣࢀࡑ࡟以前࡟示ࢀࡉ
ࢺࢫ࣍ࡓ IDࢺࢵࢿ࡟ࡽࡉࡀ࣮ࣗࣅワ࣮ࢭ࢖࣭ࣛࢡン࡟࣮ࣂ࣮ࢧࢫ当࡚ࠊ࡛ࡢࡿࡁ࡛ࡀ࡜ࡇࡿࡲࡣ標題
 ࠋࡍࡲࢀࡉ化ࣉ࣮ࣝࢢୗ࡛ࡢHostID and dongle actionsࠖࠕ
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ᅗ 2  Hostidࢻ࡜ンࣙࢩࢡ࢔ࡢࣝࢢンࢆ示ࡍ FEMtools License Configurator 

構成 

 変数 ShowDaysLeftࡣ出荷時࢕ࢸࢵࢭ࣭࣮ࢨ࣮ࣘ࡟ンࣝ࢖࢓ࣇ࣭ࢢ㸦INI㸧࡟加えࢭ࢖ࣛࠊࢀࡽンࢫ終了࡟関ࡍ
ࡀ変数ࡣいࡿ場合あࡢ31㸦୙確定ࠊࡣࢺ࢛ࣝࣇࢹࠋࡍࡲࡋ࣮ࣝࣟࢺンࢥࢆࢪ࣮ࢭࢵ࣓ࡿ 場ࡿࢀࡉࢺࢵࢭ࡟0
合㸧ࡀあࠋࡍࡲࡾ 

 新ࡋい࣐ࢥ࣭ࣉࢵ࢔ࢺ࣮ࢱࢫン࢖ࣛࢻン࣭ࢱ࣮࣓ࣛࣃ-m࢖࣭࣮ࢨ࣮ࣘࡣンࢆ࣮ࣛࣟࣉࢫࢡ࢚ࡢࢫ࢖࢙ࣇ࣮ࢱ
使用ࡿࡍ辞書ࢆࣝ࢖࢓ࣇ指定࡟ࡵࡓࡿࡍ付ࡅ加えࠋࡍࡲࢀࡽ 
辞書࡛࣮ࣛࣟࣉࢫࢡ࢚ࡣࣝ࢖࢓ࣇ使用ࡿࢀࡉ言葉ࢆ写像ࠋࡍࡲࡋ 
総括的࢚࣮ࣛࣟࣉࢫࢡ辞書ࡣࣝ࢖࢓ࣇ..￥xml.࡟఩置ࡿࡍ dictionary_explorer.xml࡛࡛࣮ࣛࣟࣉࢫࢡ࢚ࠋࡍ使用
属性ࡣ言葉ࡿࢀࡉ SOURCE࡛ࣜࠋࡍࡲࢀࡉࢺࢫ属性 TRANSLATIONࡣ翻ヂࡓࢀࡉ㸦あࡿいࡉࢬ࢖࣐ࢱࢫ࢝ࡣ
 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ㸧単語࡛完成ࡓࢀ
TRANSLATIONࡀ空㸦""㸧ࡢ場合ࠊ単語ࡣ翻ヂࠋࢇࡏࡲࢀࡉ 
 

 
 
ࡢࢀࡒࢀࡑࠊࡣい࡚ࡘ࡟翻ヂࡢ࣒࣮࢛ࣇࠊ࣮ࣂ࣮ࣝࢶࠊ࣮ࣗࢽ࣓ XMLࡢࣝ࢖࢓ࣇ翻ヂ࡛示ࠋࡍࡲࢀࡉ 
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 変更ࡢンࣙࢩ࣮ࢸキ࣓ࣗンࢻ

FEMtools࣓ࣗ࢟ࢻンࣙࢩ࣮ࢸンࢆࢫ࣮ࣜࣜࡢࡇ࡚࡭ࡍࡣ཯映࡟ࡵࡓࡿࡍ更新ࡢࣝ࢔ࣗࢽ࣐ࠋࡍࡲࢀࡉ構造࡟変更
 ࠋࢇࡏࡲࡾあࡣ

変更例 

 感ᗘ解析ࡢ ANSYSࡢࢱ࣮࣓ࣛࣃ用途ࢆ実証࣮ࢲ࢛ࣝࣇࠊ࡟ࡵࡓࡿࡍansys_parametersࡀ..\examples\sensitivity
 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆ例ࡣ࡚ࡋ関࡟概観ࠋࡍࡲࢀࡽ加え࡟

 ࣮ࢲ࢛ࣝࣇansys_parameters࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࠊࡣンࡢࢢ ANSYSࡢࢱ࣮࣓ࣛࣃ用途ࢆ実証ࡵࡓࡿࡍ
 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆ例ࡣ࡚ࡋ関࡟概観ࠋࡍࡲࢀࡽ加え࡟examples\updating\..࡟

 新ࡋい例ࠊࡣ..\examples\updating\static_strain_2࡟加え࢕ࢸ࣮ࢹࣉࢵ࢔ࠊࢀࡽン࣏ࢫ࣭ࣞࢫࣞࢺࢫࠊࢢンࡢࢫ使
用ࡼ࠾び ANSYSࠊNASTRANࠊAbaqusࠊFEMtoolsࡢ࣮ࣂࣝࢯࡢ使用ࢆࢺࣉࣜࢡࢫ示ࠋࡍࡲࡋ 

 ..\examples\updating\SIࠕࡢjimbeamࠖ例ࡣ再加ᕤࠊࢀࡉjimbeam.pdf࡛示ࠊࢀࡉ完全࡞ワ࣮ࡢ࣮ࣟࣇࢡ各ࢵࢸࢫ
 ࠋࡍࡲい࡚ࢀࡲ含࡟ࡵࡓࡃ⥆࡟ࣉࢵࢸࢫࡣࢺࣉࣜࢡࢫいࡋ新ࠋࡍࡲい࡛ࢇ含ࢆࢺࣉࣜࢡࢫ࣭ࢻン࣐ࢥࡢࣉ

 行う方法ࢆ範ᅖ解析ࢱ࣮࣓ࣛࣃ -
ࡢࡵࡓࡿࡅࡘ見ࢆ値ࢺ࣮ࢱࢫࡢ強ᗘࢢンࣜࣉࢫ - DOE 

 ..\examples\updating\oilpanࣃࣝ࢖࢜ࠕࡢンࠖ例ࠊࡣMACࡢ代わ࣏ࢫࣞ࡟ࡾン࡚ࡋ࡜ࢫ POCࡢ使用ࢆ示ࡍ新ࡋ
い例࣐ࢥンࢆࢺࣉࣜࢡࢫ࣭ࢻ含࡛ࢇいࣝ࢖࢓ࣇࠋࡍࡲ run25_poc.comࢆࢺ࣮ࣀ参照ࡉࡔࡃ࡚ࡋいࠋ 

 ..\examples\updating\dampingࡢいࠋࡓࡋࡲࢀࡉ࣒࣮ࢿࣜࡀྡࣝ࢖࢓ࣇࡢ࠿ࡘࡃ 
 
run09a.cmd -> run09_arm.cmd 
run09c.cmd -> run09_csc.cmd 
 

 例..\examples\dynamic\tds\plate_mpe.cmdࢆࣉ࣮࢙ࢩࢻ࣮ࣔࡣ᭷効࡟ࡵࡓࡿࡍ࡟ TDS࣐ࢥࡢン࡛ࢻ計算ࡓࢀࡉ時
報ࡢࡽ࠿ FEMtools MPEࢆ使用࡚ࡋᢳ出ࡿࢀࡉMAC࡜ POCࢆ使用ࡢࡇࠋࡍࡲࡋ例ࠊࡣTDS࡜MPEࡀ OMA
ࢺࢫࢸࣜࣉࡓࢀࡉ立案࡚ࡗࡼ࡟ンࣙࢩ࣮࣑ࣞࣗࢩࠊࡋ実証࠿ࡿࡁ࡛ࡀ࡜ࡇࡿࡏ合わࡳ組࡟うࡼࡢ࡝࡟ࡵࡓࡢ

解析ࠋࡍࡲࡋ࡜ 
 修ṇ済ࡢ FRF࡜ LR FRFࢆ実証ࠊࡋ剛体࡟࢕ࢸࣃࣟࣉ対ࡿࡍ結果ࢆ᭷効ࠊ࡟ࡵࡓࡿࡍ࡟追加࣐ࢥࡢンࢫ࣭ࢻ

 ࠋࡍࡲࢀࡽ加え࡟例..\rbpe\examples\engineࠊࡀࢺࣉࣜࢡ

FEMtools࣒࣮ࣞࣇワ࣮ࢡ 

 ࢫ࢖࢙ࣇ࣮ࢱン࢖࣭࣮ࢨ࣮ࣘ

 Add Band Tracker࣎ࢱン࡟࣮ࣂ࣮ࣝࢶ࣭ࢫࢡࢵ࢕ࣇࣛࢢࡣ加えࠋࡍࡲࢀࡽ 
 ࢺࢵ࢝ࢺ࣮ࣙࢩ Alt+Left Mouse Button࢕࣭࢘ࣈ࣮࢝ࡀン࡟࢘ࢻ加えࠋࡍࡲࢀࡽ 
 ࣓࣐ࢥ࣭࣮ࣗࢽンࢻ Add Band Trackerࡀ View > XY-Curves࣓࡟࣮ࣗࢽ加えࠋࡍࡲࢀࡽ 
 ࣓࣐ࢥ࣭࣮ࣗࢽンࢻ Add Band Tracker࢕࣭࢘ࣈ࣮࢝ࡀン࡟࣮ࣗࢽ࣓࣭ࣉࢵ࢔࣭ࣉࢵ࣏࣭࢘ࢻ加えࠋࡍࡲࢀࡽ 
 ࣓࣐ࢥ࣭࣮ࣗࢽンࢻ View MAC Matrix Top View Form MACࡀ Graphics > 3D-Matrices > Modal Assurance 

Criterion (MAC)࡟࣮ࣗࢽ࣓࣭ࣉࢵ࢔࣭ࣉࢵ࣏࣭࣮࣮ࣛࣟࣉࢫࢡ࢚ࡢ加えࠋࡍࡲࢀࡽ 

 ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ

 多数ࠊࡀࣝ࢖࢓ࣇࡢImport Test FRFs࡛ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ選択ࠊࡓࡲࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ各ࡣࣝ࢖࢓ࣇ連
 㸦File > Import > Test FRFs㸧ࠋࡍࡲࢀࡉࢺン࣏࣮࢖ࠊࢀࡉ処理࡚ࡋ⥆

 ࡣࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ࣭࣮ࢨ࢘ࣛࣈ࣭ࢱ࣮࣓ࣛࣃ ANSYSࡋࢺࢫࣜࢆࢱ࣮࣓ࣛࣃ選択࡟ࡵࡓࡿࡍ付ࡅ加えࢀࡽ
 ࠋࡍࡲ

 既Ꮡࡢ࡬ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲࡢ変更ࣙࢩࢡࢭࡢࢀࡒࢀࡑࡢࢺ࣮ࣀ࣭ࢫ࣮ࣜࣜࠊࡣン中࡛࣓ࣗ࢟ࢻンࢺ化ࢀࡉ

 ࠋࡍࡲ



      FEMtools 4 Release Notes - 103  

 ࣝࣈ࣮ࢸ

ANSYSࠊࡣࢺ࣮࣏ࢧࡢࢱ࣮࣓ࣛࣃParameter Selection࡟ࣝࣈ࣮ࢸ加えࠋࡍࡲࢀࡽANSYS Parameters in Table 
Windows and Mesh Graphicsࢆ参照ࡉࡔࡃ࡚ࡋいࠋ 

 ࢫࢡࢵ࢕ࣇࣛࢢ

 ANSYSࠊࡣࢺ࣮࣏ࢧࡢࢱ࣮࣓ࣛࣃ例えࡤ Parameter Changesࡼࡢう࡟࣮ࣗࣅ࣭ࢫࢡࢵ࢕ࣇࣛࢢ࡞加えࡲࢀࡽ
 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆUsing ANSYS Parameters in Table Windows and Mesh Graphicsࠋࡍ

 ࣐࣮࣮࣭࢝ࡀࢺࢵࢻ࣭ࣉ࢖ࢱ加えࡣࢀࡇࠋࡍࡲࢀࡽ෇࡟似࡚い࢖࣏ࡿンࢺ状ࠋࡍ࡛࣮࣮࣐࢝ࡢ 

 

 

 Band Tracker࣓ࢢࢭ࣭ࣈ࣮࢝ࡀンࢡ࣮ࣆࡢࢺ値ࢆ見࡟ࡵࡓࡿࡅࡘ付ࡅ加えࠋࡍࡲࢀࡽ 
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 ࣛ࢖ンࣂ࡜ンࠊ࣮࢝ࢵࣛࢺࢻ実数部࣭虚数部ࢻ࣮࣎ࠊ線ᅗ㸦振幅ࠊ఩相㸧ࡢ࡝࡞構造ࡀ表示ࠋࡍࡲࢀࡉ 

 

 HEXA8㸦4ࡢࡘ一致ࢻ࣮ࣀ㸧࢖࡚ࡋ࡜ン࣓ࣜࣉンࢻࢵ࣑ࣛࣆࡓࢀࡉࢺ固体ࢆ特色ࡿࡍ࡜場合ࠊ固定 Gouraudࢹ
 ࢖ࣞࣉࢫ࢕

 ࢩン࣎ࣝࡢ࣮࣮࣐࢝ࡢࢺࢫ࢟ࢸ࡜最適化ࡓࡋᅗ面ࢆ表示ࠋࡍࡲࡋ現代ࡢ遝ග物ᢏ術ࡣ多ࡀ࣮࣮࣐࢝ࡢࡃ表示

ࡲࢀࡉ化ࣈ࢕ࢸࢡ࢔ࡀ最適化ࡢࡇࠊࢀࡉ使用ࡀࢺࢫ࢟ࢸࠊ࣮࣮࣐࢝ࡾ織ࠊࢀ行わࡀい改良ࡋ著ࠊ場合ࡿࢀࡉ

 Edit > Settingsࠊࡣ࡛ࢻ࣮࣭ࣔࢡࢵ࢕ࣇࣛࢢ㸧ࡳࡢWindowsࠊࢺ࢛ࣝࣇࢹࡢgraphic.mode=2㸦FEMtools 4.2ࠋࡍ
> Graphics Windows > Use Optimized Graphics Renderingࢆ使用ࠋࡍࡲࡋ

  垂直ࡢࢺࢫ࢟ࢸࡢ୚えࡣ࡜ࡇࡿ最適化ࢪ࣮࣓࢖ࡓࢀࡉ回転ࢆ使用࡚ࡋ改善ࠋࡍࡲࢀࡉ垂直ࠊࡣࢺࢫ࢟ࢸࡢ特

 ࠋࡍࡲ見え࡟うࡼࡿい࡚ࡋ一㈏ࡾࡼࠊࡃ鋭ࡾࡼࡃࡋ著ࠊ࡟ࡵࡓࡢࢺン࢛ࣇ࡞ࡉᑠࡾࡼ࡟

NEW    OLD 

   

 ࢜ࣜࣗࢩࢵ࣓ࡢࣝࢼࢪ色࢖ࣛ࡜ン࣭ࡢࣝ࢖ࢱࢫ選択ࠊࡣCustomize Mesh Displayࡢࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ
Deformed࡟ࣈࢱ加えࠊࡣࢀࡇࠋࡍࡲࢀࡽwireframe࣮ࣗࣅ㸦Edge㸧࡟当࡚ࠋࡍࡲࡾࡲࡣEdgeࡢ場合ࠊEdge࢝
 ࠋࡍࡲࢀࡉ使用ࡀ࣮ࣛ
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 多ࡢࡃ PLOTELSࡣࡓࡲMPCࢆ特色ࡣ࢖ࣞࣉࢫ࢕ࢹࡢࣝࢹࣔࡿࡍ࡜速ᗘ࡛最適化࢔ࡓࡲࠋࡍࡲࢀࡉン࢖࢚ࢳ
graphic.antialiasࠋࡍࡲࡋ使用ࢆࢢン࢕ࢸࢵࢭࡢࢢンࢩ࢔ࣜ࢖࢚ࢳン࢔wireframeࠊࡣ࡟ࡿࡍ回避ࢆࢢンࢩ࢔ࣜ
ࡣࡓࡲ graphic.antialiaslimitࠊࡣ࡟ࡿࡍࢺࢵࢭࢆEdit > Settings > Graphics Windowsࢆ使用ࠋࡍࡲࡋ 

 

 ࣮࢝ࢵࣛࢺࢻンࣂ

新ࡋいࣂンࢻ㸦ࢡ࣮ࣆ㸧࢖ࣛࡣ࣮࢝ࢵࣛࢺン࣭ࠊ࣮࢝ࢵࣛࢺ利用ྍ能࡞ ࢫࢡࢵ࢕ࣇࣛࢢ࡟うࡼࡢ࣮࢝ࢵࣛࢺࡢࡘ2
 ࠋࡍࡲࢀࡽ加えࡅ付࡟

ࣂࡢ範ᅖࣈ࣮࢝ࡓࢀࡉ࣮ࣂ࡚࢝ࡗࡼ࡟ᶓᗙ標値[1%+ࠊ1%-]ෆ部࡛ࡣ値ࢡ࣮ࣆ࣭ࢺ࢖ࣛ࢖ࣁ࣭࣮࢝ࢵࣛࢺ࣭ࢻンࣂ
ンࣂࠋࡍ࡛ࢻンࡣࢻ 2行ࡢ垂直ࡢ色ࢮ࣐ࡀン࢖ࣛࡓࢀࡽࡅࡘ࡟ࢱン࡛特徴࡙ࣂࠋࡍࡲࢀࡽࡅンࡢࢻ max࠿ࢡ࣮ࣆ
minࢡ࣮ࣆ値ୖࠊࡣ記ࡢࣝࢯ࣮࢝ࡢ఩置あࡿいࣈ࣮࢝ࡣ以ୗࢀࡒࢀࡑ࡟依Ꮡ࡚ࡋ強調ࡻࡋ࡛ࡿࢀࡉうࠋ㸦ᅗ 3㸧 

   

ᅗ 3 ఩置࡟依Ꮡࣂࡿࡍンࡢࢻ max値࡜ min値ࢆ示ࣂࡍン࣮࢝ࢵࣛࢺࢻ 

ࡢࡕうࡢ方法ࡢ次ࠊࡣ࡟ࡿ加えࢆ࣮࢝ࢵࣛࢺࢻンࣂ  ࠋいࡉࡔࡃ࡚ࡋ使用ࢆࡘ1
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 ࡛ୖ࣮ࣂ࣮ࣝࢶ࣭ࢫࢡࢵ࢕ࣇࣛࢢ Add Band Tracker࣎ࢱンࢆ使用ࠋࡍࡲࡋ 
 ࢆ࣮࢝ࢵࣛࢺ置ࡃ必要ࡀあ࢕࣭࢘ࣈ࣮࣭࢝ࢫࢡࢵ࢕ࣇࣛࢢ࡛ࢁࡇ࡜ࡿンࡢࣝࢯ࣮࢝ࡢ࢘ࢻ఩置ࢆ決ࡔࡃ࡚ࡵ

 ࠋいࡉࡔࡃ࡚ࡋࢡࢵࣜࢡࢆンࢱClick Alt+Left Mouse࣎ࠋいࡉ
 View > XY-Curves > Add Band Trackerࢆ使用ࠋࡍࡲࡋ 
 ࢕࣭࢘ࣈ࣮࣭࢝ࢫࢡࢵ࢕ࣇࣛࢢン࢘ࢻ中࡛右࡚ࡋࢡࢵࣜࢡ選択ࡢࡽ࠿࣮ࣗࢽ࣓࣭ࣉࢵ࢔ࣉࢵ࣏ࠊࡋ Add Band 

Trackerࢆ選択ࠋࡍࡲࡋ 

MAC࣐࣮ࣗࣅࣉࢵࢺࡢࢫࢡࢵࣜࢺ形式 

新ࡋい࣐ࡣ࣮ࣗࣅࣉࢵࢺ࣭ࢫࢡࢵࣜࢺMAC࣐ࢫࢡࢵࣜࢺ㸦ᅗ 4㸧࡟ࡵࡓࡢ加え࣮ࢮ࢖࣐ࢱࢫ࢝ࡣࢀࡇࠋࡍࡲࢀࡽ
 ࠋࡍࡲࡋ࣮ࣝࣟࢺンࢥࢆࢺ࣮࣏ࣞ࡜ンࣙࢩ

 

ᅗ 4 MAC࣮ࣗࣅࣉࢵࢺࡢࢫࢡࢵࣜࢺ࣐ࡢ形式 

Explorer > Graphics > 3D-Matrices > Modal Assurance Criterion (MAC)࡛右࡚ࡋࢡࢵࣜࢡ開ࠊࡁView MAC Matrix Top 
View Formࢆ選択ࠋࡍࡲࡋ㸦ᅗ 5㸧 

 

ᅗ 5 MAC࣐ࢆ࣮ࣗࣅࣉࢵࢺ࣭ࢫࢡࢵࣜࢺ開ࡃ操作 

形式ࢼ࣭ࢻ࣮ࣔࡣンࡼ࠾࣭࣮ࣝ࣋ࣛࣂび周波数値ࢆ備えࢆ࣮ࣗࣅࣉࢵࢺࡢࢫࢡࢵࣜࢺ࣐ࡓ示ࠋࡍࡲࡋ次ࢥࡢンࣟࢺ
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 ࠋࡍ利用ྍ能࡛ࡀ࣮ࣝ

 FEࡢࢻ࣮࣭ࣔࢺࢫࢸ࡜形番号用ࡢ min࡜ maxࡢ範ᅖ：࡟ࡵࡓࡿࡍ࣒࣮ࢬࢆࣉ࣮࢙ࢩࢻ࣮ࣔࡣࢀࡇ使用ࡲࢀࡉ
 ࠋࡍ

 Flip Axis：列ࢆ࣒ࣛ࢝࡜ษࡾ替えࠋࡍࡲ 
 Square Aspect Ratio：ࢆࢡࢵ࢕ࣇࣛࢢ࣭࣮ࣗࣅࣉࢵࢺ維持ࠋࡍࡲࡋ 

㸦ᅗࠋࡍࡲࡁ開ࢆࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲࡓ備えࢆ࣮ࣝࣟࢺンࢥࡢ追加ࠊࡣンࢱ࣭࣎ࢢン࢕ࢸࢵࢭ 6㸧 

 ࢺࢵࣟࣉ用ࣝࢺ࢖ࢱ 
 FEAࣝ࣋ࣛࡢࢺࢫࢸ࡜ 
 周波数値ࢥࡢン࣮ࣝࣟࢺ 
 白い࣎ࢆࢫࢡࢵ備えࢆࣉ࣮࢙ࢩࢻ࣮ࣔࡓ強調ࢫࢡࢵ࣎ࢡࢵ࢙ࢳࡿࡍ 
 注釈࣎ࢼ࣭ࢻ࣮࡛ࣔࢫࢡࢵン࡜࣮ࣂMAC値ࢆ示ࣝࢭࡍ値ࣈ࢕ࢸࢡ࢔ࢆ࣮࢝ࢵࣛࢺ化ࢫࢡࢵ࣎ࢡࢵ࢙ࢳࡿࡍ

㸦ᅗ 7㸧 

形式ࢆ閉࡟ࡵࡓࡿࡌ Exit࣎ࢱンࢆ使用ࡉࡔࡃ࡚ࡋいࠋ 

 

ᅗ 6 MAC࣐࢕ࢸࢵࢭ࣮ࣗࣅࣉࢵࢺ࣭ࢫࢡࢵࣜࢺンࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ࣭ࢢ 

 

ᅗ  ࣮ࣗࣅࣉࢵࢺࡢࢫࢡࢵࣜࢺMAC࣐ࡓࢀࡉ化ࣈ࢕ࢸࢡ࢔ࡀ࣮࢝ࢵࣛࢺ値ࣝࢭ 7

うࡶࠊ࡜ࡿࡍࢡࢵࣜࢡ中࡛右࢘ࢻン࢕࢘ 㸦ᅗࠋࡍࡲ୚えࢆᶒࢫࢭࢡ࢔࡟ࢻン࣐ࢥࡢࡘ2 8㸧 
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 ࡢࢡࢵ࢕ࣇࣛࢢ࡟ࢻ࣮࣎ࣉࢵࣜࢡ：࣮ࣆࢥࡢ࡬ࢻ࣮࣎ࣉࢵࣜࢡMACࠋࡍࡲࡋ࣮ࣆࢥࢆ 
 ࣝࣈ࣮ࢸ࣭࢔࣌ࣉ࣮࢙ࢩࢻ࣮ࣔࡢ࡬ࢻ࣮࣎ࣉࢵࣜࢡ：ࣝࣈ࣮ࢸ࣭࢔࣭࣌ࢻ࣮࣮ࣔࣆࢥࡢ࡬ࢻ࣮࣎ࣉࢵࣜࢡ用

 ࠋࡍࡲࡋ生成ࢆࢺࢫ࢟ࢸ

 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿ㈞࡟ࢺン࣓ࣗ࢟ࢻ࣭ࢺ࣮࣏ࣞ࡟次ࠊࡣࢶンࢸンࢥ࣭ࢻ࣮࣎ࣉࢵࣜࢡ

 

ᅗ 8 MAC࣐࣮ࣗࢽ࣓࣭ࣉࢵ࢔ࣉࢵ࣏ࡢ࣮ࣗࣅࣉࢵࢺࡢࢫࢡࢵࣜࢺ 

 選択ࡢࢫン࣏ࢫとࣞࢱ࣮࣓ࣛࣃ

ANSYSࡢࢱ࣮࣓ࣛࣃ定義 

FEMtools 4.2ࡣ ANSYSࢆࢱ࣮࣓ࣛࣃᑟ入ࠊࡣࡽࢀࡇࠋࡍࡲࡋANSYS CDB࣮࡚ࣜࡗࡼ࡟ࢲ作成࣮࣋ࢱ࣮ࢹࡓࢀࡉ
ン࣭ࣙࢩࢡࢭࠊࢱ࣮ࢹ実数ࠊANSYS材料特性ࠊ࡚ࡋ࡜࢕ࢸࣃࣟࣉ࡞利用ྍ能ࡢ࡚࡭ࡍࡓࢀࡉ格納࡟ࣝ࢖࢓ࣇ࣭ࢫ
࣭ࢺࢫ࢟ࢸࠊ強力࡛ࡾࡼࡣࡽࢀࡑࠊࢀࡉ写像࡟ࢫ࣮࣋ࢱ࣮ࢹࡿࢀࡉ維持࡚ࡗࡼ࡟FEMtoolsࠋࡍ࡛࡝࡞࢕ࢸࣃࣟࣉ
ࡀ情報ࡢࡃ多ࡾࡼࠋࡍ簡単࡛ࡀࡢࡿࡍ使用ࡾࡼࢱ࣮࣓ࣛࣃ ANSYS࢖ンࡼ࠾ࢫ࣮࣋ࢱ࣮ࢹ࣭ࢫ࢖࢙ࣇ࣮ࢱび࣓ࣛࣃ
 ࠋࡍࡲࡾ࠿ࡘ見࡛ࢱ࣮

 定義ࡢࢫン࣏ࢫ࣭ࣞࢫࣞࢺࢫ

FEMtools 4.2ࡣ相関ศ析ࠊ感ᗘ解析࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࠊン࣏ࢫ࣭ࣞࢫࣞࢺࢫࡢࢢンࢆࢺ࣮࣏ࢧࡢࢫ加えࠋࡍࡲ 

ࡿࡍࢺ࣮࣏ࢧࢆࢫン࣏ࢫ࣭ࣞࢫࣞࢺࢫࡀࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲCreate Responseࠊࣝࣈ࣮ࢸResponsesࠊࡣ࡟目的ࡢࡇ
㸦ᅗࠋࡍࡲࢀࡉࢺ࣮ࢹࣉࢵ࢔ࠊ࡟ࡵࡓ ᅗࠊ9 10㸧 

新ࡋい࣐ࢥンࡢࢻ RESPONSE STRESS࣏ࢫ࣭ࣞࢫࣞࢺࢫࡀンࢆࢫ定義࡟ࡵࡓࡿࡍ付ࡅ加えࡣࢀࡑࠋࡍࡲࢀࡽ
RESPONSE STRAINࢩࡌྠ࡜ンࡼ࠾ࢫࢡࢵࢱび補足ࢆ使用ࠋࡍࡲࡋ 
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ᅗ  ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ作成：Static Stress Responses typeࡢࢫン࣏ࢫࣞ 9

 

ᅗ  ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ࣭࢕ࢸࣃࣟࣉࡢ作成：Static Stress Responses typeࡢࢫン࣏ࢫࣞ 10

 ࢺࣉࣜࢡࢫ࣭࣒ࣛࢢࣟࣉ࣭ࢫ࢖࢙ࣇ࣮ࢱン࢖

FRF࢖ࡢン࣏࣮ࢺ 

 多数ࡣࣝ࢖࢓ࣇࡢ Import Test FRFs࡛ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ選択ࠊࡓࡲࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ各ࡣࣝ࢖࢓ࣇ連⥆
 㸦File > Import > Test FRFs㸧ࠋࡍࡲࢀࡉࢺン࣏࣮࢖ࠊࢀࡉ処理࡚ࡋ

 FRFࡢࣉ࢖ࢱ識別ࠊࡣImport Test FRFs࡛ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ行わࠊࢀ加振 DOFࡀ見࡞ࡽ࠿ࡘい場合ࠊ出力／



110 - FEMtools 4 Release Notes  

入力 FRF࡛࡞ࡣい࡞ࢀࡋࡶ࠿い࡜いう࣏࣮ࣞࡀࢺ出力ࠋࡍࡲࢀࡉ 

DIANA᭷限要素解析ソ࢖࣭࢔࢙࢘ࢺࣇンࢫ࢖࢙ࣇ࣮ࢱ 

DIANA入力ࣝ࢖࢓ࣇ࣭ࢱ࣮ࢹ用ࡀࢲ࣮ࣜࡢ FEMtools࡟含࡚ࢀࡲいࡣࢀࡑࠋࡍࡲ FEMtoolsࢺࣉࣜࢡࢫ言語࡛ࣟࣉ
ࡲࢀࡉᥦ供࡚ࡋ࡜ࢻ࣮ࢥࢫ࣮ࢯン࣭ࣉ࣮࢜ࡿࡁ࡛ࡀ࡜ࡇࡿࡍࢬ࢖࣐ࢱࢫ࢝ࡋ使用࡟自由ࡀ࣮ࢨ࣮ࣘࠊࢀࡉ࣒ࣛࢢ

࡟うࡼࡿࡁ࡛ࡀ࡜ࡇࡿ加えࢆ情報ࡢࡽࢀࡑࠊい࡚࠾࡟将来ࠋࡍ FEMtoolsࢺ࣮࣏ࢧ㸦support@femtools.com㸧ࡢ࡬変
更ࢆ報告ࡉࡔࡃ࡚ࡋいࠋ 

DIANA入力ࢻ࣮ࣀࠊࡣࣝ࢖࢓ࣇ࣭ࢱ࣮ࢹᗙ標ࠊ要素ࠊ結線ࡢࡑࠊ௚ࢻ࣮ࣟࡢ条件ࠊ境界条件ࢆ含ࡴ᭷限要素ࣔࢹ
ࣝ全体ࡘ࡟い࡚記述ࠋࠊࡍࡲࡋ 

入力࡛ࣝࣈ࣮ࢸࠊࡣࣝ࢖࢓ࣇ࣭ࢱ࣮ࢹ細ศࠊࢀࡉ各ࡣࣝࣈ࣮ࢸ᭷限要素ࣔࡢࣝࢹ例えࢻ࣮ࣀࡤᗙ標ࠊ要素࡛࡝࡞

ࡲࢀࡉ表示࡚ࡗࡼ࡟標題ྡࡢ文Ꮠࡢ6個ࠊࡓࢀࡲCOORDI’࡛ᅖ’ࣝࣈ࣮ࢸࡢࢺ࣮࢛ࢡࣝࢢンࢩࠊࡣࣝࣈ࣮ࢸ各ࠋࡍ
 ࠋࡍࡲࡁ࡛ࡶ࡜ࡇࡿࡍ使用ࢆ長いྡ前ࡾࡼࠋࡍ

 ࠋࡍscripts\interfaces\diana\impdiana.bas࡛\..ࠊࡣࢺࣉࣜࢡࢫ࣭ࢲ࣮ࣜ

現ᅾࡘ࡟ࣝࣈ࣮ࢸࡿࢀࡉࢺ࣮࣏ࢧい࡚ࡢ情報ࠊࡣ..\scripts\interfaces\diana\readme.txtࢆ見࡚ࡉࡔࡃいࠋ 

How to use the Reader 

ࡢࢺࣉࣜࢡࢫ࣭ࢻン࣐ࢥࡣࡓࡲン࢖ࣛࢻン࣐ࢥ IMPDIANAࢆ使用ࠋࡍࡲࡋ 

 ࠋいࡉࡔࡃ࡚ࡋࣉ࢖ࢱ࡟うࡼࡢ次ࠊࡣい࡚ࡘ࡟ࣉࣝ࣊ࡢࢫࢡࢵࢱンࢩ࣭ࢻン࣐ࢥ

> help impdiana 

編集ࣙࢩ࣮ࢮ࢖࣐ࢱࢫ࢝ࠊンࡢ目的ࢆ࣮ࣆࢥࡢࢺࣉࣜࢡࢫ࣭࣒ࣛࢢࣟࣉ࣭ࢲ࣮ࣜࠊࡣ࡟作ࣝࢼࢪࣜ࢜࡜ࢀࡑࠊࡾ版

 ࠋࡍࡲࢀࡉ推奨ࡀ࡜ࡇࡿࡍ使用ࢆ別ྡ࡟ࡵࡓࡿࡍ区別ࢆ

impdiana.bas࡟ࢺࢫࣜࡢ࣮ࣜࢺࢡࣞ࢕ࢹ࣭ࢺࣉࣜࢡࢫ࣭ࢺ࢛ࣝࣇࢹࡀࢺࣉࣜࢡࢫ載࡚ࡗい࡞い別ࢥ࡟࣮ࢲ࢛ࣝࣇࡢ
࢛ࡀimpdiana.basࠊࡤ例えࠋいࡉࡔࡃ࡚ࡋ使用ࢆࢺࣉࣜࢡࢫ࣭࣒ࣛࢢࣟࣉ࡟共࡜ࢻン࣐ࢥRUNࠊࡣ場合ࡿࢀࡉ࣮ࣆ
ࢪ࣮ࣂࡓࢀࡉࢬ࢖࣐ࢱࢫ࢝ࡣ場合ࡿࢀࡉ࣒࣮ࢿ࡚ࣜࡋ࡜myimpdiana.basࠊࢀࡉ࣮ࣆࢥ࡟c:￥projects￥diana࣮ࢲࣝ
ࣙンࢆ実行࡟ࡵࡓࡿࡍୗ記࣐ࢥンࢆࢻ使用ࡉࡔࡃ࡚ࡋいࠋ 

myfileࡢࡵࡓࡢ myimpdiana.basࢆࣝ࢖࢓ࣇ実行ࠋࡍࡲࡋ 

 ࠋࡍ必要࡛ࡀᣑ張子.basࠊ場合ࡢࡇ

 ࢫ࣮࢙ࣇ࣮ࢱン࢖࣭ࣝ࢖࢓ࣇ࣭ࣝࢧ࣮ࣂࢽࣘ

 ࢺࣉࣜࢡࢫ wuffem.basࡣ wuffemset.basࣝ࢖࢓ࣇ࣭ࣝࢧ࣮ࣂࢽࣘࡣࢺࣉࣜࢡࢫࡢࡇࠋࡍࡲࢀࡉ࣒࣮ࢿ࡚ࣜࡋ࡜
ࡢ要素࡜ࢻ࣮ࣀ࡟ FEMࠋࡍࡲࡋࢺ࣮࣏ࢫࢡ࢚ࢆࢺࢵࢭ 

 ࢺࣉࣜࢡࢫ ruffem.basࠊࡣruffemset.basࣝ࢖࢓ࣇ࣭ࣝࢧ࣮ࣂࢽࣘࡣࢺࣉࣜࢡࢫࡢࡇࠋࡍࡲࢀࡉ࣒࣮ࢿ࡚ࣜࡋ࡜
 ࠋࡍࡲࡋࢺン࣏࣮࢖ࢆࢺࢵࢭ要素࡜ࢻ࣮ࣀࡽ࠿

 新ࡋいࢺࣉࣜࢡࢫ wuffemhra.basࡀ加えࡣࢺࣉࣜࢡࢫࡢࡇࠋࡍࡲࢀࡽ UFࣉ࢖ࢱ 12㸦ࣝࢺࢡ࣌ࢫ㸧ࢭࢱ࣮ࢹࡢ
ࢺࢵ 58関数ࠊ࡚ࡋ࡜Harmonic Response Analysis (HRA)ࠋࡍࡲࡋࢺ࣮࣏ࢫࢡ࢚ࢆ 

ࢺࣉࣜࢡࢫ ruftest.basࠊࡣFRF࡜時系列࢖ࢆࢱ࣮ࢹン࣏࣮ࣜࢼ࢖ࣂࠊࡋࢺ UFF㸦ࢺࢵࢭࢱ࣮ࢹ 58㸧ࡲࡋࢺ࣮࣏ࢧࢆ
ࡣࢀࡑࠊࡓࡲࠋࡍ FEMtools(CHANNELS OFF)ࣕࢳ࡟ンࢆࣝࢿ定義ࠊ࡟ࡎࡏ時系列ࢱ࣮ࢹ(TIME ON)࢖ࢆン࣏࣮ࢺ
ࢻン࣐ࢥࠊ࠿ࡿࢀࡉ定義࡟既ࡀࣝࢿンࣕࢳࡢࡽࢀࡇࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ DEFINE CHANNEL࡛別々࡟定義ࢀࡉ
 ࠋࡍ᭷効࡛࡟場合ࡿ

mailto:support@femtools.com
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ARTeMIS࢖ン࢙ࣇ࣮ࢱｲࢫ 

WRITECFG࣐ࢥンࣝ࢖࢓ࣇ࣭ࣝࢧ࣮ࣂࢽࣘࡣࢻ ASCII࡛ࢺࢵ࣐࣮࢛ࣇ࣭ࣜࢼ࢖ࣂ࡜書ࡓࢀ࠿時系列࣏ࢧࢆࢱ࣮ࢹ
 ࠋࡍࡲࢀࡉᣑ張࡟ࡵࡓࡿࡍࢺ࣮

 ࢺࣉࣜࢡࢫ࣭࣒ࣛࢢࣟࣉ࣭࢕ࢸࣜ࢕ࢸ࣮ࣘ

次ࡀࢺࣉࣜࢡࢫ࣭࢕ࢸ࢕ࣜ࢕ࢸ࣮ࣘࡢ..￥scripts￥࣮ࣘ࡟࢕ࢸ࢕ࣜ࢕ࢸ加えࠋࡍࡲࢀࡽ 

subtract_frfs.bas FE FRFࢺࢫࢸࡽ࠿ FRFࢆ引ࢺࢫࢸࠊࡁ FRFࢆࡽࢀࡑ࡚ࡋ࡜格納ࠋࡍࡲࡋ
㸦例えࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ適応࡚ࡋ࡜ࢱ࣮ࢹ変形࡟容易ࡣࢺࣉࣜࢡࢫ

 㸧࡝࡞ࢱ࣮ࢹṇ規化ࠊン࣏ࣛࣜ配列ࢸࠊFEM FRFࠊࡤ
ࡢࣝࢼࢪࣜ࢜ࡣ࢕ࢸࣜ࢕ࢸ࣮ࣘࡢࡇ FRF࡟基࡙࢖ࡃンࣈ࣮ࣝࣉ FRFsࡢ
RBPEࢆ見ࠋࡍࡲࡅࡘ但ࡣࢀࡑࠊࡋ改善ࡓࢀࡉ弾性࣮ࣔࢆࢻ得࡛ࡀ࡜ࡇࡿ
 ࠋࡍࡲࡁ

sort_freqrange.bas ࡣࢺࣉࣜࢡࢫࡢࡇ周波数ࠊࡋࢡࢵ࢙ࢳࢆFRF࡚ࡗࡼ࡟使用ࡿࢀࡉ範ᅖࢆ
高い第ࡾࡼ周波数(f2)ࡢ最後ࠊࡤ例えࠋࡍࡲࡋࢺ࣮ࢯ 1周波数(f1)࡜共࡟
使用ࡿࢀࡉ場合ࠊ範ᅖࡼࡢࡑࠋࢇࡏࡲࢀࡉࢺ࣮ࢯࡣう࡞範ᅖࡣ UFF࣮ࣜ
ࡓࡲࠊࢀࡉ理ཷ࡚ࡗࡼ࡟ࢲ FRF࣮࢝ࡀࣈ表示ࠋࡍࡲࢀࡉ相関ศ析ࢵ࢔ࠊ
い࡚࠾࡟ࢢン࢕ࢸ࣮ࢹࣉ FRFࢆ使用ࠊࡋMPE࡜ RBPE࡛ࢆ࣮࢚ࣛࡣ引ࡁ
起ࠋࢇࡏࡲࢀࡋࡶ࠿ࡍࡇ例えࠊࡤ周波数ࢆࣉࢵࢸࢫ変更࡟ࡵࡓࡿࡍ範ᅖ

࡜範ᅖࠊࡕ即ࠋࢇࡏࡲࢀࡋࡶ࠿い࡞ࡁ࡛ࡣ࡜ࡇࡿࡍ再定義ࢆ FRF定義ࢆ
最初࡟修ṇࡿࡍ必要ࡀあࠋࡍࡲࡾ 

store_mass.bas ࣐ࡣ࢕ࢸࣃࣟࣉ࣭ࢫ現ᅾࡢෆ部ࡢࢫ࣮࣋ࢱ࣮ࢹ FEࣔࡽ࠿ࣝࢹ計算ࡲࢀࡉ
前ࡿࢀࡉ࣮ࣆࢥ࡟ࢫ࣮࣋ࢱ࣮ࢹ࣭ࢺࢫࢸࡀࢀࡑࡣࢺࣉࣜࢡࢫࡢࡇࠋࡍ

参照ࠊ࡟ FEࣔࢆ࢕ࢸࣃࣟࣉ࣭ࢫ࣐ࡢࣝࢹ格納࡟ࡵࡓࡿࡍ更新ࡿࡍ FE-FE
後ࢢン࢕ࢸ࣮ࢹࣉࢵ࢔ࡢࣝࢹFEࣔࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ使用࡛ࣝࢹࣔ
参照ࡿࡍࢢン࢕ࢸ࣮ࢹࣉࢵ࢔ࡣࢺࣉࣜࢡࢫapply_response.basࠊ࡟ FEࣔࢹ
 ࠋࡍࡲࢀࡉ使用࡟ࡵࡓࡿࡍ定義ࢆ࢕ࢸࣃࣟࣉ࣭ࢫ࣐ࡢࣝ

apply_responses.bas ࡽ࠿ࢫ࣮࣋ࢱ࣮ࢹ格納ࢆ࢕ࢸࣃࣟࣉ࣭ࢫ࣐ࡓࢀࡉ検索ࠊࡋ生成ࢫࣞࠊࡋ

࣏ンࢆࢫ定義ࠋࡍࡲࡋ 
show_slices.bas ࡣࢺࣉࣜࢡࢫ࣭࢕ࢸ࢕ࣜ࢕ࢸ࣮ࣘࡢࡇ FEࣔࢫ࢖ࣛࢫࢆࣝࢹ表示ࠋࡍࡲࡋ

ࡣࢀࡇ 3D固体ࡢෆ部ࢆ見࡟ࡢࡿ᭷用࡛ࠋࡍ 
narrow_pmax.bas ࡣࢺࣉࣜࢡࢫ࣭ࢡࢵ࣍ࡢࡇ SET TUNE ISCRIPTࢆ࿨ࡘ1ࠊࡣࢀࡑࠋࡍࡲࡌ

最大ࡾࡓ཯復当ࡢ dP/P࡟対ࡿࡍ PMAXࢆ自動的࡟縮ᑠࠋࡍࡲࡋ連⥆的࡟
PMAXࢆ適応ࠊ࡚ࡗࡼ࡟࡜ࡇࡿࡍࡏࡉ཰束Ᏻ定値ࢆ改善ࡁ࡛ࡀ࡜ࡇࡿࡍ
཯復ࡢࡃ多ࡾࡼࠊࡾࡼ場合ࡓࢀ࠿࠾࡚ࡋ࡟一定ࡀPMAXࠊࡣୗ降ࠋࡍࡲ
 ࠋࢇࡏࡲࢀࡋࡶ࠿ࡿࢀࡉ要求ࡀ

FEMtools࣓ࣗࢩࢵ 

LINE2ࡽ࠿ LINE3ࡢ変換ࡣ஧次ࡢ要素転換㸦࣐ࢥンࢻMESH GENERATEࡼ࠾び Element Type Conversionࣟ࢔࢖ࢲ
 ࠋࡍࡲࢀࡉ㸧࡛加算ࢫࢡࢵ࣎ࢢ

FEMtools Dynamics 

ANSYSࢻ࣮ࣔࡢࣂ࢖ࣛࢻ解析 

ANSYS࣓࢝ࡢࣝ࢝ࢽ新ࡋいࡀࣂ࢖ࣛࢻ加えࠊࢀࡽ新ࡋい ANSYS CDB࣮࡚ࣜࡗࡼ࡟ࢲ作成࢖ࡓࢀࡉン࢖࢙ࣇ࣮ࢱ
ࡽ࠿ࢫ࣮࣋ࢱ࣮ࢹ࣭ࢫ CDBࠊࡋࢺ࣮࣏ࢫࢡ࢚ࢆࣝ࢖࢓ࣇ再解析用ࡢ ANSYSࢆ始ࠋࡍࡲࢀࡽࡵ 

ࢻン࣐ࢥࡣࣂ࢖ࣛࢻࡢࡇ SET SOLVER db2anࡣࡓࡲ SET DYNAMIC SOLVER db2an࡛選択ࠋࡍࡲࢀࡉ 
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 ࠋࡍࡲࡋ選択ࢆANSYS_DBࠊࡣ㸦Tools > Modes Analysis㸧࡛ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ解析ࢻ࣮ࣔ

db2an(ANSYS_DB)ࡀṇ規࣮ࣔࢻ解析࡚ࡋ࡜働࡟࡜ࡇࡃ注意ࡉࡔࡃ࡚ࡋいࠋ 

ANSYSࡀࢱ࣮࣓ࣛࣃ使用ࡿࢀࡉ場合ࡣࣂ࢖ࣛࢻࡢࡇࠊ感ᗘࢆ計算࡟ࡵࡓࡿࡍ ansensࢆࢺࣉࣜࢡࢫ使用࡜࡜ࡇࡿࡍ
ྠ様࡛ࠋࡍ 

ࢻン࣐ࢥいࡋ新ࡿࡍࢺࢵࢭࢆࣂ࢖ࣛࢻࡢ両方ࡢ感ᗘ࡜࣮ࣂࣝࢯ SET ANSYS ONࡀ加えࠋࡍࡲࢀࡽ 

ANSYSࡀࢱ࣮࣓ࣛࣃ使用ࡓࡗ࠿࡞ࢀࡉ場合ࠊansys.basࢆࣂ࢖ࣛࢻ࣭࣮ࣂࣝࢯ使用ࠊࡣࢀࡇࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ
ANSYS࢖ン࢙ࣇ࣮ࢱｲࢫ࣮࣋ࢱ࣮ࢹ࣭ࢫ㸦v4.2㸧ࡢ代わ࡟ࡾ FEMtoolsෆ部ࢫ࣮࣋ࢱ࣮ࢹ㸦pre v4.2㸧ࡢ CDBࢡ࢚ࢆ
 ࠋࡍࡲࡋࢺ࣮࣏ࢫ

ࡿࡼ選択にࡢと残余ࢻ࣮ࣔ FRF合成 

ࢡ残余࣋࡜FRF合成ࠊࡋ使用ࢆࡳࡢࢻ࣮ࣔࡣいࡿ㸧あࡢ部ୖࡓࡲࡘ࠿ࡃపࡾࡼ㸦ࣝࢺࢡ残余࣋ࡢࡳࡢࢻ࣮ࣔࡣࢀࡑ
࡜MODEࠊ࡟ࡵࡓࡢ目的ࡢࡇࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ計算ࢆࣝࢺ RESIDUALࡢ選択ࡢ新ࡋい補足ࡀ FRF合成ࡵࡓࡢ
ࡢ FRF࣐ࢥン࡟ࢻ加えࠋࡍࡲࢀࡽ 

FRF[TEST]MODE{NONE|mode_sel|ALL}RESIDUAL{LOWER|UPPER|{ON|OFF}} 

RESIDUAL ON ࡛ࢫ࣮࣋ࢱ࣮ࢹ見ࡓࡗ࠿ࡘ時ࠊ多数ࡢ参照用ࡢప部ୖ࡜部ࡢ両方ࡢ残余ࡀ

選択ࠋࡍ࡛ࢺ࢛ࣝࣇࢹࡣࢀࡇࠋࡍࡲࢀࡉ 
MODE OFF RESIDUAL LOWER LRࡢࡽ࠿ࡳࡢ FRFࢆ生成ࠊ࡟ࡵࡓࡿࡍ剛体ࢱࢡࣛࢺࢫࢡ࢚࣭࢕ࢸࣃࣟࣉ

࣮㸦RBPE㸧࡜結合࡚ࡋ使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 
MODE 1 RESIDUAL OFF 第 ࡢࡳࡢࣉ࣮࢙ࢩࢻ1࣮ࣔ FRFࢆ生成࡟ࡵࡓࡿࡍ RBPE࡜結合࡚ࡋ使用ࡍ

ࡢ修ṇ済ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿ FRFࡾࡼࡣ広い周波数ࣞン࡟ࢪ質量ࣛ࢖ンࢆ
供給ࠋࡍࡲࡋ 

再ࢧンࣜࣉンࢢ FRF 

再ࢧンࡀࣉࢵࢸࢫࣝࣉ倍ࣙࢩࣉ࢜ࡢンࡼࡿ࡞࡟うࡉࣉࢵࢸࢫ1ࠊ࡟え使用ࠊࡋ୙ྠࡢ周波数ࢆࣉࢵࢸࢫ備えࡓ FRF
 ࠋࡍࡲࢀࡉ修ṇࡀMODIFY FRF…RESAMPLE[real_val]ࢻン࣐ࢥࡿࢀࡉ使用࡟ࡵࡓࡿࡍࢢンࣜࣉンࢧ再ࢆ

値ࡀ指定࡞ࢀࡉい場合ࠊ周波数ࡣࣉࢵࢸࢫ現ᅾࡢ範ᅖ㸦minࠊmax値㸧ࡽ࠿得ࠋࡍࡲࢀࡽ 

仮想 OMA 

例題..\examples\dynamic\tds\plate_mpe.cmdࢆࣉ࣮࢙ࢩࢻ࣮ࣔࡣ᭷効࡟ࡵࡓࡿࡍ࡟ TDS࣐ࢥࡢンࢻ㸦時間領域࣑ࣗࢩ
ࡢࡽ࠿時報ࡓࢀࡉン㸧࡛計算ࣙࢩ࣮ࣞ FEMtools MPEࢆ使用࡚ࡋᢳ出ࡿࢀࡉMACࡼ࠾び POCࢆ使用ࠋࡍࡲࡋ 

ࡀMPE࡜TDSࠊࡣ例ࡢࡇ OMAࡼࡢ࡝࡟う࡟組ࡳ合わ࠿ࡿࡁ࡛ࡀ࡜ࡇࡿࡏ実証ࣙࢩ࣮࣑ࣞࣗࢩࠊࡋン࡚ࡗࡼ࡟立
案ࡓࢀࡉ範ᅖ࡛ࢺࢫࢸࣜࣉ解析ࠋࡍࡲࡋ 

FEMtoolsࢺࢫࢸࣜࣉ解析と相関分析 

自動ࢭン࣮ࢧ選択ࡢ改善 

自動ࢭン࣮ࢧ選択ࡾࡼࡣࢻ࣮ࢥ速࣓ࣜࣔࡘ࠿ࡃ足跡ࢆ縮ᑠ࡟ࡵࡓࡿࡍ書ࡁ直ྠࠋࡍࡲࢀࡉ時ࠊ࡟異ࢭࡢࣉ࢖ࢱࡿ࡞

ン࣮ࢧ㸦uni-axialࠊtri-axial㸧ࡢ組ࡳ合わࠊࡏ異࢚ࣜ࢜ࡿ࡞ンࣙࢩ࣮ࢸン㸦ࣝࣂ࣮ࣟࢢ軸࣮ࣝ࢝ࣟࠊ軸ࠊṇ規ᖹ面㸧
 ࠋࡍࡲࢀࡉ使用ࡀ
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改善さࢀた基準計算㸦NMD、NKE、MPA/MPM㸧 

 ࡾࡼࢆࢻ࣮ࢥ速ࡃ作࣮࢚ࣛࡘ࠿ࠊࡾや警告ࡼࡿࡍࢺ࣮࣏ࣞࢆう࡟再加ᕤࠋࡍࡲࢀࡉ 
 抑制ࣝࢹࣔࡓࢀࡉ㸦ࡢࢻ࣮ࣀ境界条件㸧ࡢࡑࠋࡍࡲࢀࡉࢺ࣮࣏ࢧࡀ DOFࡣMPA計算ࡀ許ྍ࡞ࢀࡉい0ࠊ࡛ࡢ

変఩ࡢ入力 DOFࢆࢪ࣮ࢭࢵ࣓࣮࢚ࣛࡣ回避࡟ࡵࡓࡿࡍ自動的ࡀ࣮ࢱࣝ࢕ࣇ࡞設定ࡢࡑࠋࡍࡲࢀࡉ結果ࠊ加振
఩置ࡢ選択ࡣ抑制ࡓࢀࡉ構造ྍ࡚ࡗ࡜࡟能࡛ࠋࡍ 

 ṇ規方向ࢆ計算࡞ࡁ࡛ࡀ࡜ࡇࡿࡍい場合࡛ࡉえࠊṇ規表面ࡣ許容࣮ࢱࣝ࢕ࣇࡣࡽࢀࡇࠋࡍࡲࢀࡉ化ࡲࢀࡉ

 ࠋࡍ
 3ࡢࡘ変換 DOF/ࡀࢻ࣮ࣀ使用࡚ࢀࡉい࡞いࡀ࡜ࡇ検知ࡀࢀࡑࠊࢀࡉいྍࡢ࠿ࡘࡃ能性㸦要素質量計算ࠊṇ規

ᗙ標系ࡢ定義㸧࡛あࢆ࡜ࡇࡿ報告ࠋࡍࡲࡋ 
 ࣓࣮ࣝࢺ系ࠕ重ࡳ付ࠊࡣࠖࡅNMD࡜ NKEࡢ加振選択方法࡟ࡵࡓࡢ加えࠋࡍࡲࢀࡽ重ࡣࡳ加えࠊ࡜ࡿࢀࡽ

SPANMD࡜ SPANKE࣐ࢥࡢン࡛ࢻ使用࡜ࢺ࢛ࣝࣇࢹࡿࢀࡉ一致ࠋࡍࡲࡋ 

他ࡢ変更ࢺࢫࢸࣜࣉࡢ解析 

 補足 EXCITERࡣ EXAMINE SPANKEࢆ追加ࠋࡍࡲࡋ 
 TDS࡜ OMAࡼࡢ࡝ࡀうࢺࢫࢸࣜࣉ࡟解析࡛使用ࢆ࠿ࡿࢀࡉ仮想 OMA࡛見ࠋࡍࡲࡁ࡛ࡀ࡜ࡇ 

FEMtools感ᗘ解析と DEO 

ANSYSࡢࢱ࣮࣓ࣛࣃ使用例 

ANSYSࡀࢺ࣮࣏ࢧࡢࢱ࣮࣓ࣛࣃ感ᗘ解析࡟加えࠊࡣࢀࡇࠋࡍࡲࢀࡽSET ANSYS ON࣐ࢥンࣈ࢕ࢸࢡ࢔࡛ࢻ化ࡉ
ࢆConfiguring the ANSYS Solver and Sensitivity AnalysisConfiguringࠋࡍࡲࡾ࡞࡟必要ࡀࣂ࢖ࣛࢻࡓࡋⓎ展࡟高ᗘࠊࢀ
参照ࡉࡔࡃ࡚ࡋいࠋ 

ANSYS Parameters ࡢ例題ࡀ..\examples\sensitivity ࡢ ansys_parameters࡟紹௓࡚ࢀࡉいࢆࡽࢀࡑࠋࡍࡲ確認ࡉࡔࡃ࡚ࡋ
いࠋ 

 使用ࡢࢫン࣏ࢫ࣭ࣞࢫࣞࢺࢫ

ࡉࡔࡃ࡚ࡋ参照ࢆࣝࢹࣔࡢࢫ࣮࣭࣋ࢫࣞࢺࢫࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ使用࡟ࡵࡓࡢ感ᗘ解析ࡣࢫン࣏ࢫ࣭ࣞࢫࣞࢺࢫ

いࠋ 

指数 DOEࢧンࣜࣉンࢢ 

実㦂計画法㸦DOE㸧ࡢ指数関数的࡞ DOEࢧンࣜࣉンࡣࢢ線形指数関数的࣮ࣜࢣࢫンࢆࢢ使用ࠊ࡚ࡋ行う࡛ࡀ࡜ࡇ
ンࣜࣉンࢧ指数関数的ࠊ強ᗘࢢンࣜࣉࢫࡤ例えࠊ࡚ࡋ࡜ࢱ࣮࣓ࣛࣃࡿࡁ࡛ࡀ࡜ࡇࡿ変わ࡟ୖࡢ桁ࡢ多数ࠋࡍࡲࡁ

いࡼࡾࡼࡣࢢ DOE結果࡟結びࠋࡍࡲࡁࡘ 

Scaleࢧンࣜࣉンࢥ࣭ࢢンࠊࡣ࣮ࣝࣟࢺDesign of Experiments – Sampling㸦実㦂計画法ࢧンࣜࣉンࢢ㸧࣎ࢢࣟ࢔࢖ࢲ
㸦ᅗࢫࢡࢵ 11㸧࡟追加ࠋࡍࡲࢀࡉ 
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ᅗ 11 実㦂計画法ࢧンࣜࣉンࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ࣭ࢢ 

新ࡋい補足[SCALE {LINEAR | EXPONENTIAL}]ࡌྠࡣ目的࡟ࡵࡓࡢ SET DOE࡟付ࡅ加えࠋࡍࡲࢀࡽ 

ࡣ関係ࡢࡇࠋࡍࡲࢀࡽ加えࡀࢺ࣮࣏ࢧࡢ関係ࢱ࣮࣓ࣛࣃࡢDOEࠊ࡟ࡽࡉ ࢻン࣐ࢥ㸦ࢱ࣮࣓ࣛࣃࡢࡘ2 DEFINE 
RELATION㸧間࡛線形࡛あ࡟ࡿ遊いあࠋࢇࡏࡲࡾ定数ࡣ  ࠋࡍࡲࡾ࡞異ࡣ࡜0

FEMtoolsࣔ࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹンࢢ 

 ࢢン࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࡢࢫ࣮࣭࣋ࢫࣞࢺࢫ

ࡲࢀࡉࢺ࣮࣏ࢧ࡛࣮ࣂࣝࢯNastranࠊAbaqusࠊAnsysࠊFEMtoolsࠊࡣࢢン࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࡢࢫ࣮࣭࣋ࢫࣞࢺࢫ
ࣞࢺࢫࠋࡍࡲ似࡚い࡟ࣉ࢖ࢱ࣭ࢢン࢕ࢸ࣮ࢹࣉࢵ࢔ࡢ࡚࡭ࡍࡢ௚ࠊ場合ࡿࢀࡉ選択ࡀࢫン࣏ࢫ࣭ࣞࢫࣞࢺࢫࠋࡍ

ࢫ面ෆࡿࡍ起因࡟変形ࢻ࣮࣭ࣟࢡࢵ࢕ࢸࢱࢫࠊࢀࡉ測定࡚ࡋ関࡟表面ࡿࡍ相当࡟᭷限要素表面ࡣࢫン࣏ࢫ࣭ࣞࢫ

ࡣいࡿ固体要素面あࡢ実際ࡣࢀࡇࠋࡍtxy㸧࡛ࠊsyࠊ値㸦sxࢫࣞࢺ 2D要素面あࡿいࡢ࣮ࣂ࢖࢓ࣇࡣ頂部ࢆ覆う࡜ࡇ
 ࠋࡍࡲࡁ࡛ࡀ

ࡾ遊いあ࡟ࡿ要素物理的性質࡛あࠊ࡟うࡼࡢ敏感㸧࡟ࢫࣞࢺࢫ㸦要素ࡉ厚ࢺ࣮ࣞࣉࡣいࡿ要素特性あࡣࢱ࣮࣓ࣛࣃ

 ࠋࢇࡏࡲ

ࡃࡽ恐ࠊࡋ使用ࢆࢫン࣏ࢫ࣭ࣞࢫࣞࢺࢫࠊࡀࢇࡏࡲࡾあࡣン㸧࡛࢖ࣞࢺࢫࡣいࡿ一般的測定値㸦あࡣࢫࣞࢺࢫ

FEM-FEM相関ศ析࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࠊンࠋࡓࡋࡲࢀ࠿࠾࡚ࡗྲྀ࡟ࡵࡓࡢࢢ 

次ࡢ例ࢺ࣮ࣞࣉࡣ厚ࡢࢫ࣮࣭࣋ࢫࣞࢺࢫࡢࡉ更新例ࢆ示࣮ࣜࢡࢫࠋࡍࡲࡋンࡣࢺࢵࣙࢩ཰束࣮࢝ࣈ㸦ࠊࣉࢵࢺ

ᕥ㸧ࠊ静的変఩㸦ࠊࣉࢵࢺ右㸧ࠊ静的要素࢖ࣞࢺࢫン㸦底ࠊᕥ㸧ࢱ࣮࣓ࣛࣃࠊ変更㸦底ࠊ右㸧ࢆ示ࠋࡍࡲࡋ 
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FEMtools 12 ࢺ࣮ࣞࣉ厚ࢺ࣮ࢹࣉࢵ࢔࣭ࢫ࣮࣭࣋ࢫࣞࢺࢫࡢࡉ例 

びࡼ࠾ࢫン࣏ࢫ࣭ࣞࢫࣞࢺࢫࡀࢢン࢕ࢸ࣮ࢹࣉࢵ࢔ࠊࢀࡽ加え࡟examples\updating\static_strain_2\..ࠊࡣ例ࡢࡇ
ANSYSࠊNASTRANࠊAbaqusࠊFEMtools࡛࣮ࣂࣝࢯ使用࡚ࢀࡉいࠋࡍࡲ 

ANSYSࡢࢱ࣮࣓ࣛࣃ使用 

ANSYSࡣࢱ࣮࣓ࣛࣃ感ᗘ解析࡛ࢺ࣮࣏ࢧࡢあ࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࡣࡽࢀࡑࠊࡾン࡟ࢢ使用ࡲࡁ࡛ࡀ࡜ࡇࡿࡍ
 ࠊࡓࡲࠋࡍࡲࢀࡉ化ࣈ࢕ࢸࢡ࢔࡛ࢻン࣐ࢥSET ANSYS ONࠊࡋ࡜必要ࢆࣂ࢖ࣛࢻࡓࡋⓎ展࡟高ᗘࡣࢀࡇࠋࡍ
Configuring the ANSYS Solver and Sensitivity Analysisࢆ参照ࡉࡔࡃ࡚ࡋいࠋ 

ࡢࢢン࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔ ANSYSࡢࢱ࣮࣓ࣛࣃ実証例ࠊࡣ..\examples\updatingࡼ࠾び感ᗘ解析࣮ࢲ࢛ࣝࣇ
ansys_parametersࢆ参照ࡉࡔࡃ࡚ࡋいࠋ概観࡟関ࠊࡣ࡚ࡋ例ࢆ参照ࡉࡔࡃ࡚ࡋいࠋ 

ࡢࢢン࢕ࢸ࣮ࢹࣉࢵ࢔࣭ࢫン࣏ࢫࣞ POC使用例 

POC࣏ࢫࣞࡀン࢕ࢸ࣮ࢹࣉࢵ࢔ࡢࢫン࡚ࡋ࡜ࢢ使用ࡿࢀࡉ場合ࡣࡶࡣࢀࡑࠊや࣮ࣔࢆࣉ࣮࢙ࢩࢻ行うࠊࡃ࡞࡜ࡇ
POCࢆ使用ࠊࡣࢀࡇࠋࡍࡲࡋPOC࣏ࢫࣞࡀン࡚ࡋ࡜ࢫ選択࡚ࢀࡉいࠊ࠿ࡿ既࡟相関ศ析ࡢ一部࡚ࡋ࡜計算ࡓࢀࡉ
場合ࡢ࡚࡭ࡍࠊ࡟཯復ࢆ備えࡓ POC値࢕ࢸ࣮ࢹࣉࢵ࢔ࢆンࡿࡍࢢෆ部ࣔ࢕ࢸ࣮ࢹࣉࢵ࢔ࡢࣝࢹンࢳ࣮ࣝࡿࡍࢢン
࡚ࡋ対࡟ࡏ合わࡳ組ࣉ࣮࢙ࢩࢻ࣮ࣔࡀࢀࡑࠊࡣン࡛ࣙࢪ࣮ࣂᪧࡢFEMtoolsࠋࡍࡲࡾ࡞࡟能ྍࡾࡼ࡟࡜ࡇࡿ強い࡟
使用ࡓࢀࡉ場合ࠊPOCࡀ更新ࠋࡓࡋࡲࢀࡉ 

MACࢆ使用ࣜ࢔࣌ࢻ࣮ࣔࠊࡋンྍࡀࢢ能࡛ࠊࡀࡍPOC㸦࣐ࢥンࢻ EXAMINE POC㸧ࢆ計算࢕ࢸ࣮ࢹࣉࢵ࢔ࠊࡋン
両ࡢMAC࡜POCࠊ࡚ࡋ࡜ࢫン࣏ࢫ࣭ࣞࢢン࢕ࢸ࣮ࢹࣉࢵ࢔ࠊ࡟ࡽࡉࠋࡍࡲࡁ࡛ࡶ࡜ࡇࡿࡍ計算ࢆࢫン࣏ࢫ࣭ࣞࢢ
方ࢆ組ࡳ合わྍࡀ࡜ࡇࡿࡏ能࡛ࠋࡍ 

 ࢺࢵࢭࡢ変更限界ࢱ࣮࣓ࣛࣃ

Advanced Model Updatingࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ㸦ᅗ 13㸧ࡣ変数 tune.pmethodࡿࡍࢺࢵࢭࢆ Parameter Change Limit 
Methodࢆ含࡛ࢇいࠋࡍࡲ 
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以前࢕ࢸࢵࢭࡢࡇࠊンࡣࢢ SET TUNE PMETHOD࣐ࢥンྍ࡚ࡗࡼ࡟ࢻ能࡛ࡢࡑࠋࡓࡋᢏ術ࡣ࡚ࡘ࠿ࡀ PMAXࢆ超
過ࢱ࣮࣓ࣛࣃࡿࡍ変更ࢆ修ṇࢆ࡜ࡇࡓࡋ明示ࠋࡍࡲࡋSCALEࡣࢺࢵࢭࡢ最大ࢱ࣮࣓ࣛࣃࡢ変更ࡀ等ࡋいࡌྠ࡜ࡢ
方法࡛ࢱ࣮࣓ࣛࣃ値࡚࡭ࡍࢆ設立ࡋ直ࠋࡍࡲࡋCUTࠊࡣPMAX限界ࡢ࡬ PMAXࢆ超過ࢱ࣮࣓ࣛࣃࡿࡍ変更࡭ࡍࢆ
 ࠋࢇࡏࡲࡋ修ṇࢆ変更ࢱ࣮࣓ࣛࣃࡿࡍ超過ࢆPMAXࠊࡣOFFࠋࡍࡲࡋࢺࢵࢭ࡚ࣜ

 

ᅗ ࡢࢢン࢕ࢸࢵࢭ変更限界方法ࢱ࣮࣓ࣛࣃ 13 Advanced Model Updating Settings 

tune.pmethod࢕ࢸࢵࢭンࢢ㸦࣮࣮ࣘࢨINI࡟ࣝ࢖࢓ࣇ[変数]࣮ࢨ࣮ࣘ࡟定義ࢀࡉ格納ࡓࢀࡉ㸧ࠊAnalysis > Model 
Updating > Parameter Change Limit Method.ୗࡢ Setting࡟ࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ加えࠋࡍࡲࢀࡽ 

ABAQUS࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

 ABAQUS 2021ࢺ࣮࣏ࢧࡢ 
 ABAQUS 2021+࡟ SIMࣙࢪ࣮ࣂン  ࠋࡍࡲࢀࡉ修ṇࡀࢲ࣮࣭ࣜࣝ࢖࢓ࣇSIMࠊ࡟うࡼࡿࡏࡉ関連ࢆ531

ANSYS࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

 ANSYS 2021R1ࢺ࣮࣏ࢧࡢ 
 新ࡋい ANSYS࢖ン࡜ࢫ࣮࣋ࢱ࣮ࢹ࣭ࢫ࢖࢙ࣇ࣮ࢱ ANSYSࢱ࣮࣓ࣛࣃ 
 RST࣮ࣜࡣࢲ ANSYS 2021R1࡛使用ࢱ࣮ࢹࡿࢀࡉ構造ࡢ変化࡟ࡵࡓࡿࡍࢺ࣮࣏ࢧࢆ修ṇࠋࡍࡲࢀࡉ個々ࡢ要

素࢖ンࡢ25ࠊࡣࣝࣈ࣮ࢸ࣭ࢫࢡࢵࢹ代わ࡟ࡾ ࠊ場合ࡴㄞࢆン࢖ࣞࢺࢫ࡜ࢫࣞࢺࢫࠊࡋ使用ࢆࢻ࣮ࣝ࢕ࣇࡢ26
"WARNING:୙適当ࡀ"(26>25) ࢬ࢖ࢧ࣭࣮࢓ࣇࢵࣂ࡞生ࠋࡍࡲࡌ 

 ANSYSࡀࢱ࣮࣓ࣛࣃ使用ࡓࢀࡉ場合ࠊCDBࡣ新ࡋい ANSYS࢖ンࢆࢫ࣮࣋ࢱ࣮ࢹ࣭ࢫ࢖࢙ࣇ࣮ࢱ使用ࡲࡋ
 ࠋࡍ
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 新ࡋい幾何学ࢺࢵ࣐࣮࢛ࣇ ANSYS 2021ࡀ追加࢖ࢆࢫࣞࢺࢫࠋࡍࡲࢀࡉࢺ࣮࣏ࢧン࣏࣮ࡿࡍࢺ場合ࠊ幾何学
࡜ࢺンࢿン࣏࣮ࢥ࣭ࣝࢯンࢸࡢ࡬ࢻ࣮ࣀ要素࡟ṇ確ࡓࡲࠊ場合ࡓࢀࡲㄞࡀKEYOPT㸧+：ࣉ࢖ࢱ㸦要素ࢱ࣮ࢹ
ࢀࡉ解析ࡀ情報ࣉ࢖ࢱ要素ࠊࢀࡉ検知ࡣࢢࣛࣇいࡋ新ࠋࡍࡲࡏࡉ関連ࢆン角ᗘࣙࢩ࣮ࢸン࢚࣭࣮ࣜ࢜ࣛ࢖࢜

 ࠋࡍࡲ
 CDB࡚ࡗࡼ࡟使用ࠊࡣࣉ࢖ࢱ࣭࢙ࣝࢩ࣭ࢺ࢛ࣝࣇࢹࡿࢀࡉSHELL63ࡽ࠿ SHELL181࡟修ṇࠋࡍࡲࢀࡉ 
 ࢖ࣞࢺࢫン࣭࢕ࢸ࣮ࢹࣉࢵ࢔ンࢢ例ࡢ..\updating\static_strain_2ࡣ SHELL63ࡢ代わ࡟ࡾ SHELL181࡛得ࡓࢀࡽ

参照値ࢆ使用࡟ࡵࡓࡿࡍ修ṇࠋࡍࡲࢀࡉ 
 FCOMP㸦ᅽ縮㸧࡛生産ࡓࢀࡉ RSTࢆࢺ࣮࣏ࢧࡢࣝ࢖࢓ࣇ改善ࠋࡓࡋࡲࡋANSYSࠊࡣ࡛ࣂ࢖ࣛࢻFCOMPࡀ

OFFࡀࢀࡇࠊࢀࡉࢺࢵࢭ࡟生成ࡓࢀࡉ CDB࡟ࣝ࢖࢓ࣇ対処࡟࡜ࡇࡿࡍ注意ࡉࡔࡃ࡚ࡋいࠋ 
 MODOPT௙様ࢆ新ࡃࡋ防࣐ࢥࡄンࡢࢻ固定蓄積ࢆ考慮ࠋࡍࡲࡋ 
 最新ࡢ ANSYS要素ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆࣉ࢖ࢱ古い ANSYS要素ࡣ最新ࡢ ANSYSࣙࢪ࣮ࣂンࡔࡲ࡚ࡗࡼ࡟認

識ࢀࡇࠊࡀࡍࡲࢀࡉ以ୖ࣓ࣗ࢟ࢻンࢺ化ࠋࢇࡏࡲࢀࡉ 
 ANSYS࡟ FEMtools FEࣔࡿࡍࢺ࣮࣏ࢫࢡ࢚ࢆࣝࢹ場合ࠊ新ࡋいࢺ࢛ࣝࣇࢹ要素ࡀࣉ࢖ࢱ使用ࡋࡶࠋࡍࡲࢀࡉ

ࡀࣝࢹࣔ ANSYS࡟最初࡟定義ࠊࡤࢀࢀࡉ最初ࡢ要素ࡀࣉ࢖ࢱ保Ꮡࠋࡍࡲࢀࡉ 

Old New 
BEAM4 BEAM188ࠋࡍ࡛࢙ࣝࢩࡣ 
SOLID45 SOLID185 (for TETR4/HEXA8/PENT6 elements) + KEYOPT(2) = 3 =ࢩン࢚࣭ࣝࣉンࣁン

 ン࢖ࣞࢺࢫ࣭ࢫ
SOLID92 SOLID187 (for TET10 elements) 
SOLID95 SOLID186 (for HEX20 and PEN15 elements) + KEYOPT(2) = 1 = Full integration (this is 

identical to the original SOLID95) 
SHELL63 SHELL181 (for 3 or 4 Node SHELL elements) + KEYOPT(3) = 2 = Full integration with 

incompatible modes 
SHELL93 SHELL281 (for 6 or 8 Node SHELL elements) 

ࢺ࢛ࣝࣇࢹ KEYOPTࡣ考慮ࠊࢀࡉ一般的࡟使用ࠋࡍࡲࢀࡉ 

௚ࡢ典型的࡞ KEYOPT選択ࡣ要素࡜幾何学ࢆࣉ࢖ࢱࣈࢧࡢ割ࡾ当࡚࢖ࡾࡼ࡟࡜ࡇࡿン࣏࣮ࢺ中࡟一㈏࢚ࡓࡋ
 ࠋࡍࡲい࡚ࢀ࠿࠾࡚ࡗྲྀ࡟ࡵࡓࡢࢺ࣮࣏ࢫࢡ

ANSYS࢖ンࢫ࣮࣋ࢱ࣮ࢹ࣭ࢫ࢖࢙ࣇ࣮ࢱとࢱ࣮࣓ࣛࣃ 

ࣔࢺン࣏࣮࢖ࡿࢀࡉᥦ出࡟ࡵࡓࡢ再解析ࡓ備えࢆ࣮ࣂࣝࢯANSYSࠊ࡜定義ࣝࢹࣔࡓࢀࡉࢺン࣏࣮࢖ࡢࣝࢼࢪࣜ࢜
 ࠋࡓࡋࡲࢀࡉ再加ᕤࡣࢫｲ࢙ࣇ࣮ࢱン࢖ANSYSࠊ࡟ࡵࡓࡿࡍ維持ࢆ厳Ᏺ࡞完全ࡢ間ࣝࢹ

ෆ部ࡣ࡟目的ࡢࡇ FEMtoolsࡶ࡟ࢫ࣮࣋ࢱ࣮ࢹ外部ࣝ࢖࢓ࣇ࣭ࢫ࣮࣋ࢱ࣮ࢹ㸦SQLITE3ࢺࢵ࣐࣮࢛ࣇ㸧ࡶ࡟
ANSYSࣔࢱ࣮ࢹ࣭ࣝࢹ全体ࢆ格納ࡾࡼ࡟࡜ࡇࡿࡍ到遉ࡣࢀࡇࠋࡓࡋࡲࡋ両方ࢆࢱ࣮ࢹࠊࢫ࣮࣋ࢱ࣮ࢹࡢ自動的࡟
通信ࡋ交換ࡀ࡜ࡇࡿࡍ求࡜ࢫࢡࢵ࢕ࣇࣛࢢࡣࢀࡑࠋࡍ࡛ࡽ࠿ࡿࢀࡽࡵᖹ板状࡟࢖ࣞࣉࢫ࢕ࢹࡢ容易࡟利用ྍ能࡛

あࠊࡾ結節点ࡢᗙ標ࠊ要素ࡢ定義ࡼࡢうࠊ࡟主࡚ࡋ࡜ෆ部 FEMtools࡛ࢫ࣮࣋ࢱ࣮ࢹ維持ࠋࡍࡲࢀࡉ 

FEࣔࡀࣝࢹ FEMtoolsෆ部࢖࡛ࢫ࣮࣋ࢱ࣮ࢹン࣏࣮ࠊࡎࢀࡉࢺ࣮࣏ࢫࢡ࢚／ࢺ専用外部࡟ࣝ࢖࢓ࣇ࣭ࢫ࣮࣋ࢱ࣮ࢹ
残ࡿ場合ࠊANSYSࢆ࣮ࣂࣝࢯ備えࡓ再解析ࡣ FEMtools外部࡛走100%ྠࠊ࡜࡜ࡇࡿ一࡛ࡲࡲࡢあࠋࡍ࡛ࡁ࡭ࡿ 

ࡓࢀࡉࢺ࣮࣏ࢫࢡ࢚／ࢺン࣏࣮࢖ ANSYS CDBࣝ࢖࢓ࣇ間ࡢ維持࡟加え࡚ࡢࡇࠊ新ࡋい࢖ン࣓࣭࢝ࢫ࢖࢙ࣇ࣮ࢱ
 ࠋࡍࡲい࡚ࡗ持ࢆ利点ࡢ追加ࡢࡃ多ࡣ࣒ࢬࢽ

 ANSYS࡛ࣔࣝࢹ使用ࡿࢀࡉ動解析ࡢ実数定数ࠊ材料ࣙࢩࢡࢭࠊン特性ࠊࡣ感ᗘ解析ࡼ࠾び࣮ࣔࢹࣉࢵ࢔ࣝࢹ
ࡣࢱ࣮࣓ࣛࣃࡢࡽࢀࡇࠋࡍࡲࡁ࡛ࡀ࡜ࡇ選ぶ࡚ࡋ࡜ࢱ࣮࣓ࣛࣃࡢࢢン࢕ࢸ ANSYS࡜ࢱ࣮࣓ࣛࣃ࿧ࠋࡍࡲࢀࡤ
FEMtools࡚ࡗࡼ࡟認識ࡿࢀࡉෆ部材料特性ࠊ幾何学的特性࡟ࣝࣈ࣮ࢸࡢ格納ࡿࢀࡉ特性࡟制限ࡣあࡏࡲࡾ
 ࠋࢇ

 ࡢࡽࢀࡇ要素ࡀ FEMtoolsෆ部࢖࡛ࢫ࣮࣋ࢱ࣮ࢹン࣏࣮ࠊࡶ࡚ࡃ࡞ࢀࡉࢺ以前࡟支持࡞ࢀࡉい要素ࡍࡣࣉ࢖ࢱ
い࡛ࢇ含ࢆ௚ࡢࡑࠊ࣒࣮ࣅ合成ࠊ合成固体ࠊ接触要素ࡣࡽࢀࡇࠋࡍࡲࢀࡉࢺ࣮࣏ࢧ࡟ࡵࡓࡢ感ᗘ解析ࠊ࡚࡭

 ࠋࡍࡲ
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 ࡢ࡚࡭ࡍ要素ࡼ࠾び中間節点࡚࡭ࡍࢆ含ࡴ剛性࡜質量࡟ࢫࢡࢵࣜࢺ࣐ࡢ関ࡿࡍ固᭷࣋ࣝࢺࢡ直角㸦EVO㸧ࡢ
計算ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆ 

 解析間࡟ ANSYS࡚ࡗࡼ࡟生成ࠊࢀࡉRST࡟ࣝ࢖࢓ࣇ格納ࡓࢀࡉ要素中間節点ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆ 
 FEMtools࡛࢖ン࣏࣮ࡓࢀࡉࢺ要素࡟ ANSYS要素ࢆ写像ࡢࢡࢵ࢕ࣇࣛࢢࡢࢱ࣮࣓ࣛࣃࡾࡼ࡟࡜ࡇࡿࡍ表現ࢆ

許ྍࠋࡍࡲࡋ 

ANSYSࡣࢱ࣮࣓ࣛࣃ新ࡋい付加的࡛ࢱ࣮࣓ࣛࣃ࡞あࠊࡾANSYSࣔࡢࣝࢹMAP特性࡛ࡋ࡜ࢱ࣮࣓ࣛࣃࡣࢀࡑࠋࡍ
࡚選択ࡢࣝࢼࢪࣜ࢜ࡿࢀࡉ ANSYSࣔࡀࣝࢹ既࡟定義ࢆ࡜ࡇࡿࢀࡉ必要ࠋࡍࡲࡋ࡜ 

ANSYSࠊࡣࢱ࣮࣓ࣛࣃFEMtoolsࠕࡢ古典的ࠖ࡞ෆ部ࠊࡿࡁ࡛ࡀ࡜ࡇࡍࡽࡓࡶ࡛ࢱ࣮࣓ࣛࣃ材料特性ࡼ࠾び実数定
数ࢆ生成࡞࣮ࣝ࢝ࣟࡿࡍ要素特性࡛ࡣあࡢ࡚࡭ࡍࠋࢇࡏࡲࡾ ANSYS材料特性あࡿいࡣ幾何学特性ࡣ感ᗘ解析ࡼ࠾
びࣔ࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹン࡚ࡋ࡜ࢱ࣮࣓ࣛࣃࡢࢢ選ぶࠋࡍࡲࡁ࡛ࡀ࡜ࡇ 

ANSYSࡢࢱ࣮࣓ࣛࣃ感ᗘ解析ࡣ動解析ࢆ使用ࠊࡋ感ᗘ差ࢆ示ࡍෆ部ࠊࡀࡍ࡛ࢱ࣮࣓ࣛࣃ解析速ᗘ࠾࡟い࡚ࡣ高ᗘ
 ࠋࡍࡲࡾ࡞ࡃ遅ࡾࡼࡿࢀࡉ最適化࡟

感ᗘ計算ࡢ革新的ࡢࢫࢡࢵࣜࢺ࣐ࡢࡽࢀࡇࠊࡣࢳ࣮ࣟࣉ࢔࡞派生的࣮ࣔࢆࢱ࣮ࢹࣝࢲ得࡜ࣝࢼࢪࣜ࢜࡟ࡵࡓࡿ

perturbated要素ࡢ剛性࡜質量࣐ࢆࢱ࣮ࢹࣝࢲ࣮ࣔࡢࢫࢡࢵࣜࢺ格納ࡾࡼ࡟࡜ࡇࡿࡍ使用ࠋࡍࡲࢀࡉEMATࢆ派生ࡋ
 ࠋࡍࡲࢀࡉ格納࡟࣓ࣜࣔ࡟効率的ࠊࢀࡉ処理ࡳ込ࡳㄞࡀࢫࢡࢵࣜࢺ質量࣐࡜剛性ࡢ要素ࡢ注目࡛ࣝࢹࣔࡓ

ANSYS࡟࠿ࡿࡣࡾࡼࢱ࣮࣓ࣛࣃ࣭ࢺࢫ࢟ࢸࡣࢱ࣮࣓ࣛࣃ強力࡛ࡢࡑࠊࡀࡍ使用方法ࡾࡼࡣ困㞴࡛ࠋࡍ㸦CDB࢓ࣇ
࡞ࢀࡋࡶ࠿ࢳ࣮ࣟࣉ࢔࡞総括的࡟非常ࡀPARAMETER TEXTࠊࡵࡓࡢࡑ㸧࡚࡭比࡜ࢻ࣮ࣝ࢕ࣇ࣭࣮ࢱ࣮࣓ࣛࣃࣝ࢖
い場合ࡢࢱ࣮࣓ࣛࣃࡣࢀࡑࠊపい数࡟制限࡚ࢀࡉいࠋࡍࡲ 

古典的࡞ෆ部࡜ࢱ࣮࣓ࣛࣃ新ࡋい ANSYSࡣࢱ࣮࣓ࣛࣃ共ྠ࡛Ꮡᅾࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

 FEMtools࣮ࣂࣝࢯあࡿいࡣ厳Ᏺࡢ損失࡞ࡢい ANSYS࡛࣮ࣂࣝࢯ解決ࠊࡿࡁ࡛ࡀ࡜ࡇࡿࡍపい複雑ࢆࡉ備え
標準ࡓ FEࣔࣝࢹ用ࡢෆ部ࢱ࣮࣓ࣛࣃ 

 多ࡀࢱ࣮࣓ࣛࣃࡢࡃ要素࢕ࢸ࣮ࢹࣉࢵ࢔࣭࣮ࣝ࢝ࣟࡢ࡜ࡈンࠊࢱ࣮࣓ࣛࣃ࣭ࢢෆ部ࢱ࣮࣓ࣛࣃ 
 ANSYSࢆ࣮ࣂࣝࢯ備えࡓ再解析ࢆ要求ࡀࣝࢹࣔࡿࡍ使用ࡿࢀࡉ場合ࠊANSYSࢱ࣮࣓ࣛࣃ 
 ࡀࢱ࣮࣓ࣛࣃ必要࡞場合ࡢࡽࢀࡇࠊ新ࡋい特徴ࡀ範ᅖࢆ著ࡃࡋ広ࠊࡿࡆෆ部ࢱ࣮࣓ࣛࣃ㸦例えࢭ࣭࣒࣮ࣅࡤ

 ン次元㸧ࣙࢩࢡ

ࡢࢀࡒࢀࡑ ANSYSࠊࢱ࣮࣓ࣛࣃFEMtools࡜ ANSYS࡚ࡗࡼ࡟扱うࡿࡁ࡛ࡀ࡜ࡇ要素ࢆ結合ࠋࡓࡋࡲࡋ 

ANSYSࢱ࣮࣓ࣛࣃ定義 

新ࡋいࠊࡣࣉ࢖ࢱ࣭ࢱ࣮࣓ࣛࣃANSYS࡜ࢱ࣮࣓ࣛࣃ࿧ࡿࢀࡤ FEMtools 4.2࡟ᑟ入ࠋࡍࡲࢀࡉ 

ANSYSࡣࢱ࣮࣓ࣛࣃ  ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ方法࡛定義ࡢࡘ2

 ࣐ࢥンࢻ PARAMETER ANSYSࡢ使用 
 Parameter Browserࡢࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ使用 

コ࣐ンࢱ࣮࣓ࣛࣃ࣭ࢻ ANSYS 

利用ྍ能ࡢ࡚࡭ࡍࡓࢀࡉ格納࡟ࣝ࢖࢓ࣇ࣭ࢫ࣮࣋ࢱ࣮ࢹࡓࢀࡉ作成࡚ࡗࡼ࡟ࢲANSYS CDB࣮ࣜࠊࡣࢻン࣐ࢥࡢࡇ
ࡽ࠿࢕ࢸࣃࣟࣉ࡞ ANSYS材料特性ࠊ実数定数ࣙࢩࢡࢭࠊン࣭ࢆ࢕ࢸࣃࣟࣉ選ぶ࡟ࡵࡓ使用ࠋࡍࡲࢀࡉ 

 ࢫࢡࢵࢱンࢩ

[DEFINE] PARAMETER ANSYS <TABLE table_name table_id, TYPE type_name>[LAYER layer_id]. 
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補語 

TABLE Specifies the table name and ID. See overview hereafter 
TYPE Specifies the property label belonging to a given table. See overview hereafter. 
LAYER Specifies a layer ID. 

Table Names 

"MP", "TBDATA" Material properties (TBDATA for anisotropic properties) 
"RCONST" Real constant properties (tend to be replaced by section properties in modern 

elements) 
"SECDATA", "SECOFFSET", 
"SECBLOCK_SHELL", 
"SECCONTROL", "CBMX" 

Section properties 

Type Names 

MP Table (Material Properties) 

Type  Description 
DENS  Mass density 
EX  Elastic Modulus (in X direction) 
EY  Elastic Modulus in Y direction 
EZ  Elastic Modulus in Z direction 
GXY  Shear Modulus in XY plane 
GXZ Shear Modulus in XZ plane 
GYZ Shear Modulus in YZ plane 
NUXY  Minor Poisson's ratio (in XY plane) 
NUXZ  Minor Poisson's ratio in XZ plane 
NUYZ  Minor Poisson's ratio in YZ plane 
PRXY  Major Poisson's ratio (in XY plane) 
PRXZ Major Poisson's ratio in XZ plane 
PRYZ  Major Poisson's ratio in YZ plane 
MATRIX  Orthotropic Elasticity Matrix (uniformly scales EX, EY, EZ, GXY, GXZ, GYZ as 

single parameter) 

TBDATA Table (Anisotropic Material Properties) (corresponding to TB, ANEL) 

Type Description Description 
Dij Anisotropic Elasticity Coefficients 
Where Dij can be  
D11, D21, D31, D41, D51, D61,  
D22, D32, D42, D52, D62,  
D33, D43, D53, D63,  
D44, D54, D64,  
D55, D65,  
D66  

RCONST Table (Real Constant Physical Properties) 

Element Type Labels 
LINK1 AREA, ISTRN 
BEAM3 AREA, IZZ, SHEARZ, ISTRN, ADDMAS 
BEAM4 AREA, IZZ, IYY, ISTRN, IXX, SHEARZ, SHEARY, ADDMAS 
LINK8 AREA, ISTRN 
COMBIN14 K 
PIPE16 OD, TKWALL, SIFI, SIFJ, FLEX, DENSFL, DENSIN, TKIN, TKCORR, 

AREADIN, MWALL, STIFF 
PIPE18 OD, TKWALL, RADCUR, SIFI, SIFK, FLXI, DENSFL, DENSIN, TKIN, 
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TKCORR, FLXO 
MASS21 MASS, IZZ, MASSX, MASSY, MASSZ, IXX, IYY, IZZ 
MASS27 C1 to C144: Mass, Stiffness matrix elements 
SHELL41 TK, TK_J, TK_K, TK_L, THETA, EFS, ADMSUA 
SHELL43 TK, TK_J, TK_K, TK_L, THETA, ZSTIF1, ZSTIF1, ADMSUA 
BEAM44 AREA1, IZ1, IY1, IX1, AREA2, IZ2, IY2, IX2, DX1, DY1, DZ1, DX2, DY2, 

DZ2, SHEARZ, SHEARY 
SOLID45 HGSTF 
PIPE59 DO, TKWALL, CD, CM, DENSO, FSO, CENMPL, CI, CB, CT, ISTR, DENSIN, 

TKIN 
PIPE60 OD, TKWALL, RADCUR, SIFI, SIFJ, FLXI, FLXO 
SHELL63 TK, TK_J, TK_K, TK_L, EFS, THETA, RMI, ADMSUA 
SHELL93 TK, TK_K, TK_K, TK_L, THETA, ADMSUA 
SURF154 EFS, SURT, ADMSUA, TK, TKJ, TKK, TKL 
SURF154 R1, R2 
CONTA174/175 R1, R2, FKN, PINB 
SOLID185 HGSTF 

SECDATA Table (Section Data Physical Properties) 

Element Type  Labels 
BEAM, RECT B, H 
BEAM, QUAD yI, zI, yJ, zJ, yK, zK, yL, zL 
BEAM, CSOL R 
BEAM, CTUB Ri, Ro 
BEAM, CHAN W1, W2, W3, t1, t2, t3 
BEAM, I W1, W2, W3, t1, t2, t3 
BEAM, Z W1, W2, W3, t1, t2, t3 
BEAM, L W1, W2, t1, t2 
BEAM, T W1, W2, t1, t2 
BEAM, HATS W1, W2, W3, W4, t1, t2, t3, t4, t5 
BEAM, HREC W1, W2, t1, t2, t3, t4 
BEAM, ASEC A, Iyy, Iyz, Izz, Iw, J, CGy, CGz, SHy, SHz, TSxz, TSxy 
CONTACT, CIRC X0, Y0 
CONTACT, SPHE X0, Y0, Z0 
CONTACT, CYLI  X1, Y1, Z1, X2, Y2, Z2 
CONTACT, NORM NX, N VAL1 
CONTACT, RADI VAL1, VAL2 
CONTACT, BOLT Dm, P, ALPHA, X1, Y1, Z1, X2, Y2, Z2 
AXIS X1, Y1, Z1, X2, Y2, Z2 
JOIN length1, length2, length3, angle1, angle2, angle3 
LINK AREA 
PIPE Do, Tw 
REINF, DISC A 
REINF, SMEA A, S, THETA 
SHELL TK, THETA (in CDB files, SECBLOCK_SHELL is used instead) 
SUPPORT, BLOC T, L 
SUPPORT, ASEC VAL1, VAL2, VAL3, VAL4, VAL5, VAL6, VAL7, VAL8 

SECOFFSET Table (Section Offsets) 

Element Type Labels 
BEAM OFFSETY, OFFSETZ, CG-Y, CG-Z, SH-Y, SH-Z 

PIPE OFFSETY, OFFSETZ 

SHELL OFFSET 

GENS OFFSET 

SECCONTROL Table (Section Control) 
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Element Type Labels 
BEAM TXZ, TXY, ADDMAS 

LINK ADDMAS 

PIPE ADDMAS 

SHELL E11, E22, E12, ADDMAS, HMEMSCF, HBENSCF, DRLSTIF, BENSTIF 

SECBLOCK_SHELL Table (Shell Specific Section Data written as SECBLOCK to CDB Files) 

Type Description 
Sij Cross Section Stiffness matrix coefficients 

Where Sij can be S11, S12...S17, S22...S27, S33...S37, S44...S47, S55...S57, 
S66...S67, S77 

MATRIX Cross Section Stiffness (scales all Sij) 

CBMX Table (Composite Beams Cross Section Stiffness) 

Type Description 
ADDMAS Added mass per unit length 
ADMSUA Added mass per unit area 
AREA Cross sectional area 
B Width 
BENSTIF Bending-stiffness scale factor 
DRLSTIF Drill-stiffness factor 
FKN Normal penalty stiffness factor 
H Height 
HBENSCF Hourglass-control bending-scale factor 
HMEMSCF Hourglass-control membrane scale factor 
IW Warping constant 
IXX Torsional moment of inertia 
IYY Moment of inertia about Y axis 
IYZ Product of inertia 
IZZ Moment of inertia about Z axis 
J Torsional constant 
K Spring constant 
MASS Concentrated mass 
MASSX Concentrated mass in X direction 
MASSY Concentrated mass in Y direction 
MASSZ Concentrated mass in Z direction 
OD Outer diameter 
PINB Pinball region 
R Radius 
RADCUR Radius of curvature 
RI Inner radius 
RO Outer radius 
SHEARY Shear deflection constant 
SHEARZ Shear deflection constant 
T1 Beam thickness 1 
T2 Beam thickness 2 
T3 Beam thickness 3 
T4 Beam thickness 4 
T5 Beam thickness 5 
THETA Rotation angle 
TK Shell thickness 
TKWALL Wall thickness 
W1 Beam dimension 1 
W2 Beam dimension 2 
W3 Beam dimension 3 
W4 Beam dimension4 
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備考 

࡜ࣉ࢖ࢱ解析ࡀ衝撃ࡢࡽࢀࡑࡢࢫン࣏ࢫࣞࠊࡎࡽ限ࡣ࡜ࡿࡍ使用࡚ࡋ࡜ࢱ࣮࣓ࣛࣃࡢ感ᗘ解析ࡣ特性ࡢ࡚࡭ࡍ

KEYOPT࢜ࣙࢩࣉンࡢ無効࡟依Ꮡ࡞ࢀࡋࡶ࠿࡜ࡇࡿࡍい࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔࠊ࡛ࡢンࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍࢢ 

PINBࡼࡢう࡞௚࡜ࢬ࢖ࢧ࣭ࣗࢩࢵ࣓ࡣࢱ࣮࣓ࣛࣃࡢ対ヰࠊࡋ線形ࡢ感ᗘ計算ࢆ防い࡛ࠊ୙連⥆ࡢ方法࡛࣏ࣞࢫン
 ࠋࢇࡏࡲࢀࡋࡶ࠿ࡿࡍ影響࡟ࢫ

例 

PARAMETER ANSYS TABLE MP 1 TYPE EX DENS NUXY 

PARAMETER ANSYS TABLE MP 999 TYPE EX NUXY 

PARAMETER ANSYS TABLE RCONST 16 TYPE AREA IXX IYY IZZ 

PARAMETER ANSYS TABLE RCONST 1 TO 15 TYPE TK 

PARAMETER ANSYS TABLE RCONST 3 TO 10 TYPE FKN 

PARAMETER ANSYS TABLE MP 1 TO 4 TYPE EX # (uniform modification of dij= d11 -> d66) 

PARAMETER ANSYS TABLE TBDATA 6 TYPE MATRIX 

PARAMETER ANSYS TABLE TBDATA 6 TYPE D11 D22 D33 D44 D55 D66 # (uniform modification of sij) 

PARAMETER ANSYS TABLE CBMX 1 TO 35 TYPE MATRIX 

PARAMETER ANSYS TABLE CBMX 1 TYPE S11 S12 S13 S14 S15 S16 S22 + 

S23 S24 S25 S26 S33 S34 S35 S36 S44 S45 S46 S55 S56 S66 

PARAMETER ANSYS TABLE SECBLOCK_SHELL 110 TYPE TK LAYER 1 

PARAMETER ANSYS TABLE SECBLOCK_SHELL 110 TYPE TK LAYER 2 

PARAMETER ANSYS TABLE SECBLOCK_SHELL 110 TYPE TK LAYER 3 

PARAMETER ANSYS TABLE SECBLOCK_SHELL 111 TYPE TK LAYER 1 

PARAMETER ANSYS TABLE SECBLOCK_SHELL 111 TYPE TK LAYER 2 

PARAMETER ANSYS TABLE SECBLOCK_SHELL 111 TYPE TK LAYER 3 

PARAMETER ANSYS TABLE MP 3 TYPE EX EY EZ GXY GXZ GYZ 

PARAMETER ANSYS TABLE SECCONTROL 21 23 26 TYPE ADDMAS 

PARAMETER ANSYS TABLE SECDATA 16 TYPE A J IYY IZZ 

PARAMETER ANSYS TABLE SECBLOCK_SHELL 1 TO 15 TYPE TK 
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 使用方法ࡢ࣮ࢨ࢘ࣛࣈ࣭ࢱ࣮࣓ࣛࣃ

ࡣࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ࣭࣮ࢨ࢘ࣛࣈ࣭ࢱ࣮࣓ࣛࣃ ANSYS CDB࣮ࣜࢲ㸦ᅗ 14㸧࡚ࡗࡼ࡟作成࣮࣋ࢱ࣮ࢹࡓࢀࡉ
ࡓࢀࡉ格納࡟ࣝ࢖࢓ࣇ࣭ࢫ ANSYS材料特性ࠊ実数定数ࣙࢩࢡࢭࠊン࣭ࢆࢺࢫࣜࡢ࢕ࢸࣃࣟࣉ検査࡟ࡵࡓࡿࡍ使用
ࡣ࢕ࢸࣃࣟࣉࡢࡽࢀࡇࠋࡍࡲࢀࡉ ANSYS࡚ࡋ࡜ࢱ࣮࣓ࣛࣃ選択ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

 

ᅗ 14 ANSYSࡋࢺࢫࣜࢆࢱ࣮࣓ࣛࣃ選択࣮ࢨ࢘ࣛࣈ࣭ࢱ࣮࣓ࣛࣃࡿࡍ 

ANSYSࣔ࢖ࡀࣝࢹン࣏࣮ࠊࢀࡉࢺANSYS࢖ンࡀࣝ࢖࢓ࣇ࣭ࢫ࣮࣋ࢱ࣮ࢹ࣭ࢫ࢖࢙ࣇ࣮ࢱ作成ࡿࢀࡉ場合࣓ࣛࣃࠊ
ࡣ࡜ࡇࡿ加えࢆࢱ࣮࣓ࣛࣃ࡟ࣝࣈ࣮ࢸ࣭ࢱ࣮ ANSYSࡀࢱ࣮࣓ࣛࣃ加え࡚ࡗ࡞࡟࡜ࡇࡿࢀࡽい࡝࠿ࡿう࠿決定ࡲࡋ
ࢱ࣮࣓ࣛࣃ古典的ࠊ࡜ࡿ答え࡜Noࠊࡁ開ࢆࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ࣭࣮ࢨ࢘ࣛࣈ࣭ࢱ࣮࣓ࣛࣃࠊ࡜ࡿ答え࡜Yesࠋࡍ
選択ࢆࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ開ࠋࡍࡲࡁANSYS࡜ࢱ࣮࣓ࣛࣃ古典的ࢆࢱ࣮࣓ࣛࣃ混合࡞ࡁ࡛ࡀ࡜ࡇࡿࡍい࡟࡜ࡇ注
意ࡉࡔࡃ࡚ࡋいࠋANSYS࡜ࢱ࣮࣓ࣛࣃ古典的ࢆࢱ࣮࣓ࣛࣃษࡾ替えࠊࡣ࡟ࡿ最初ࣝࣈ࣮ࢸ࣭ࢱ࣮࣓ࣛࣃ࡟全体ࢆ
削除ࠊࡋ次ࠊ࡟再びࢆࢱ࣮࣓ࣛࣃ加え࡚ࡉࡔࡃいࡑࠋうࠊࡤࢀࡍ選択ࡣࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲ再び示ࠋࡍࡲࢀࡉ 

 

ᅗ 15 ANSYSࡀࢱ࣮࣓ࣛࣃ利用ྍ能࡞場合࡟選択ࣉ࢖ࢱ࣭ࢱ࣮࣓ࣛࣃࡿࡍ 

ࡓ備えࢆ要素ࡿࡍ使用ࢆ࢕ࢸࣃࣟࣉࡓࢀࡉ選択ࠊࢀࡉ強調ࡣ࣮ࣗࣅࢡࢵࣜࢡ FEࣔࢆࣝࢹ示ࠋࡍࡲࡋ以前表示ࢀࡉ
 ࠋࡍࡲࡋ適合ࡀ࢕ࢸࣃࣟࣉࡓࢀࡉ選択ࠊ࡛ࡲࡿࢀࡉ表示ࡀࣝࢹFEࣔࠊࡓ

Apply࣎ࢱンࡣୗ限ࡢ Parameter Selectionࣝࣈ࣮ࢸ㸦Tables > Parameter Selection㸧࡛選択ࢆ࢕ࢸࣃࣟࣉࡓࢀࡉ加えࠊ
Lower BoundࠊUpper BoundࠊScatterࠊPDF ID値ࠋࡍࡲࢀࡉࢺࢵࢭࡀ 

対応ࡿࡍ PARAMETER ANSYS࣐ࢥン࢖ࣛࢻン࡟ࣝ࢖࢓ࣇࢢࣟࡣ加えࢱ࣭࣎ࢻ࣮࣮࣎࢟ࠊࢀࡽンࢆ௓ࢥࠊ࡚ࡋンࢯ
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 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ検査ࢆࢻン࣐ࢥ࣭࣮ࣝ

ANSYS࣏ࢫࣞࡢࢱ࣮࣓ࣛࣃンࢺ࣮࣏ࢧ࣭ࢫ 

以ୗ࣏ࢫࣞࡢンࠊࡀࣉ࢖ࢱ࣭ࢫANSYS࡜ࢱ࣮࣓ࣛࣃ共࡟使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

 共振周波数 
 ࣮ࣔࢥ࣭ࣉ࣮࢙ࢩࢻン࣏࣮ࢿンࢺ 
 MAC値 
 POC値 
 総括的࣏ࣞࢫンࢫ 
 ࣐࢕ࢸࣃࣟࣉ࣭ࢫ㸦質量ࠊ重心ࠊ質量慣性࣮࣓ࣔンࢺ㸧 
 FRF値 
 CSAC࡜ CSFࡢ FRF相関関数値 

ࡢࢫࢡࢵ࢕ࣇࣛࢢ࣭ࣗࢩࢵと࣓ࢬ࢘ࢻン࢖࣭࢘ࣝࣈ࣮ࢸ ANSYSࢱ࣮࣓ࣛࣃ 

ANSYSࡣࢱ࣮࣓ࣛࣃ一般的࡛ࣝࣈ࣮ࢸ࣭ࢱ࣮࣓ࣛࣃ࡞示ࣝ࣋ࣞࡣࡽࢀࡑࠋࡍࡲࢀࡉ ANSYS࡚ࡋ࡜示ࠋࡍࡲࢀࡉ 

 

選択ࡓࢀࡉ ANSYSࣝࣈ࣮ࢸ࣭ࢱ࣮࣓ࣛࣃ 

ࡣࢻン࣐ࢥ補足ࡿࡍ指定ࢆ࣭ࣝ࣋ࣛࢱ࣮࣓ࣛࣃ ANSYSࠋࡍࡲࡋࢺ࣮࣏ࢧࢆࢱ࣮࣓ࣛࣃ 

例えࠊࡤ次ࡢ感ᗘ࣐ࢥࡣࡓࡲ࣮࣮ࣛࣟࣉࢫࢡ࢚࣭ࢫࢡࢵ࢕ࣇࣛࢢࡣࢺࢵࣟࣉンࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍࢺࢵࣟࣉ࡛ࢻ 

MESH SENSITIVITY RESPONSE 1 TYPE EX FEM 
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ANSYSソ࣮ࣝࣂと感ᗘ解析ࡢ形成 

ANSY CDB࣮ࣜ࡜ࢲ ANSYS࡚ࡗࡼ࡟ࢱ࣮࣓ࣛࣃ作成ࢆࢫ࣮࣋ࢱ࣮ࢹࡓࢀࡉ使用ࠊࡣ࡟ࡿࡍ新ࡋいࡢࣂ࢖ࣛࢻ
ANSYS機械的࡜࣮ࣂࣝࢯ感ᗘ計算ࡀ必要࡛ࠋࡍ新ࡋい高ᗘࠊࡣࣂ࢖ࣛࢻࡢSET ANSYS ON࣐ࢥンࢡ࢔࡚ࡗࡼ࡟ࢻ
 ࠋࡍࡲࢀࡉ化ࣈ࢕ࢸ

SET ANSYSコ࣐ンࢻ 

ANSYS࢖ン࣒ࣛࢢࣟࣉ࣭ࢫ࢖࢙ࣇ࣮ࢱ用ࡼ࠾࣮ࣂࣝࢯࡢび感ᗘࢆ計算ࡿࡍ SET ANSYS࣐ࢥンࢆࢻ実行ࡔࡃ࡚ࡋ
 ࠋいࡉ

 ࢫࢡࢵࢱンࢩ

SET ANSYS [<ON> | OFF] 

補語 

OFF 
 ࠋࡍࡲࡋ指定࡟ࡵࡓࡿࡍ化ࣈ࢕ࢸࢡ࢔ࢆࢻFEMtools࣮ࣔࡢ感ᗘ解析࡜࣮ࣂࣝࢯ

ON 
 ࠋࡍࡲࡋ指定࡟ࡵࡓࡿࡍ化ࣈ࢕ࢸࢡ࢔ࢆࢻANSYS࣮ࣔࡢ感ᗘ解析࡜࣮ࣂࣝࢯ

備考 

 SET ANSYS࣐ࢥンࡣࢻୗ記࣐ࢥンࠋࡍ࡛ࢺࢵ࢝ࢺ࣮ࣙࢩࡢ࡬ࢻ 
SET SOLVER db2an 
SET SENSITIVITY METHOD ansens 
 
使用ࢆࢫ࣮࣋ࢱ࣮ࢹࡿࢀࡉ作成࡚ࡗࡼ࡟ࢲANSYS CDB࣮ࣜࠊ࡚ࡗ代わ࡟ࣂ࢖ࣛࢻ標準ࠊࡣࢻン࣐ࢥࡢࡽࢀࡇ
ࡣdb2anࠋࡍࡲࡋ化ࣈ࢕ࢸࢡ࢔ࢆࣂ࢖ࣛࢻࡿࡍ ANSYS࣓࢝ࢆࣝ࢝ࢽ操縦ࡲࠋࡍ࡛ࢺࣉࣜࢡࢫ࣭࣒ࢱࢫ࢝ࡿࡍ
ࡣansensࠊࡓ ANSYSࡢࢱ࣮࣓ࣛࣃ感ᗘࢆ計算࡟ࡵࡓࡿࡍ使用ࠋࡍࡲࢀࡉ 

例 

ANSYSࡢࢱ࣮࣓ࣛࣃ使用法ࢆ実証ࠊ࡟ࡵࡓࡿࡍ次ࡢ新ࡋい例題ࡀ࣮ࢲ࢛ࣝࣇ加えࠋࡍࡲࢀࡽ 

..\examples\sensitivity\ansys_parameters\aniso 

直交性࡜異方性ࡢ材料ࢆ特色ࡢࢻࢵࣜࢯ࡜࢙ࣝࢩࡿࡍ࡜要素ࢆ含ࡢࣝࢹࣔࡴ感ᗘ解析 

..\examples\sensitivity\ansys_parameters\composite_beam 

統合ࡓࢀࡉᶓษࡾ剛性ࡘ࡟い࡚記述ࡿࡍ CBMXࣙࢩࢡࢭンࢆ備えࡓ合成ࡢࣝࢹ࣭࣒࣮ࣔࣅ感ᗘ解析 

..\examples\sensitivity\ansys_parameters\contact 

࡜材料特性ࡣࢱ࣮࣓ࣛࣃࠋࡍ接触要素࡛ࡣ感ᗘ解析ࡢࢻࢵࣜࢯ RCONSTࢆ含࡛ࢇいࠋࡍࡲ 

..\examples\sensitivity\ansys_parameters\m3 

 感ᗘ解析ࡢ棒㸦r㸧直ᚄ࡜h㸧ࠊン次元㸦bࣙࢩࢡࢭ࣭࣒࣮ࣅ

..\examples\sensitivity\ansys_parameters\simple_plate 

 ࠋࡍࡲい࡛ࢇ含ࢆ材料特性࡜ࡉᒙ厚ࡣࢱ࣮࣓ࣛࣃࠊࡋ作成ࢆ要素ࢻࢵࣜࢯ直交性ࡽ࠿感ᗘ解析ࡢࣝࢹ࣭ࣔࢺ࣮ࣞࣉ
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..\examples\sensitivity\ansys_parameters\support 

非組織的࡞質量ࢱ࣮࣓ࣛࣃ㸦ADMASS㸧ࡢ感ᗘ解析 

..\examples\updating\ansys_parameters\disk_modal 

感ᗘ解析࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔ࡜ンࢆࢢ示ࡍ典型的࡞例題࡚ࡋ࡜ࢱ࣮࣓ࣛࣃ࡜ RCONSTࡼࡢうࢭ࣭ࢱ࣮࣓ࣛࣃ࡞
 例題ࡓࡋ使用ࢆSECDATA㸧ࠊン㸦SECBLOCK_SHELLࣙࢩࢡ

LS-Dyna࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

 LS-Dyna R11.1.0ࢺ࣮࣏ࢧࡢ 
 新ࡋいࡿࡍࢺ࣮࣏ࢧࢆ࣮ࢲࢵ࣭࣊ࣝ࢖࢓ࣇ修ṇࠊࡣ要素࣐ࡢࣝ࢖࢓ࣇ࣭ࢫࢡࢵࣜࢺ ࡲࡋ増加࡟ࢺࢵࣅ35～32

 ࠋࡓࡋ

NASTRAN࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

 MSC.Nastran 2020࡜MSC.Nastran 2021ࢺ࣮࣏ࢧࡢ 
 NX Nastran 2020ࢺ࣮࣏ࢧࡢ 
 ᑠࢻ࣮ࣝ࢕ࣇ࡞ࡉ㸦第 ࡿࡍ混合ࢆン㸧࢖ࣛ⥆⥅形式㸦ࢻ࣮ࣝ࢕ࣇ大規模࡜ン㸧࢖1ࣛ TABLEM1࣮࢝ࢧࡢࢻ

 ࢺ࣮࣏
 FEMtoolsࡽ࠿ Nastranࢆ実行ࡿࡍ場合ࢆࢡࢵ࢙ࢳ࣭ࣗࢩࢵ࣓ࠊ回避ࠊ࡟ࡵࡓࡿࡍGEOMCHECK=NONE࣮࢝ࢻ

ࡢ㸦前࣮ࣝࣟࢺンࢥ࣭ࣈ࢕ࢸࢡࢮࢢ࢚ࡀ CEND㸧࡟加えࣗࢩࢵ࣓ࡣࢀࡑࠋࡍࡲࢀࡽ品質ࡀࢡࢵ࢙ࢳ別々࡟行
わࠊࢀNASTRANࣂ࢖ࣛࢻ㸦ࡣࢀࡑ再解析ࢆ目的ࡿࡍ࡜㸧ࢆ使用ࡿࡍ前࡟行わࡀ࡜ࡇࡿࢀ勧࡜ࡿࢀࡽࡵいうࡇ
 ࠋࡍ࡛࡜

 ࡀ࣮ࣜࢺࢡࣞ࢕ࢹ異ࡿ࡞場合ࠊ処理ࠊࡎࢀࡉFEMtoolsෆ部࢖࡛ࢫ࣮࣋ࢱ࣮ࢹン࣏࣮ࢲࡓࢀࡉࢺン࢖࢓ࣇ࣭ࣉ
ࣝ㸦nastran.dmp㸧ࡣࣝ࢖࢓ࣇ現ᅾࡢ作業࢖ࠊࢀࡉ࣮ࣆࢥ࡟࣮ࣜࢺࢡࣞ࢕ࢹン࣏࣮ࡓࢀࡉࢺ FEM࡟ࣝ࢖࢓ࣇ఩
置ࢆࢢࣂࡣࢀࡇࠋࡍࡲࡋ解決ࠊࡋ作業ࡀ࣮ࣜࢺࢡࣞ࢕ࢹ変更ࡓࢀࡉ場合㸦例えࠊࡤ異࡟࣮ࢲ࢛ࣝࣇࡿ࡞保Ꮡ

 ࠋࢇࡏࡲࢀࡉ使用ࠊࢀ失わࡣ㸦nastran.dmp㸧ࣝ࢖࢓ࣇ࣭ࣉンࢲࠊ㸧ࢺࢡ࢙ࢪࣟࣉࡓࢀࡉࡍ

SAP2000࢖࣭ࢱ࣮ࢹンࢫ࢖࢙ࣇ࣮ࢱとࣂ࢖ࣛࢻ 

 SAP2000 v22ࢺ࣮࣏ࢧࡢ 
 SAP2000ࡢࢫࢭࣟࣉ開始ࢺ࣮࣏ࢧࡢࢬ࣮ࣟࢡ࡜ 

 㸦MPE㸧࣮ࢱࢡࣛࢺࢫࢡ࢚࣭ࢱ࣮࣓ࣛࣃ࣭ࣝࢲ࣮ࣔ

 MPEࡢࢻ࣮ࣔࣝ࢔ࣜࡿࡅ࠾࡟ᢳ出ࢺࢵࣟࣉࡣᅗ形ࢆ複素࣮࡛ࣔࢻ実現࠿ࡿࡍあࡿいࡣ REALIZE࣐ࢥンࡼ࡟ࢻ
遊い࡞ࡉᑠࠊࢀࡉ使用ࡀ法ࢻ࣮ࣔࣝ࢔ࣜࡿ࡞異ࠋࡓࡋࡲࢀࡉᢳ出法࡛改訂࡞うࡼࡿࡍ表示ࢆࢻ࣮ࣔࣝ࢔ࣜࡿ

 ࠋࢇࡏࡲࢀࡋࡶ࠿ࡿ残ࡀ
 FRF Explorerࢥࡢン࣏࣮ࢿンࡀࢺ選択ࡿࢀࡉ場合ࠊFRF࢚ࡢࣈࢱ࣭࣮ࢱࢡࣛࢺࢫࢡ歪ࡀࣉ࣮࢙ࢩࡔࢇ選択ࢀࡉ

ࡓ FRFࠋࡍࡲࡁ⥆࡟࣮ࣗࣅ௚࠾࡟࣮ࣗࣅࡢい࡚ࠊࡣ複素値ࡀ示ࠋࡍࡲࢀࡉ㸦ᅗ 16参照㸧 
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ᅗ 16 FRF虚数部表示ࡢ ODSࢥン࣏࣮ࢿンࢺ 

 FRF࢚ࡢࣈࢱ࣭࣮ࢱࢡࣛࢺࢫࢡ ODS選択࡛ࣂࠊࡣンࡀ࣮ࢱࢡࣛࢺࢻ狭い周波数ࣞンࢡ࣮ࣆࡢࢪ周波数ࢆ選択
㸦ᅗࠋࡓࡋࡲࡋ 16参照㸧 

 ࣜンࣂࡓࡋࢡンࠊࡣ࣮ࢱࢡࣛࢺࢻRe/Imࢡ࣮ࣆࡢ周波数ࢆ選択࡟ࡵࡓࡿࡍ使用ࠋࡍࡲࡋࢺࢵࣟࣉࠊࢀࡉ㸦ᅗ 17
参照㸧 

 

ᅗ 17  FRF虚数部表示ࡢ ODSࢡ࣮ࣆ 

 異࢖࣭ࢻ࣮ࣔࡢࣉ࢖ࢱࡿ࡞ンࢱ࣮ࢣࢪ関数ࠊࡣPoles Extractionࣈࢱ()࡛選択ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 
― CMIF㸦複素MIF㸧：FRF࣐ࡢࢫࢡࢵࣜࢺ特異値ศ解ࡽ࠿得ࡼࡿࢀࡽうࡣࢀࡇࠊ࡟標準ࡢ複雑ࢻ࣮ࣔ࡞標識
機能࡛ࠋࡍ 
― 虚数部MIF：ࡣࡽࢀࡇ FRFࡢ想像ୖࢥࡢン࣏࣮ࢿン࡟ࢺ基࡙ࡾࡼࠊࡣࢡ࣮ࣆࠋࡍࡲࡁᑠࡉいࠊࡀ貧弱࡟起
動ࡿࢀࡉ比例ࡓࡗ‵࡚ࡋ構造ࡢ場合ࡾࡼࡣ࡟明白ࠋࡍࡲࡾ࡞࡟ 
― 無限軌遈 CMIF：交差ࡢ後࡟ CMIF࣮࢝ࠋࡍࡲࡁ⥆࡟ࣈ 
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ᅗ 18  Poles Extractionࡢࣈࢱ CMIF選択 

 Poles Extractionࡀࣈࢱ必要ࡓࡗࡔ時ࡀ࣮ࢱࢡࣛࢺࠊ保Ꮡࠊࢀࡉ回復ࠋࡍࡲࢀࡉ 
 Modes Extractionࡿࡼ࡟ࣈࢱ複素ࡢࢺࢵࣟࣉ極ᗙ標ᅗࡢ問題ࡀ解決࣮ࢱ࣮ࣞࣃࢭࠋࡍࡲࢀࡉ角ᗘࢆ変更ࡿࡍ場

合ࠊ表示ࡿࢀࡉ角ᗘࡢ180+～180-ࠊࡣ範ᅖ࡛ࠋࡍ 

剛体࣮ࢱࢡࣛࢺࢫࢡ࢚࣭࢕ࢸࣃࣟࣉ㸦RBPE㸧 

FRF TEST࣐ࢥンࡓࢀࡉ࡞࡛ࢻ修ṇࠊࡣRBPEࡢ改善 FRFࢆ計算࡟ࡵࡓࡿࡍ使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ例えࡼࠊࡤ
ࡓ基࡙い࡟పい残余ࡾ FRFࡢ計算結果あࡿいࡣప部ୖ࡜部࡟ࢺ࢛ࣝࣇࢹࡢ含࡞ࢀࡲい弾性࣮ࣔࡢࢻ選択結果ࢆ表
示ࠋࡍࡲࡋ 

FEMtools 4.2 RBPEࡢ質量ࣛ࢖ンᢳ出ࡣ完全࡟水ᖹࡢ FRF࣮࢝ࡢࣈ特別஦件ࠋࡍࡲࡋࢺ࣮࣏ࢧࢆ஧次関数ࣈ࣮࢝ࡢ
適合ࡢࡇࡣ場合必要࡛ࡣあࡢࡇࠋࢇࡏࡲࡾ修ṇࡾࡼࡣపい残余㸦LR㸧࡟基࡙いࠊࡓ改善ࡓࢀࡉ FRFࡢ別ࡢ方法ࢆ
使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

 ࠋいࡉࡔࡃ࡚ࡋ参照ࢆࢻ࢖࣮࢞ࢨFEMtools RBPE࣮ࣘࠊࡣい࡚ࡘ࡟ヲ細ࡾࡼ

改善さࢀた FRFࡢ使用方法 

剛体࣮ࣔ࡜ࢻ第 1弾性࣮ࣔࢻ間ࡢ周波数ࣞンࡀࢪ質量ࣛ࢖ン値ࢆᢳ出࡟ࡢࡿࡍ十ศ࡟広い場合ࡓࡲࠊ FRFࡀ十ศ
ࡢࢪ周波数ࣞンࡢࡇࠊ場合ࡿࢀࡽ考え࡜ࡿࢀࡉ測定࡟ FRFࢆ測定ࢀࡑࠊࡋ以ୖࡢ処理࡛ࡋ࡞使用ࡁ࡛ࡀ࡜ࡇࡿࡍ
 ࠋࡍࡲ

 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ方法࡛改善ࡿ࡞異ࡣFRFࠊࡤࢀࡅ࡞う࡛ࡑ

 弾性࣮ࣔࡁ࡜ࡢࡑࡀࢻ利用ྍ能࡞場合ࠊ最పࡢ弾性࣮ࣔࡣࢻ FRFࡾྲྀࡽ࠿除ࡣࢀࡇࠋࢇࡏࡲࢀࡋࡶ࠿ࡿࢀ࠿
ᢳ出ࡓࢀࡉ弾性࣮ࣔࡢࢻ最ప࣮ࣔࢆࢻ含࡞ࡲい FRFࢆ再合成ࡾࡼ࡟࡜ࡇࡿࡍ行わࠋࡍࡲࢀ次ࠊ࡟再合成ࢀࡉ
ࡓ FRFࡢࣝࢼࢪࣜ࢜ࡣ FRFࡽ࠿引ࡣࢀࡇࠋࡍࡲࢀ࠿質量ࣛ࢖ンࡀᢳ出ࡿࡁ࡛ࡀ࡜ࡇࡿࡍ周波数ࣞンࢆࢪ広ࡆ
ࡢࣝࢼࢪࣜ࢜ࠋࡍࡲ FRFࡀ使用ࠊࢀࡉ質量ࣛ࢖ンࢆᢳ出ࡢࡵࡓࡿࡍ周波数ࣞン࡛ࢪあ࡟ࡿ遊いあࠋࢇࡏࡲࡾ 

 弾性࣮ࣔ࡟ࢻ加えࡾࡼࠊపい残余㸦LR㸧ࡀ利用ྍ能࡞場合ࡣࡽࢀࡇࠊ FRF再合成࡟含ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡴ次
ࡓࢀࡉ再合成ࠊ࡟ FRFࡢࣝࢼࢪࣜ࢜ࡣ FRFࢆ交換ࠋࡍࡲࡋ質量ࣛ࢖ンࢆᢳ出࡟ࡵࡓࡿࡍ使用ࡿࢀࡉ周波数ࣞ
ンࡢࣝࢼࢪࣜ࢜ࡢࢪ測定 FRF࡟పい確信ࡀあࡿ場合ࡢࡇࠊ手⥆ࡀࡁ好ࡢࡇࠋࡍࡲࢀࡲ手⥆ࡣࡁ質量ࣛ࢖ン値
࡟ࡵࡓࡢFRF再合成ࠊࡋ࡟水ᖹࢆFRFࠊࡅ見付࡟容易ࡀ LRࢆࡳࡢ使用ࠋࡍ࡛࡜ࡇࡿࡍ 

 FEMtoolsࠊࡣ残余ࡢప部࡟様ྠ࡜残余ࡢ部ୖࠊ場合ࡿࢀࡉ使用ࡀ法㸦pLSCF㸧࣮ࢱࢡࣛࢺࢫࢡ࢚࣭ࣝࣂ࣮ࣟࢢ
MPEࡢ副産物࡛ࠊ࡚ࡗࡀࡓࡋࠋࡍFRF改良方法ࡣ両方ࡶ࡜使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍFEMtools MPEࡣ個別࢖ࣛࡢ
 ࠋࡍࡲࡋ要求ࢆࢫンࢭ

FEMtools MPE࡜ࣉ࣮࢙ࢩࢻ࣮ࣔࡀ LRࢆᢳ出࡟ࡵࡓࡿࡍ使用ࡿࡍ場合ࠊࡣLRࡢ評価ୖࣝࢲ࣮ࣔࡢษ断࢖ࡢンࢡࣃ
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第ࠊ࡟ࡵࡓࡿࡍ縮ᑠࢆࢺ  ࠋいࡉࡔࡃ࡚ࡋᢳ出ࢆࢻ࣮ࣔࡿࡍ関࡟ࢪ周波数ࣞンࡴ含ࢆࢻ࣮ࣔࡢࡃ多ࡾࡼࡢࡶࡢ1

ࢺン࣏࣮࢖ࢆࣉ࣮࢙ࢩࢻ࣮ࣔࡢFEMtoolsࠊࢀࡉᢳ出ࡶLRࠊ場合ࡿࢀࡉ中࡛ᢳ出࣒ࣛࢢࣟࣉࡢ別ࡀࣉ࣮࢙ࢩࢻ࣮ࣔ
 ࠋいࡉࡔࡃ࡚ࡋࢡࢵ࢙ࢳ࠿う࡝࠿ࡿࢀࡲ含ࡀࣝ࢖࢓ࣇࡿࢀࡉ使用࡟ࡵࡓࡿࡍ

前述ࡼࡢう࡞改善ࡓࢀࡉ FRFࢆ得ࠊࡣ࡟ࡿ最初࡟改良方法ࢆ決ࡣࢀࡇࠋࢇࡏࡲࡾ࡞ࡤࢀࡅ࡞ࡵ弾性࣮ࣔࡾࡼ࡜ࢻ
పい残余ࡢ᭷効性関数ࠋࡍࡲࡾ࡞࡟ 

第 ࢺࢫࢸࡢࣝࢼࢪࣜ࢜࡟ࢫ࣮࣋ࢱ࣮ࢹFEࠊࡣ方法ࡢ1 FRFࠊࡋ࣮ࣆࢥࢆ次ࠊ࡟第 第ࡣいࡿ㸦あࢻ弾性࣮ࣔࡢ1
第ࠊ2 ࢺࢫࢸࠊࡋ使用ࢆ㸧…ࠊ3 FRFࢆ再合成ࡓࢀࡉ FRFࡾྲྀ࡟替えࠋࡍ࡛࡜ࡇࡿ但ࠊࡋLRࡣ含ࠋࢇࡏࡲࡳ 

COPY TEST 
FRF TEST MODE 1 RESIDUAL OFF  

次ࠊ࡟FE FRFࢺࢫࢸࡽ࠿ FRFࢆ引ࢺࢫࢸࠊࡁ FRFࢆࡽࢀࡑ࡚ࡋ࡜格納ࢺࣉࣜࢡࢫ࣭࢕ࢸࣜ࢕ࢸ࣮ࣘ࡟ࡵࡓࡿࡍ
subtract_frfs.basࢆ使用ࢺࢫࢸࡢࡽࢀࡇࠋࡍࡲࡋ FRFࢺࢫࢸࡢࣝࢼࢪࣜ࢜ࡣ FRFࡢ改善ࡓࢀࡉ FRF࡛ࠋࡍ但ࠊࡋ第
࡟ࡵࡓࡿࡆ広ࢆン周波数帯࢖質量ࣛࡣFRFࠖࡓࢀࡉ改善ࠕࡢࡶ࡞うࡼࡢࡑࠋࡍ࡛ࡋ࡞ࡣ㈉献ࡢࢻ弾性࣮ࣔࡢ1
RBPE࡛使用ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ 

第 ࢺࢫࢸࡓ備えࢆࡳࡢLRࠊࢀࡉ使用࡟場合࡞利用ྍ能ࡀLRࠊࡣ方法ࡢ2 FRFࢆ再合成ࡽ࠿࡜ࡇࡿࡍ成ࠋࡍࡲࡾ 

FRF TEST MODE NONE RESIDUAL LOWER  

水ᖹࡿࡁ࡛ࡀ࡜ࡇࡿࡍRBPE࡛使用ࠊࡣࢀࡇ FRFࢆ生産ࡢࡑࠋࡍࡲࡋ後ࠊ慣性ࡢ࢕ࢸࣃࣟࣉᢳ出ࡣ選択ࡓࢀࡉ周波
数ࣞン࡜ࢪ無関係ࠋࡍࡲࡾ࡞࡟ 

変形ࢺࢫࢸࡣ FRFࢆ再合成࡟ࡵࡓࡿࡍ LR࡜弾性࣮ࣔࡢࢻ両方ࢆ使用ࡣࢀࡇࠋࡍ࡛࡜ࡇࡿࡍ滑ࢬ࢖ࣀࠊ࡞࠿ࡽ音࡞
ࡢࡋ FRF࡟結びࠊࡀࡍࡲࡁࡘ質量ࣛ࢖ン範ᅖࢆ広ࠋࢇࡏࡲࡆ 

修ṇ済ࡢ FRF࡜ LR FRFࡢ使用ࢆ実証ࡘ࠿ࠊࡋ数的࡟得ࡓࢀࡽ剛体࡟࢕ࢸࣃࣟࣉ対ࡿࡍ結果ࢆ᭷効ࠊ࡟ࡵࡓࡿࡍ࡟
追加࣐ࢥࡢンࡣࢺࣉࣜࢡࢫ࣭ࢻ例題..\rbpe\examples\engine࡟加えࠋࡍࡲࢀࡽ 

コ࣐ンࢻ 

新ࡋいコ࣐ンࢻ 

PARAMETER ANSYS ANSYSࢆࢱ࣮࣓ࣛࣃ定義࣐ࢥࠋࡍࡲࡋンࢻ PARAMETER ANSYSࢆ参
照ࡉࡔࡃ࡚ࡋいࠋ 

RESPONSE STRESS ࢫࣞࢺࢫ値ࢆ感ᗘ解析࢕ࢸ࣮ࢹࣉࢵ࢔ࣝࢹࣔ࡜ン࣏ࢫࣞࡢࢢンࡋ࡜ࢫ

࡚定義ࢆ࡜ࡇࡿࡍ確ࡉࡔࡃ࡚ࡵ࠿いࢩࠋンࡣࢫࢡࢵࢱ RESPONSE 
STRAINྠ࡜一࡛ࠋࡍ 

SET ANSYS ON ANSYS࢖ン࡜ࢫ࣮࣋ࢱ࣮ࢹ࣭ࢫ࢖࢙ࣇ࣮ࢱ ANSYSࡀࢱ࣮࣓ࣛࣃ使用
࡜࣮ࣂࣝࢯ感ᗘ解析ࠊ場合ࡓࢀࡉ ANSYSࢆࣂ࢖ࣛࢻ形成ࠋࡍࡲࡋSET 
ANSYS࣐ࢥンࢆࢻ参照ࡉࡔࡃ࡚ࡋいࠋ 

修正済ࡢコ࣐ンࢻ 

EXAMINE SPANKE 補足 EXCITERࢆ付ࡅ加えࠋࡓࡋࡲ 
FRF TEST MODE࡜ RESIDUAL選択ࡢ新ࡋい補足ࡀ追加ࣔࡣࢀࡑࠋࡓࡋࡲࢀࡉ

ࡳࡢࢻ࣮ࣔࡣいࡿ部㸧あୖࡣࡓࡲࠊ㸦ప部ࣝࢺࢡ࣋ࡢ残余ࠊࡳࡢࢻ࣮

 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿࡍ指定ࢆ残余࡜FRF合成ࠊࡋ使用ࢆ
MODIFY FRF RESAMPLE値ࣙࢩࣉ࢜ࡣン࡛ࠊࡃ࡞実値࡛ࠋࡍ 
SET DOE 補足[SCALE{LINEAR|EXPONENTIAL}]࣐ࢆࢫࢡࢵࣜࢺ加えࠋࡓࡋࡲ 



130 - FEMtools 4 Release Notes  

TABLE MATRIX ࣜࢺࢫンࠋࡍ࡛ࢫࢡࢵࣜࢺ࣐࣭ࢢ 

FEMtoolsࢺࣉࣜࢡࢫ 

新ࡋい FEMtoolsࢺࣉࣜࢡࢫ機能 

いࡋ新ࡣンࣙࢩࢡࢭࡢࡇ FEMtoolsࢺࣉࣜࢡࢫ関数ࢆ記述ࠋࡍࡲࡋ 

UniqueRows 値࡜配列ࢆ得ࠋࡍࡲ 

修正済ࡢ FEMtoolsࢺࣉࣜࢡࢫ機能 

 ࠋࡍࡲࡋ記述ࢆ変更ࡢ関数ࢺࣉࣜࢡࢫFEMtoolsࠊࡣンࣙࢩࢡࢭࡢࡇ

SQLQuery bThreaded引ࡁ数࡟加算ࠋࡍࡲࢀࡉ 

FEMtools API 

新ࡋい FEMtools API機能 

いࡋ新ࡣンࣙࢩࢡࢭࡢࡇ FEMtools API関数ࡘ࡟い࡚記述ࠋࡍࡲࡋ 

Ft_PutObject ࣈ࢕ࢸࢡ࢔ OLE࣮࢜ࣙࢩ࣮࣓ࢺン㸦ActiveX㸧࢜ࣁࡢ࡬ࢺࢡ࢙ࢪࣈンࢻ
 ࠋࡍࡲࡋ格納ࢆࣝ

Ft_GetElemStrainComp 要素࢖ࣛࢺࢫン࣭ࢆࢱ࣮ࢹ返ࠋࡍࡲࡋ 
Ft_GetElemStressComp 要素ࢆࢱ࣮ࢹ࣭ࢫࣞࢺࢫ返ࡍࡲࡋ 
Ft_GetRespStres ࣏ࢫ࣭ࣞࢫࣞࢺࢫンࢆࢱ࣮ࢹ࣭ࢫ返ࠋࡍࡲࡋ 

修正済ࡢ FEMtools API機能 

 ࠋࡍࡲࡋい࡚記述ࡘ࡟変更ࡢFEMtools API関数ࠊࡣンࣙࢩࢡࢭࡢࡇ

Ft_SaveSettings ࣮࣮ࣘࢨ定義ࡿࢀࡉ(VF_USER)ࡼうࡀࢢࣛࣇࠊ࡟変数࡟立࡚࡚ࢀࡽい
࡟ンࣙࢩࢡࢭ[Variables]ࡢࣝ࢖࢓ࣇINIࠊ࠿変数ࡢෆ蔵ࡀࢀࡑࠊ場合ࡿ
あࡿ場合ࠊ[Settings]࡟保Ꮡࠋࡍࡲࢀࡉ以前ࠊࡣ[Settings]࡟常࡟書ࡲࢀ࠿
 ࠋࡓࡋ

Ft_SendGraphicCommand 引ࡁ数ࠕࡢtracker.leftࠖࠕ࡜tracker.rightࠖࢆ加えࠋࡍࡲ 
Ft_Set/GetGraphic 新ࡋい属性ࠕfsizeࠖࡢࢺ࢛ࣝࣇࢹࡣ自動㸦࢘࢕ンࢬ࢖ࢧ࣭࢘ࢻ依Ꮡ㸧

加ࡅ付࡟ࡵࡓࡿࡍ指定ࢆࢬ࢖ࢧ࣭ࢺン࢛ࣇ固定࡟ࡾ代わࡢࢢンࢪ࢖ࢧ

えࠋࡍࡲࢀࡽ 
Ft_UpdateEmat ࡚ࡗࡼ࡟ࢱ࣮࣓ࣛࣃࡢࡑࡣࢀࡑ影響ࡓࡅཷࢆ要素࣐ࢆࢫࢡࢵࣜࢺ単࡟

更新ࢱ࣮࣓ࣛࣃ࡟ࡵࡓࡿࡍ ID࣮ࣜࢣࢫ࡜ンࢢ係数ࢆ指定࡛ࡀ࡜ࡇࡿࡍ
 ࠋࡍࡲࡁ

定数 

新ࡋい一定࣭࣮ࠖࣝ࣋ࣞࢱ࣮࣓ࣛࣃࠕࣉ࢖ࢱࡢ(PL_)ࡀᑟ入ࠋࡍࡲࢀࡉ次ࡢ定数ࡀ定義ࠋࡍࡲࢀࡉ 

Constant   Value   Description 

PL_GLOBAL 1   Global parameters 
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PL_LOCAL  2   Local parameters 

PL_LDAMPING  5   Local damping parameters 

PL_GDAMPING  6   Global damping parameters 

PL_TEXT  7   Text parameters 

PL_GENERIC  8   Generic parameters 

PL_MATERIAL  9   Material property parameters 

PL_GEOMETRY  10   Geometry property parameters 

PL_ANSYS  11   ANSYS parameters 

環境変数 

 ࢢンࣜࢺࢫと࣮ࣛ࢝ࢫ

ansys.database ANSYS࢖ンࣝ࢖࢓ࣇ࣭ࢫ࣮࣋ࢱ࣮ࢹ࣭ࢫ࢖࢙ࣇ࣮ࢱ㸦SQLITE 3࣮ࢹࣝ࢖࢓ࣇ
 ࠋࡍࡲࡳ含ࢆࢫࣃ࡜前ྡࡢ㸧ࣝࣈ࣮ࢸ࣭ࢫ࣮࣋ࢱ

ansys.db.export ࢚࢖ࡿࡍࢺ࣮࣏ࢫࢡンྡࡢࢺࣉࣜࢡࢫ࣭ࢫ࢖࢙ࣇ࣮ࢱ前࡜補足ࢆ指定ࠋࡍࡲࡋ

ࡣࢺࣉࣜࢡࢫ࣭ࢫ࢖࢙ࣇ࣮ࢱン࢖ࡢࡇ ANSYS࢖ン࣮࣋ࢱ࣮ࢹ࣭ࢫ࢖࢙ࣇ࣮ࢱ
࢝ࠊࡀい࡞࡟ࣝ࢖࢓ࣇ࣭ࢢン࢕ࢸࢵࢭࠊࡾ固定࡛あࡣ変数値ࠋࡍࡲࡋ利用ࢆࢫ

 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇࡿ加え࡟ン目的ࣙࢩ࣮ࢮ࢖࣐ࢱࢫ
ansys.method ࢱ࣮࣓ࣛࣃ選択ࠊ感ᗘ解析ࡼ࠾び再解析ࡢ ANSYS値ࡀ使用ࢆ࡜ࡇࡿࢀࡉ明示

 ࠋࡍࡲࡋ
-1=未知数：࣮ࣘ࡟࣮ࢨ ANSYSࢆࢱ࣮࣓ࣛࣃ選ࠋࡍࡲࡏࡤ㸦not=ࢺ࢛ࣝࣇࢹ㸧 
0=標準ྲྀࡾ扱い㸦FEMtools 4.2以前㸧 
1=新ࡋい ANSYS࢖ンࢆࣂ࢖ࣛࢻ࡜ࢫ࣮࣋ࢱ࣮ࢹ࣭ࢫ࢖࢙ࣇ࣮ࢱ使用ࠋࡍࡲࡋ
ࢻン࣐ࢥࡣ変数ࡢࡇ SET ANSYSࠋࡍࡲࢀࡉࢺࢵࢭ࡚ࡗࡼ࡟ 

graphic.mode ࢆࢻ࣮࣭࣮ࣔࣗࣅ࣭ࢫࢡࢵ࢕ࣇࣛࢢ指定ࠋࡍࡲࡋ 
0=即時࣮ࣔࢻ㸦glBegin/glEnd㸧：ᪧ式࡛ࡀࡍほ࣮࢝ࢫࢡࢵ࢕ࣇࣛࢢࡢ࡝ࢇ࡜
 ࠋࡍࡲࡋࢺ࣮࣏ࢧ࡟࣮ࣂ࢖ࣛࢻ࣭ࢻ
1=保持࣮ࣔࢻ㸦VOB Vertex Object Buffers㸧：幾何学ࡀࢱ࣮ࢹ配列࡟格納ࠊࢀࡉ
GPU࣓ࣔࣜ࡟㏦ࡓࡲࠊࢀࡽ多数回使用ࠋࡍࡲࢀࡉ 
࡟ࢺࢡ࢙ࢪࣈ࣭࢜ࢡࢵ࢕ࣇࣛࢢ=2 VOB+遝ග物ࢆ使用ࠋࡍࡲࡋ遝ග物ࡣ 3Dᗙ
標ࣝࢭࢡࣆࡽ࠿㸦頂点遝ග物㸧࡛ࡲ変形࡜色࡙ࢆࡅ管理ࠋࡍࡲࡋ遝ග物ᢏ術ࡣ

ࢺࢡ࢙ࢪࣈ࣭࣮࢜࢓ࣇࢵࣂ頂点ࡓࢀࡉび例証ࡼ࠾生地࡟ࡵࡓࡿ୚えࢆ࣮࣮࣐࢝

矢印㸧表ࠊࢺࢫ࢟ࢸࠊン࣎ࣝࢩ㸦࣮࣮࣐࢝ࠊࡾࡼ࡟࡜ࡇࡿࡍ使用ࢆ遝ග物ࡢ࡜

示ࢆ加速ࠋࡍࡲࡋ 
interface.ansys.mode 対ヰࢥࢆࣝ࢖ࢱࢫンࠋࡍࡲࡋ࣮ࣝࣟࢺ 

 ࣝ࢖ࢱࢫ࣭ࢬ࢘ࢻン࢖࢘=0
1=Qt “native”ࣝ࢖ࢱࢫ 
 Windowsࠊࡀࡍࡲࡋ使用࡟ࡵࡓࡿࡍ変更ࢆ外観ࡢࢫࢡࢵ࣎ࢢࣟ࢔࢖ࢲࡣࢀࡇ
API࣮ࣜࢺࢡࣞ࢕ࢹ࣭ࣝ࢖࢓ࣇࡀ㸦࢔ࠊࣉࢵ࢔ࢡࢵࣂンࠊࢫࣝ࢕࢘ࢳ...㸧ࢆ集
中的࡟利用ࡿࡍ௚ࣙࢩ࣮ࢣࣜࣉ࢔ࡢンあࡿい࡟ࢫࢭࣟࣉࡣ対処࡚ࡋいࡿ場合ࠊ

実行࡟影響ࠋࢇࡏࡲࢀࡋࡶ࠿ࡿࡍ 
interface.ansys.mode ANSYS࢖ン࢙ࣇ࣮ࢱｲࢫ方法ࢆ指定ࠋࡍࡲࡋ 

0=ANSYS࢖ンࢆࢫ࣮࣋ࢱ࣮ࢹ࣭ࢫ࢖࢙ࣇ࣮ࢱ使用ࠋࢇࡏࡲࡋ㸦FEMtools 4.2ᑟ
入前㸧 
1=ANSYS࢖ンࢆࣝ࢖࢓ࣇ࣭ࢫ࣮࣋ࢱ࣮ࢹ࣭ࢫ࢖࢙ࣇ࣮ࢱ作成ࠊࡋ使用ࡲࡋ
変数ࡓࡲࠋࡍ値࡛ࢺ࢛ࣝࣇࢹࡣࢀࡇࠋࡍ ansys.databaseࢆ参照ࡉࡔࡃ࡚ࡋいࠋ 
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lsdyna.database LS-DYNA࢖ンࣝ࢖࢓ࣇ࣭ࢫ࣮࣋ࢱ࣮ࢹ࣭ࢫ࢖࢙ࣇ࣮ࢱ㸦SQLITE 3ࣝ࢖࢓ࣇ㸧
 ࠋࡍࡲࡳ含ࢆࢫࣃ࡜前ྡࡢ

parameter.ansys.script ࢱ࣮࣓ࣛࣃ値ࢆ定義ࠊࡋࢺࢵࢭࠊ検索ࡿࡍ ANSYSࣕࢪ࣮ࢿ࣐࣭࣮ࢱ࣮࣓ࣛࣃ
ン࢕ࢸࢵࢭࠊ࡛ࢻ࣮ࢥࢻ࣮ࣁࡣ変数ࡢࡇࠋࡍࡲࡋ指定ࢆ前ྡࡢࢺࣉࣜࢡࢫ࣭࣮

ࡿ加え࡟ࡵࡓࡢ目的ࡢンࣙࢩ࣮ࢮ࢖࣐ࢱࢫ࢝ࠊࡀࢇࡏࡲࡾあࡣ࡟ࣝ࢖࢓ࣇ࣭ࢢ

 ࠋࡍࡲࡁ࡛ࡀ࡜ࡇ
sensitivity.parameter 現ᅾࡢ感ᗘ再解析実行࡛処理࡚ࢀࡉい࢖࣭࣮ࢱ࣮࣓ࣛࣃࡢࢱ࣮࣓ࣛࣃࡿンࢵࢹ

 ࠋࡍࡲࡳ含ࢆࢫࢡ
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